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1- POWITANIE 

O Systemie Pomocy 
Ten System Pomocy jest przeznaczony dla użytkowników, którzy będą używać edytora laserowego do 
tworzenia układów graficznych dla operacji grawerowania laserowego. 

Stosowanie Systemu Pomocy: 
Dostęp do całej zawartości można uzyskać przez wybranie Help > Help z paska menu edytora laserowego 
lub naciśnięcie F1 na głównym ekranie aplikacji. 

Poza tym można skorzystać z pomocy kontekstowej, tzn. można wyświetlić temat pomocy, w zależności od 
tego co się robi: 

 Naciśnięcie F1 (lub przycisku ? na pasku tytułowym okna) otwiera pomoc na poziomie dialogu lub 
okna; 

 kliknięcie w tytuł właściwości w oknie Properties (właściwości) (np. Geometry [geometria]) 
podczas pracy na dokumencie lub obiekcie graficznym, a następnie naciśnięcie F1 otwiera tabelę z 
opisem tych właściwości. 

Zawartość Pomocy: 
Pomoc obejmuje następujące główne tematy: 

Rozdział  Zawartość 
Rozpoczęcie pracy z edytorem 
laserowym 

Przedstawia przegląd produktu pod kątem zakresu, architektury i 
interfejsu użytkownika. 

Operacje przygotowawcze Opisuje sposób rejestrowania edytora laserowego, a także sposób 
ustawiania parametrów domyślnych dla aplikacji. 

Tworzenie układów graficznych 
Opisuje sposób tworzenia układu graficznego przez dodawanie 
obiektów do dokumentu płaskiego lub pierścieniowego oraz sposób 
operowania obiektami. 

Wykonanie operacji grawerowania Zawiera instrukcje dotyczące sposobu testowania układu 
graficznego i sposobu wykonania operacji grawerowania. 

Interfejs użytkownika  mechanizmu 
laserowego 

Opisuje sposób stosowania interfejsu użytkownika mechanizmu 
laserowego. 
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2- ROZPOCZĘCIE PRACY Z EDYTOREM LASEROWYM 

Ten rozdział jest podzielony na następujące sekcje: 

Temat Czego się dowiesz 

O edytorze laserowym Zakres i przegląd właściwości edytora laserowego oraz 
architektura nowych laserowych urządzeń znakujących. 

Podręczny informator dotyczący interfejsu 
użytkownika edytora laserowego 

Skrócona instrukcja obejmująca środowisko pracy, paski 
narzędziowe i menu edytora laserowego. 
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O edytorze laserowym 
Edytor laserowy jest to elementarny pakiet oprogramowania, który umożliwia użytkownikom łatwe 
oznaczania, wytrawianie lub grawerowanie informacji identyfikujących produkt, takich jak 2-
wymiarowe kody matrycowe, liniowe kody kreskowe, kody pocztowe, piętrowe kody kreskowe, 
tekst, włącznie z wszelkimi przemysłowymi, standardowymi formatami czcionek, 
alfanumerycznymi numerami fabrycznymi, kodami dat, numerami części, grafiką i logo w każdym 
środowisku produkcyjnym. 

Edytor laserowy stanowi rozwinięcie poprzedniego programu Smartist. 

Edytor laserowy jest to kompletny system znakowania laserowego, który może służyć do: 
 edytowania układów graficznych 
 precyzyjnego dostrajania urządzeń laserowych i sterowania nimi, włącznie ze zintegrowanym 

modułem we/wy do zarządzania osiami, który umożliwia integrację z linią produkcyjną lub innym 
sprzętem znakującym 

 pełnego dostosowania do potrzeb klienta przez tworzenie zautomatyzowanych procedur 
 łatwej integracji z liniami montażowymi z komputerem lub bez 

Co jest nowego w edytorze laserowym 
Edytor laserowy ma nowy, inteligentny i intuicyjny interfejs graficzny, który jest dostępny w kilku językach. 
Kontekstowy system pomocy prowadzi użytkownika przez procedury w celu tworzenia i 
znakowania jego układów. 

Poza tym dodano nowe, potężne i elastyczne właściwości.  

Dodano nowe właściwości edycji graficznej, włącznie z, ale bez ograniczenia do 
następujących: 

 ulepszone możliwości edycji wektorów 
 zaawansowane właściwości przetwarzania wektorowego dla zautomatyzowanej edycji węzłów 
 nowe filtry importowe 
 wspomagane są zaawansowane wzory wypełniania 
 kompletna właściwość „Tablicy” specjalnie przeznaczona do znakowania układów scalonych (IC) 
 interaktywna funkcja szacowania czasu znakowania 
 funkcja optymalizacji kolejności znakowania 
 możliwość podglądu znaku (wdrożona również na poziomie edytora skryptowego) 
 możliwości anulowania / ponawiania 

(Bliższe informacje, patrz Tworzenie układów graficznych). 

Dodano nowe, zaawansowane właściwości: 
 4-osiowe sterowanie silnikiem dla obrotowych aparatów podziałowych, osi Z, osi wirnika, stołów X-Y 

i tym podobnych 

 Wbudowany moduł we/wy do sterowania sprzętem zewnętrznym 

 Możliwości znakowania „w trakcie działania programu” za pomocą kreatora konfiguracji 

 Zdalne sterowanie procesem znakowania poprzez Ethernet 

 Kontrola użytkowników i zarządzanie hasłami 
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W pełni programowalna aplikacja: 
 Dodano edytor projektu, nowy potężny edytor programów. Użytkownik może tworzyć własne 

programy i narzędzia automatyzacji: 

o aktualizować zawartość układu podczas wykonania 

o ładować i znakować dokumenty 

o zbierać dane ze źródeł zewnętrznych lub systemów baz danych 

o budować własny interfejs użytkownika 

o stosować zaawansowane funkcje eliminacji błędów 

o i dużo więcej 

Edytor projektu jest dostarczany z próbkami plików źródłowych, materiałem referencyjnym i systemem 
pomocy kontekstowej. 

Interfejs ActiveX (funkcja licencjonowana) 
Do mechanizmu laserowego dodano interfejs ActiveX. Użytkownikom, którzy są zaznajomieni z 
programowaniem Smartist ActiveX, zapewnia to podobny sposób łatwego napisania  własnego 
interfejsu graficznego na górze mechanizmu laserowego bez zajmowania się szczegółami 
sterowania laserowego niskiego poziomu. 

 

Uwaga: 
Kiedy stosuje się ActiveX, wtyczki są niedostępne. Bliższe szczegóły znajdują się w 
dokumentacji online edytora projektu, rozdział „Language reference”. 

Tematy pokrewne: 
 Podręczny informator dotyczący interfejsu użytkownika edytora laserowego 
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Podręczny informator dotyczący interfejsu użytkownika 
edytora laserowego 
Ten rozdział zawiera przegląd interfejsu użytkownika edytora laserowego i ma służyć jako podręczny 
informator, zwłaszcza w następujących kwestiach: 

 Środowisko pracy- Jak jest zorganizowane środowisko edytora laserowego 

 Stosowanie narzędzi z pasków narzędziowych- Szybki przegląd dostępnych przycisków pasków 
narzędziowych 

Środowisko pracy 
Poniższy rysunek przedstawia główne okno edytora laserowego po otworzeniu go: 
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Komponenty środowiska pracy 

 

Wskazówka: 
Bardziej szczegółowy opis sposobu wyświetlania, ukrywania lub dokowania komponentów 
środowiska pracy edytora laserowego, patrz  Ustawianie swojego środowiska pracy. 

Obszar Opis 

 
Pasek menu z wszystkimi rozkazami edytora laserowego. 

 

Paski narzędziowe z narzędziami, które umożliwiają: 

 rysowanie i zarządzanie układem grawerowania (patrz Stosowanie narzędzi z pasków 
narzędziowych) 

 interakcję z urządzeniem laserowym (patrz Pasek narzędziowy lasera.) 

 zarządzanie prawami użytkownika do funkcji systemu (patrz rozdział Mechanizm laserowy, 
sekcja Zarządzanie użytkownikami i prawami dostępu 

Pasek narzędziowy można wyświetlić przez wybranie odpowiedniego przycisku w pionowym pasku 
narzędziowym wyboru. Poza tym paski narzędziowe można ukrywać / wyświetlać przez kliknięcie 
prawym przyciskiem myszy w pusty obszar w górnej części okna. 

 

Wybór paska narzędziowego - Pionowy pasek narzędziowy umożliwia przełączanie się między 
paskami narzędziowymi. Każdy przycisk uaktywnia podzestaw przycisków poziomego paska 
narzędziowego. 
Ten pasek narzędziowy można ukryć / wyświetlić przez kliknięcie prawym przyciskiem myszy w pusty 
obszar w obszarze pasków narzędziowych. 

 

Lista poleceń anulowania / ponawiania - Wymienia wszystkie działania, które zostały wykonane 
podczas edycji układu. Umożliwia śledzenie wszystkich działań oraz anulowanie lub ponowienie 
dowolnego z tych działań. W celu anulowania / ponowienia działania należy wybrać go, a potem 
wykonać jedną z następujących czynności: 

 kliknąć w przyciski  na pasku narzędziowym 

 wybrać Edit > Undo [edytuj > anuluj] (lub Redo [ponów]) z paska menu 

Okno anulowania / ponawiania może pływać po całym obszarze roboczym albo można go zadokować 
po lewej stronie okna tuż pod paskami narzędziowymi przez podwójne kliknięcie w jego pasek tytułowy. 
Poza tym to okno można ukryć / wyświetlić przez kliknięcie prawym przyciskiem myszy w pusty obszar 
w obszarze pasków narzędziowych. 

 

Kolejność grawerowania obiektów - Pokazuje kolejność, w jakiej obiekty, które były dodane do 
dokumentu, będą grawerowane. W celu zmiany kolejności znakowania należy przeciągać obiekty na 

żądaną pozycję. W celu optymalizacji kolejności znakowania można zastosować funkcję 

 kolejność znakowania, która staje się dostępna po kliknięciu w   przycisk regulacji obiektów na 
pionowym pasku narzędziowym. 
To okno może pływać po całym obszarze roboczym albo można go zadokować po lewej stronie okna 
tuż pod paskami narzędziowymi przez podwójne kliknięcie w jego pasek tytułowy. Poza tym to okno 
można ukryć / wyświetlić przez kliknięcie prawym przyciskiem myszy w pusty obszar w obszarze 
pasków narzędziowych. 

 

Obszar roboczy - Graficzny obszar roboczy, będzie przedstawiony układ lub sekwencja grawerowania. 
Po wybraniu File > New plane (or ring) document (plik > nowy dokument płaski lub pierścieniowy), 
dokument jest wyświetlany w tym obszarze. Mogłeś jednocześnie pracować nad wieloma 
dokumentami; w tym przypadku u góry obszaru roboczego będą wyświetlane zakładki 

dokumentu,  żeby umożliwić przełączanie się między 
dokumentami. Aby zamknąć poszczególny dokument, należy kliknąć przycisk  w prawym górnym 
rogu obszaru. 

 Uwaga: Maksymalna szerokość obszaru roboczego jest zdefiniowana przez ogniskową ustawioną 
w konfiguracji lasera. (Patrz Ustawianie obszaru roboczego.) 
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Przeglądarka właściwości - Podaje informacje (tj. ustawienia) o dowolnym wybranym obiekcie w obszarze 
roboczym. Dokumenty są traktowane jako obiekty w edytorze laserowym; więc jeżeli nie jest wybrany żaden 
obiekt, wyświetlane są właściwości dokumentu. Przeglądarka właściwości może pływać po całym obszarze 
roboczym albo można ją zadokować po prawej stronie okna tuż pod paskami narzędziowymi przez podwójne 
kliknięcie w jej pasek tytułowy. Poza tym to okno można ukryć / wyświetlić przez kliknięcie prawym przyciskiem 
myszy w pusty obszar w obszarze pasków narzędziowych. 
Przeglądarka właściwości współpracuje z pomocą kontekstową: Kliknięcie w tytuł właściwości (np. Geometry), a 
następnie naciśnięcie F1 otwiera tabelę z opisem tych właściwości. 

 
Pasek stanu - Pokazuje nazwę i stan podłączonego urządzenia laserowego. Poza tym, kiedy wskaźnik myszy 
znajduje się na przycisku paska narzędziowego, w tym obszarze jest wyświetlany krótki opis. 

Stosowanie narzędzi z pasków narzędziowych 
W tym rozdziale: 

 Paski narzędziowe: pionowy i poziomy 

 Standardowy pasek narzędziowy 

  Pasek narzędziowy wstawiania obiektów 

  Pasek narzędziowy operowania obiektami 

  Pasek narzędziowy regulacji obiektów 

  Pasek narzędziowy zmiany wielkości obrazu 

  Pasek narzędziowy lasera 

Paski narzędziowe: pionowy i poziomy 
Edytor laserowy ma pionowy pasek narzędziowy ( pasek narzędziowy wyboru) i poziomy pasek 
narzędziowy. 

Poziomy pasek narzędziowy zawiera standardowy zestaw przycisków ( główny pasek narzędziowy) plus 
zmienny zestaw przycisków; ten zestaw zmienia się w zależności od tego, w który przycisk klikniesz na 
pionowym pasku narzędziowym. 

W poniższym przykładzie wyświetlony został pasek narzędziowy Zoom (zmiana wielkości obrazu) po 
naciśnięciu przycisku Zoom na pionowym pasku narzędziowym: 

 

W poniższej tabeli opisano pokrótce funkcję każdego przycisku paska narzędziowego. Użycie linku 
podanego w tabeli wyświetla temat Pomocy z większą ilością szczegółów funkcji. 
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Uwaga: 
Przyciski są dostępne lub niedostępne w zależności od wykonywanej operacji. 
Paski narzędziowe można również ukryć / wyświetlić przez kliknięcie prawym przyciskiem 
myszy w pusty obszar w obszarze pasków narzędziowych, a następnie cofnięcie wyboru / 
wybranie pozycji z menu skrótów. 

Standardowy pasek narzędziowy 
Ten pasek narzędziowy jest zawsze wyświetlony: 

Przycisk Opis 

 

Dokument płaski - Umożliwia otwarcie nowego dokumentu w obszarze roboczym, albo 
 Plane (płaski), Ring (pierścieniowy), albo Sequence (sekwencja). Kliknąć w przycisk, 
żeby otworzyć nowy dokument płaski; kliknąć w strzałkę w dół, żeby wyświetlić listę rozwijaną 
w dół, która umożliwia wybór żądanego dokumentu: 

 
(To samo co polecenie menu File > New [plik > nowy]): 

 

 
Edytor projektu - Uruchamia aplikację edytora projektu, która umożliwia tworzenie 
programów w celu zautomatyzowania operacji znakowania. (To samo co polecenie menu File 
> Project editor [plik > edytor projektu]). 

 
Otwórz - Otwiera okno, które umożliwia wybór istniejącego układu. (To samo co polecenie 
menu File > Open [plik > otwórz]). 

 
Zapisz - Otwiera okno, które umożliwia zapisanie układu. (To samo co polecenie menu File > 
Save [plik > zapisz]). 

 

Podgląd znakowania - Umożliwia sprawdzenie ostatecznego wyniku procesu znakowania 
układów użytkownika bezpośrednio w edytorze laserowym. Ten przycisk jest dostępny po 
utworzeniu lub otwarciu dokumentu w obszarze roboczym. (To samo co File > Mark Preview 
[plik > podgląd znakowania]). 

 
Wytnij - Umożliwia wycięcie wybranego obiektu. (To samo co polecenie menu Edit > Cut 
[edytuj > wytnij]). 

 
Kopiuj - Umożliwia skopiowanie wybranego obiektu. (To samo co polecenie menu Edit > 
Copy [edytuj > kopiuj]). 

 
Wklej - Umożliwia wklejenie obiektu. (To samo co polecenie menu Edit > Paste [edytuj > 
wklej]). 

 
Anuluj - Umożliwia anulowanie wybranego polecenia. (To samo co polecenie menu Edit > 
Undo [edytuj > anuluj]). 

 
Ponów - Umożliwia ponowienie poprzednio anulowanego polecenia. (To samo co polecenie 
menu Edit > Redo [edytuj > ponów]). 

 Czas znakowania - Umożliwia obliczenie czasu grawerowania aktywnego dokumentu. 
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Pasek narzędziowy wstawiania obiektów 

Ten pasek narzędziowy jest wyświetlany po naciśnięciu przycisku  Wstaw obiekty na pionowym pasku 
narzędziowym. Umożliwia dodawanie obiektów do bieżącego dokumentu. Więcej informacji, patrz O 
obiektach graficznych . 

Przycisk Opis 

 
Usuń obiekt(y) - Umożliwia usunięcie wybranego obiektu. (To samo co polecenie menu 
Actions > Remove object(s) [działania > usuń obiekt(y)]). 

 
Ciąg tekstowy - Umożliwia wstawienie ciągu tekstowego do bieżącego dokumentu. (To samo 
co polecenie menu Actions > Insert > Text string [działania > wstaw > ciąg tekstowy]). 

 
Kod - Umożliwia wstawienie kodu do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Code [działania > wstaw > kod]). 

 

Importowane - Wyświetla okno, które umożliwia wstawienie importowanego obiektu 
graficznego do bieżącego dokumentu. Można importować obrazy wektorowe lub rastrowe, pliki 
AutoCad/AutoDesk .DXF i .DWG , pliki .HPGL lub .PLT , a także istniejące układy (pliki.XLP ). 
(To samo co polecenie menu Actions > Insert > Imported [działania > wstaw > importowane]). 

 
Tablica - Umożliwia wstawienie tablicy do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Array [działania > wstaw > tablica]). 

 
Okrąg - Umożliwia wstawienie elipsy do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Circle [działania > wstaw > okrąg]). 

 
Prostokąt - Umożliwia wstawienie prostokąta do bieżącego dokumentu. (To samo co polecenie 
menu Actions > Insert > Rectangle [działania > wstaw > prostokąt]). 

 
Poly - Umożliwia wstawienie wielokąta do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Poly [działania > wstaw > wielokąt]). 

 
Lines - Umożliwia wstawienie linii do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Lines [działania > wstaw > linie]). 

 
Dot - Umożliwia wstawienie kropki do bieżącego dokumentu. (To samo co polecenie menu 
Actions > Insert > Dot [działania > wstaw > kropka]). 
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Pasek narzędziowy operowania obiektami 

Ten pasek narzędziowy jest wyświetlany po naciśnięciu przycisku  Operowanie obiektami na pionowym 
pasku narzędziowym. Umożliwia wykonywanie operacji na obiektach, takich jak np. grupowanie / 
rozgrupowanie obiektów, edytowanie wektorów i tym podobne. Więcej informacji, patrz Grupowanie, 
scalanie lub dołączanie obiektów . 

Przycisk Opis 

 

Wybór grupy - Umożliwia grupowanie wybranych obiektów w jeden obiekt. Pojedyncze obiekty 
zachowują swoje właściwości, ale operacje transformacji i przemieszczania obejmują wszystkie 
zgrupowane obiekty. (To samo co polecenie menu Actions > Group selection [działania > wybór 
grupy]). 

 

Wybór scalania - Umożliwia zebranie dwóch lub więcej obiektów w jeden obiekt. Pojedyncze 
obiekty zachowują swoje właściwości, z wyjątkiem właściwości laserowych i wypełniania. (To 
samo co polecenie menu Actions > Merge selection [działania > wybór scalania]). 

 

Wybór rozgrupowania - Umożliwia rozmontowanie zgrupowanych lub scalonych obiektów, żeby 
można było je przenosić lub zmieniać indywidualnie. (To samo co polecenie menu Actions > 
Ungroup selection [działania > wybór rozgrupowania]): 

 

Zespolenie - Umożliwia zebranie obiektów wektorowych, tak żeby scalić tworzące je wielokąty w 
jeden obiekt. Tę operację można odwrócić tylko przy użyciu polecenia Anuluj. (To samo co 
polecenie menu Actions > Union [działania > zespolenie]). 

 

Część wspólna - Umożliwia zebranie nakładających się obiektów w nowy pojedynczy obiekt 
wektorowy. Tylko obszar, który jest wspólny dla obiektów, będzie brany pod uwagę przy 
grawerowaniu. Tę operację można odwrócić tylko przy użyciu polecenia Anuluj. (To samo co 
polecenie menu Actions > Intersection [działania > część wspólna]). 

 

Różnica - Umożliwia zebranie nakładających się obiektów w nowy pojedynczy obiekt wektorowy. 
Będzie znakowany tylko kontur pierwszego wybranego obiektu minus obszar wspólny. Tę 
operację można odwrócić tylko przy użyciu polecenia Anuluj. (To samo co polecenie menu 
Actions > Difference [działania > różnica]). 

 

Wykluczenie - Umożliwia zebranie nakładających się obiektów w nowy pojedynczy obiekt 
wektorowy. Będą znakowane kontury dwóch obiektów minus obszar wspólny. Tę operację można 
odwrócić tylko przy użyciu polecenia Anuluj. (To samo co polecenie menu Actions > Exclusion 
[działania > wykluczenie]). 

 

Stwórz wektorowy - Umożliwia przekształcenie wybranego ciągu lub kodu w obiekt wektorowy, 
aby użytkownik mógł edytować węzły. Należy zwrócić uwagę, że kiedy ciąg zostanie 
przekształcony na wektorowy, to straci swoje właściwości i stanie się zwykłym obiektem 
wektorowym. (To samo co polecenie menu Actions > Make vectorial [działania > stwórz 
wektorowy]). Więcej informacji, patrz Edytowanie wielkości wektorowych obiektów . 

 

Przetwarzanie zaawansowane - Ten przycisk umożliwia dostęp do zaawansowanych opcji 
przetwarzania wektorowego, które dają zaawansowany sposób edytowania wielkości 
wektorowych. (To samo co polecenie menu Actions > Advanced processing [działania > 
przetwarzanie zaawansowane]). Więcej informacji, patrz Stosowanie zaawansowanych opcji 
przetwarzania . 

 

Edytuj węzły - Umożliwia edycję węzłów obiektu wektorowego. Po naciśnięciu tego przycisku 

wyświetlany jest pasek narzędziowy  Edytuj węzły , który umożliwia 
edycję kształtu obiektu. (To samo co polecenie menu Actions > Edit nodes [działania > edytuj 
węzły]). 
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Pasek narzędziowy regulacji obiektów 

Ten pasek narzędziowy jest wyświetlany po naciśnięciu przycisku  Reguluj obiekty na pionowym pasku 
narzędziowym. Umożliwia osiowanie, spacjowanie, przełączanie lub zmianę wielkości obiektów, a także 
precyzyjne dostrajanie kolejności znakowania. Więcej informacji, patrz Osiowanie, przełączanie lub 
spacjowanie obiektów . 

Przycisk Opis 

 
Równaj w lewo - Umożliwia wyrównanie wybranych obiektów do lewej. (To samo co polecenie 
menu Actions > Align > Align left [działania > równaj > równaj do lewej]). 

 
Równaj w górę - Umożliwia wyrównanie wybranych obiektów do góry. (To samo co polecenie 
menu Actions > Align > Align top [działania > równaj > równaj do góry]). 

 
Równaj w prawo - Umożliwia wyrównanie wybranych obiektów do prawej. (To samo co polecenie 
menu Actions > Align > Align right [działania > równaj > równaj do prawej]). 

 
Równaj w dół - Umożliwia wyrównanie wybranych obiektów do dołu. (To samo co polecenie menu 
Actions > Align > Align bottom [działania > równaj > równaj do dołu]). 

 
Równaj środek X - Umożliwia wyosiowanie wybranych obiektów wzdłuż osi X. (To samo co 
polecenie menu Actions > Align > Align center X [działania > równaj > równaj środek X]). 

 
Równaj środek Y - Umożliwia wyosiowanie wybranych obiektów wzdłuż osi Y. (To samo co 
polecenie menu Actions > Align > Align center Y [działania > równaj > równaj środek Y]). 

 
Przełącz poziomo - Umożliwia przełączanie wybranego obiektu (obiektów) poziomo. (To samo co 
polecenie menu Actions > Flip > Flip horizontally [działania > przełącz > przełącz poziomo]). 

 
Przełącz pionowo - Umożliwia przełączanie wybranego obiektu (obiektów) pionowo. (To samo co 
polecenie menu Actions > Flip > Flip vertically [działania > przełącz > przełącz pionowo]). 

 

Rozstaw poziomo - Umożliwia rozstawianie wybranych obiektów równo w poprzek. (To samo co 
polecenie menu Actions > Spacing > Space horizontally [działania > spacjowanie > rozstaw 
poziomo]). 

 
Przełącz pionowo - Umożliwia rozstawianie wybranych obiektów równo w dół. (To samo co 
polecenie menu Actions > Spacing > Space vertically [działania > spacjowanie > rozstaw pionowo]). 

 
Taka sama wielkość - Umożliwia ustanowienie takiej samej wielkości dla wybranych obiektów. (To 
samo co polecenie menu Actions > Size > Make same size [działania > wielkość > stwórz taką 
samą wielkość]). 

 
Taka sama szerokość - Umożliwia ustanowienie takiej samej szerokości dla wybranych obiektów. 
(To samo co polecenie menu Actions > Size > Make same width [działania > wielkość > stwórz taką 
samą szerokość]). 

 
Taka sama wysokość - Umożliwia ustanowienie takiej samej wysokości dla wybranych obiektów. 
(To samo co polecenie menu Actions > Size > Make same height [działania > wielkość > stwórz 
taką samą wysokość]). 

 

Przywróć transformacje - Umożliwia przywrócenie pierwotnej wielkości lub orientacji wybranemu 
obiektowi (obiektom). (To samo co polecenie menu Actions > Size > Restore transformation 
[działania > wielkość > przywróć transformacje]). 

 

Kolejność znakowania - Umożliwia optymalizację kolejności w jakiej obiekty będą grawerowane. 
(To samo co polecenie menu Actions > Marking order [działania > kolejność znakowania]). Więcej 
informacji, patrz Optymalizacja kolejności znakowania obiektów . 
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Pasek narzędziowy zmiany wielkości obrazu 

Ten pasek narzędziowy jest wyświetlany po naciśnięciu przycisku  zmiana wielkości obrazu na 
pionowym pasku narzędziowym. Umożliwia wyświetlanie całego obszaru graficznego na ekranie lub 
znacznie powiększonego szczegółu danej części. Więcej informacji, patrz Zbliżanie . 

Przycisk Opis 

 
Powiększanie - Umożliwia stopniowe zbliżanie całego obszaru graficznego. (To samo co polecenie menu 
View > In [widok > powiększanie]). 

 
Zmniejszanie - Umożliwia stopniowe zmniejszanie wielkości obrazu. (To samo co polecenie menu View > Out 
[widok > zmniejszanie]). 

 

Wybór - Umożliwia przybliżenie wybranego obiektu (obiektów), żeby dopasować go do całego obszaru 
graficznego. Aby powrócić do pierwotnego obszaru graficznego, należy kliknąć w Stronę zmiany wielkości 
obrazu. (To samo co polecenie menu View > Selection [widok > wybór]). 

 
Strona - Umożliwia przywrócenie pierwotnego obszaru graficznego. (To samo co polecenie menu View > 
Page [widok > strona]). 

 
Okno - Umożliwia zbliżenie konkretnego obszaru na rysunku. (To samo co polecenie menu View > Window 
[widok > okno]). 

Pasek narzędziowy lasera 
Ten pasek narzędziowy jest zawsze wyświetlony. Umożliwia interaakcję z urządzeniem laserowym. 
Bliższe informacje, patrz Wykonanie operacji grawerowania . 

Przycisk Opis 

 

Podłącz do urządzenia - Ten przycisk jest dostępny tylko wtedy, gdy jest zainstalowany program nadzorczy 
edytora laserowego (patrz Rodzaje instalacji i tryby podłączania). 
Wyświetla okno, które umożliwia podłączenie do urządzenia laserowego, albo lokalnie, albo zdalnie. (To samo 
co polecenie menu Laser > Connect to device [laser > podłącz do urządzenia]). 

 
Otwórz z urządzenia - Umożliwia otwarcie dokumentu laserowego, który został uprzednio zapisany w 
urządzeniu laserowym. (To samo co File > Open from device [plik > otwórz z urządzenia]). 

 

Zapisz do urządzenia - Umożliwia zapisanie układu do konkretnego urządzenia o konkretnej nazwie, w 
folderze zarządzanym przez mechanizm laserowy. (To samo co File > Save to device [plik > zapisz do 
urządzenia]). 

 

Przełącz na tryb ręczny (lub automatyczny) Mode - Umożliwia przełączanie się między trybami działania. 
Wybór trybu ręcznego umożliwia ustawianie parametrów lasera lub wysyłanie dokumentów do znakowania. 
Domyślnie ustawiony jest tryb automatyczny, a układy są wysyłane do znakowania za pomocą programu 
edytora projektu. (To samo co polecenie menu Laser > Select Manual (lub Auto) Mode [laser > wybierz tryb 
ręczny (lub automatyczny)]). 

 

Tryb pracy - Ten przycisk działa tylko w trybie ręcznym. Umożliwia znakowanie wybranego układu przy użyciu 
zewnętrznych poleceń  Start i Stop, bezpośrednio z edytora. Jeżeli urządzenie nie jest podłączone, to 
uaktywnia się symulator. (To samo co polecenie menu Laser > Send marking [laser > wyślij znakowanie]). 

 

Wyślij znakowanie - Ten przycisk działa tylko w trybie ręcznym. Umożliwia wysłanie układu do urządzenia w 
celu znakowania. Jeżeli urządzenie nie jest podłączone, to uaktywnia się symulator. (To samo co polecenie 
menu Laser > Send marking [laser > wyślij znakowanie]). 

 

Wyślij znakowanie po wyborze - Ten przycisk działa tylko w trybie ręcznym. Umożliwia wysłanie wybranego 
obiektu do urządzenia w celu znakowania. Jeżeli urządzenie nie jest podłączone, to uaktywnia się 
symulator. (To samo co polecenie menu   Laser > Send marking on selection [laser > wyślij znakowanie po 
wyborze]). 

 
Zatrzymaj znakowanie - Umożliwia przerwanie operacji znakowania laserowego. (To samo co polecenie menu 
Laser > Stop marking [laser > zatrzymaj znakowanie]). 
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Granice po wyborze - Umożliwia śledzenie granic grawerowania obecnie wybranego obiektu 
(obiektów). Pokazany jest obszar objęty grawerowaniem, a nie profil obiektu do grawerowania. (To 
samo co polecenie menu   Laser > Limits on selection [laser > granice po wyborze]). 

 

Wszystkie granice - Umożliwia śledzenie granic grawerowania na płaszczyźnie roboczej. 
Marginesy są wyświetlane przy użyciu czerwonego wskaźnika laserowego. (To samo co polecenie 
menu   Laser > Limits all [laser > wszystkie granice]). 

 

Granice w poprzednim / następnym sektorze - Te przyciski umożliwiają śledzenie granic 
grawerowania w sektorach, które tworzą obiekt(y). Ta funkcja jest przydatna przy grawerowaniu na 
dokumentach pierścieniowych. (To samo co polecenia menu Laser > Limits previous sector oraz 
Limits next sector [laser > granice w poprzednim sektorze oraz granice w następnym sektorze). 

 

Symulator - Służy do symulacji wyników grawerowania w trybie ręcznym. Kiedy symulowane jest 
grawerowanie, wyświetla się nowe okno graficzne. Symulacja zachowuje wszystkie parametry 
ustawione dla dokumentu, czyli prędkość, wypełnienie, bicie wzdłużne lub inne parametry. (To 
samo co polecenie menu   Laser > Simulator [laser > symulator]). 

 

Pokaż mechanizm laserowy - Umożliwia otwarcie okna mechanizmu laserowego bezpośrednio z 
edytora laserowego, albo lokalnie, albo zdalnie. Patrz interfejs użytkownika  mechanizmu 
laserowego. 

 

Konfiguracja lasera - Umożliwia otwarcie okna konfiguracji lasera bezpośrednio z edytora 
laserowego w celu ustawienia parametrów lasera i osi. (To samo co polecenie menu Laser > Laser 
Configuration [laser > konfiguracja lasera]). 

 

Edytuj zmienne globalne urządzenia - Umożliwia zarządzanie zmiennymi globalnymi, żeby dzielić 
się zawartością (liczniki i ciągi) z wieloma dokumentami. (To samo co polecenie menu Laser > Edit 
device global variables [laser > edytuj zmienne globalne urządzenia]). Patrz Stosowanie zmiennych 
globalnych. 

 

Zarządzanie użytkownikami urządzeń - Umożliwia ustawianie i zarządzanie prawami użytkowników do 
systemu podłączonego do urządzenia laserowego, albo lokalnie, albo zdalnie. Patrz Zarządzanie 
użytkownikami i prawami dostępu. 

 

Test systemu - Umożliwia dostęp do okna dialogowego, gdzie można przetestować system 
laserowy i sprawdzić swoje podłączenia do systemu. W szczególności można przetestować 
wszystkie wejścia i wyjścia, a także zewnętrzne sygnały Start i Stop. 
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3- OPERACJE PRZYGOTOWAWCZE 

Przed rozpoczęciem pracy z edytorem laserowym trzeba wykonać następujące procedury: 

 Rejestracja swojego produktu 

 Rodzaje instalacji i tryby podłączania 

 Ustawienie domyślnego zachowania edytora laserowego 

 Import projektów Smartist 

 Otwarcie folderów danych 
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Rejestracja swojego produktu 
Podczas gdy edytor laserowy nie wymaga licencji, to mechanizm laserowy, który jest komponentem 
wykonawczym systemu znakowania, można zainstalować jako wersję próbną na 30 dni, po upływie których 
przestanie grawerować. Natomiast edytor laserowy będzie nadal działać jako edytor graficzny. 

W celu zarejestrowania mechanizmu laserowego zanim straci ważność należy wykonać następujące 
procedury: 

 Uzyskanie pliku licencyjnego 
 Wysłanie klucza aktywacyjnego do urządzenia zdalnego 

Uzyskanie pliku licencyjnego 

W celu zarejestrowania edytora laserowego: 
1. Z paska menu edytora laserowego wybrać Help > Get device ID (pomoc > uzyskaj identyfikator 

urządzenia). 
2. W oknie Device ID (identyfikator urządzenia) wybierz przycisk Copy Device ID to 

clipboard (skopiuj identyfikator urządzenia do schowka): 

 
3. Skopiuj kod identyfikacyjny i wklej go do e-maila, który wyślesz na adres, który pojawia się u dołu 

okna dialogowego. 
4. Otrzymasz odpowiedź z załączonym plikiem o nazwie License.dat. 

Wysłanie klucza aktywacyjnego do urządzenia zdalnego 

 

Uwaga: 
W celu wykonania tej operacji trzeba być podłączonym do urządzenia. Bliższe informacje, patrz Podłączenie 
do urządzenia laserowego. 

Ta procedura umożliwia wysłanie klucza aktywacyjnego do urządzenia zdalnego, do którego jesteś 
podłączony: 

W celu wysłania licencji: 
1. Z paska menu edytora laserowego wybrać Help > Send license (pomoc > wyślij licencję). 
2. W oknie Choose license file ((wybierz plik licencji), które się wyświetli, wybierz plik License.dat , 

który otrzymałeś od producenta (patrz Uzyskanie pliku licencyjnego). 
3. Kliknij w Open (otwórz). To spowoduje automatyczne wysłanie licencji do urządzenia zdalnego. 
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Rodzaje instalacji i tryby podłączania 
Podczas instalacji edytora laserowego można wybierać spośród różnych rodzajów instalacji, w zależności od 
potrzeb. 

Rodzaj instalacji  określa czy instaluje się edytor laserowy, mechanizm laserowy, czy oba komponenty, a 
także czy jest możliwa zdalna interakcja z mechanizmem laserowym.  

W poniższej tabeli zestawiono dostępne rozwiązania: 

Rodzaj i opis instalacji 
Edytor laserowy można 
podłączyć do dowolnego 
mechanizmu laserowego 
dostępnego w sieci 

Mechanizm laserowy 
nadaje się do 
sterowania zdalnego 
poprzez sieć 

Interaktywna 

 Instaluje zarówno edytor laserowy jak i 
mechanizm laserowy. 

 Zastosuj tę opcję, jeżeli instalujesz 
oprogramowanie na komputerze osobistym, 
który będzie sterować laserem lokalnie 
(urządzenie PODLEGŁE). 

 Ta opcja zainstaluje komponenty do 
lokalnego edytowania układów i sterowania 
źródłem laserowym. 

 Ta opcja umożliwia sterowanie źródłem 
laserowym przez urządzenie NADRZĘDNE 
poprzez Ethernet. 

NIE TAK 

Program nadzorczy 
 Zastosuj tę opcję, jeżeli instalujesz 

oprogramowanie na komputerze osobistym, 
który będzie sterować źródłem laserowym 
zdalnie (urządzenie NADRZĘDNE). 

 Ta opcja zainstaluje komponenty do 
edytowania układów i sterowania źródłem 
laserowym poprzez Ethernet. 

 Ta opcja umożliwia sterowanie źródłem 
laserowym przez urządzenie NADRZĘDNE 
poprzez zdalny sterownik ActiveX. 

TAK NIE 



ROZDZIAŁ 3 

22  
 

Ustawienie domyślnego zachowania edytora laserowego 
Można użyć ramki dialogowej Configuration (konfiguracja) edytora laserowego, żeby ustawić domyślne 
parametry konfiguracji dla swojej aplikacji. 

Bliższe informacje znajdują się w następujących sekcjach: 
 Ustawianie języka, jednostki miary i efektów graficznych (strona ogólna) 
 Ustawianie parametrów dokumentów (strona geometrii) 
 Ustawianie parametrów lasera (strona lasera) 

Ustawianie języka, jednostki miary i efektów graficznych (strona ogólna) 
To okno umożliwia określenie języka interfejsu użytkownika, jednostki miary długości i efektu graficznego dla 
swojej aplikacji. 

W celu ustawienia parametrów ogólnych: 
1. Z paska menu edytora laserowego wybrać File > Configuration (plik > konfiguracja). Wyświetla się 

okno Default parameters configuration (konfiguracja parametrów domyślnych). 
2. W lewej części okna należy zostawić wybrane słowo General (ogólne). 
3. Ustawić parametry domyślne korzystając z poniższej tabeli. 

Ramka 
grupy Parametr Opis 

Język   

Wymienione są języki dostępne dla interfejsu użytkownika. Wybrać 
język, który ma być zastosowany. 
Należy zwrócić uwagę, że domyślnie język jest ustawiony 
na Autodetect (automatyczne wykrywanie), co oznacza, że zależy on 
od języka systemu operacyjnego użytkownika. 

Długości Ustawia jednostkę miary długości. Dostępne opcje to: mm lub cale. 
Jednostki 

Ułamki dziesiętne Ustawia liczbę stosowanych miejsc po przecinku. Dopuszczalne 
wartości:  0 do 5. 

Rejestracja Maks. obszar rejestracji 
(KB) 

Określa maksymalny obszar na dysku na pliki-rejestratory. 
Plik-rejestrator jest kompilowany na poziomie mechanizmu 
laserowego i rejestruje wszystkie działania, które nastąpiły 
umożliwiając użytkownikowi rozwiązanie jakiegoś problemu, który 
mógł wystąpić. 
Bliższe informacje o sposobie stosowania i zarządzania plikiem-
rejestratorem znajdują się w sekcji Zrozumienie pliku-rejestratora. 

Efekty 
graficzne Wielkość tekstu Umożliwia zwiększenie wymiarów czcionki. Jest to szczególnie 

przydatne, kiedy stosuje się czcionki azjatyckie. 

Narzędzia Aktualizacje ewaluatora 

Umożliwia zarządzanie ewaluatorem czasu znakowania w celu 
przyśpieszenia edycji układów. Dostępne są dwie nastawy: 

o każda zmiana - ewaluator jest obliczany przy każdej zmianie 
zawartości dokumentu. Ta nastawa spowalnia operacje 
edytowania. 

o na kliknięcie - ewaluator jest obliczany na życzenie 
użytkownika. Jest to zalecane ustawienie, zwłaszcza w 
przypadku układów z wieloma grafikami. 
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4. Kliknąć w OK , żeby wdrożyć swoje ustawienia. 

5. W celu przywrócenia parametrów domyślnych, kliknąć w Restore window settings (przywróć 
ustawienia okna), a następnie zrestartować aplikację. 

6. W celu wyczyszczenia list ze źródeł laserowych i soczewek uzyskanych z kilku mechanizmów, 
kliknąć w Reset to factory settings (zresetuj do ustawień fabrycznych),  a następnie 
zrestartować aplikację. 

Ustawianie parametrów dokumentów (strona geometrii) 
To okno umożliwia ustawienie wymiarów, orientacji i ustawień siatki dla dokumentów. 

 

Uwaga: 
Wszystkie jednostki miary na tej stronie zależą od jednostek, które wybrano na stronie ogólnej. Patrz Ustawianie 
języka, jednostki miary i efektów graficznych (strona ogólna). 

W celu ustawienia parametrów dokumentów: 
1. Z paska menu edytora laserowego wybrać File > Configuration (plik > konfiguracja). Wyświetla się 

okno Default parameters configuration (konfiguracja parametrów domyślnych). 
2. Z lewej części okna wybrać Geometry. Parametry w tym oknie umożliwiają ustawienie parametrów 

domyślnych dla dokumentów, które będą tworzone. 
3. Dokonać żądanych zmian przy użyciu następującej tabeli: 

Ramka grupy Parametr Opis 
Szerokość Ustawia szerokość obszaru roboczego dla dokumentu płaskiego. 
Wysokość Ustawia wysokość obszaru roboczego dla dokumentu płaskiego. 
Margines X Ustawia szerokość marginesów w obszarze roboczym dla dokumentu płaskiego. 

Płaszczyzna 

Margines Y Ustawia wysokość marginesów w obszarze roboczym dla dokumentu płaskiego. 

Średnica Ustawia wielkość średnicy zewnętrznej lub wewnętrznej dla dokumentu 
pierścieniowego. 

Grubość Ustawia wysokość pierścienia lub cylindra dla dokumentu pierścieniowego. Pierścień 

Margines Y Ustawia szerokość marginesów w obszarze roboczym dla dokumentu 
pierścieniowego. 

Pokaż siatkę Jeżeli jest wybrane, w obszarze roboczym jest wyświetlana siatka (domyślnie: 
wybrane). 

Przerzut do 
siatki 

Jeżeli jest wybrane, włącza przerzut obiektów do siatki. (Domyślnie: wybór 
odwołany). 

Ustawienia siatki 

Skok siatki Umożliwia ustawienie rozstawu siatki. 

Położenie 
początku 

Domyślny początek dla współrzędnych kartezjańskich (x y), które są stosowane 
jako punkt odniesienia. Ich początek jest ustawiony domyślnie na 0.0 (środek). 
Lista rozwijana w dół umożliwia wybór innego początku niż środek, np. Left Top (z 
lewej u góry) czy Right Bottom (z prawej u dołu). 
Poza tym można ustawić początek  Custom (własny): w tym przypadku należy 
wprowadzić nowe wartości dla współrzędnych X,Y. 

Początek X Ustawia współrzędną X (poziomą) nowego początku w stosunku do położenia 
domyślnego, którym jest środek dokumentu. 

Początek Y Ustawia współrzędną Y (pionową) nowego początku w stosunku do położenia 
domyślnego, którym jest środek dokumentu. 

Odwróć X Jeżeli jest wybrane, odwraca oś X, żeby zmienić orientację pola. (Domyślnie: wybór 
odwołany) 

Początek i 
orientacja 

Odwróć Y Jeżeli jest wybrane, odwraca oś Y, żeby zmienić orientację pola. (Domyślnie: wybór 
odwołany) 

 

 

Uwaga: 
Następnie będzie można zmienić ustawienia na poziomie dokumentu przed edycję okna Właściwości dla 
aktywnego dokumentu. Patrz Ustawianie języka, jednostki miary i efektów graficznych (strona ogólna). 

4. Kliknąć w OK , żeby wdrożyć swoje ustawienia. 



ROZDZIAŁ 3 

24  
 

Ustawianie parametrów lasera (strona lasera) 
To okno umożliwia określenie urządzenia laserowego, z którym się łączysz, a także soczewki i techniki 
znakowania. 

 

Ważna uwaga: 
Parametry ustawione w tym oknie będą parametrami domyślnymi dla edytora laserowego. Jednakże 
na poziomie dokumentu można nadal ustawiać różne parametry (patrz O dokumentach). 

W celu ustawienia parametrów lasera: 
1. Z paska menu edytora laserowego wybrać File > Configuration (plik > konfiguracja). Wyświetla się 

okno Default parameters configuration (konfiguracja parametrów domyślnych). 
2. Z lewej części okna wybrać Laser. 
3. Ustawić stosowne parametry korzystając z poniższej tabeli: 

Ramka 
grupy Parametr Opis 

Docelowa Laser 

Jeżeli masz instalację wolnostojącą, podawane jest źródło laserowe, do którego 
jesteś obecnie podłączony. 
Jeżeli masz zainstalowany program nadzorczy, podawane są dostępne źródła 
laserowe, do których można podłączyć się zdalnie. 
Uwaga: Jeżeli to pole jest puste, oznacza to, że nie jesteś podłączony do żadnego 
źródła laserowego. Jeżeli pracujesz w sieci, musisz przynajmniej raz uruchomić 
mechanizm laserowy, żeby zobaczyć stosowne źródło laserowe wymienione na 
liście. 

  Soczewka Zawiera listę dostępnych soczewek, które można zainstalować na głowicy skanera 
i umożliwia wybór domyślnej soczewki, która będzie stosowana. 

4. Kliknąć w OK , żeby wdrożyć swoje ustawienia. 
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Import bazy danych materiałów 
Ta funkcja służy do importowania do bazy danych edytora laserowego materiałów stworzonych przy użyciu 
Smartist. Można importować: 

 Bazę danych materiałów (pliki .ini, .DB ) 

W celu zaimportowania bazy danych materiałów ze Smartist: 

1. Z paska menu edytora laserowego wybrać File > Import Materials Database (plik > importuj 
bazę danych materiałów), żeby wyświetlić okno Choose a materials database to open (wybierz 
bazę danych materiałów do otwarcia). 

2. Z listy rozwijanej w dół Type of file (rodzaj pliku) wybrać właściwy rodzaj pliku. Dostępne są dwie 
opcje: 

o pliki .ini  

o pliki .DB  

3. Przeglądać, żeby zlokalizować żądany plik i kliknąć w Open (otwórz). 

4. Po zakończeniu operacji importu wyświetli się wiele komunikatów z informacjami o zaimportowanym 
pliku (plikach). 
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Otwieranie projektów Smartist 
W edytorze laserowym można otworzyć dowolny projekt utworzony przy użyciu Smartist. Można otworzyć: 

 Projekty Smartist (pliki .prj ) 

 Dokumenty Smartist (pliki .LDX, .LDC ) 

W celu otwarcia projektu lub dokumentu Smartist: 

1. Z paska menu edytora laserowego wybrać File > Open (plik > otwórz), żeby wyświetlić 
okno Choose a document to open (wybierz dokument do otwarcia). 

2. Z listy rozwijanej w dół Type of file (rodzaj pliku) wybrać właściwy rodzaj pliku. Dostępne są dwie 
opcje: 

o Smartist projects (pliki .prj ) - Ta opcja umożliwia import projektu Smartist, który może 
składać się z jednego lub kilku układów graficznych. 

o Smartist documents (pliki .LDX, .LDC ) - Ta opcja umożliwia import konkretnego 
dokumentu stworzonego przy użyciu Smartist. 

3. Przeglądać, żeby zlokalizować żądany plik i kliknąć w Open (otwórz). 

4. Po zakończeniu operacji importu wyświetli się wiele komunikatów z informacjami o zaimportowanym 
pliku (plikach), wersji Smartisst i tym podobne. Każdy otwarty dokument będzie wyświetlany w 
zakładce w oknie edytora laserowego, żeby można było nim zarządzać lub edytować go jak każdy 
inny dokument edytora laserowego. 

 

Wskazówka: 
Należy zwrócić uwagę, że jeżeli jakiś skrypt lub plik formatera był włączony do projektu, to 
komunikat wskaże w którym folderze na komputerze osobistym użytkownika został on 
zapisany podczas operacji importu. Do jego otwarcia lub edycji można wykorzystać edytor 
projektu. Edytor projektu jest narzędziem, które umożliwia tworzenie własnych programów 
oraz posiada własny system pomocy. W celu uzyskania dostępu do niego należy wybrać File > 
Project Editor (plik > edytor projektu) z paska menu edytora laserowego. 
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Automatyczna konwersja projektów Smartist 
Możliwa jest automatyczna konwersja listy projektów Smartist z katalogu wejściowego i podkatalogów. 

Stosowanie:   LaserEditor.exe --convert-files <from directory> <to directory> <file pattern> [--convert-
subdirs] [--convert-log <log file name>]   

o --conver-files – Umożliwia określenie katalogu wejściowego i wyjściowego. 
 <from directory> – katalog wejściowy 
 <to directory>  – katalog wyjściowy 
 <file pattern>  – Można określić wzór nazwy pliku 

o --convert-subdirs – Umożliwia konwersję plików z podkatalogów. 
o –convert-log – Umożliwia określenie nazwy pliku-rejestratora tworzonego w katalogu 

wyjściowym. Domyślną nazwą pliku jest ‘convert.log’. 
 <log file name>  – Nazwa pliku-rejestratora  

 
  
Przykład: 

LaserEditor.exe --convert-files c:\temp\prj_from c:\temp\prj_to *.prj 
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Otwieranie folderów danych 
Funkcja Otwórz folder danych umożliwia odszukanie informacji, które mogą być potrzebne w celu 
wsparcia, a także do sprawdzania danych lub konfiguracji urządzenia. 

Przeglądanie zawartości folderów: 

1. Z menu Help (pomoc) wybrać Open data folder (otwórz folder danych). 

 

2. W oknie, które się wyświetli, wybrać żądany folder. Skorzystać z następującej tabeli: 

Folder Zawartość 
Config Pliki konfiguracyjne, konfiguracja lasera i licencja. 
Corrections Pliki do korekcji soczewek. 
Database Bazy danych haseł, materiałów i zmiennych globalnych. 
Fonts Lista czcionek, które można zastosować w mechanizmie laserowym. 

Logs Piliki-rejestratory, które były generowane z mechanizmu laserowego i sterownika 
serwisowego mechanizmu laserowego 

Docs/Layouts Dokumenty, które są ładowane podczas wykonywania skryptów 

Docs/Temp Lista tymczasowych dokumentów, które są wysyłane do znakowania w trybie 
ręcznym, bezpośrednio z edytora laserowego. 

Projects Foldery zawierające projekty, które są zapisane w urządzeniu. Folder „domyślny" 
musi zawsze obejmować projekt domyślny. 

Plugins Wtyczki, które są zarejestrowane podczas uruchamiania mechanizmu laserowego. 
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4- TWORZENIE UKŁADÓW GRAFICZNYCH 

Ten rozdział jest podzielony na następujące sekcje: 

Temat Czego się dowiesz 
Ustawianie swojego 
środowiska pracy 

Jak ustawić swoje środowisko pracy, jeśli chodzi o okienka i paski 
narzędziowe. 

Przegląd edycji grafiki Przegląd sposobów zarządzania układami graficznymi w edytorze laserowym. 

O dokumentach 
Jak tworzyć dokumenty i zarządzać nimi jako pojemnikami obiektów do 
grawerowania laserowego, płaskiego i pierścieniowego, oraz jak ustawiać ich 
właściwości. 

O sekwencjach 
Jak tworzyć sekwencje i zarządzać sekwencjami, które umożliwiają 
definiowanie kolejności działań do wykonania na poziomie mechanizmu 
laserowego. 

O obiektach graficznych 
Czemu służą właściwości obiektów. Jak dodawać obiekty graficzne i 
zarządzać obiektami graficznymi, które tworzą układ (proste obiekty 
wektorowe, ciągi, kody, tablice, importowane obrazy rastrowe lub wektorowe). 

Stosowanie zmiennych 
globalnych. 

Jak ustawić zmienne globalne i tak nimi zarządzać, żeby dzielić się 
zawartością (liczniki i ciągi) z wieloma dokumentami. 

Zrozumienie koloru obiektów 
w obszarze roboczym Znaczenie koloru obiektów w obszarze roboczym. 

Zwykłe operacje na 
obiektach 

Jak wykonywać zwykłe operacje na obiektach, takie jak osiowanie, 
regulowanie, zmiana wielkości, spacjowanie lub przełączanie obiektów, przy 
użyciu myszy, pasków narzędziowych lub przez ustawianie właściwości 
obiektów. 
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Ustawianie swojego środowiska pracy 
Domyślnie, w oknie edytora laserowego są wyświetlane wszystkie okna potomne, tzn. właściwości, lista 
poleceń anulowania / ponawiania i okna kolejności grawerowania obiektów. 

Poza tym wyświetlanych jest kilka przycisków paska narzędziowego, żeby umożliwić szybki dostęp do 
głównych funkcji edytora laserowego. 

Jednakże można dostosować swoje środowisko pracy przez wyświetlenie lub ukrycie zarówno okien jak i 
pasków narzędziowych. 

Ukrywanie / wyświetlanie okien lub pasków narzędziowych 

W celu ukrycia / wyświetlenia elementu: 
1. Kliknąć prawym przyciskiem myszy w pusty obszar obok pasków narzędziowych, żeby wyświetlić 

menu skrótów, które wymienia wszystkie elementy, które tworzą środowisko pracy (okienka i paski 
narzędziowe). 

 

2. Należy odwołać wybór / wybrać odpowiednie pole wyboru, żeby, odpowiednio, ukryć / wyświetlić 
element. 

Dokowanie / wydokowanie okienek 
Domyślnie wyświetlane są trzy okienka Undo/redo commands list (lista poleceń anulowania / 
ponawiania), Objects engraving order (kolejność grawerowania obiektów) i Properties (właściwości), 
odpowiednio po lewej i prawej stronie okna edytora laserowego. Można je przesuwać lub zmieniać ich 
wielkość. Na przykład, można sobie zażyczyć, żeby okno Właściwości pływało po obszarze roboczym. 

Dokowanie / wydokowanie okienka: 
 W celu wydokowania okienka należy kliknąć w jego pasek tytułowy, np.  Właściwości , a następnie 

przeciągnąć go na żądaną pozycję. 

 W celu zmiany wielkości okienka należy go wydokować, a potem użyć myszy do zmiany jego 
wymiarów. 

 W celu zadokowania okienka na jego pierwotnej pozycji należy dwukrotnie kliknąć w pasek tytułowy. 
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Przegląd edycji grafiki 
W celu stworzenia układu i zarządzania układami do grawerowania laserowego trzeba wykonać co 
następuje: 

 Stworzyć dokument, który jest „pojemnikiem” na obiekty graficzne, które tworzą układ. (Patrz O 
dokumentach) 

 Dodać i edytować obiekty graficzne do wygrawerowania (patrz O obiektach graficznych) 

Przeglądarka Właściwości, która jest dostępna dla dokumentów i obiektów, umożliwia edytowanie 
właściwości, żeby je dopasować do potrzeb grawerowania. Można dostosować parametry, które definiują 
sposób grawerowania obiektów: obejmuje to wielkości, początki, wypełnienie, parametry lasera i tym 
podobne. 

Poza tym można operować na obiektach przy użyciu pasków narzędziowych, myszy i paska menu. 

Podczas edycji można używać klawisza F1 w celu uzyskania dostępu do pomocy kontekstowej, która odnosi 
się do tego co aktualnie robisz, a także w celu wyświetlenia informacji o każdej grupie właściwości jak 
pokazano w poniższym przykładzie, gdzie do płaskiego dokumentu dodano obiekt Ciąg: 
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O dokumentach 
W edytorze laserowym dokument można traktować jak pojemnik na obiekty graficzne, które tworzą układ do 
wygrawerowania. Obszar dokumentu odpowiada obszarowi roboczemu lasera grawerującego. 

Edytor laserowy przewiduje dwa rodzaje dokumentów, które można stosować w zależności od potrzeb 
grawerowania: 

 Dokumenty płaskie stosuje się do grawerowania wektorowego lub rastrowego na powierzchniach 
płaskich. 

 Dokumenty pierścieniowe stosuje się do grawerowania wektorowego lub rastrowego na 
powierzchniach cylindrycznych. 

Kiedy instaluje się edytor laserowy, trzeba koniecznie być podłączonym do mechanizmu laserowego, to jest 
do źródła laserowego, aby móc tworzyć nowe dokumenty. Jeżeli pracujesz na stanowisku wolnostojącym, 
mechanizm laserowy jest uruchamiany automatycznie; natomiast, jeżeli pracujesz w sieci, musisz ręcznie 
podłączyć się do mechanizmu laserowego przynajmniej jeden raz. W przeciwnym razie będziesz mógł tylko 
edytować istniejące dokumenty. 

Przy tworzeniu nowego dokumentu stosuje się domyślne paarametry do ustawiania źródła laserowego, 
wymiarów graficznego obszaru roboczego i tym podobnych; te parametry zostały ustawione dla aplikacji 
(patrze Ustawienie domyślnego zachowania edytora laserowego). Jednakże można użyć 
przeglądarki właściwości dokumentów, żeby zmienić te ustawienia, co opisano w następnych sekcjach. 

Przy dodawaniu obiektu do dokumentu stosuje się parametry lasera, które zostały ustawione dla dokumentu. 
Można nadal ustawić inne parametry lasera dla każdego obiektu; w tym przypadku obiekt stanie się 
niebieski. (Patrz Zrozumienie koloru obiektów w obszarze roboczym). 

Następne sekcje opisują sposób pracy z dokumentami w edytorze laserowym. 

 Wspólne właściwości dokumentów 

 Tworzenie dokumentu do grawerowania płaskiego 

 Tworzenie dokumentu do grawerowania pierścieniowego 

 Otwieranie istniejących układów 

 Zapisywanie układów 

Do tworzenia programów można także użyć funkcji Sekwencja, która umożliwia automatyzację operacji 
znakowania dokumentów (patrz O sekwencjach). 

Wspólne właściwości dokumentów 

 

Wskazówka: 
Właściwości opisane w tej sekcji odnoszą się do dokumentów zarówno płaskich jak i 
pierścieniowych. Właściwości, które są charakterystyczne albo dla dokumentów płaskich albo dla 
pierścieniowych, są opisane w stosownych sekcjach. 

Poniższe tabele opisują właściwości docelowe i właściwości laserowe , które są wspólne dla dokumentów 
płaskich i pierścieniowych. 

Te właściwości są dostępne wtedy, gdy tworzy się nowy dokument i nie są wybrane żadne obiekty. 
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Właściwości docelowe dla dokumentów                                                    

 

Uwaga: 
Ten zestaw właściwości jest widoczny tylko wtedy, gdy: 

 operujesz w sieci i nie jesteś jeszcze podłączony do źródła laserowego; lub 
 jesteś podłączony do kilku źródeł laserowych. 

Przy tworzeniu nowego dokumentu stosowane są parametry domyślne, które zostały ustawione w 
oknie Domyślne parametry konfiguracji dla edytora laserowego. Bliższe informacje, patrz Ustawianie 
parametrów lasera (strona lasera). 

Poniższe właściwości są dostępne, kiedy najpierw zainstalowałeś edytor laserowy, a nie jesteś jeszcze 
podłączony do mechanizmu laserowego. Po podłączeniu do mechanizmu laserowego te właściwości 
przestaną być dostępne. One staną się dostępne, jeżeli podłączysz się do mechanizmu laserowego, który 
jest podłączony do innego źródła laserowego lub soczewki; w tym przypadku można wybrać z list żądane 
źródło lub soczewkę. 

Grupa Właściwość Opis 

Źródło 
laserowe   

Zestawia dostępne źródła laserowe (instalacja wolnostojąca) lub źródło (źródła) 
laserowe, do którego można podłączyć się zdalnie (instalacja programu 
nadzorczego) 

Obiektyw   

Zawiera listę dostępnych soczewek, które można zainstalować na głowicy 
skanera urządzenia laserowego. 
Od tego parametru zależą wymiary obszaru roboczego (patrz Ustawianie obszaru 
roboczego). 
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Właściwości laserowe dla dokumentów 
Poniższe właściwości będą stosowane jako domyślne parametry laserowe przy dodawaniu nowych obiektów 
do dokumentu. Jednakże nadal można ustawić inne parametry dla konkretnego obiektu. (Patrz Własne 
parametry laserowe dla obiektów). 

Grupa Właściwość Opis 

Przejścia   

Umożliwia to ustawienie liczby przejść światła laserowego po obiekcie w 
celu grawerowania. Można ustawić do 3 przejść, a każde z innymi 
parametrami laserowymi (patrz grupa właściwości Przejście). Ta opcja 
może być szczególnie przydatna w celu wykonania kilku przejść 
grawerujących, żeby oczyścić przedmiot obrabiany po ostrzejszym procesie 
grawerowania. (Patrz Stosowanie kilku przejść grawerujących) 

Moc Wskazuje moc wyjściową lasera. Wartość jest wyrażona jako procent mocy 
maksymalnej źródła laserowego. 

Częstotliwość 

Światło emitowane przez laser jest pulsujące. Ten parametr służy do 
regulacji częstotliwości emitowanego światła. 
Przy niezmiennych innych parametrach niższa częstotliwość powoduje 
wyższy na impuls. Nie wszystkie kombinacje mocy i częstotliwości są 
dozwolone. W zależności od rodzaju źródła laserowego, niskie 
częstotliwości wymagają odpowiednio niskich mocy. 

Prędkość 
skanowania 

Wskazuje prędkość grawerowania. Wartość jest wyrażona w milimetrach na 
sekundę. (Uwaga: Mniejsza prędkość pociąga za sobą głębsze 
grawerowanie. Dla procesów specjalnych, takich jak dogniatanie lub 
głębokie grawerowanie, należy ustawić bardzo małą prędkość (50-100 
mm/s). 

Zwłoka punktowa Ustawia czas grawerowania każdego punktu, tzn. czas wymagany do emisji 
laserowej na punkt. 

Czas błysku Ustawia czas trwania impulsu laserowego, tzn. czas, gdy przełącznik Q jest 
otwarty (lub raczej przezroczysty) 

Przejście 
(#) 

Powtórzenia Określa ile razy obiekty są znakowane. Zwiększenie liczby przejść zwiększy 
głębokość grawerowania, a w konsekwencji wpłynie na czas cyklu. 

Jeżeli ta właściwość jest ustawiona na True (rzeczywiste), to umożliwia grawerowanie 
grubszych linii dzięki ruchowi spiralnemu zamiast ruchu liniowego. (Patrz Stosowanie funkcji 
bicia wzdłużnego do grawerowania grubszych linii) 
Promień Przedstawia promień krzywej spiralnej 

Bicie 
wzdłużne 

Prędkość Przedstawia częstotliwość powtarzania spirali 

Oś X  Jeżeli jest ustawiona na True (rzeczywista), to umożliwia ustawienie 
żądanej pozycji dla osi X. 

Oś Y  Jeżeli jest ustawiona na True (rzeczywista), to umożliwia ustawienie 
żądanej pozycji dla osi Y. 

Oś Z   
Jeżeli jest ustawiona na True (rzeczywista), to umożliwia ustawienie 
wysokości, tzn. odległości między zerem mechanicznym a zerem logicznym 
dla osi Z (położenie ogniska). 

Oś R  Jeżeli jest ustawiona na True (rzeczywista), to umożliwia ustawienie 
żądanej pozycji dla osi R. 

Parametry dla obiektów można ustawić w dokumencie w oparciu o konkretny materiał (np. tworzywo 
sztuczne) i jego reakcje na operację znakowania. Bliższe informacje o sposobie zapisywania i odszukiwania 
bazy danych materiałów, patrz Zapisywanie bazy danych materiałów do późniejszego użytku. 
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Tworzenie dokumentu do grawerowania płaskiego 
Dokument płaski służy do grawerowania wektorowego lub rastrowego na powierzchniach płaskich. 

Obszar dokumentu odpowiada obszarowi roboczemu lasera grawerującego. Jest to miejsce, gdzie tworzy 
się dokument poprzez rysowanie i edytowanie obiektów graficznych lub importowanie plików obrazów 
rastrowych lub wektorowych, takich jak logo (patrz O obiektach graficznych). 

Przy tworzeniu nowego dokumentu stosuje się parametry domyślne, które zostały ustawione w 
oknie Domyślne parametry konfiguracji dla edytora laserowego. (Patrz Ustawienie domyślnego 
zachowania edytora laserowego). W celu ustawienia innych parametrów można użyć przeglądarki 
Właściwości. 

Bliższe informacje, patrz: 
 Tworzenie dokumentu 
 Zapisywanie bazy danych materiałów do późniejszego użytku 
 Ustawianie obszaru roboczego 
 Wspólne właściwości dokumentów 
 Właściwości geometryczne - dokument płaski 

Tworzenie dokumentu 

W  celu stworzenia dokumentu należy: 

1. Wykonać jedną z następujących czynności: 
o Z paska menu edytora laserowego wybrać File > New > Layer (plik > nowa > warstwa). 

o Na standardowym pasku narzędziowym edytora laserowego kliknąć w przycisk  . 
2. Dokument pojawia się w oknie edytora laserowego, gdzie jest przedstawiony układ grawerowania. 

 

Należy zauważyć, że okno Properties (właściwości) zawiera parametry domyślne, tzn. parametry 
ustawione dla edytora laserowego. 
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3. W celu stworzenia układu grawerowania należy wykonać następujące operacje: 

o Dla dokumentu ustawić właściwości, które najlepiej pasują do wymagań grawerowania. 
Bliższe informacje, patrz Wspólne właściwości dokumentów, Właściwości geometryczne - 
dokument płaski oraz Zapisywanie bazy danych materiałów do późniejszego użytku . 

W szczególności, przy ustawianiu obszaru roboczego dokumentu, patrz Ustawianie obszaru 
roboczego. 

o Dodać obiekty graficzne do grawerowania, albo rysując je, albo importując (patrz O 
obiektach graficznych) 

4. Po zakończeniu można zapisać dokument stosując następujące sposoby: 

o Wybrać File > Save (plik > zapisz) lub kliknąć w przycisk  , żeby zapisać dokument na 
swoim komputerze jako układ graficzny (plik .xlp ). 

o Wybrać File > Save as (plik > zapisz jako), żeby zapisać kopię dokumentu. 

o Wybrać File > Save to Device (plik > zapisz do urządzenia) lub nacisnąć przycisk  , 
żeby zapisać układ zdalnie, bezpośrednio do urządzenia laserowego w celu znakowania. 
Można wybrać urządzenie i wprowadzić nazwę dla dokumentu. 

Dokument(y) będzie na bieżąco wysłany do grawera laserowego poprzez zautomatyzowaną 
procedurę napisaną za pomocą edytora laserowego. 

(Bliższe informacje, patrz Zapisywanie układu do urządzenia). 

 

Uwaga: 
 Edytor projektu jest to edytor programów, który służy do automatyzacji 
procedur znakowania lub aktualizacji zawartości układu podczas wykonania. Ma 
swoją własną pomoc kontekstową i jest zintegrowany z edytorem laserowym. 
Aby uzyskać dostęp do niego, należy wybrać File > Project Editor (plik > 
edytor projektów). 

5. Aby zamknąć dokument, należy kliknąć w przycisk  w prawym górnym rogu obszaru roboczego. 

Uwaga: Można pracować na kilku dokumentach jednocześnie. Każdy dokument będzie wyświetlany w 
zakładce w oknie edytora laserowego. 
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Zapisywanie bazy danych materiałów do późniejszego użytku 
Właściwość Materiały umożliwia zapisanie specyficznych ustawień lasera i wypełnienie parametrów w bazie 
danych, którą można potem importować do nowego układu. Po ustawieniu swoich parametrów dla 
konkretnego materiału i jego reakcji na procedurę znakowania i gdy już układ jest gotowy, można 
przechować go do późniejszego użytku. 

Taką samą operację można wykonać dla każdego poszczególnego obiektu w dokumencie. 

W celu zapisania bazy danych materiałów: 

1. Kliknąć we właściwości Materiałów: 

 

2. Kliknąć w przycisk Save (zapisz), żeby wyświetlić następującą ramkę dialogową: 

 

3. Wprowadzić sensowną Material name (nazwę materiału), (np. tworzywo sztuczne) i kliknąć w OK , 
żeby zapisać bazę danych. Należy zauważyć, że lista rozwijana w dół zawiera bazy danych 
materiałów, które uprzednio stworzyłeś. 

4. Przycisk Delete (usuń) służy do usuwania istniejących baz danych. 

Aby powtórnie otworzyć uprzednio zapisaną bazę danych: 

1. Z menu edytora laserowego wybrać File > Import Materials Database (plik > importuj bazę danych 
materiałów). 

2. W wyświetlanym oknie przejść do Data_Lighter > Database , a następnie wybrać żądany plik: plik 
.ini, jeżeli układ był utworzony w Smartist,  plik .db , jeżeli był utworzony w edytorze 
laserowym. 
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Ustawianie obszaru roboczego 
Zasadniczym ustawieniem jest wielkość obszaru roboczego. Maksymalna wielkość jaką można zastosować 
zależy od kilku elementów, włącznie z wysokością ogniska zainstalowanego na laserze grawerującym i 
jakością soczewki. Zasadą ogólną jest, że zwiększanie ogniskowej spowoduje zwiększenie obszaru 
roboczego, ale model i jakość soczewki może również wpłynąć na wielkość obszaru roboczego. 

Soczewka może mieć różne ogniskowe: to wyznacza wielkość obszaru znakowania. 

Ogniskowe wyznaczają także inne właściwości systemu znakowania laserowego, takie jak odległość 
robocza i plamka lasera. 

Podczas ustawiania parametrów obszaru roboczego należy pamiętać, że jego szerokość nie może 
przekraczać ogniskowej ustawionej dla lasera. Na poniższym rysunku pokazano przykład: 

 

Ogniskową dla obiektywu ustawia się zarówno na poziomie urządzenia laserowego jak i na poziomie 
dokumentu. 

W celu ustawienia ogniskowej na poziomie urządzenia laserowego: 
1. Kliknąć prawym przyciskiem myszy w ikonę mechanizmu laserowego  na pasku narzędziowym 

Windows i wybrać Laser Configuration (konfiguracja lasera). (Więcej informacji o tym jak działa 
mechanizm laserowy, patrz Interfejs użytkownika mechanizmu laserowego). 

2. Wybrać stronę Correction (korekcja). 
3. Pod Lens (soczewka), z listy rozwijanej w dół Focal Length [mm] (ogniskowa [mm]) wybrać 

ogniskową stosowaną przez urządzenie laserowe. 

W celu ustawienia ogniskowej na poziomie dokumentu: 
1. W oknie Properties (właściwości) aktywnego dokumentu, pod Target (cel), z listy rozwijanej w 

dół Lens (soczewka) wybrać soczewkę, która będzie stosowana. 
2. Podczas ustawiania obszaru dla dokumentu należy pamiętać, żeby nie przekraczać wymiarów, które 

wyznacza zainstalowana soczewka. 
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Właściwości geometryczne - dokument płaski 
Przy tworzeniu nowego dokumentu stosowane są parametry domyślne, które zostały ustawione w 
oknie Domyślne parametry konfiguracji dla edytora laserowego. Bliższe informacje, patrz Ustawianie 
parametrów dokumentów (strona geometrii). 

W celu ustawienia innych parametrów niż domyślne  należy użyć przeglądarki właściwości dokumentu. 

 

Uwaga: 
Wszystkie jednostki miary, które są stosowane na tej stronie, zależą od jednostek, które 
wybrałeś na poziomie aplikacji. Patrz Ustawianie języka, jednostki miary i efektów 
graficznych (strona ogólna). 

 
Grupa Właściwość Opis 

Odpowiada powierzchni do wygrawerowania. Zasadniczym parametrem jest wielkość 
obszaru roboczego. Maksymalna wielkość jaką można zastosować zależy od kilku 
parametrów, włącznie z wysokością ogniska zainstalowanego na laserze grawerującym i 
modelem soczewki. (Patrz Ustawianie obszaru roboczego). 
Szerokość Ustawia szerokość obszaru roboczego. 

Obszar 
roboczy 

Wysokość Ustawia Wysokość obszaru roboczego. 
X Ustawia odległość między lewym a prawym marginesem obszaru roboczego. 

Marginesy 
Y Ustawia odległość między górnym a dolnym marginesem obszaru 

roboczego. 
Jeżeli jest ustawiona na True (domyślnie), siatka jest wyświetlana, a stosowne właściwości 
są dostępne. Siatka jest szeregiem nakreślonych linii, które się przecinają. Mozna je 
wykorzystać do precyzyjnego wyosiowania i pozycjonowania obiektów w oknie rysowania. 
(Patrz Stosowanie siatki dokumentu). 
Krok  Ustawia wymiar komórek siatki. 

Siatka 

Przerzut do 
siatki 

Jeżeli jest ustawiony na True (prawda) umożliwia przerzut do obiektów w 
siatce, tzn. kiedy przesuwasz obiekty na siatce, to będą one wyosiowane z 
najbliższą linią siatki. (Domyślnie: False (fałsz). 

Domyślny początek dla współrzędnych kartezjańskich (x y), które są stosowane jako punkt 
odniesienia. Ich początek jest ustawiony domyślnie na 0.0 (środek). Położenie obiektów 
odnosi się do tego punktu. 
Lista rozwijana w dół umożliwia wybór innego początku niż środek, np. Left Top (z lewej u 
góry) czy Right Bottom (z prawej u dołu). 
Poza tym można ustawić początek  Custom (własny): w tym przypadku należy wprowadzić 
nowe wartości dla współrzędnych X,Y. 

Położenie X Ustawia współrzędną X (poziomą) nowego początku w stosunku do 
położenia domyślnego, którym jest środek dokumentu. 

Położenie Y Ustawia współrzędną Y (pionową) nowego początku w stosunku do 
położenia domyślnego, którym jest środek dokumentu. 

Odwróć oś 
X 

Jeżeli jest ustawione na True (prawda), odwraca oś X, żeby zmienić 
orientację pola. (Domyślnie: False (fałsz). 

Początek  

Odwróć oś 
Y 

Jeżeli jest ustawione na True (prawda), odwraca oś Y żeby zmienić 
orientację pola. (Domyślnie: False (fałsz). 
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Tworzenie dokumentu do grawerowania pierścieniowego 

 

Uwaga: 
W celu znakowania dokumentu pierścieniowego trzeba zainstalować i skonfigurować separator 
pierścieni na swoim urządzeniu. 
Poza tym trzeba uaktywnić oś wirnika (właściwość uaktywnij oś ) w ustawieniach konfiguracji 
lasera. (Patrz Ustawianie parametrów X, Y, Z i osi wirnika). 

Dokumenty pierścieniowe służą do grawerowania powierzchni cylindrycznej. Obszar roboczy dokumentu 
stanowi całkowicie liniowe rozwinięcie powierzchni do grawerowania (360°). 

Obszar dokumentu odpowiada obszarowi roboczemu lasera grawerującego. Jest to miejsce, gdzie tworzy 
się dokument poprzez rysowanie i edytowanie obiektów graficznych lub importowanie plików obrazów 
rastrowych lub wektorowych, takich jak logo (patrz O obiektach graficznych). 

Przy tworzeniu nowego dokumentu stosuje się parametry domyślne, które zostały ustawione w 
oknie Domyślne parametry konfiguracji dla edytora laserowego. (Patrz Ustawienie domyślnego 
zachowania edytora laserowego). W celu ustawienia innych parametrów można użyć przeglądarki 
Właściwości  dokumentu. 

Bliższe informacje, patrz: 

 Tworzenie dokumentu 

 Wspólne właściwości dokumentów 

 Właściwości geometryczne - dokument pierścieniowy 

Tworzenie dokumentu 

W  celu stworzenia dokumentu należy: 
1. Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać File > New > Ring Document (plik > nowy > 
dokument pierścieniowy). 

o Na standardowym pasku narzędziowym edytora laserowego kliknąć w strzałkę w dół obok 

przycisku  , a potem wybrać Ring Document (dokument pierścieniowy): 
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2. Dokument pojawia się w oknie edytora laserowego, gdzie jest przedstawiony układ grawerowania. 

 

Zwrócić uwagę, że wyświetlany obszar roboczy stanowi liniowe rozwinięcie powierzchni do 
grawerowania, a okno Właściwości zawiera domyślne parametry, które zostały ustawione dla 
edytora laserowego. 

3. W celu stworzenia układu grawerowania pierścieniowego należy wykonać następujące operacje: 
o Na poziomie dokumentu ustawić właściwości, które pasują do wymagań grawerowania. 

Bliższe informacje, patrz sekcje Wspólne właściwości dokumentów, Właściwości 
geometryczne - dokument pierścieniowy oraz Zapisywanie bazy danych materiałów 
do późniejszego użytku. 

o Dodać obiekty graficzne, albo rysując je, albo importując (patrz O obiektach graficznych) 

4. Po zakończeniu można zapisać dokument stosując następujące sposoby: 

o Wybrać File > Save (plik > zapisz) lub kliknąć w przycisk  , żeby zapisać dokument na 
swoim komputerze jako układ graficzny (plik .xlp ). 

o Wybrać File > Save as (plik > zapisz jako), żeby zapisać kopię dokumentu. 

o Wybrać File > Save to Device (plik > zapisz do urządzenia) lub nacisnąć przycisk  , 
żeby zapisać układ zdalnie, bezpośrednio do urządzenia laserowego w celu znakowania. 
Można wybrać urządzenie i wprowadzić nazwę dla dokumentu. 

Dokument(y) będzie na bieżąco wysłany do grawera laserowego poprzez zautomatyzowaną 
procedurę napisaną za pomocą edytora laserowego. 

(Bliższe informacje, patrz Zapisywanie układu do urządzenia). 

 

Uwaga: 
 Edytor projektu jest to edytor programów, który służy do automatyzacji procedur znakowania lub 
aktualizacji zawartości układu podczas wykonania. Ma swoją własną pomoc kontekstową i jest zintegrowany 
z edytorem laserowym. Aby uzyskać dostęp do niego, należy wybrać File > Project Editor (plik > edytor 
projektów). 

5. Aby zamknąć dokument, należy kliknąć w przycisk  w prawym górnym rogu obszaru roboczego. 

Uwaga: Można pracować na kilku dokumentach jednocześnie. Każdy dokument będzie wyświetlany w 
zakładce w oknie edytora laserowego. 
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Właściwości geometryczne - dokument pierścieniowy 
Przy tworzeniu nowego dokumentu stosowane są parametry domyślne, które zostały ustawione w 
oknie Domyślne parametry konfiguracji dla edytora laserowego. Bliższe informacje, patrz Ustawianie 
parametrów dokumentów (strona geometrii). 

W celu ustawienia innych parametrów niż domyślne  należy użyć przeglądarki właściwości dokumentu. 

 

Uwaga: 
Wszystkie jednostki miary, które są stosowane na tej stronie, zależą od jednostek, które wybrałeś na 
poziomie aplikacji. Patrz Ustawianie języka, jednostki miary i efektów graficznych (strona 
ogólna). 

 
Grupa Właściwość Opis 

Średnica  Wielkość średnicy zewnętrznej lub wewnętrznej. 
Wysokość Wysokość pierścienia lub walca. Pierścień 

Znak Ustawia grawerowanie wewnątrz lub na zewnątrz pierścienia. 
Margines   Ustawia szerokość marginesów pionowych. 

Jeżeli jest ustawiona na True (domyślnie), siatka jest wyświetlana i są dostępne następujące 
właściwości: 
Krok Ustawia wymiar komórek siatki. Siatka 

Przerzut do 
siatki 

Jeżeli jest ustawiony na True (prawda) umożliwia przerzut do obiektów w 
siatce, tzn. kiedy przesuwasz obiekty na siatce, to będą one wyosiowane z 
najbliższą linią siatki. (Domyślnie: False (fałsz). 

Domyślny początek dla współrzędnych kartezjańskich (x y), które są stosowane jako punkt 
odniesienia. Ich początek jest ustawiony domyślnie na 0.0 (środek). Położenie obiektów 
odnosi się do tego punktu. 
Lista rozwijana w dół umożliwia wybór innego początku niż środek, np. Left Top (z lewej u 
góry) czy Right Bottom (z prawej u dołu). Poza tym można ustawić początek 
 Custom (własny): w tym przypadku należy wprowadzić nowe wartości dla współrzędnych 
X,Y. 

Położenie X Ustawia współrzędną X (poziomą) nowego początku w stosunku do położenia 
domyślnego, którym jest środek dokumentu. 

Położenie Y Ustawia współrzędną Y (pionową) nowego początku w stosunku do położenia 
domyślnego, którym jest środek dokumentu. 

Odwróć oś 
X 

Jeżeli jest ustawione na True (prawda), odwraca oś X, żeby zmienić orientację 
pola. (Domyślnie: False (fałsz). 

Początek 

Odwróć oś 
Y 

Jeżeli jest ustawione na True (prawda), odwraca oś Y żeby zmienić orientację 
pola. (Domyślnie: False (fałsz). 



TWORZENIE UKŁADÓW GRAFICZNYCH 

 43
 

4
 

Zaawansowane Wielkość 
sektora 

Definiuje szerokość sektora Sektor stanowi część obszaru roboczego do 
wygrawerowania w jednym ruchu osi obrotu. 
Wartość 0 (domyślna) zapewnia najwyższy poziom jakości: do każdego wielokąta jest 
dołączony ruch osi obrotu, więc znakowana część jest zawsze umieszczona w środku 
obszaru znakowania. Większa wartość skraca całkowity czas znakowania, ale może 
mieć wpływ na jakość. 
Należy zwrócić uwagę, że wielkość sektora nie może przekraczać części obszaru, 
który jest w ognisku; zależy to od głębi ostrości lasera. Jeżeli ustawi się większą 
wartość, aplikacja zignoruje ją i zamiast niej zastosuje maksymalną dozwoloną 
wartość, w zależności od głębi ostrości lasera użytkownika. 

  Przerwa 
sektorowa 

Stosuje się ją razem z właściwością Wielkość sektora i 
właściwością Podział dla obiektów wektorowych. Umożliwia dokładne 
dostrojenie wyników znakowania. 
Zastosowanie właściwości Podział do obiektu spowoduje, że: 

 Obiekt zostanie podzielony na tworzące go wielokąty. 

 Jeżeli wielokąt będzie większy niż sektor i będzie zamknięty (algorytm 
nie będzie działać, jeżeli figura będzie otwarta), mechanizm laserowy 
spróbuje „pokroić” go na części o wymiarach równych sektorowi 
pierścienia do znakowania. 

Jeżeli jest ustawiona na  0, to tylko jedna linia cięcia jest zastosowana między 
dwoma sektorami (lewa i prawa granica), natomiast jeżeli jest < 0, to są 
zastosowane dwie linie cięcia, co umożliwia nałożenie lub rozdzielenie granic 
w razie potrzeby. 
Szczegółowy opis działania właściwości Podział, patrz Zastosowanie funkcji 
podziału. 

  Kąt Kąt nachylenia osi obrotu wyrażony w stopniach. (Możliwe wartości: od 0 do 
60). 

  
Reset osi po 
zakończeniu 
wykonania 

Jeżeli jest ustawiony na True, to na końcu grawerowania sprowadza wirnik do 
pozycji początkowej. 

  

Zastosuj 
promień 
pierścienia 
jako 
położenie 
osi Z 

Jeżeli jest ustawiony na True, to umożliwia ustawienie ogniska jako 
niezależnego od promienia pierścienia. Oznacza to, że (przy stałym 
separatorze pierścieni), jeżeli promień pierścienia zmieni się, to odpowiednio 
musi zmienić się oś Z w celu zogniskowania obszaru do grawerowania. 
Aktywując tę funkcję trzeba tylko zogniskować środek obrotu; następnie 
system będzie automatycznie sterować osią Z, żeby ustawić ognisko 
odpowiednio do wymiarów pierścienia. 

 
Dla prawidłowego działania trzeba ustawić zero logiczne osi Z w środku 
obrotu. Zero logiczne jest położeniem ogniska na artykule do grawerowania. 
Zero logiczne zależy również od parametru „Przesunięcie pierścienia” w 
ustawieniach konfiguracji lasera, patrz Ustawianie parametrów X, Y, Z i osi 
wirnika 
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Otwieranie istniejących układów 
Można otwierać układy (tj. dokumenty lasera, .xlp ), które zostały uprzednio zapisane, w celu dalszej edycji 
lub wysłania ich do grawera. 

Można otworzyć układ, który był zapisany lokalnie, albo układ, który był zapisany w urządzeniu. 

Bliższe informacje, patrz: 

 Otwieranie układu na komputerze osobistym 

 Otwieranie układu z urządzenia 

Otwieranie układu na komputerze osobistym 
1. Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać File > Open (plik > otwórz). 

o Na standardowym pasku narzędziowym edytora laserowego kliknąć w przycisk 
 (otwórz). 

2. W wyświetlonym oknie Choose a document to open (wybierz dokument do otwarcia), przeglądaj 
dokumenty, żeby zlokalizować dokument lasera .xlp , który chcesz otworzyć. 

3. Kliknij w Open (otwórz). Wybrany dokument jest wyświetlany w obszarze roboczym edytora 
laserowego. 

Otwieranie układu z urządzenia 
Ta funkcja umożliwia otwarcie dokumentu laserowego, który został uprzednio zapisany w urządzeniu 
laserowym do przyszłej edycji. 

1. Wykonać jedną z następujących czynności: 

o Na pasku narzędziowym edytora laserowego kliknąć w przycisk   (otwórz z 
urządzenia). 

o Z paska menu edytora laserowego wybrać File > Open from device (plik > otwórz z 
urządzenia). 

2. W wyświetlonym oknie Choose a document to open (wybierz dokument do otwarcia), z rozwijanej 
w dół listy Devices (urządzenia) wybrać urządzenie, w którym dokument był zapisany. (Tutaj są 
wymienione wszystkie urządzenia dostępne w sieci). 

3. Obszar File (plik) pokazuje układy, które zostały zapisane w wybranym urządzeniu. Wybrać 
potrzebny plik. 

4. Kliknąć w OK. Wybrany dokument jest wyświetlany w obszarze roboczym edytora laserowego. 
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Zapisywanie układów 
Kiedy tworzenie układu laserowego zostało zakończone, można zapisać go albo lokalnie, albo w 
urządzeniu, żeby następnie został wysłany do grawera za pomocą automatycznej procedury. 

Zapisywanie układu na komputerze osobistym 
Poniższa procedura umożliwia zapisanie układu jako pliku .xlf na dysku, do późniejszego użytku lub edycji. 

W celu zapisania układu: 
1. W celu zapisania nowego układu bez nazwy: 

o Wybrać File > Save (plik > zapisz) (lub kliknąć w przycisk  na pasku narzędziowym). 

o W wyświetlonym oknie Save document as (zapisz dokument jako) przejść do dowolnej 
lokalizacji dostępnej z komputera (lub utworzyć nowy folder). 

o W ramce File name (nazwa pliku) wpisać nazwę dla dokumentu i kliknąć w Save (zapisz). 
Dokument będzie zapisany z rozszerzeniem .xlp . 

2. W celu zapisania kopii istniejącego dokumentu: 

o Wybrać File > Save as (plik > zapisz jako). 

o W wyświetlonym oknie Save document as (zapisz dokument jako) przejść do dowolnej 
lokalizacji dostępnej z komputera (lub utworzyć nowy folder). 

o W ramce File name (nazwa pliku) wpisać nową nazwę dla dokumentu i kliknąć w Save 
(zapisz). 

Zapisywanie układu w urządzeniu 
Poniższa procedura umożliwia zapisanie układu do konkretnego urządzenia o konkretnej nazwie, w folderze 
zarządzanym przez mechanizm laserowy. 

Potem można użyć edytora projektu, żeby napisać program do przesyłania dokumentów, tak żeby 
zapisane dokumenty były wysyłane do grawera w automatyczny sposób. 

 

Uwaga: 
 Edytor projektu jest to edytor programów, który służy do automatyzacji procedur znakowania lub 
aktualizacji zawartości układu podczas wykonania. Ma swoją własną pomoc kontekstową i jest zintegrowany 
z edytorem laserowym. Aby uzyskać dostęp do niego, należy wybrać File > Project Editor (plik > edytor 
projektów). To narzędzie zapewnia domyślne programy i łatwe do zastosowania przykłady. 

W celu zapisania układu w urządzeniu: 
1. Wykonać jedną z następujących czynności: 

o Na pasku narzędziowym edytora laserowego kliknąć w przycisk  (zapisz w urządzeniu) 
o Z paska menu edytora laserowego wybrać File > Save to device (plik > zapisz w urządzeniu). 

2. W wyświetlonym oknie Save document as (zapisz dokument jako), z rozwijanej w dół 
listy Devices (urządzenia) wybrać urządzenie, do którego układ jest przesyłany. (Wymienione są 
wszystkie urządzenia dostępne w sieci). 

Obszar File (plik) pokazuje układy, które zostały zapisane w wybranym urządzeniu. 

3. Wprowadź nazwę dla dokumentu i kliknąć w OK. Jest to nazwa, która będzie stosowana w 
programie edytora projektów. 
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O sekwencjach 
Sekwencja jest to program zawierający działania, które mechanizm laserowy będzie wykonywać 
automatycznie. 
Umożliwia on zautomatyzowanie operacji znakowania w prostych scenariuszach i dostarcza użytkownikowi 
łatwy do stosowania interfejs do projektowania programów przy użyciu edytora laserowego. 
Typowym scenariuszem, gdzie można zastosować tę funkcję, jest linia produkcyjna z PLC (sterownik 
programowalny), który zarządza działaniami automatycznymi i który jest podłączony do karty we/wy PCI: 
Funkcja sekwencji umożliwia interakcję z PLC w celu wykonania operacji znakowania w konkretnej 
kolejności. 

Przy użyciu sekwencji można: 

 zdefiniować konkretną kolejność operacji znakowania, które będą wykonywane automatycznie; 

 stworzyć lub importować dokumenty płaskie lub pierścieniowe do znakowania; 

 współdziałać z PLC przez ustawianie wyjść lub odczytywanie wejść; 

 przesunąć oś, jeżeli jest aktywna. 

 

Wskazówka: 
Oprócz tworzenia sekwencji, do zautomatyzowania procedur znakowania można również 
użyć edytora projektów, który jest edytorem programów zintegrowanym z edytorem laserowym. 
Aby uzyskać dostęp do niego, należy wybrać File > Project Editor (plik > edytor projektów). To 
narzędzie zapewnia domyślne programy i łatwe do zastosowania przykłady, a także pomoc 
kontekstową. 

Tworzenie i wykonywanie sekwencji 
W celu utworzenia sekwencji: 

1. Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać File > New > Sequence (plik > nowa > 
sekwencja). 

o Na standardowym pasku narzędziowym edytora laserowego kliknąć w strzałkę w dół obok 
przycisku  , a potem wybrać Sequence (sekwencja): 
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2. W obszarze roboczym edytora laserowego pojawi się: 

 

Należy zwrócić uwagę, że pasek narzędziowy Sequence items (elementy sekwencji) jest 
wyświetlony obok standardowego paska narzędziowego edytora laserowego, a sekwencja z 
domyślną pozycją jest wyświetlona w obszarze roboczym. 

3. Klikać w przyciski na pasku narzędziowym, żeby dodawać pozycje do swojej sekwencji, korzystając 
z poniższych informacji (patrz także przykład poniżej). 

Pozycja Opis 

 
If-Else-End IF –  jest to struktura sterująca, która umożliwia wykonanie bloku pozycji w oparciu o 
warunek Boole’a. 

 
Licznik – Umożliwia ustawienie lokalnego licznika dla sekwencji lub wybór licznika z bazy danych 
zmiennych globalnych. Wymagane jest stosowanie właściwości Warunek z pozycją If-Else-End if. 

 

Wejście - Umożliwia ustawienie wejść na karcie we/wy PCI, która może być podłączona do PLC (jest 
dostępnych 16 bitów wejściowych). Umożliwia to interakcję z PLC, który zarządza operacjami - można 
powiedzieć mu jak się zachowywać przy wykonywaniu programu. 
Właściwości: Bit 0 - Bit 15 - są to bity wejściowe, które można ustawiać. Możliwe są następujące opcje: 

o    Don't care - Ignoruje bit, to znaczy pozostawia bit taki jaki był. 
o    If reset - if bit = o, wówczas przetwarzaj pozycję If, w przeciwnym razie przetwarzaj pozycję Else-
End If. 
o    If set – if bit = 1, wówczas przetwarzaj pozycję If, w przeciwnym razie przetwarzaj pozycję Else-

End If. 

 
Przerwa – Zatrzymaj sekwencję w dowolnym stanie. 

 

Etykieta - Jest to znak-wypełniacz. Jest wymagany w celu zastosowania pozycji Get and Go . Etykieta 
mówi pozycji Get and Go gdzie musi skoczyć po sprawdzeniu określonego warunku. 
Właściwości: Właściwość Etykieta jest to pole edytowalne, gdzie można wprowadzić tekst dla etykiety. 
Wpisany tekst będzie potem wyświetlony w nawiasie obok pozycji Etykieta. 

 

Przesuń oś - Ta pozycja jest czynna tylko wtedy, gdy co najmniej jedna oś włączona na laserze. 
Wykonanie tej pozycji powoduje przesunięcie jednej lub kilku osi; wykonanie jest ukończone, gdy zostaną 
osiągnięte docelowe pozycje wszystkich osi. (Patrz także Ustawianie parametrów X, Y, Z i osi wirnika). 
Właściwości: Ustawić na True , żeby uaktywnić jedną lub więcej osi. Następnie wyświetli się 
parametr Position (położenie), żeby użytkownik określił położenie osi. Parametr Home Search służy do 
przesuwania osi w położenie spoczynkowe 
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Dokument - Umożliwia tworzenie lub import dokumentu płaskiego lub pierścieniowego do sekwencji. 
Wykonać jedną z następujących czynności: 

o W celu utworzenia nowego dokumentu należy dwukrotnie kliknąć w pozycję Dokument , która 
ma być dodana do sekwencji. Jeżeli jest włączone zarządzanie dokumentami pierścieniowymi, 
wyświetla się okno zachęcające do określenia rodzaju dokumentu, który chcemy stworzyć. 
(Patrz O dokumentach, żeby uzyskać informacje o sposobie pracy z dokumentami). 

o Aby zaimportować istniejący dokument, należy kliknąć we właściwość Import w okienku 
Właściwości, a potem przy użyciu przycisku przeglądania   wybrać dokument. 

Właściwości: Właściwość Import umożliwia import istniejącego dokumentu. Właściwość Name (nazwa) jest 
to pole edytowalne, żeby użytkownik mógł wprowadzić nazwę dokumentu. 

 

Ustaw wyjścia - Umożliwia ustawienie wyjść na karcie we/wy PCI, która może być podłączona do PLC 
(jest dostępnych 16 bitów wyjściowych). Umożliwia to interakcję z PLC, który zarządza operacjami - można 
powiedzieć mu jak się zachowywać przy wykonywaniu programu. 
Właściwości: Bit 0 - Bit 15 - są to bity wyjściowe, które można ustawiać. Możliwe są następujące opcje: 

o Don't care - Ignoruje bit, to znaczy pozostawia bit taki jaki był 
o Set - Ustawia bit jako Prawdę. 
o Reset - Ustawia bit jako Fałsz. 

 
Zwłoka - Umożliwia ustawienie zwłoki, która może być potrzebna do zakończenia operacji w toku. 
Właściwości: Właściwość zwłoka [ms] umożliwia określenie zwłoki w milisekundach. 

 

Czekanie na start - Jest to pozycja domyślna, która wyświetla się przy tworzeniu sekwencji. W celu 
wykonania lub kontynuowania przetwarzania sekwencji mechanizm laserowy czeka aż użytkownik naciśnie 
Start. 

 

Get and Go - W celu uaktywnienia tej pozycji trzeba najpierw wybrać co najmniej jedną Etykietę. Pozycja 
Get and Go jest związana z konkretną Etykietą, do której może skoczyć lub nie, w zależności od warunku, 
który będzie sprawdzany (o ile jest). Aby to zrobić, pozycja Get and Go sprawdza bity wejściowe ustawione 
przez PLC, a następnie wykorzystuje te informacje w celu działania (skocz do etykiety lub kontynuuj). 
Jeżeli wybrano opcję If Set, sprawdza czy bit wejściowy jest uaktywniony zanim skoczy do skojarzonej 
etykiety. W przeciwnym razie ignoruje skok i wykonuje następną operację. (Patrz poniższy przykład). 
Właściwości: Właściwość Skocz do jest to pole edytowalne, żeby użytkownik mógł wprowadzić nazwę 
skojarzonej etykiety, która potem będzie wyświetlona w nawiasie obok pozycji Get and Go. Właściwość Bit 
0 - Bit 15 umożliwia ustawienie warunków, które pozycja Get and Go musi sprawdzić przed kontynuacją 
wykonania. Możliwe są następujące opcje: 

o Don't care - Ignoruje bit. To wskazuje na skok bezwarunkowy, tzn. skok będzie 
wykonany w każdym przypadku. 

o If Set - Sprawdza czy bit został uaktywniony (prawda). 
o If Reset - Sprawdza czy bit został zdezaktywowany (fałsz). 

 

Klonuj dokument - Umożliwia klonowanie dokumentu, który jest już w sekwencji, tzn. dodanie jednej lub 
kilku kopii istniejącego dokumentu. 
Właściwości: Właściwość Nazwa umożliwia wprowadzenie nowej nazwy dla sklonowanego dokumentu. 

 
Usuń pozycję sekwencji - Umożliwia usunięcie z sekwencji pozycji, która została uprzednio dodana. W 
celu usunięcia pozycji należy wybrać ją, a następnie nacisnąć ten przycisk. 

 

 
Wskazówka: 
Pozycje można przeciągać i upuszczać w celu przesunięcia ich do nowej lokalizacji w sekwencji. 

Poniższy przykład pokazuje sekwencję, gdzie zastosowano Get and Go w celu wielokrotnego oznakowania 
dwóch dokumentów. Na rysunku pokazano również jak były ustawione właściwości dla pozycji Get and Go: 

Przykład 
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Poniższy schemat pokazuje jak program będzie wykonany na podstawie tej sekwencji: 

 

W celu wykonania sekwencji: 
Sekwencje są wykonywane jako projekty, tzn. po zapisaniu sekwencji w urządzeniu będzie ona wykonana 
na poziomie mechanizmu laserowego przez uaktywnienie trybu automatycznego (patrz Automatyczny / 
ręczny tryb pracy). 

W celu uzyskania bliższych informacji o zapisywaniu sekwencji, należy postępować zgodnie z instrukcjami 
opisanymi w sekcji Zapisywanie układów. 
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O obiektach graficznych 
Po utworzeniu dokumentu można przygotować układ do grawerowania laserowego poprzez: 

 dodanie kształtów (okręgi, prostokąty lub wielokąty): 

 import następujących grafik rastrowych lub wektorowych: 

o wektorowe: .PLT, .HPGL, .DXF, .DWG 

o rastrowe: .BMP, .JPEG, .GIF, .PNG, .TIF 

 tworzenie ciągów tekstowych, kodów matrycowych, kodów kreskowych lub tablic. 

Bliższe informacje: 
Następujące sekcje opisują sposób pracy z obiektami w edytorze laserowym: 

 Wspólne właściwości obiektów 

 Praca z prostymi obiektami wektorowymi 

 Stosowanie ciągów tekstowych 

 Stosowanie kodów 

 Stosowanie tablic 

 Import obiektów graficznych 

 Stosowanie funkcji podziału 

 Zrozumienie koloru obiektów w obszarze roboczym 

 Zwykłe operacje na obiektach 

Wspólne właściwości obiektów 

 

Wskazówka: 
Okno Właściwości współpracuje z pomocą kontekstową: Podczas edycji układu - wybór tytułu 
właściwości (np. Geometry), a następnie naciśnięcie F1 otwiera pomoc kontekstową dla tych 
właściwości. 
Bliższe informacje o tym jak operować na obiektach przy użyciu właściwości, patrz Zwykłe 
operacje na obiektach. 
Właściwości, które są charakterystyczne dla każdego obiektu lub dla dokumentów, są opisane w 
stosownej sekcji. 

Poniższe tabele opisują właściwości Geometry (geometria), Laser, Filling (wypełnianie) i Clone (klon), 
które są wspólne dla obiektów graficznych. 

Właściwości geometryczne obiektów 
W poniższej tabeli opisano właściwości geometryczne, które umożliwiają aktywację / dezaktywację 
obiektów, zmianę ich wielkości, obrót i zukosowanie, a także zmianę położenia obiektów. Te właściwości 
są wyświetlane po wyborze obiektu w obszarze roboczym. 

 

Uwagi: 
W celu szybkiego, wstępnego wymiarowania, obracania i pozycjonowania obiektu można użyć 
myszy (patrz Użycie myszy do wyboru obiektów i manipulowania nimi). Przeglądarka właściwości 
umożliwia dokładniejsze operacje. 
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Właściwości  
geometryczne Opis 

ID Do każdego obiektu załadowanego do obszaru graficznego można przydzielić unikalny, 
alfanumeryczny ID (identyfikator), który identyfikuje obiekt w układzie. 

Enable 
Jeżeli jest ustawiony na True (domyślnie), to zezwala na grawerowanie wybranego obiektu. 
Jeżeli nie ma zezwolenia dla obiektu (False), to nie będzie on grawerowany, a kolor obiektu w 
obszarze roboczym zmieni się na szary. 

Locked 
Jeżeli jest ustawiony na True, to blokuje obiekt uniemożliwiając edycję. Znikają uchwyty 
wyboru wokół obiektu i pojawia się uchwyt : Należy w niego kliknąć, żeby odblokować 
obiekt. (Domyślnie: False.) (fałsz) 

Keep Aspect Jeżeli jest ustawiony na True (domyślnie), to utrzymuje proporcje między szerokością a 
wysokością. Nie ma zastosowania do obiektów kodowych. 

Tillable 

Ma zastosowanie tylko do obiektów wektorowych w dokumentach pierścieniowych, tzn. na 
powierzchniach cylindrycznych. Nadaje się do bardzo precyzyjnego znakowania, zwykle biżuterii. 
Umożliwia cięcie wielokątów obiektu, które mają wymiary przekraczające wielkość sektora, na płytki, 
które mają rozmiary równe sektorom pierścienia. Szczegółowy opis, patrz Stosowanie funkcji podziału 
Ta właściwość jest stosowana razem z właściwościami dokumentów pierścieniowych Przerwa 
sektorowa i Wielkość sektora, które definiują wymiary sektora. 

Contour 

Jeżeli jest ustawiony na True, to umożliwia scalanie wektorów, które tworzą obiekt. W 
przypadku ciągu ta właściwość jest szczególnie przydatna, kiedy pracuje się z językami, 
których alfabety mają ligatury, takich jak np. język arabski. (Patrz Praca z ligaturami). 
(Domyślnie: False (fałsz)). 
Nie ma zastosowania do tablicy, importowanych obiektów rastrowych i kodów 2D. 

Pocketing 
Umożliwia dokładne dostrajanie wymiarów obiektu przez regulację konturu. 
Nie ma zastosowania do tablicy, obiektów rastrowych i kodów 2D. 

Origin 

Jest to punkt początkowy obiektu. Początek jest zdefiniowany przez symbol krzyża, który 
domyślnie jest umieszczony w środku. Jeżeli wybierze się inną wartość 
niż środek (domyślnie), to ten symbol odpowiednio przesunie się. Następujący przykład 
pokazuje obiekt, którego początek został ustawiony na środku u góry w dokumencie, 
którego punkt początkowy jest ustawiony w środku. 

 
Można określić położenie obiektu w stosunku do początku dokumentu przez ustawienie 
współrzędnych X i Y . 

Position (X) 
Ustawia położenie poziome obiektu w stosunku do początku, który został ustawiony dla 
dokumentu. Można zwiększyć wartość X, żeby przesunąć obiekt w prawo, albo 
zmniejszyć ją, żeby przesunąć obiekt w lewo. 

Position (Y) 
Ustawia położenie pionowe obiektu w stosunku do początku, który został ustawiony dla 
dokumentu. Można zwiększyć wartość Y żeby przesunąć obiekt w górę, albo 
zmniejszyć ją, żeby przesunąć obiekt w dół. 
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Dimensions (W) Ustawia szerokość obiektu. 
Dimensions (H) Ustawia wysokość obiektu. 

Angle Ustawia kąt obrotu (w stopniach) obiektu na obszarze grawerowania. Nie ma 
zastosowania do obiektu tablicowego. 

Scale (X) Domyślnie skala jest ustawiona na 1,00. Zwiększanie / zmniejszanie tej wartości 
powoduje zmianę szerokości obiektu. Nie ma zastosowania do obiektu tablicowego. 

Scale (Y) Domyślnie skala jest ustawiona na 1,00. Zwiększanie / zmniejszanie tej wartości 
powoduje zmianę wysokości obiektu. Nie ma zastosowania do obiektu tablicowego. 

Skew 
Ustawia zukosowanie dla obiektu: jeżeli ustawi się wartość dodatnią, obiekt jest 
ukosowany w prawo, natomiast przy wartości ujemnej jest ukosowany w lewo. 
(Domyślnie: 0). Nie ma zastosowania do obiektów tablicowych ani kodowych. 

Własne parametry laserowe dla obiektów 
Poniższe właściwości są wyświetlane wtedy, gdy wybierze się obiekt w obszarze roboczym, a potem ustawi 
na True parametr Custom Laser (własny laser) w oknie Właściwości. 

Domyślnie ten parametr jest ustawiony na False, ponieważ kiedy dodaje się obiekt graficzny do dokumentu, 
to obiekt dziedziczy parametry laserowe, które zostały ustawione dla dokumentu. Można nadal ustawić inne 
parametry laserowe dla każdego obiektu; w tym przypadku kolor obiektu zmieni się na niebieski. 

Grupa Właściwość Opis 

Przejścia   

Umożliwia to ustawienie liczby przejść światła laserowego po obiekcie w celu 
grawerowania. Można ustawić do 3 przejść, a każde z innymi parametrami 
laserowymi (patrz grupa właściwości Przejście). Ta opcja może być szczególnie 
przydatna w celu wykonania kilku przejść grawerujących światła, żeby oczyścić 
przedmiot obrabiany po ostrzejszym procesie grawerowania. (Patrz Stosowanie 
kilku przejść grawerujących) 

Moc Wskazuje moc wyjściową lasera. Wartość jest wyrażona jako procent mocy 
maksymalnej źródła laserowego. 

Częstotliwość 

Światło emitowane przez laser jest pulsujące. Ten parametr służy do regulacji 
częstotliwości emitowanego światła. Przy niezmiennych innych parametrach 
niższa częstotliwość powoduje dłuższy impuls. Nie wszystkie kombinacje mocy 
i częstotliwości są dozwolone. W zależności od rodzaju źródła laserowego, 
niskie częstotliwości wymagają odpowiednio niskich mocy. 

Prędkość 
skanowania 

Wskazuje prędkość grawerowania. Wartość jest wyrażona w milimetrach na 
sekundę. (Uwaga: Mniejsza prędkość pociąga za sobą głębsze grawerowanie. 
Dla procesów specjalnych, takich jak dogniatanie lub głębokie grawerowanie, 
należy ustawić bardzo małą prędkość (50-100 mm/s). 

Zwłoka 
punktowa 

Ustawia czas grawerowania każdego punktu, tzn. czas emisji laserowej na 
punkt. 

Czas błysku Ustawia czas trwania impulsu laserowego, tzn. czas, gdy przełącznik Q jest 
otwarty (lub raczej przezroczysty) 

Przejście 
(#) 

Powtórzenia 
Ustawia liczbę przejść wymaganych przez laser w celu wygrawerowania 
importowanych obiektów. Zwiększenie liczby przejść zwiększy głębokość 
grawerowania, a w konsekwencji wpłynie na czas cyklu. 
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Jeżeli ta właściwość jest ustawiona na True (rzeczywiste), to umożliwia grawerowanie grubszych linii 
dzięki ruchowi spiralnemu zamiast ruchu liniowego. (Patrz Stosowanie funkcji bicia wzdłużnego do 
grawerowania grubszych linii) 
Promień Przedstawia średnicę krzywej spiralnej 

Bicie wzdłużne 

Prędkość Przedstawia częstotliwość powtarzania spirali 

Oś X     Jeżeli jest ustawiona na True (prawda), to umożliwia ustawienie żądanej pozycji dla osi 
X. 

Oś Y     Jeżeli jest ustawiona na True (prawda), to umożliwia ustawienie żądanej pozycji dla osi 
Y. 

Oś Z   
Jeżeli jest ustawiona na True (prawda), to umożliwia ustawienie wysokości, tzn. 
odległości między zerem mechanicznym a zerem logicznym dla osi Z (położenie 
ogniska). 

Oś R     Jeżeli jest ustawiona na True (rzeczywista), to umożliwia ustawienie żądanej pozycji dla 
osi R.  

Parametry dla konkretnego obiektu można ustawić w oparciu o konkretny materiał (np. tworzywo sztuczne) i 
jego reakcje na operację znakowania. Bliższe informacje o sposobie zapisywania i odszukiwania bazy 
danych materiałów, patrz Zapisywanie bazy danych materiałów do późniejszego użytku. 

Wypełnianie właściwości dla obiektów 
Poniższe właściwości są wyświetlane kiedy wybierze się obiekt w obszarze roboczym, a potem ustawi inną 
wartość niż None (żaden) (domyślnie) dla właściwości Filling (wypełnianie). 

 

Uwagi: 
Właściwości wypełniania nie mają zastosowania do obiektu tablicowego ani do importowanych map bitów. 
Patrz także Określanie wzorów wypełniania, gdzie są przykłady wypełniania. 

 
Właściwości 
wypełniania Opis 

Wypełnianie 

Ta właściwość służy do ustawienia wypełniania dla obiektów. Grawerowanie jest przeważnie 
wykonywane za pomocą precyzyjnych równoległych linii. W szczególności wypełnianie może być 
wykonane za pomocą następujących funkcji: 

 Pojedyncza linia 
 Krzyżujące się linie 
 Potrójne linie - nachylenie linii będzie wynosić 0, 60 i 120 stopni. 
 Wyspy - Umożliwiają głębokie grawerowanie przez wykonanie serii koncentrycznych oznaczeń 

począwszy od konturu obiektu, żeby uzyskać kształty zagłębione. Wyspy pozwalają uniknąć 
krzyżowania ścieżek, tak że każda wytrawiana powierzchnia jest wystawiona na działanie 
lasera tylko raz, co jest szczególnie przydatne przy grawerowaniu delikatnych materiałów. 

 Spirala - Ma zastosowanie tylko do kodów. Służy do wypełniania prostokątów za pomocą 
ciągłej emisji wiązki laserowej. To ustawienie nie jest kompatybilne (nie może być stosowane 
razem) z ustawieniem  przesunięcia przywłaszczenia i geometrii konturów. 

 Kropka - Ma zastosowanie tylko do kodów 2D. Umożliwia traktowanie kwadratu jak kropki. Ten 
rodzaj wypełniania pasuje do znakowania miniaturowych elementów układu elektronicznego, 
takich jak np. obiekty o wielkości plamki laserowej na powierzchni. W tym przypadku wypełnienie 
typu Kropka umożliwia znakowanie bezpośrednio kropki zamiast wypełniania kwadratu. 

 Raster - Umożliwia znakowanie obiektu wektorowego jak gdyby był obiektem rastrowym, tzn. 
przy użyciu rastrowej techniki grawerowania (więcej informacji, patrz Znakowanie rastrowe i 
wektorowe). To ustawienie nadaje się zwłaszcza do kart plastikowych, ponieważ stała 
prędkość skanowania daje lepszą jakość. 

Interlinia Ustawia odległość między liniami wypełnienia. 

Kąt 
Kąt (0-360°), który definiuje kierunek równoległych linii grawerowania. Ustawienie kąta powoduje 
zmianę kierunku linii grawerowania (0 = poziomy, od lewej do prawej (domyślnie) - 90 = pionowy, od 
dołu do góry - 180 = poziomy, od prawej do lewej). 
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Zaawansowane 

Kierunek 

Ta właściwość służy do określenia sposobu wykonania operacji wypełniania przez laser: 
 Dwukierunkowo - Laser znakuje za pomocą linii równoległych: pierwsze linie od lewej 

do prawej, następnie od prawej do lewej (lub odwrotnie, w zależności od wartości 
ustawionej dla kąta) i tak dalej. To umożliwia skrócenie czasu znakowania. 
(Domyślnie). 

 Jednokierunkowo - Grawerowanie odbywa się tylko w jednym kierunku, co 
wydłuża czas znakowania. 

Opcja 
konturu 

Ta właściwość służy do określania jak ma być zaznaczony kontur w stosunku do wypełnienia: 
 Brak konturu - Kontur obiektu nie będzie zaznaczony. 
 Najpierw wypełnienie - Najpierw będzie wykonane wypełnienie obiektu . (Domyślnie). 
 Najpierw kontur - Najpierw będzie wykonany kontur obiektu. 

Tolerancja Ustawia odległość między konturem oniektu a liniami wypełnienia. 

Wypełnij za 
pomocą 

Ta właściwość służy do określenia sposobu w jaki laser znakuje wypełnienie obiektów, które 
składają się z wielu wielokątów (takich jak ciągi). 

 Obiekt - Laser znakuje poziomo stosując linie równoległe dla 
wszystkich danych wektorowych, które tworzą obiekt (np. ciąg będzie wykonany od 
dołu do góry, przy skanowaniu wszystkich liter w jednym przebiegu). Ta opcja 
wypełniania wydłuża czasy znakowania, ale jest zalecana do znakowania kart 
plastikowych, ponieważ zapewnia ujednolicony rezultat. 

 Wielokąt - Laser znakuje wielokąt po wielokącie (np. litera po literze w ciągu lub 
kreska po kresce w kodzie). Ta opcja wypełniania skraca czasy znakowania i jest 
zalecana w środowiskach przemysłowych. 

Właściwości Klon dla obiektów 

Poniższe właściwości wyświetlają się po wybraniu obiektu w obszarze roboczym. 

 

Uwagi: 
Właściwości Klon nie mają zastosowania do obiektu tablicowego ani do importowanych 
grafik. 

 

Właściwości  Klon Opis 

Klony 

Ta właściwość służy do powtarzania obiektów graficznych w innych 
miejscach. W szczególności, klon może być wykonany przy użyciu: 

 Liczby  klonów 
 Przesunięcia 

Liczba klonów Ustawia liczbę sklonowanych obiektów i współrzędne X i Y. 
Przesunięcie  Ustawia odległość między obiektami i położenie X i Y. 
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Praca z prostymi obiektami wektorowymi 

 
 

 

 

 

Przyciski paska narzędziowego Circle (okrąg), Rectangle (prostokąt), Poly (wielokąt), i Lines (linie) (a 
także menu Actions (działania) umożliwiają wstawianie do układu prostych kształtów wektorowych, którymi 
można łatwo manipulować przez edytowanie wektorów. (Patrz Edycja węzłów początkowych.) 

Taki obiekt stosuje linie i krzywe, zwane wektorami, do opisania obrazu Przy grawerowaniu laserowym 
grafika wektorowa jest szybsza do grawerowania i lepiej zdefiniowana w kategoriach linii konturowych i 
wypełnienia. 

Poza tym można zastosować okno Właściwości, paski narzędziowe lub mysz w celu zmiany wielkości, 
regulacji, grupowania, spacjowania, ścinania, podziału na płytki, wypełniania kształtów itp. 

 

Wskazówki: 
Więcej informacji o operowaniu myszą, patrz Użycie myszy do wyboru obiektów i manipulowania nimi. 
Informacje o tym jak operować grafikami, patrz Zwykłe operacje na obiektach. 
Kliknięcie w tytuł właściwości w przeglądarce Properties, a następnie naciśnięcie F1 otwiera tabelę z 
opisem tych właściwości. 

Następujące sekcje opisują sposób pracy z kształtami wektorowymi: 
 Dodawanie kształtu 
 Edycja węzłów początkowych 
 Stosowanie funkcji podziału 
 Właściwości geometryczne obiektów 
 Własne parametry laserowe dla obiektów 
 Wypełnianie właściwości dla obiektów 

Dodawanie kształtu 

W celu dodania kształtu: 
Najpierw utworzyć lub otworzyć dokument w celu wstawienia tam obiektów (patrz Tworzenie układów 
graficznych i Otwieranie istniejących układów). 

W celu dodania okręgu lub prostokąta należy wykonać jedną z następujących czynności: 

1. Na pionowym pasku narzędziowym kliknąć w przycisk   (wstaw obiekty), a potem, na poziomym 

pasku narzędziowym, który się wyświetla, kliknąć w    (okrąg) lub   (prostokąt). 
2. Z paska menu edytora laserowego wybrać Actions > Insert > Circle (działania > wstaw > okrąg) 

lub Rectangle (prostokąt). 

W obszarze roboczym pojawia się kształt (okrąg lub kwadrat) otoczony uchwytami wyboru: 
Przeciągnij, żeby uzyskać taką wielkość kształtu jaką chcesz (patrz Użycie myszy do wyboru 
obiektów i manipulowania nimi). 
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W celu dodania wielokąta należy wykonać jedną z następujących czynności: 

1. Na pionowym pasku narzędziowym kliknąć w przycisk   (wstaw obiekty), a potem, na poziomym 

pasku narzędziowym, który się wyświetla, kliknąć w    (wielokąt). 
2. Z paska menu edytora laserowego wybrać Actions > Insert > Poly (działania > wstaw > wielokąt). 
3. Ustawić wskaźnik myszy na wymaganym punkcie początkowym dla wielokąta i kliknąć lewym 

przyciskiem myszy. 
4. W celu utworzenia krzywej: Kliknąć lewym przyciskiem myszy i przytrzymać przeciągając do 

żądanego położenia: 

 

(Bliższe informacje o węzłach, patrz Edycja węzłów początkowych) 

5. Gdy już wskaźnik jest w żądanym miejscu, kliknąć lewym przyciskiem myszy, żeby narysować 
zieloną linię. 

6. Powtarzać poprzednie kroki tyle razy ile trzeba, żeby dodać kolejne rogi wielokąta. 
7. W celu zamknięcia wielokąta kliknąć w pierwszy punk klikania. Wokół obiektu pojawiają się uchwyty 

wyboru. Aby wyjść z trybu tworzenia wielokąta, należy nacisnąć Esc. 

(Więcej informacji patrz Użycie myszy do wyboru obiektów i manipulowania nimi. 

W celu dodania linii należy wykonać jedną z następujących czynności: 

1. Na pionowym pasku narzędziowym kliknąć w przycisk  Insert objects (wstaw obiekty), a potem, 

na poziomym pasku narzędziowym, który się wyświetla, kliknąć w   Lines (linie). 
2. Z paska menu edytora laserowego wybrać Actions > Insert > Lines (działania > wstaw > linie). 
3. Kliknąć i przeciągnąć, żeby narysować żądaną linię. 
4. W celu zamknięcia linii kliknąć w pierwszy punk klikania. Wokół obiektu pojawiają się uchwyty 

wyboru. Aby wyjść z trybu tworzenia linii, należy nacisnąć Esc. 

(Więcej informacji patrz Użycie myszy do wyboru obiektów i manipulowania nimi. 

Operowanie kształtami: 
 Za pomocą okna Properties (właściwości), pasków narzędziowych lub myszy można dostosować 

wygląd kształtu, jeśli chodzi o wielkość, położenie, obrót, wypełnienie i tym podobne, a także ustawić 
własne parametry lasera. 

 Wybrać kształt, a potem dwukrotnie kliknąć w niego. To spowoduje, że segmenty kształtu zmienią 
kolor na zielony i zostanie uaktywniona funkcja Edit nodes (edytuj węzły). Patrz Edycja węzłów 
początkowych. 
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Stosowanie ciągów tekstowych 

 

 

Za pomocą przycisku paska narzędziowego lub menu Actions (działania) edytor laserowy umożliwia 
wstawianie ciągów tekstowych do układu. 

Następnie przy użyciu przeglądarki Properties (właściwości), narzędzi z paska narzędziowego lub myszy 
można ustawić wymiary, znak drukarski, styl fontu, spacjowanie, ścięcie i wypełnienie. (Kliknąć w tytuł 
właściwości, a potem nacisnąć F1 , żeby otworzyć tabelę z opisem właściwości.) 

Edytor laserowy umożliwia: 
 dynamiczne wyświetlanie zaktualizowanych tekstów; 
 stosowanie znaków specjalnych w celu tworzenia zmiennych tekstów (data, godzina, licznik 

samoprzyrostowy); 
 umieszczanie teksty wewnątrz lub na zewnątrz łuku okręgu; 
 import dowolnego rodzaju fontu; 
 ustawianie fontu, wymiarów, stylu, znaków drukarskich, spacjowania i wypełnienia; 
 edycję ciągów jako obiektów czysto wektorowych; 
 obrót, ścięcie lub zmianę wielkości ciągów przy użyciu myszy (patrz Użycie myszy do wyboru 

obiektów i manipulowania nimi); 
 ustawienie własnych parametrów lasera, które różnią się od parametrów ustawionych dla 

dokumentu. 
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Następujące sekcje opisują sposób pracy z ciągami tekstowymi: 

 Dodawanie ciągu tekstowego 

 Zmiana stylu znaków (patrz właściwości: Styl) 

 Osiowanie tekstu z kołem (patrz właściwości: Okrąg) 

 Import fontów 

 Stosowanie specjalnych sekwencji znaków 

 Włączanie licznika samoprzyrostowego do ciągu tekstowego 

 Edycja ciągu jako obiektu czysto wektorowego 

 Dynamiczne zarządzanie ciągami, które mają wspólne zawartości 

 Praca z ligaturami 

 Stosowanie funkcji podziału 

 Właściwości ciągu tekstowego 

 Zwykłe operacje na obiektach 

Dodawanie ciągu tekstowego 
W celu dodania ciągu: 

1. Utworzyć lub otworzyć dokument, żeby umożliwić wstawianie obiektów (patrz Tworzenie układów 
graficznych i Otwieranie istniejących układów). 

2. Wykonać jedną z następujących czynności: 

o Na pionowym pasku narzędziowym kliknąć w przycisk   (wstaw obiekty), a potem, na 

poziomym pasku narzędziowym, który się wyświetla, kliknąć w    (ciąg tekstowy). 
o Z paska menu edytora laserowego wybrać Actions > Insert > Text string (działania > 

wstaw > ciąg tekstowy). 

3. W obszarze roboczym jest wyświetlany obiekt Ciąg otoczony uchwytami wyboru: w celu szybkiego 
zgrubnego ustalenia wielkości, obrotu czy pozycjonowania należy użyć myszy (patrz Użycie myszy 
do wyboru obiektów i manipulowania nimi). 

4. Za pomocą okna Properties (właściwości) i przycisków pasków narzędziowych można formatować i 
dostosowywać ciąg. (Patrz niżej). 

 

Wskazówka: 
Podręczne informacje o stosowaniu pasków narzędziowych w edytorze laserowym, 
patrz Stosowanie narzędzi z pasków narzędziowych. 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości. 
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Import fontów 

 
Uwaga: 
W celu włączenia tej funkcji trzeba zamknąć wszystkie dokumenty. 

Domyślnie edytor laserowy wykorzystuje standardowe fonty, ale można użyć tej funkcji, żeby zaimportować dowolny 
rodzaj fontów. Wtedy będzie można wybrać fonty z listy właściwości Font z grupy właściwości Style (styl). 

Poza tym są przewidziane dwa niestandardowe fonty jednoliniowe (a mianowicie antykwa i standard), które optymalizują 
czas znakowania. Można także zaimportować jednoliniowe fonty komercyjne („www.onelinefonts.com”). 

W celu zaimportowania fontów: 

1. Wybrać File > Import fonts (plik > importuj fonty) z paska menu. Wyświetla się ramka dialogowa 
importu fontów. 

Na obszarze System font (font systemowy) po lewej stronie są wymienione wszystkie fonty, które 
są obecnie zainstalowane w systemie; po wyborze fontu, po lewej stronie okienka wyświetla się 
podgląd. 

2. Wybierz font(y), który chcesz zaimportować do edytora laserowego, a potem kliknij w  , żeby 
wprowadzić font na listę fontów laserowych po prawej stronie. 

3. Kliknij w  , żeby zaimportować wszystkie istniejące fonty. 

Stosowanie specjalnych sekwencji znaków 
Do tworzenia zmiennych tekstów, które zawierają daty i/lub godziny, można zastosować narzędzie do 
ciągów tekstowych. W tym celu trzeba użyć specjalnych sekwencji znaków. 

Tworzenie dat i godzin przy użyciu specjalnych sekwencji znaków: 
1. Dodać ciąg tekstowy do dokumentu (patrz Dodawanie ciągu tekstowego). 
2. W przeglądarce Properties (właściwości), pod String (ciąg), wybrać ramkę Text a potem 

wprowadzić pożądaną, specjalną sekwencję znaków, w zależności od potrzebnego formatu daty 
i/lub godziny. Skorzystać z następującej tabeli: 

Tabela 1 Specjalne sekwencje znaków dla dat i godzin 
Specjalna 
sekwencja 
znaków 

Wynik 

%a, %A Dzień tygodnia, skrócony (a) lub pełny (A) 
%b, %B Miesiąc roku, skrócony (b) lub pełny (B) 
%c Data i godzina, zgodnie z bieżącą lokalizacją 
%d Dzień miesiąca, liczba dziesiętna (01 - 31) 
%H Godzina, format zegara 24-godzinnego (00 - 23)  
%I Godzina, format zegara 12-godzinnego (01 - 12) 
%j Dzień roku, liczba dziesiętna (001 - 366) 
%m Miesiąc roku, liczba dziesiętna (01 - 12) 
%M Minuty, liczba dziesiętna (00 - 59) 
%p Wskaźnik A.M. / P.M. (przed południem / po południu) 
%S Sekundy, liczba dziesiętna (00 -59) 
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%U Tydzień roku, liczba dziesiętna (00 - 51, niedziela jest pierwszym dniem tygodnia) 
%w Dzień tygodnia, liczba dziesiętna (1 - 7, niedziela = 1) 
%W Tydzień roku, liczba dziesiętna (01 - 52, poniedziałek jest pierwszym dniem tygodnia) 
%x Data, zgodnie z bieżącą lokalizacją 
%X Godzina, zgodnie z bieżącą lokalizacją 
%y Rok, dwucyfrowa liczba dziesiętna (00 - 99) 
%Y Rok, czterocyfrowa liczba dziesiętna 
%z, %Z Strefa czasowa, nazwa (Z) lub skrót (z) 
%% Znak wartości procentowej, % 

%[ID] 

Znak wartości procentowej, po którym następuje ciąg ID (identyfikacyjny), który 
umożliwia skopiowanie zawartości ciągu do innego ciągu w celu dynamicznej 
aktualizacji. (Bliższe informacje, patrz Dynamiczne zarządzanie ciągami, które mają 
wspólne zawartości). 

%#c Długie przedstawienie daty i godziny, właściwe dla bieżącej miejscowości. (Na przykład: 
Wtorek, 1 kwietnia 2008 r., 12:41:29) 

%#x Długie przedstawienie daty, właściwe dla bieżącej miejscowości. (Na przykład: Wtorek, 1 
kwietnia 2008 r.). 

%v[], %V[] Te sekwencje umożliwiają zastosowanie zmiennych globalnych. V wymusza duże litery. 
(Bliższe informacje, patrz Stosowanie zmiennych globalnych). 

%f 

Umożliwia kodowanie znaku FNC1 dla symbolizmów wspierających standard GS1. 
(Bliższe informacje, patrz sekcja Stosowanie kodów, standardu GS1-128 i witryna GS1). 
Przykład: dostarczenie wartości tekstowej %f00350123451234567894 w kodzie 128 
koduje GS1-128 mające AI 00 i kod 350123451234567894. 

%T[] 
Wstawia znak ASCII odpowiadający liczbie w nawiasie kwadratowym. Jest to przydatne 
przy dodawaniu ciągu znaków ASCII, które nie mają przedstawienia graficznego. (Na 
przykład: %T[21] zakoduje kod NAK ASCII. 

3. Po wprowadzeniu wybranej sekwencji nacisnąć Enter. Ciąg zmienia się w wybrany format daty i/lub 
godziny. Ustawić parametry wymagane dla ciągu przez ustawienie właściwości ciągu tekstowego lub 
użycie przycisków z pasków narzędziowych. 

Przykład: 
 Wprowadzenie sekwencji %d/%m/%Y w ramce tekstowej da w wyniku ciąg tekstowy o 

następującym formacie: 01/04/2008. 
 Wprowadzenie sekwencji %d/%m/%y w ramce tekstowej da w wyniku ciąg tekstowy o następującym 

formacie: 01/04/08. 

 
Uwaga: 
Aby wprowadzić znak % do ciągu, należy wpisać go dwa razy %%  w ramce Text (tekst). 
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Włączanie licznika samoprzyrostowego do ciągu tekstowego 
Do tworzenia zmiennego tekstu, który zawiera licznik samoprzyrostowy, można zastosować narzędzie do 
ciągów tekstowych. W tym celu można: 

 Użyć specjalnej sekwencji znaków, aby dołączyć licznik do konkretnego ciągu. 

 

Uwaga: 
Stosowanie tego typu licznika jest utrzymywane tylko w celu wsparcia oprogramowania 
odziedziczonego. Należy unikać stosowania go w nowych projektach. Odradzamy ten licznik na 
korzyść zmiennych globalnych. Wykorzystanie takich liczników z edytora może spowodować, że 
przedstawienie wartości nie będzie dostosowane do użytego w mechanizmie. 

 Tak tworzyć zmienną globalną, żeby zapisać licznik na poziomie urządzenia, a potem zastosować 
prawidłowe, specjalne sekwencje znaków, żeby dołączyć go do kilku ciągów i/lub dokumentów. 
(Patrz sekcja Stosowanie zmiennych globalnych). 

Stosowanie specjalnych sekwencji znaków w celu utworzenia licznika: 
Ta procedura opisuje jak użyć specjalnych sekwencji znaków, aby dołączyć licznik do konkretnego ciągu w 
konkretnym dokumencie. (Tworzenie zmiennej, którą można dzielić się z wieloma ciągami i/lub dokumentem, 
a także zapisać na poziomie urządzenia, patrz sekcja „Stosowanie zmiennych globalnych” na str. 133.) 

1. Dodać ciąg tekstowy do dokumentu (patrz Dodawanie ciągu tekstowego). 
2. W oknie Properties (właściwości), pod String (ciąg), wybrać ramkę Text a potem wprowadzić 

pożądaną, specjalną sekwencję znaków, w zależności od typu licznika, który ma być stworzony. 
Skorzystać z następującej tabeli: 

Tabela 2 Specjalne sekwencje znaków dla liczników 
Specjalna 

sekwencja znaków Wynik 

%n Licznik, format dziesiętny. Można go dołączyć do konkretnego ciągu. 
%o Licznik, format ósemkowy. Można go dołączyć do konkretnego ciągu. 

%e, %E Licznik, format szesnastkowy, małe litery (e) lub duże litery(E). Można go dołączyć do 
konkretnego ciągu. 

%v, %V Umożliwia stosowanie zmiennych globalnych (patrz Stosowanie zmiennych 
globalnych). 
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3. Nacisnąć Enter. Ciąg zmienia się na licznik określonego formatu. Ustawić wymagane 
właściwości licznika . 

 

4. Skorzystać z następującej tabeli: 

Właściwość licznika Opis 
Start Minimalna wartość dla licznika. 
Stop Maksymalna wartość dla licznika. 
Current (bieżąca) Bieżąca wartość licznika jaka pojawia się w ciągu. 
Step (krok) Wartość przyrostu (dodatnia lub ujemna). 
Cycles (cykle) Liczba razy jaką licznik będzie oznaczony zanim nastąpi przyrost o jeden krok. 
Digits (cyfry) Minimalna liczba cyfr, jaka będzie wyświetlana. 

Przykład 
 Wprowadzenie %n w ramce tekstowej, a potem ustawienie parametrów jak następuje 

Current = 1 - Start = 1 - Stop = 10 - Steps = 2 - Cycles = 2 - Digits = 3 

spowodowałoby, że format 001 stałby się 003 ... 005 ... 007 ... 009 ... 002 ... 004 ... 006 ... 008 ... 
010 ... 001. 

Przyrost nastąpiłby co dwa zadania grawerowania. 
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Edycja ciągu jako obiektu czysto wektorowego 

Ta procedura obejmuje stworzenie z ciągu obiektu czysto wektorowego. 

W ten sposób ciąg traci swoje specyficzne właściwości i zmienia się w obiekt wektorowy, który można 
edytować przy użyciu funkcji edytora laserowego Edit nodes (edytuj węzły). (Patrz Edycja obiektów 
wektorowych). 

W celu edycji wektorów: 
1. Wybrać ciąg, który ma być przekształcony na wektorowy. 
2. Wykonać jedną z następujących czynności: 

1. Z paska menu edytora laserowego wybrać Actions > Make vectorial (działania > 
przekształć na wektorowy). 

2. Na pionowym pasku narzędziowym kliknąć w  , potem kliknąć w  (przekształć na 
wektorowy) na poziomym pasku narzędziowym. 

3. W celu włączenia funkcji edycji węzłów należy kliknąć w przycisk . (edytuj węzły). To 
spowoduje, że zostanie wyświetlony poziomy pasek narzędziowy  Edit nodes (edytuj węzły), a kolor 
konturu zmieni się na zielony. 

4. Kliknąć w ciąg, żeby wyświetlić węzły i punkty kontrolne, które można wykorzystać do edycji znaków: 

 
Szczegółowe informacje o sposobie edycji węzłów, patrz sekcja Edycja obiektów wektorowych. 

5. Aby wyjść z trybu operacyjnego Edytuj węzły, należy kliknąć w przycisk  (wstaw obiekty). 

Dynamiczne zarządzanie ciągami, które mają wspólne zawartości 
Edytor laserowy umożliwia dynamiczne zarządzanie zawartością ciągów. 

Przypuśćmy, że masz dwa ciągi, które dzielą taką samą zawartość i że chcesz utrzymać ich zawartość 
dostosowaną w razie wystąpienia zmiany. Aby to zrobić, możesz połączyć ze sobą zawartość ciągów za 
pomocą ich ID (identyfikatora), który jest unikalnym ciągiem alfanumerycznym, który identyfikuje obiekt w 
układzie. 

 

Uwaga: 
Zależności cykliczne są niedozwolone. Jeżeli wprowadzi się zależność cykliczną, zostanie 
wyświetlony komunikat o błędzie. 
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Zastosowanie identyfikatorów do łączenia i dynamicznej aktualizacji ciągów tekstowych: 

1. Wybrać ciąg, którego zawartość ma być wprowadzona do innego ciągu. 

2. Dołączyć ID do ciągu: W oknie Properties (właściwości), pod Geometry (geometria), kliknąć w 
ramkę tekstową obok ID, a potem wprowadzić żądany ciąg alfanumeryczny. Należy zauważyć, że 
ID pojawia się pod ciągiem: 

 

3. Do dokumentu dodać ciąg, który musi dzielić taką samą zawartość co powyższy ciąg. 
(Patrz Dodawanie ciągu tekstowego). 

4. W oknie Properties (właściwości), pod String (ciąg), kliknąć w ramkę tekstową obok słowa Text i 
wprowadzić %[St1] , a po nim tekst nowego ciągu, jak pokazano poniżej: 

 

W ten sposób, kiedy ciąg IDTest zmieni się, drugi ciąg zostanie także dynamicznie zaktualizowany. 

Praca z ligaturami 

Co to jest ligatura? 

Ligatura pojawia się wtedy, gdy co najmniej dwie litery są połączone w jeden glif. Ligatury zwykle zastępują 
kolejne znaki dzielące wspólne elementy. 

Na przykład w alfabecie arabskim, historycznie pochyłym, większość liter przyjmuje kształt wariantowy w 
zależności od innych liter, które następują po nich (na początku wyrazu), które je poprzedzają (na końcu 
wyrazu) lub obu (w środku). 

Z punktu widzenia układu grawerowania, ligatury pojawiałyby się jako litery (tzn. dane wektorowe) 
zachodzące na siebie; w wyniku tego nałożone obszary nie byłyby wypełnione zgodnie z oczekiwaniem. 

W celu rozwiązania problemu stosuje się właściwość Contour (kontur), która umożliwia scalanie liter przy 
jednoczesnym powstrzymaniu ciągu przed staniem się obiektem wektorowym. 
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Stosowanie właściwości Kontur do scalania liter: 

1. Wybrać tekst z ligaturami (literami, które zachodzą na siebie). 

2. Z okna Properties (właściwości) wybrać Filling (wypełnianie), a potem z listy rozwijanej w dół 
wybrać żądaną wartość wypełnienia. (Bliższe informacje, patrz Właściwości wypełniania dla 
obiektów). Nałożone obszary pojawią się w następującej postaci: 

 

3. Pod Geometry (geometria) wybrać pole wyboru Contour (kontur), żeby ustawić wartość True . W 
wyniku tego nałożone obszary zostaną wypełnione, a obiekt będzie utrzymywany jako ciąg: 

 

Właściwości ciągu tekstowego 
Okno Properties (właściwości) współpracuje z pomocą kontekstową: Podczas edycji układu - wybór 
tytułu właściwości (np. Geometry), a następnie naciśnięcie F1 otwiera pomoc kontekstową dla tych 
właściwości. 

Kiedy w obszarze roboczym jest wybrany obiekt w postaci ciągu tekstowego, pojawiają się poniższe 
właściwości (patrz Stosowanie ciągów tekstowych). 

 

Wskazówki: 
W celu szybkiego, wstępnego wymiarowania, obracania i pozycjonowania ciągu można użyć 
myszy (patrz Użycie myszy do wyboru obiektów i manipulowania nimi). Przeglądarka 
właściwości umożliwia dokładniejsze operacje. 
Bliższe informacje o sposobie stosowania właściwości w celu wykonania konkretnych operacji 
na obiekcie, patrz sekcja Zwykłe operacje na obiektach . 

 
Właściwość Podwłaściwość Opis 

Text (tekst)   

Ciąg tekstowy do wygrawerowania. Wybrać ramkę tekstową, wprowadzić 
ciąg lub wartość zmiennej, która go przedstawia i nacisnąć Enter. 
(Informacje o sposobie stosowania specjalnych sekwencji znaków, 
patrz Specjalne sekwencje znaków dla dat i godzin i Specialne 
sekwencje znaków dla liczników). 
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Font Przetworzony font, który tekst musi zastosować. Rozwijana w dół lista zawiera 
dostępne fonty. Można także importować nowe fonty (patrz Import fontów) 

Style (styl) Styl fontu, który ma być zastosowany do ciągu. Rozwijana w dół lista zawiera 
dostępne opcje. 

Height  Wysokość znaków. 
Shear (ścięcie) Przedstawia ścięcie wybranego ciągu na osi X. 

Style (styl) 

Angle (kąt) 

Przedstawia kąt obrotu, który pojedyncza litera stosuje w stosunku do jej 
początku. W poniższym przykładzie pokazano ciąg, gdzie kąt znaku wynosi 
15 stopni: 

 

Spacing 
(spacjowanie) 

Przedstawia odległość między znakami ciągu (wartość domyślna wynosi 0). 
Wartości ujemne zmniejszają domyślne spacjowanie, natomiast wartości 
dodatnie zwiększają. Displacement 

(przemieszczenie) 
Compression 
(kompresja) 

Przedstawia kompresję każdego znaku ciągu (wartość domyślna wynosi 
100). 

Jeżeli ta właściwość jest uaktywniona (True), to Circle umożliwia umieszczenie tekstu na 
łuku okręgu (standardową wartością jest False). Ustawienie wartości na True spowoduje, że 
następujące właściwości staną się widoczne w celu określenia stosownych parametrów: 

Radius 
(promień) 

Przedstawia średnicę łyku okręgu w celu wyosiowania ciągu. Ustawić 
wartość różną od 0, żeby utworzyć okrąg. Na rysunku pokazano okrąg o 
promieniu, którego wartość wynosi 8: 

 

Counter 
clockwise 
(przeciwnie do 
ruchu wskazówek 
zegara) 

Ustawia kierunek tekstu na łuku okręgu. Domyślnie jest ustawiony na: 
zgodnie z ruchem wskazówek zegara. 

Inside 
(wewnątrz) 

Jeżeli jest włączona (True), umożliwia umieszczenie ciągu wewnątrz 
okręgu. 

Autostart angle 
(kąt 
automatycznego 
startu) 

Jeżeli jest włączony (True), umożliwia ustawienie punktu startu ciągu na łuku. 
Wtedy można ustawić punkt startu w stopniach w polu Start Angle (kąt startu) 
poniżej. Na rysunku pokazano kąt automatycznego startu (kiedy ta opcja jest 
ustawiona na False): 

 

Circle (okrąg) 

Start angle (kąt 
startu) Przedstawia, w stopniach, punkt startu ciągu na łuku. 
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Grupa Counter (licznik) umożliwia tworzenie zmiennego tekstu, który obejmuje licznik 
samoprzyrostowy (patrz Włączanie licznika samoprzyrostowego do ciągu tekstowego). 
Start Minimalna wartość dla licznika. 
Stop Maksymalna wartość dla licznika. 
Current 
(bieżąca) Bieżąca wartość licznika jaka pojawia się w ciągu. 

Step (krok) Wartość przyrostu (dodatnia lub ujemna). 
Cycles 
(cykle) Liczba razy jaką licznik będzie oznaczony zanim nastąpi przyrost o jeden krok. 

Counter 
(licznik) 

Digit (cyfra) Minimalna liczba cyfr, jaka będzie wyświetlana. 
Formatery są plikami źródłowymi, które są dostarczane z edytorem projektów. Te pliki można 
wykorzystywać jako biblioteki funkcji. Ich celem jest ułatwienie wykonawcom tworzenia 
własnych aplikacji. Na przykład, będąc integratorem, możesz potrzebować konkretnych 
funkcji, którymi dysponują te biblioteki. Formatery mają rozszerzenie .qs i są przechowywane 
w folderze ...\Data\Formatters. 
True or 
False 
(prawda czy 
fałsz) 

Umożliwia lub uniemożliwia użycie własnego pliku formatera 

Własne 
formatery 

Script 
(skrypt) 

Widoczny tylko wtedy, gdy właściwość Własne formatery jest ustawiona na 
True. Zastosować, żeby wybrać  własne formatery z listy dostępnych plików. 

Patrz także: 

 Właściwości geometryczne obiektów 

 Własne parametry laserowe dla obiektów 

 Wypełnianie właściwości dla obiektów 
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Stosowanie kodów 

 
 

Kody przedstawiają dane tekstowe, które są formatowane i wyświetlane, zwłaszcza w celu 
automatycznego pozyskiwania przez dedykowane urządzenia optyczne (skanery lub czytniki 
kodów). 

Edytor laserowy dostarcza kilka symbolizmów kodów. 
 Długości 
 Pocztowe 
 Piętrowe 
 Dwuwymiarowe (2D) 

Przy użyciu przycisku paska narzędziowego Code (kod) lub menu Actions (działania) można wstawiać kody 
do układu. 

Wtedy można użyć przeglądarki Properties (właściwości) lub narzędzi z paska narzędziowego w celu 
ustawienia wymiarów, rodzaju standardu, wielkości, poziomów błędu, sumy kontrolnej, wypełnienia i tym 
podobnych. (Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości). 

Kod jest traktowany przez edytor laserowy w taki sam sposób jak ciąg tekstowy, dlatego można połączyć 
funkcje specjalnych sekwencji znaków, jak to opisano dla obiektu typu ciąg. (Patrz Specjalne sekwencje 
znaków dla dat i godzin i Specjalne sekwencje znaków dla liczników.) 

Poza tym można: 
 ustawiać wymiary, stosunek czerni do bieli i wypełnienie; 
 obracać lub zmieniać wymiary kodu; 
 ustawienie własnych parametrów lasera, które różnią się od parametrów ustawionych dla 

dokumentu. 

Następujące sekcje opisują sposób pracy z kodami 

 Ogólnie przyjęta terminologia kodów 

 O liniowych kodach kreskowych 

 O piętrowych kodach kreskowych 

 O kodach dwuwymiarowych (2D)  

 Dodawanie kodu 

 Ustawianie zdolności do odzyskiwania danych 

 Równoważenie stosunku czerni do bieli 

 Właściwości kodów 

 Stosowanie funkcji podziału 

 Zwykłe operacje na obiektach 
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Ogólnie przyjęta terminologia kodów 

Symbol kodu kreskowego 
Kompletny kod kreskowy złożony z pustego obszaru przed kodem, znaku początkowego, jednego lub więcej 
znaków zawierających informacje, znaku stop i pustego obszaru końcowego (cicha strefa). 

Stosunek czerni do bieli 
Stosunek między białymi i czarnymi modułami. Można dokładnie dostroić ten stosunek, gdy znakuje się 
bardzo małe elementy. 

Słowa kodowe 
Grupa kresek i spacji przedstawiająca jedną lub więcej liczb, liter lub innych symboli. 

Element 
Nazwa spacji lub kreski. 

Standard GS1-128  

Standard GS1-128 jest standardem użytkowym (odwiedź witrynę GSI, żżeby uzyskać bliższe informacje) w 
ramach kodu kreskowego Kod 128. Umożliwia stosowanie szeregu identyfikatorów aplikacji w celu włączenia 
dodatkowych danych, takich jak dat „najlepiej spożyć przed”, numerów partii, ilości, ciężarów i wielu innych 
cech, których może potrzebować użytkownik. Współpracuje z naszym oprogramowaniem 
poprzez Stosowanie specjalnych sekwencji znaków. 

Spacja między znakami 
Spacja, która oddziela dwa sąsiednie znaki; w niektórych kodach (kod 39, kod kreskowy) spacje wewnątrz 
znaku zawierają informacje, spacje między znakami - nie. 

Liniowy kod kreskowy 
Symbol liniowego kodu kreskowego (znany również pod nazwą kodu kreskowego 1D) składa się z szeregu 
kresek i spacji, które zawierają informacje i elementy kontrolne. 

Moduł 
Najmniejsza grubość w elemencie kodu. W przypadku liniowych kodów kreskowych stanowi jednostkę miary 
grubości szerokich elementów. W przypadku kodów 2d jest to pojedyncza komórka, która reprezentuje bit 
reprezentacji kodu. Jest reprezentowana przez kwadrat. 

Cicha strefa 
Puste przestrzenie bezpośrednio poprzedzające znak początkowy i następujące po znaku stop. 

Proporcja druku 
W kodach o dwóch grubościach jest to stosunek grubości szerokiego elementu do grubości wąskiego 
elementu. 

Kod piętrowy 

Symbol, który jest podzielony na sekcje i „ułożony” jeden na drugim, podobnie do zdań w akapicie. 
Wyjątkowo zwarte kody. 

Kody dwuwymiarowe (kody 2D) 
Kod dwuwymiarowy (znany również jako kod matrycowy) jest zbudowany na prawdziwej matrycy 2-D. Jest to 
dwuwymiarowy sposób przedstawienia informacji, który zawiera informacje w obu kierunkach, pionowym i 
poziomym. 
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O liniowych kodach kreskowych 
Symbol liniowego kodu kreskowego (znany również pod nazwą kodu kreskowego 1D) składa się z szeregu kresek i 
spacji, które zawierają informacje i elementy kontrolne. Wszystkie kreski mogą mieć taką samą długość albo niektóre z 
nich mogą być dłuższe, wystające poza dolną część, tak jak w kodach EAN (europejski kod kreskowy). 
W symbolizmach liniowych są też kody pocztowe, które wyróżniają się kreskami rozmieszczonymi zawsze w tych 
samych odstępach, o tej samej szerokości, ale o różnych wysokościach kresek (do 4), jak w przypadku kodu królewskiej 
poczty brytyjskiej pokazanego niżej. 
Poniżej pokazano liniowy kod kreskowy EAN 8 i kod królewskiej poczty brytyjskiej : 

  

Poniżej przedstawiono strukturę symbolu kodu kreskowego: 

 

Gdzie: 
 Y: Grubość szerokiego elementu 
 X: Grubość wąskiego elementu 
 Q: Grubość pustych stref nadmiarowych na końcu etykiety (ciche strefy) 

Liniowe kody kreskowe dostępne w edytorze laserowym 
Właściwość Encoding Type (rodzaj kodowania) pod Code (kod) umożliwia wybór żądanego kodu z 
rozwijanej w dół listy: 

 

Uwaga: 
Aby uzyskać bliższe informacje o właściwościach dostępnych kodów i ich opis, należy wybrać tytuł 
właściwości Encoding (kodowanie) i nacisnąć F1, żeby wyświetlić stosowny temat Pomocy. 

Kody kreskowe o dwóch grubościach 
Kreski i spacje kodu 2of5 lub 39 mogą przyjmować tylko dwie grubości, przy proporcji druku od 2 do 3, co 
jest proporcją zgodną z normami. W celu ustawienia tego parametru należy wybrać właściwość Advanced > 
Print ratio (zaawansowane > proporcja druku) pod Property (właściwość) kodu. (Patrz Codes 
properties[właściwości kodu]). 
W tej kategorii są inne kody (Codabar, kod 32 itd.), ale ich proporcja druku jest stała. 

Kody kreskowe o wielu grubościach 
Jest wiele symbolizmów kodowych, których kreski i spacje mogą przyjmować więcej niż dwie różne grubości. 
Są to na przykład: EAN (europejski kod kreskowy), UPC (uniwersalny kod kreskowy), kod 128, kod 93, kod 
DPD itd. 

Kody pocztowe 
Tego rodzaju symbolizmy są zbudowane z jednakowych kresek o tej samej szerokości, ale różniących się 
wysokością. Kreski są rozstawione regularnie, ponieważ także odległość kolejnych kresek jest równa 
szerokości kreski. 

Tam, gdzie kreski mają dwie różne wysokości (krótka i długa kreska), to dzielą one tę samą linię 
podstawową, narastającą od dołu do góry. Przykładami są kody US Postal, CEPNet, Planet. 

Tam gdzie w kodach stosuje się trzy różne wysokości, takie kody składają się z długich i krótkich kresek 
rosnących albo z dołu do góry, albo w dół oraz krótkich kresek. Przykładem jest kod Pharmacode 2-Track. 

Kody kreskowe o czterech różnych wysokościach składają się z długich kresek, średnich kresek 
rosnących albo z dołu do góry, albo w dół oraz krótkich kresek wyśrodkowanych pionowo. Przykładami są 
kody: Australian Postal, Royal Mail 4 State, KIX, Intelligent Mail® Barcode, DAFT, Japanese Postal. 



TWORZENIE UKŁADÓW GRAFICZNYCH 

 71
 

4

Tematy pokrewne: 

 Ogólnie przyjęta terminologia kodów 

 O piętrowych kodach kreskowych 

 O kodach dwuwymiarowych (2D) 

 Dodawanie kodu 

 Ustawianie zdolności do odzyskiwania danych 

 Równoważenie stosunku czerni do bieli 

 Właściwości kodów 

O piętrowych kodach kreskowych 
Piętrowe kody kreskowe stanowią kompromis między prawdziwymi kodami kreskowymi 2D a kodami 
liniowymi i są zbudowane jak przekładaniec kodów kreskowych układanych jeden na drugim. Są to 
wyjątkowo zwarte kody. 
Codablock-F i PDF 417 to przykłady piętrowych kodów kreskowych, gdzie długi symbol jest podzielony na 
sekcje, które są „ułożone w stos” jedna na drugiej, podobnie do zdań w akapicie. Patrz rysunek poniżej: 

  

W szczególności, kod PDF 417 ma zdolność do korekcji błędów, która umożliwia odzyskiwanie danych, 
jeżeli kod jest brydny lub uszkodzony. Bliższe informacje, patrz Ustawianie poziomu korekcji błędów). 

Piętrowe kody kreskowe dostępne w edytorze laserowym 
Właściwość Encoding Type (rodzaj kodowania) pod Code (kod) umożliwia wybór żądanego kodu 2D z 
rozwijanej w dół listy: 

 

Uwaga: 
Aby uzyskać bliższe informacje o właściwościach dostępnych kodów i ich opis, należy wybrać tytuł 
właściwości Encoding (kodowanie) i nacisnąć F1 , żeby wyświetlić stosowny temat Pomocy. 

 PDF417 
 MicroPDF417 
 Codablock F 
 GS1 Databar Omni 
 GS1 Databar Stacked 
 GS1 Databar Expanded 
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O kodach dwuwymiarowych (2D) 
Kod dwuwymiarowy (2D) (znany również jako kod matrycowy) jest zbudowany na prawdziwej matrycy 2-D. 
Jest to dwuwymiarowy sposób przedstawiania informacji, którego główną zaletą jest zdolność do kodowania 
wielu informacji na małej przestrzeni. 
Kod 2D zawiera informacje w obu kierunkach, pionowym i poziomym, podczas gdy kod kreskowy zawiera 
dane w tylko jednym kierunku. 
Informacje zakodowane w symbolu kodu matrycowego 2D można odzyskać nawet wtedy, gdy znak jest 
uszkodzony lub brak jest części. Ta zdolność zależy od tego ile informacji nadmiarowych zawiera kod i od 
poziomu korekcji błędów (patrz Ustawianie zdolności do odzyskiwania danych). 

Kody matrycowe są zbudowane ze wzoru komórek, które mogą mieć kształt kropki, kwadratu (jak w kodzie 
Datamatrix 2D poniżej), below), sześciokątny lub kołowy, jak w kodzie MaxiCode pokazanym poniżej: 

  

Kody 2D dostępne w edytorze laserowym 
Właściwość Encoding Type (rodzaj kodowania) pod Code (kod) umożliwia wybór żądanego kodu 2D z 
rozwijanej w dół listy: 

 

Uwaga: 
Aby uzyskać bliższe informacje o właściwościach dostępnych kodów i ich opis, należy wybrać tytuł 
właściwości Encoding (kodowanie) i nacisnąć F1 , żeby wyświetlić stosowny temat Pomocy. 

 Datamatrix 
 QRcode 
 MicroQRcode 

Dodawanie kodu 
W celu dodania kodu: 

1. Utworzyć lub otworzyć dokument, żeby umożliwić wstawianie obiektów (patrz Tworzenie układów 
graficznych lub Otwieranie istniejących układów). 

2. Wykonać jedną z następujących czynności: 

o Na pionowym pasku narzędziowym kliknąć w przycisk   (wstaw obiekty), a potem, na 
poziomym pasku narzędziowym, który się wyświetla, kliknąć w    (kod). 

o Z paska menu edytora laserowego wybrać Actions > Insert > Code (działania > wstaw > 
kod). 

3. Kod jest wyświetlany w obszarze roboczym. Domyślnie stosowany jest ostatni rodzaj kodu, ale przy 
pierwszej instalacji wyświetlany jest liniowy kod kreskowy typu 128. Aby zmienić symbol, w 
przeglądarce Property (właściwość): pod Code symbol (symbol kodu) wybrać Encoding > Type 
(kodowanie > rodzaj), a potem z rozwijanej w dół listy wybrać opcję, która najlepiej odpowiada 
naszym wymaganiom. (Więcej informacji o dostępnych kodach, patrz Właściwości kodów ). 

4. Zastosować okno Properties (właściwości), żeby ustawić inne parametry kodu, a operacje na nim 
wykonywać za pomocą myszy i przycisków pasków narzędziowych. 

 

Wskazówka: 
Podręczne informacje o stosowaniu pasków narzędziowych w edytorze laserowym,patrz Stosowanie 
narzędzi z pasków narzędziowych. 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 otwiera tabelę z 
opisem tych właściwości. 
Bliższe informacje o tym jak operować na obiektach, patrz Zwykłe operacje na obiektach. 
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Ustawianie zdolności do odzyskiwania danych 
Informacje zakodowane w kodach 2D można odzyskać nawet wtedy, gdy znak jest uszkodzony lub brak jest 
części. 

Ta zdolność zależy od tego ile informacji nadmiarowych zawiera kod i od ustawionego poziomu korekcji 
błędów. Większy nadmiar i wyższy poziom korekcji błędów powodują większą zdolność do 
odzyskiwania, ale wpływają na wymiary kodu, a w konsekwencji na czas znakowania. 

Należy zwrócić uwagę, że PDF 417, który jest piętrowym kodem kreskowym, ma zdolności do korekcji 
błędów. 

Bliższe informacje: 
 Ustawianie poziomu nadmiarowości dla kodów 2D 
 Ustawianie poziomu korekcji błędów 

Ustawianie poziomu nadmiarowości dla kodów 2D 

 

Uwaga: 
Proszę zapoznać się z „Barcode Reference.pdf", gdzie są podane informacje o każdym 
symbolizmie współpracującym z tą funkcją. 

W przypadku kodów 2D można ustawiać różne wymiary kodów, tzn. można określać ile danych 
nadmiarowych może zawierać kod. 

Kody 2D mieszczą się w przedziale od mniejszych do większych wersji. Każda wersja ma inną liczbę 
modułów. Należy zauważyć, że w miarę wzrostu ilości danych potrzeba więcej modułów 
składających się na kod, co powoduje, że symbole kodu są większe. 

Można zastosować właściwość Size (wielkość) w przeglądarce Property (właściwość) kodu w celu 
wyznaczenia wymiarów symbolu, żeby pasował do potrzeb nadmiarowości. (Patrz Właściwości kodu). 

W celu ustawienia wymiarów kodów: 

1. Wybrać kod w dokumencie. Przeglądarka Property (właściwość) jest wyświetlana dla kodu. 

2. Pod Encoding (kodowanie), w grupie właściwości Code (kod) wybrać żądaną wartość z rozwijanej 
w dół listy Size (wielkość). Należy zwrócić uwagę, że opcje Best Fit (najlepsze dopasowanie) 
odpowiadają minimalnej wielkości informacji, która ma być zakodowana. 

Poniższy rysunek pokazuje zakres wielkości w przypadku kodu QRCode: 
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Ustawianie poziomu korekcji błędów 

 

Uwaga: 
Ta opcja ma zastosowanie do kodów dwuwymiarowych (2D) i niektórych innych. Proszę 
zapoznać się z „Barcode Reference.pdf", gdzie są podane konkretne informacje o każdym 
symbolizmie współpracującym z tą funkcją. 

Zdolność do korekcji błędów umożliwia odzyskiwanie danych, jeżeli kod jest brudny, uszkodzony lub 
częściowo niedostępny. Wiele kodów umożliwia ustawianie różnych poziomów korekcji błędów. 

Różne poziomy korekcji błędów są dostępne dla użytkowników, do wyboru w zależności od środowiska 
operacyjnego (ilość danych, które trzeba zakodować, wielkość i ilość uszkodzeń symbolu, które mogłyby 
wystąpić), a każdy odpowiada innej proporcji odzyskiwania danych dla sumarycznych słów kodowych. 
Zwiększenie tego poziomu poprawia zdolność do korekcji błędów, ale także zwiększa ilość danych 
i wielkość kodu QR. 

Można zastosować właściwości Error Level (poziom błędów) w przeglądarce Property (właściwość), żeby 
ustawić korekcję błędów. (Patrz Właściwości kodu). 

W celu ustawienia poziomu korekcji błędów: 
1. Wybrać kod w dokumencie. Przeglądarka Property (właściwość) jest wyświetlana dla kodu. 
2. Pod Encoding (kodowanie), w grupie właściwości Code (kod) wybrać żądaną wartość z rozwijanej 

w dół listy Error Level (poziom błędu). 

Równoważenie stosunku czerni do bieli 
Ta zdolność umożliwia regulację proporcji między białymi a czarnymi elementami, kiedy znakuje się bardzo 
małe elementy. 
Ta właściwość jest także nazywana „redukcją szerokości kreski" (BWR), „korekcją szerokości kreski" (BWC), 
„goleniem pikseli”. 
W tym przypadku wymiary plamki mogą wpływać na proporcję wymiarową czerni i bieli i może wystąpić 
potrzeba zrównoważenia proporcji. Elementy grawerowania (czarne) muszą być identyczne z pustymi. 

W celu zrównoważenia proporcji: 
1. Wybrać kod w dokumencie. Przeglądarka Property (właściwość) jest wyświetlana dla kodu. 
2. Pod Encoding (kodowanie), w grupie właściwości Code > Advanced (kod > zaawansowane) 

ustawić wartość Black/White ratio (proporcja czerni do bieli) na żądaną wartość procentową. 
Domyślnie jest 100%, co oznacza, że elementy czarne i białe są identyczne. 

3. Ustawić niższą wartość procentową, żeby skompensować wymiar plamki lasera. 

Właściwości kodów 
Okno Properties (właściwości) współpracuje z pomocą kontekstową: Podczas edycji układu - wybór 
tytułu właściwości (np. Geometry), a następnie naciśnięcie F1 otwiera pomoc kontekstową dla tych 
właściwości. 

Poniższe właściwości pojawiają się po wyborze kodu w obszarze roboczym. 

 

Wskazówki: 
Bliższe informacje o sposobie stosowania właściwości w celu wykonania konkretnych operacji 
na obiekcie, patrz sekcja Zwykłe operacje na obiektach . 
Patrz Ogólnie przyjęta terminologia kodów, gdzie znajduje się opis terminów technicznych. 
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Grupa Właściwość Wartości Opis 

Tekst     

Ciąg do wygrawerowania w polu TEKST kodu lub wartość, 
która go reprezentuje. (Patrz Specjalne sekwencje znaków 
dla dat i godzin i Specjalne sekwencje znaków dla 
liczników). 

Kodowanie Typ   Przedstawia rodzaj kodowania. 

  128 

Liniowy kod kreskowy o wielu grubościach. Jest używany dla 
alfanumerycznych lub tylko numerycznych kodów 
kreskowych o zmiennej długości. Jest to wartość domyślna. 
Może gościć standard GS1-128. Jest to nowoczesny 
symbolizm o dużej gęstości wynaleziony w 1981 r. przez 
Computer Identics. Oprogramowanie analizuje dane 
wejściowe i wybiera najbardziej odpowiednią reprezentację 
kodu kreskowego o największej gęstości danych. Wykonuje 
się to przez tzw. „przełączanie podzbiorów”. Stosowane są 3 
różne zestawy znaków wewnętrznych (= podzbiory): 

 Code128A = duże litery + znaki niedrukowalne 
(ASCII 0-31) 

 Code128B = duże / małe litery + wszystkie znaki 
drukowalne 

 Code128C = numeryczny o podwójnej gęstości 

Code128 wykorzystuje wbudowaną cyfrę kontrolną (Modulo 
103). Ta cyfra kontrolna jest częścią kodu i nie można jej 
pomijać. Nie jest nigdy drukowana w tekście czytelnym dla 
ludzi. Skanery sprawdzają ją podczas odczytywania 
kodu, ale nie dostarczają cyfry kontrolnej do 
podłączonych systemów. 

2/5 Liniowy kod kreskowy o dwóch grubościach. Jest to tylko 
numeryczny kod kreskowy. 

Standardowy 
Jest to kod samokorekcyjny. Służy do zastosowań 
przemysłowych, numerowania artykułów, wywoływania 
fotografii, wystawiania biletów. 

Przemysłowy Jak wyżej, ale z różnym kodowaniem znaku Start/Stop 

Przeplatany 

Kod przeplatany 2 of 5 Interleaved jest szeroko stosowany 
(numerowanie artykułów, zastosowania przemysłowe). Ten 
kod samokorekcyjny ma dużą pojemność danych dzięki 
kodującym parom liczb (pierwsza cyfra jest kodowana w 
kreskach, a druga w spacjach). Tak więc ten symbolizm 
może kodować tylko parzystą liczbę cyfr. Jeżeli liczba cyfr 
będzie nieparzysta, automatycznie będzie wstawione zero 
nieznaczące. 

IATA 

Jest to kod samokorekcyjny. Znaki start/stop są identyczne z 
kodem przemysłowym 2 of 5 Industry. Wspiera odczyt 
odległości (> 1 m) i można go drukować za pomocą bardzo 
prostych technik drukowania.   Służy do przemieszczania 
bagażu w zastosowaniach transportu lotniczego 
(Międzynarodowe Zrzeszenie Przewoźników Powietrznych = 
IATA). 

Podtyp 

Datalogic Ten symbolizm jest prawnie zastrzeżonym wariantem kodu 2 
of 5 Standard. 

 

Suma 
kontrolna Prawda lub fałsz Jeżeli jest ustawiona na prawdę, to uaktywnia kończące 

słowa kodowe sumy kontrolnej. 
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3/9 

Kod 39 jest często stosowany w przemyśle, w organizacjach 
i w handlu. Został opracowany w 1974 r. przez INTERMEC i 
został znormalizowany przez ANSI MH 10.8 M-1983 i MIL-
STD-1189. 
Liniowy kod kreskowy o dwóch grubościach. Jest to 
samokorekcyjny, alfanumeryczny kod kreskowy o 
średniej gęstości i zmiennej długości. 

Standardowy Koduje 43 znaki: A-Z, 0-9, spację i -.$/+%. 

Pełny 

Ta wersja jest rzadko używana, ponieważ kod 128 zapewnia 
dużo lepszą kompresję. Wykorzystuje ten sam symbolizm co 
kod 39, ale koduje także małe litery i znaki specjalne („+A“ 
daje w wyniku małą literę „a“ przy skanowaniu). Skaner musi 
być prawidłowo skonfigurowany w celu dekodowania kodu 
39 Full/Extended. Podtyp 

LogMars 

Jest to specjalny wariant kodu 39 stosowanego przez 
Ministerstwo Obrony USA. Ten standard definiuje możliwe 
do przyjęcia zakresy dla liczby zmiennych, włącznie z 
gęstością, proporcją, wysokością kresek i wielkością linii 
interpretacyjnej czytelnej dla ludzi. Cyfra kontrolna modulo-
43, która jest opcjonalna dla kodu 39, jest zdefiniowana i 
zalecana w specyfikacji. 

 

Suma 
kontrolna Prawda lub fałsz Jeżeli jest ustawiona na prawdę, to uaktywnia kończące 

słowa kodowe sumy kontrolnej. 

93 

Kod 93 był wynaleziony w 1982 r. przez INTERMEC w celu 
osiągnięcia lepszych gęstości informacji (w porównaniu z 
kodem 39). Możliwa jest konkatenacja kodów (jeżeli 
pierwszy zakodowany znak jest spacją, skaner łączy 
kolejne kody kreskowe). 

Standardowy Koduje 43 znaki: A-Z, 0-9, spację i -.$/+%. 
 

Podtyp 
Rozszerzony 

Oparty na kodzie 93, ale koduje pełen zestaw znaków ASCII. 
Jeden z czterech dostępnych znaków kontrolnych służy do 
przesuwania w tabeli znaków ASCII. 

Australian Post 
Ten kod kreskowy jest stosowany przez pocztę australijską 
do znakowania przesyłek. Dostępne są specjalne warianty 
kodu do przeadresowywania, odpowiedzi itd. 

Klient 

Wysokość kodu kreskowego wynosi od 4,2 mm do 5,8 mm. 
Szerokość modułu powinna być regulowana do 0,47 mm 
Wyświetlany jest zwykły nieczytelny tekst. Długość będzie 
zależeć od zastosowania dodatkowych kresek (warianty 
kodu Klient 2 i Klient 3). 

Klient 2 

Jest to taki sam kod kreskowy co standardowy Klient poczty 
australijskiej, ale z 5 dodatkowymi znakami na specyficzne 
dane klienta. Pierwsze 8 znaków musi być cyframi. Ten 
symbolizm jest także nazywany Australia Post 52-CUST (z 
powodu jego 52 kresek). 

Klient 3 

Jest to taki sam kod kreskowy co standardowy Klient poczty 
australijskiej, ale z 10 dodatkowymi znakami na specyficzne 
dane klienta. Pierwsze 8 znaków musi być cyframi. Ten 
symbolizm jest także nazywany Australia Post 67-CUST (z 
powodu jego 67 kresek). 

Przeadresowanie Jeżeli kod jest wybrany, to może zawierać do 8 cyfr 
Odpowiedź 
opłacona Jeżeli kod jest wybrany, to może zawierać do 8 cyfr 

 

Podtyp 

Trasowanie Jeżeli kod jest wybrany, to może zawierać do 8 cyfr 
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 Aztec Code 

Aztec Code może kodować od małych do dużych ilości danych z 
wybranymi przez użytkownika procentami korekcji błędów. Wielkość 
symbolu dostosowuje się automatycznie, w zależności od ilości 
danych wejściowych. Dane wejściowe są zawsze analizowane, a 
odpowiedni tryb kodowania jest wybierany automatycznie. 
Przełączanie trybu odbywa się według potrzeb, żeby dostarczyć 
najsprawniejsze kodowanie. 

 Brazilian CEPNet / brazylijski 
kod pocztowy 

Ten kod jest stosowany przez pocztę brazylijską. Kodowany jest 8-
cyfrowy kod pocztowy. Cyfra kontrolna jest obliczana 
automatycznie. Nie można jej określić w danych wejściowych. 
Wysokość kodu kreskowego powinna być wyregulowana na 3,2 
mm, a szerokość modułu na 0,423 mm; zwykle nie jest wyświetlany 
jawny tekst. Kodowanie jest oparte na amerykańskich kodach 
pocztowych. 

 Codabar 

Znaki „A”, „B”, „C” i „D” są używane tylko jako znaki start lub stop. 
Kod kreskowy stosuje 2 szerokości elementów i 4 różne znaki 
start/stop (A, B, C i D). Te znaki start/stop można wykorzystać dla 
dodatkowych informacji - np. "B1234B". Proporcja druku powinna 
być w następującym zakresie: 1:2 -1:3 (Pr >= 2.25:1). Ponieważ 
symbolizm jest „samokorekcyjny”, nie ma ustalonej metody 
sumy kontrolnej. 

 Codablock F 

Jest to w rzeczywistości symbolizm „piętrowego” kodu 128. 
Jest oparty na kodzie 128 - każdy rząd jest pojedynczym 
symbolem kodu 128 rozszerzonym za pomocą informacji 
wskaźnika rzędu i dodatkowych cyfr kontrolnych. 
Współpracuje ze wskaźnikiem formatu UCC/EAN/GS1. 

 Kod 11 

Ten symbolizm jest używany głównie w telekomunikacji do 
znakowania sprzętu i komponentów. Był wynaleziony w 1977 r. 
przez INTERMEC. Jest podobny do kodu 2 of 5 Matrix. Symbolizm 
nie jst samokorekcyjny, dlatego zalecane są 2 cyfry kontrolne. Kod 
11 jest kodem o dużej gęstości, ale wymaga także urządzenia 
wyjściowego o dużej gęstości zapisu (głównie z powodu 
wykorzystywanej proporcji druku). 

 Kod 32 

Jest stosowany przez włoski przemysł farmaceutyczny. Kod 
jest nazywany również Italian Pharmacode. Liczba kodu 32 
składająca się z 9 cyfr jest przekształcana na równoważny 
kod kreskowy kodu 39 składający się z 6 znaków. Tekst 
czytelny dla ludzi jest poprzedzony literą „A”, która nie jest 
kodowana. 

 Kod DAFT  
Kod DAFT nie jest symbolizmem. Jest to technika 
generowania dowolnych kodów pocztowych (jak na przykład 
australijskie kody pocztowe czy kod Royal Mail 4 State). 

Deutsche Post Ten symbolizm jest stosowany przez pocztę niemiecką. 

Leitcode 
Jest to w zasadzie kod 2 of 5 Interleaved ulepszony za 
pomocą specjalnego obliczania cyfry kontrolnej. Służy do 
kodowania kodu pocztowego, ulicy i numeru przesyłki.  

Podtyp 

Identcode Jest to w zasadzie kod 2 of 5 Interleaved ulepszony za 
pomocą specjalnego obliczania cyfry kontrolnej. 

 Dotcode 

DotCode jest to symbolizm kodu 2D dot przeznaczony do tego, żeby 
był niezawodnie czytelny po wydrukowaniu przy użyciu szybkiej 
technologii mozaikowej, atramentowej lub laserowej. Tryby 
kodowania DotCode są oparte na kodowaniu danych kodu 128 (z 
trybami A, B i C), rozszerzonym przez tzw. tryb dwójkowy. 
Domyślną interpretacją dla danych DotCode jest ECI 000003 
przedstawiający zestaw znaków Latin-I. Symbolizm DotCode nie ma 
bezwzględnych granic pojemności, ale zalecana jest maksymalna 
wielkość symbolu 124x124 punktów. 
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Auto Discriminate 
Jeżeli dane zaczynają się 2 cyframi, to kod kreskowy ma 
format GS1, w przeciwnym razie stosowany jest Generic 
Format (format ogólny) 

Generic Format 
Dane kodu kreskowego nie spełniają warunków jakiegoś 
specjalnego formatu; jeżeli dane zaczynają się 2 cyframi, to 
wstawiany jest FNC1 

UCC/EAN/GS1 Dane wewnętrzne muszą zaczynać się 2 cyframi i muszą 
stosować się do formatu tzw. identyfikatora aplikacji 

Industry Specyficzny kod przemysłowy, który dodaje FNC1 na 2. 
pozycji 

Macro 05 Dane są poprzedzone przez “[)>” + RS + “05” + GS i 
zakończone przez RS + EOT 

Macro 06 Dane są poprzedzone przez “[)>” + RS + “06” + GS i 
zakończone przez RS + EOT 

Macro 12 Dane są poprzedzone przez “[)>” + RS + “12” + GS i 
zakończone przez RS + EOT 

Custom Macro 
Dane są poprzedzone przez “[)>” + RS i zakończone przez 
RS + EOT; reszta specyfikatora formatu musi być 
zakodowana przez użytkownika 

 Podtyp 

Reader 
Programming  

Dane kodu kreskowego służą do programowania czytnika 
kodu kreskowego 

 DPD 
Kod DPD jest stosowany przez Deutscher Paket Dienst. 
Jest oparty na kodzie 128 i jest ograniczony do 28 
zakodowanych znaków. Zakodowane dane i tekst czytelny 
dla ludzi różnią się nieco. 

EAN 

Liniowy kod kreskowy o wielu grubościach. Jest to samokorekcyjny 
kod numeryczny. 
Ten symbolizm jest zastrzeżony dla europejskiego kodu 
kreskowego (EAN). 
Numer jest utrzymywany przez EAN i koduje producenta i produkt. 
Cyfra kontrolna jest obliczana automatycznie, jeżeli nie jest 
określona w danych wejściowych (tzn. jeżeli zastosowano tylko 7 
cyfr w celu stworzenia kodu). 

8 Jeżeli kod jest wybrany, to może zawierać do 8 cyfr. 
Służy do znakowania małych artykułów o ograniczonej przestrzeni. 

8 + 2 

Ten symbolizm rozszerza EAN-8 o 2 dodatkowe cyfry, które 
są stosowane głównie do kodowania ceny lub wagi. 
Ten symbolizm jest także stosowany do kodowania 
kreskowego broszur lub gazet. W tym przypadku jest 
kodowany 2(3)-cyfrowy kod kraju i 4(5)-cyfrowy kod artykułu. 

8 + 5 Ten symbolizm rozszerza EAN-8 o 5 dodatkowych cyfr, które 
są stosowane głównie do kodowania ceny lub wagi. 

13 Jeżeli kod jest wybrany, to może zawierać do 13 cyfr. 
13 + 2 Ten symbolizm rozszerza EAN-13 o 2 dodatkowe cyfry. 
13 + 5 Ten symbolizm rozszerza EAN-13 o 5 dodatkowych cyfr. 

 

Podtyp 

128 

Kod EAN-128 jest oparty na kodzie 128. Ma znak FNC1 na 1. 
pozycji (za kodem start). To pozwala skanerom i oprogramowaniu 
do przetwarzania danych odróżnić EAN-128 od innych 
symbolizmów. 
Kod EAN-128 jest w szerokim użyciu (handel detaliczny, logistyka, 
żywność i napoje, itd.). Służy do znakowania jednostek 
transportowych w łańcuchach dostaw. Oprócz numerów artykułów 
koduje ilości, ciężary, ceny, daty i inne informacje w strukturalny 
sposób. Jest to wspierane przez zastosowanie tzw. identyfikatorów 
aplikacji (AIs) - patrz rozdział 5. 
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 Ciąg 
tekstowy Prawda lub fałsz Jeżeli jest ustawiony na prawdę, to wyświetla i znakuje ciąg 

czytelny dla ludzi 

 Flattermarken Jest to specjalny „ kod kresowy” stosowany do 
rozpoznawania prawidłowej kolejności stron w drukarniach. 

GS1 DataBar (RSS-14) 

Kod GS1 DataBar służy do kodowania GTIN (Globalny Numer 
Jednostki Handlowej) z identyfikatorem aplikacji (AI) “01“. GTIN 
składa się ze wskaźnika opakowania (0..9), po którym następuje 12-
cyfrowy numer (wzięty z systemu numeracji towarów EAN-13), po 
którym następuje cyfra kontrolna Cyfra kontrolna na 14. pozycji 
jest obliczana automatycznie, jeżeli nie jest przewidziana w 
danych wejściowych. 

Standardowy 

Wysokość symbolu powinna wynosić co najmniej 33X, żeby 
współpracować z wielokierunkowym skanowaniem (X = 
szerokość modułu). Oprogramowanie TEC-IT automatycznie 
poprzedza dane kodu kreskowego przedrostkiem AI “01” - 
nie dostarczaj AI 01 ze swoimi danymi wejściowymi. 

Truncated 
Ten symbolizm jest podobny do GS1 DataBar, ale wysokość 
powinna wynosić co najmniej 13X. Skanowanie 
wielokierunkowe może nie być możliwe. 

Omni Directional Ten symbolizm jest podobny do GS1 DataBar Stacked i 
współpracuje ze skanowaniem wielokierunkowym. 

 

Podtyp 

Piętrowe 

Ten symbolizm jest podobny do GS1 DataBar, ale jest 
rozdzielony na dwa rzędy, żeby symbol był mniejszy. Jest 
stosowany do opakowań farmaceutycznych. Skanowanie 
wielokierunkowe nie jest możliwe. 

 GS1 DataBar Limited 
Ten symbolizm jest podobny do GS1 DataBar, ale jest 
mniejszy i ogranicza się do wskaźnika opakowania (pierwsza 
cyfra) 0 lub 1. 

 GS1 DataBar Expanded 

Jest to symbolizm o zmiennej długości. Koduje do 74 znaków 
numerycznych lub 41 znaków alfabetycznych. Dane powinny 
być kodowane za pomocą identyfikatorów aplikacji (AIs). 
Skanowanie wielokierunkowe jest możliwe. 

 Kod Han Xin  
Kod Han Xin Code jest to symbolizm matrycowy 2D, który 
służy do kodowania dużych ilości danych i zapewnia 
specjalne wsparcie dla chińskich znaków (zestaw znaków 
GB18030) 

 HIBC 

Kody kreskowe HIBC są powszechnie stosowane przez przemysł 
sanitarny. Standardy HIBC nie opisują właściwie unikalnych 
symbolizmów, ale rodzinę struktur danych. Te struktury danych 
mogą być przedstawione przez kilka symbolizmów. 
Są dwie kategorie HIBC: 

 Kod identyfikacji etykiety (LIC) - określony przez standard 
etykietowania dostawcy 

 Standard aplikacji zaopatrzeniowca (PAS) 

 ISBN 

ISBN jest skrótem międzynarodowego znormalizowanego 
numeru książki. Wykorzystuje symbolizm EAN-13 i można go 
opcjonalnie rozszerzyć o 5 dodatkowych cyfr. Rozszerzenie 
jest stosowane dla dodatkowych informacji cenowych. Więcej 
informacji, patrz http://www.isbn.org 

 ISMN 

ISMN oznacza międzynarodowy numer drukowanych 
materiałów muzycznych. ISMN jest znormalizowanym kodem 
międzynarodowym, który identyfikuje drukowane materiały 
muzyczne. 
ISMN jest poprzedzony cyframi 9790. Cyfra kontrolna ISMN 
(=EAN-13) jest obliczana i dołączana automatycznie! 
Więcej informacji, patrz http://www.ismn-international.org/. 
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 ISSN 

ISMN oznacza międzynarodowy znormalizowany numer 
wydawnictwa ciągłego. ISSN jest znormalizowanym 
kodem międzynarodowym, który identyfikuje dowolną 
publikację seryjną niezależnie od kraju jej pochodzenia, 
języka czy alfabetu, czy też częstotliwości, nośnika itd. 

ISSN jest poprzedzony cyframi 977. Cyfra kontrolna 8-
cyfrowego kodu ISSN (ostatnia z 8 cyfr) musi być 
pominięta! Na końcu jest dodawany dwucyfrowy kod 
ceny, prawie zawsze „00”. Na koniec dodawana jest 
cyfra kontrolna EAN-13. 

Opcjonalnie można dołączyć numer wydania jako 2-
cyfrowe rozszerzenie. Więcej informacji, patrz 
http://www.issn.org 

 Italian Postal 
Jest to włoski kod pocztowy 2 of 5 oparty na kodzie 2 of 5 
Interleaved, ale jest on ograniczony do 12 cyfr (11 cyfr 
użytecznych + cyfra kontrolna 1 modulo 10). 

 Japanese Postal 

Ten kod jest stosowany przez japoński system pocztowy. 
Można zakodować 7 cyfr, po których następuje numer 
bloku i ulicy (duże znaki alfanumeryczne). Na życzenie 
można włączyć specjalny tryb upakowania japońskich 
znaków (parametr formatu „J”). Ten symbolizm kodu 
kreskowego współpracuje z dwiema metodami 
dostarczania danych kodu kreskowego (z wydzielaniem 
danych z pola B japońskiego adresu i bez) 

 KIX Ten kod jest stosowany przez holenderski system 
pocztowy 

 Korean Postal Authority 
Ten kod jest stosowany przez koreański system 
pocztowy. Zakodowanych jest 6 cyfr kodu pocztowego i 1 
cyfra kontrolna 

MaxiCode 

MaxiCode jest stosowany (i był wynaleziony) przez 
UPS®. 

MaxiCode przedstawia dane przez rysowanie pozycji 
heksagonalnych, które są ułożone wokół kołowego 
środka (tzw. „wolego oka"). Można nastawiać różne tryby 
kodowania w celu włączenia informacji pocztowych 
(SCM): Trybami UPS są Mode 2 (operator amerykański) i 
Mode 3 (operator międzynarodowy).  

Wielkość drukowania jest zwykle ustawiona na stałą 
wartość. Jeżeli trzeba zmienić wielkość symbolu, należy 
nastawić własną szerokość modułu (domyślnie wynosi 
0,870 mm) 

Mode 4 - SEC / 
standardowa 
korekcja błędów 
Mode 5 - EEC = 
ulepszony E.C. 

Wewnętrzna struktura danych jest regulowana przez 
różne „tryby”. W celach standaryzacji, dane można 
kodować z dwoma różnymi poziomami korekcji błędów 

Mode 2 - SCM 
numeryczny 

 

Podtyp 

Mode 3 - SCM 
alfanumeryczny 

Tryby dla „strukturalnego komunikatu przewoźnika” 
(SCM) zostały zdefiniowane przez serwis transportu 
paczek UPS®. Jeżeli chcesz użyć MaxiCode dla UPS, 
skorzystaj z tych trybów SCM  
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 MicroPDF417 
Ten piętrowy symbolizm 2D służy do kodowania dużych ilości 
danych. Dane wejściowe są zawsze analizowane, a właściwy tryb 
kodowania  jest wybierany automatycznie. Przełączanie trybu odbywa 
się według potrzeb, żeby dostarczyć najsprawniejsze kodowanie. 

 MSI Kod MSI jest wariantem kodu Plessey. MSI wykorzystuje różne metody 
obliczania cyfry kontrolnej - lepiej wdrożone są 2 najczęściej stosowane. 

 NVE-18 

NVE oznacza “Nummer der Versandeinheit” (niemiecki termin dla liczby 
śledzącej). Ten kod wykorzystuje symbolizm EAN-128 z dodanym z 
przodu identyfikatorem aplikacji (AI) 00. AI “00” jest wstawiany 
automatycznie i nie może być włączony do danych wejściowych. Jest 
podobny do SSCC-18 

Pharmacode Ten kod jest wynaleziony przez Laetus®. Jest stosowany w 
farmaceutyce 

One-Track 

Dane dla kresek / spacji są kodowane bezpośrednio we 
właściwości Tekst:  

 „0” jest stosowane dla wąskiej kreski (szerokość tych 
kresek zwiększa się po zmianie koloru, zgodnie z 
proporcją 1C) 

 „1” jest stosowane dla szerokiej kreski (szerokość tych 
kresek zwiększa się po zmianie koloru, zgodnie z 
proporcją 2C) 

 „b” jest stosowane dla wąskiej kreski 

 „c” jest stosowane dla szerokiej kreski 

 
Podtyp 

Two-Track 

Pharmacode przydziela wartości numeryczne do kresek. Jest 
stosowany przy pakowaniu lekarstw w farmaceutyce; do małych 
etykiet. Zwykle Pharmacode jest drukowany bez tekstu 
czytelnego dla ludzi. 

Placet Ten kod został opracowany dla usług pocztowych w Stanach 
Zjednoczonych 

12 Jest to wariant 3-of-5 kodu kreskowego Postnet.  
Podtyp 

14 Jest to wariant 3-of-5 kodu kreskowego Postnet. 

 Plessey 

Kod Plessey jest stosowany głównie w bibliotekach. Jest to kod z 
modulacją szerokości impulsu, który został opracowany przez Plessey 
Company Limited w Wielkiej Brytanii. Podstawowa zasada kodowania w 
kodzie Plessey była wykorzystana przez firmę MSE Data Corporation do 
skonstruowania jej kodu kreskowego MSI. Cyfra kontrolna jest obliczana 
za pomocą algorytmu wielomianowego CRC i jest zawsze częścią 
symbolizmu. 

 PZN Germany 
PZN wykorzystuje kod 39 jako symbolizm bazowy. Stosuje specjalną 
cyfrę kontrolną, a tekst czytelny dla ludzi zawsze zawiera przedrostek 
„PZN-” (który nie jest kodowany w danych kodu kreskowego) 

 Royal Mail 

Ten kod jest kodem z modulacją wysokości stosującym 4 różne pionowe 
kreski. Jest stosowany w aplikacjach mailingu masowego (Cleanmail, 
Mailsort) królewskiej poczty brytyjskiej, w Wielkiej Brytanii i Singapurze 
(nazywany również kodem kreskowym SinPost). Kodowane są kody 
pocztowe. 

 SSCC 

SSCC-18 służy do kodowania kodu seryjnych kontenerów 
wysyłkowych. Służy do jednoznacznej identyfikacji artykułów 
handlowych na całym świecie. SSCC-18 jest oparty na 
symbolizmie GS1-128 z identyfikatorem aplikacji (AI) 00. Cyfra 
kontrolna jest kodowana automatycznie, jeżeli dla danych 
wejściowych stosuje się 17 cyfr. 

 Telepen 
Telepen może kodować tylko pary znaków. Para musi składać się 
z 2 cyfr lub jednej cyfry i litery „X” 
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USPS Usługi pocztowe Stanów Zjednoczonych 

Intelligent 
Mail® 

Ten symbolizm jest także znany jako 

 OneCode 4CB 

 USPS 4CB 

 4-CB 

 Kod kreskowy 4-State Customer  

 Kod kreskowy USPS OneCode Solution. 

Intelligent 
Mail® 
Package 

Dane kodu kreskowego składają się z informacji o trasowaniu i 
informacji o śledzeniu. Informacje o śledzeniu są opcjonalne. Nie 
są drukowane w tekście czytelnym dla ludzi i składają się z” 

 Identyfikatora aplikacji kodu pocztowego (AI): 
zawsze 420 

 Kodu pocztowego przeznaczenia (5 lub 9 cyfr) 

Postnet 5 

Kodowany jest 5-cyfrowy kod pocztowy. Cyfra kontrolna jest obliczana 
automatycznie. Nie może być określona w danych wejściowych. 
Wysokość kodu kreskowego powinna być wyregulowana na 3,2 mm, a 
szerokość modułu na 0,423 mm; zwykle nie jest wyświetlany jawny tekst. 
Nowszy USPS Intelligent Mail®Barcode lub IM® Barcode (kod kreskowy 
4-State Customer) obejmuje dodatkowo 20-cyfrowy kod śledzący. 

Postnet 6 
Taki sam jak Postnet 5, ale cyfrę kontrolną można określić 
dowolnie (6. cyfra). Stosować tylko wtedy, gdy cyfra kontrolna 
jest już częścią danych wejściowych. 

Postnet 9 

Kodowany jest 5-cyfrowy kod pocztowy i 4 dodatkowe cyfry. 
Cyfra kontrolna jest obliczana automatycznie; nie może być 
określona w danych wejściowych. 
Wysokość kodu kreskowego powinna być wyregulowana na 3,2 
mm, a szerokość modułu na 0,423 mm; zwykle nie jest 
wyświetlany jawny tekst. 
Nowszy USPS Intelligent Mail®Barcode lub IM® Barcode (kod 
kreskowy 4-State Customer) obejmuje dodatkowo 20-cyfrowy kod 
śledzący. 

Postnet 10 

Kodowany jest 5-cyfrowy kod pocztowy i 4 dodatkowe cyfry. 
Cyfra kontrolna jest obliczana automatycznie; nie może być 
określona w danych wejściowych. 
Wysokość kodu kreskowego powinna być wyregulowana na 3,2 
mm, a szerokość modułu na 0,423 mm; zwykle nie jest 
wyświetlany jawny tekst. 
Nowszy USPS Intelligent Mail®Barcode lub IM® Barcode (kod 
kreskowy 4-State Customer) obejmuje dodatkowo 20-cyfrowy kod 
śledzący. 

Postnet 11 

Zakodowanych jest 5 cyfr kodu pocztowego i od 4 do 9 
dodatkowych cyfr. Cyfra kontrolna jest obliczana automatycznie. 
Nie może być określona w danych wejściowych. 
Wysokość kodu kreskowego powinna być wyregulowana na 3,2 
mm, a szerokość modułu na 0,423 mm; zwykle nie jest 
wyświetlany jawny tekst. 
Nowszy USPS Intelligent Mail®Barcode lub IM® Barcode (kod 
kreskowy 4-State Customer) obejmuje dodatkowo 20-cyfrowy kod 
śledzący. 

 
Podtyp 

Postnet 12 
Taki sam jak Postnet 11, ale cyfrę kontrolną można określić 
dowolnie (12. cyfra). Stosować tylko wtedy, gdy cyfra kontrolna 
jest już częścią danych wejściowych. 
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 VIN/FIN 

Kod VIN/FIN służy do identyfikacji pojazdów. Jest oparty na kodzie 39, ale nie 
zawiera znaków start i stop. Zestaw ważnych znaków zawoera cyfry i duże litery. 
Litery “I”, “O” i “Q” są niedozwolone, ponieważ mogłyby łatwo mylić się z cyframi 
“0” i “1”. 
Kod VIN/FIN jest wdrażany inaczej w Europie i Ameryce Północnej. Oba rodzaje 
są kompatybilne, ale wersja północnoamerykańska jest zdefiniowana bardziej 
rygorystycznie. Więc metoda obliczania cyfry kontrolnej jest ważna tylko dla 
północnoamerykańskiej implementacji kodu. 

UPC Liniowy kod kreskowy o wielu grubościach. Jest to samokorekcyjny kod 
numeryczny. Wymagana suma kontrolna. 

A Jeżeli kod jest wybrany, to może zawierać do 10 cyfr 
Podtyp 

E Jeżeli kod jest wybrany, to może zawierać do 6 cyfr 
 

Ciąg tekstowy Prawda lub fałsz Jeżeli jest ustawiony na prawdę, to wyświetla i znakuje ciąg czytelny dla ludzi. 

Datamatrix 
Dwuwymiarowy kod matrycowy składający się z czarnych i białych kwadratowych 
modułów ułożonych we wzór, albo kwadratowy, albo prostokątny. Może kodować 
do 3116 znaków z całego zestawu znaków ASCII (z rozszerzeniami). 

t mode Standardowy format matrycy danych bez specjalnego nagłówka. 

UCC/EAN/GS1 
mode 

Specjalny format zdefiniowany przez UCC i EAN/GS1 do kodowania 
identyfikatorów aplikacji. Ten format dodaje znak funkcji FNC1 na 1. pozycji w 
symbolu. 

Industry mode współpraacuje ze specyficznymi formatami przemysłowymi (dodaje FNC1 na 2. 
pozycji) 

Macro 05 mode [)>Rs05Gs jest kodowany na początku kodu; RS + EOT jest dodawane jako 
ostatnie 

Macro 06 mode [)>Rs05Gs jest kodowany na początku kodu; RS + EOT jest dodawane jako 
ostatnie 

Reader 
Programming  Uaktywnia tryb programowania czytnika. 

Podtyp 

DP Postmatrix Specjalny format zdefiniowany przez „Deutsche Post". 

Wielkość 
Ta właściwość umożliwia ustawianie wielkości matrycy danych, żeby pasowała 
do wymiaru kodu. (Bliższe informacje, patrz Ustawianie zdolności do 
odzyskiwania danych). 

Square Best Fit 
(najlepsze 
dopasowanie 
kwadratu) 

Ustawia mniejszy wymiar kwadratu, zgodnie z informacją, która ma być 
zakodowana.   

Rectangular 
Best Fit 
(najlepsze 
dopasowanie 
prostokątne) 

Ustawia mniejszy wymiar prostokątny, zgodnie z informacją, która ma być 
zakodowana. 

 

 

10x10 do 48x16 Umożliwia określenie wymiaru w zakresie od 10x10 do 48x48 modułów dla 
wielkości kwadratowej i od 18x8 do 48x16 modułów dla wielkości prostokątnej. 

QRcode Kod QR (szybka odpowiedź) jest dwuwymiarowym kodem matrycowym. Duża 
pojemność, mała wielkość wydruku, duża szybkość skanowania. 

Wielkość 
Ta właściwość umożliwia ustawienie wielkości kodu QR do celów 
nadmiarowości. Każda wersja ma inną liczbę modułów. (Bliższe informacje, 
patrz Ustawianie zdolności do odzyskiwania danych). 

Best Fit 
(najlepsze 
dopasowanie) 

Ustawia mniejszy wymiar (21x21) dla informacji, która ma być zakodowana. 
 

Wersja 1 do 40 Umożliwia określenie wymiaru z zakresu od 21x21 do 177x177 modułów. 

Poziom błędu 

Ta właściwość umożliwia ustawienie dla kodu takiego poziomu korekcji błędów, 
który umożliwia odzyskiwanie danych, jeżeli kod jest brudny lub uszkodzony. 
Każdemu poziomowi odpowiada wyższa nadmiarowość danych i inna szybkość 
odzyskiwania. (Domyślnie: M) 

Poziom L Można odzyskać 7% słów kodowych. 
Poziom M Można odzyskać 15% słów kodowych. 
Poziom Q Można odzyskać 25% słów kodowych. 

 

 

Poziom H Można odzyskać 30% słów kodowych. 
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 PDF 417 

Przenośny plik danych 417 (PDF417) jest to wielorzędowy, 
piętrowy, liniowy kod kreskowy o zmiennej długości. Ma 
dużą pojemność danych i dużą gęstość, i jest szeroko 
stosowany w przemyśle motoryzacyjnym. 
Możliwa jest gęstość zapisu danych do 900 znaków na cal 
kwadratowy. 
Dane wejściowe są zawsze analizowane, a właściwy tryb 
kodowania  jest wybierany automatycznie. 
Przełączanie trybu odbywa się według potrzeb, żeby 
dostarczyć najsprawniejsze kodowanie. 

Standardowy Ma kreski kontrolne po lewej i prawej stronie. Podtyp 
Truncated Opuszcza część prawostronną, żeby zaoszczędzić miejsce.  

Wielkość od 1 do 30 kolumn Ustawia liczbę kolumn danych dla symbolu. 

Poziom błędu 

Ta właściwość umożliwia ustawienie dla kodu takiego 
poziomu korekcji błędów, który umożliwia odzyskiwanie 
danych, jeżeli kod jest brudny lub uszkodzony. Każdemu 
poziomowi odpowiada wyższa nadmiarowość danych i inna 
szybkość odzyskiwania. PDF 417 stosuje korekcję błędów 
Red Solomon. (Domyślnie: Recommended [zalecane]). 
Bliższe informacje, patrz Ustawianie poziomu korekcji 
błędów). 

Recommended 
[zalecane]). 

Ta wartość zmienia się w zależności od specyfikacji i 
wielkości kodu. 

 

 
od 0 do 8 Umożliwia określenie poziomu z zakresu od 0 do 8. 

Zalecany poziom minimalny wynosi 2. 
RSS 14(GS1 DataBar) 

Standardowy 

Piętrowy, liniowy kod kreskowy. RSS 14 (zredukowana 
symbolika przestrzeni) jest symboliką liniową, która ułatwia 
skanowanie wielokierunkowe. Koduje 14 cyfr danych 
numerycznych. 

Wielokierunkowy Umożliwia drukowanie w dwóch rzędach pełnej wysokości 
RSS-14 (patrz wyżej). 

Ścięty Wysokość jest zredukowana do minimum 13X. 

Podtyp 

Piętrowy Jest to dwurzędowy format RSS-14 Truncated. 

RSS Limited(GS1 DataBar) 
Piętrowy, liniowy kod kreskowy. Koduje 14-cyfrową 
identyfikację pozycji EAN.UCC z cyframi wskaźnika 
wynoszącymi 0 lub 1 w małym symbolu 

RSS Expanded(GS1 DataBar) 
Piętrowy, liniowy kod kreskowy. Może mieć do 74 znaków 
danych numerycznych lub 41 alfanumerycznych w jednym 
rzędzie 

 

Wielkość od 1 do 11 linii Ustawia liczbę linii dla symbolu. 

MicroQRcode 

Dwuwymiarowy kod kreskowy. Jest to mniejsza wersja 
standardu kodu QR, która pasuje do aplikacji wymagających 
mniejszej przestrzeni i zastosowania mniejszych ilości 
danych. 

Wielkość 

Ta właściwość umożliwia ustawienie wielkości kodu 
MicroQR do celów nadmiarowości.  Każda wersja ma inną 
liczbę modułów i większą nadmiarowość danych. 
(Domyślnie: M2) Bliższe informacje, patrz Ustawianie 
zdolności do odzyskiwania danych. 

Best Fit (najlepsze 
dopasowanie) 

Ustawia mniejszy wymiar (11x11) dla informacji, która ma 
być zakodowana. 

 

 
Wersja od M1 do 
M4 

Umożliwia określenie wymiaru z zakresu od 11x11 do 17x17 
modułów. 
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Poziom błędu 

Ta właściwość umożliwia ustawienie dla kodu takiego 
poziomu korekcji błędów, który umożliwia odzyskiwanie 
danych, jeżeli kod jest brudny lub uszkodzony. 
Każdemu poziomowi odpowiada wyższa nadmiarowość 
danych i inna szybkość odzyskiwania. (Domyślnie: M). 

O Tylko dla M1. Tylko wykrywanie błędów. 
L Można odzyskać 15% słów kodowych. 
M Można odzyskać 25% słów kodowych. 

 

 

Q Można odzyskać 30% słów kodowych. 

Szerokość Ustawa szerokość modułu (w liniowym kodzie kreskowym jest to 
najmniejsza grubość; w kodzie 2D jest najmniejszym kwadratem). Moduł 

Height 
(wysokość) 

Ustawia wysokość modułu dla liniowych kodów kreskowych. (Niedostępny 
dla Datamatrix, QRcode i MicroQRcode). 

Stosunek 
czerni do 
bieli 

Umożliwia regulację proporcji między białymi a czarnymi elementami, kiedy 
znakuje się bardzo małe elementy. W tym przypadku laser punktowy 
mógłby wpływać na proporcje wymiarową. Wartością domyślną jest 100%. 
Bliższe informacje, patrz Równoważenie stosunku czerni do bieli. 

Proporcja 
druku 

Dostępna tylko dla kodów 2/5 i 3/9. W kodach o dwóch grubościach jest to 
stosunek grubości szerokiego elementu do grubości wąskiego elementu. 
Im wyższa proporcja, tym większy symbol, co wpływa na zdolności skanera 
do odczytu. Domyślnie: 200. 

Odwrotność Prawda lub fałsz 

Jeżeli jest ustawiony na prawdę, to uaktywnia 
grawerowanie kodu kreskowego odwrotnie. Odwrotne 
grawerowanie kodu kreskowego powinno być 
wykonywane tylko na tych materiałach, gdzie laser 
znakuje na biało lub czarno. Standard kodu 
kreskowego nie obejmuje kodowania odwrotnego. 

Cicha strefa 

Widoczna tylko wtedy, gdy właściwość Odwrotność jest ustawiona na 
prawdę. Obszar bez oznakowań, bezpośrednio poprzedzający znak start i 
następujący po znaku stop, jest nazywany cichą strefą. Cicha strefa 
pomaga skanerowi znaleźć przednią część kodu kreskowego, żeby mogło 
zacząć się odczytywanie. 

Zaawansowane 

Kodowanie 
bajtów 

Ta opcja umożliwia interpretację właściwości tekstu jako potoku bajtów; 
wszędzie gdzie tekst jest unikodem, tylko młodsze bajty są używane. 

Grupa Licznik umożliwia tworzenie zmiennego tekstu, który obejmuje licznik 
samoprzyrostowy (patrz Włączanie licznika samoprzyrostowego do ciągu tekstowego). 
Start Minimalna wartość dla licznika. 
Stop Maksymalna wartość dla licznika. 
Current 
(bieżąca) Bieżąca wartość licznika jaka pojawia się w ciągu. 

Step (krok) Wartość przyrostu (dodatnia lub ujemna). 
Cycles 
(cykle) 

Liczba razy jaką licznik będzie oznaczony zanim nastąpi przyrost o jeden 
krok. 

Licznik 

Digit (cyfra) Minimalna liczba cyfr, jaka będzie wyświetlana. 
Formatery są plikami źródłowymi, które są dostarczane z edytorem projektów. Te pliki można 
wykorzystywać jako biblioteki funkcji. Ich celem jest ułatwienie wykonawcom tworzenia własnych 
aplikacji. Na przykład, będąc integratorem, możesz potrzebować konkretnych funkcji, którymi 
dysponują te biblioteki. Formatery mają rozszerzenie .qs i są przechowywane w folderze 
...\Data\Formatters. 
Prawda lub fałsz Umożliwia lub uniemożliwia użycie własnego pliku formatera 

Własne 
formatery 

Script 
(skrypt) 

Widoczny tylko wtedy, gdy właściwość Własne formatery jest ustawiona na 
True. Zastosować, żeby wybrać  własne formatery z listy dostępnych 
plików. 
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Stosowanie tablic 

 

 

Obiekt tablicowy służy do powtarzalnego znakowania obiektu (lub grupy obiektów) w różnych położeniach, 
umożliwiając dostosowanie układu i rozmieszczenia elementów. 

Obiekty graficzne są włączone do komórek, które można dostosować, żeby pasowały do potrzeb 
użytkownika. 

Obiekt tablicowy jest szczególnie dopasowany do znakowania układów scalonych (IC). 

Przy użyciu przycisku paska narzędziowego Array (tablica) lub menu Actions (działania) edytor laserowy 
umożliwia tworzenie tablicy. 

Można użyć myszy do zmiany wielkości i przesunięcia tablicy lub w celu wyboru / odwołania wyboru 
komórek; można użyć okna Properties (właściwości), żeby ustawić wymiary i liczbę komórek oraz 
zdefiniować ich zawartość, a także ustawić nieprostoliniowo lub zmienić odległość między komórkami. 

 

Wskazówki: 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości. 
Więcej informacji o operowaniu myszą, patrz Użycie myszy do wyboru obiektów i manipulowania 
nimi. 

Następujące sekcje opisują sposób pracy z tablicami: 

 Dodawanie tablicy 

 Ustawianie liczby komórek 

 Zmiana wielkości tablic i komórek 

 Zmiana odległości między komórkami 

 ../../../../AppData/Local/Microsoft/Windows/Dati applicazioni/Documents and 
Settings/daniele.patrignani/Dati applicazioni/Dati 
applicazioni/Microsoft/Lighter/Misalignment.html - wp1094717Cells misalignment 

 Wybór / odwołanie wyboru jednej lub kilku komórek 

 Tworzenie zawartości poszczególnych komórek 

 Właściwości tablic i komórek 
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Dodawanie tablicy 

Aby dodać tablicę: 
1. Utworzyć dokument płaski, żeby umożliwić wstawienie obiektu, patrz Tworzenie dokumentu do 

grawerowania płaskiego). 

2. Wykonać jedną z następujących czynności: 

o Na pionowym pasku narzędziowym kliknąć w przycisk   (wstaw obiekty), a potem, na 

poziomym pasku narzędziowym, który się wyświetla, kliknąć w    (tablica). 
o Z paska menu edytora laserowego wybrać Actions > Insert > Array (działania > wstaw > 

tablica). 

3. Tablica jest wyświetlana w obszarze roboczym. Domyślnie wybrana jest cała tablica, która zawiera 9 
komórek. Użyć okna Properties (właściwości), żeby ustawić parametry tablicy i komórek; użyć 
myszy do zmiany wielkości lub przesunięcia tablicy, a także do wyboru poszczególnych komórek. 
Więcej informacji, patrz lista tematów poniżej. 

 

Wskazówka: 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości. 

Ustawianie liczby komórek 

Właściwości Columns (kolumny) i Rows (rzędy) obiektu Tablica umożliwiają ustawienie liczby rzędów i 
kolumn, które tworzą tablicę, żeby uzyskać liczbę komórek. 

Aby ustawić liczbę komórek, które tworzą tablicę: 
1. Kliknąć w tablicę, żeby włączyć okno Properties (właściwości). 

2. Pod Array (tablica) wybrać ramki obok właściwości Columns (kolumny) i/lub Rows (rzędy) i 
wprowadzić żądaną liczbę. 

3. Tablica zmieni się odpowiednio. Być może trzeba będzie zmienić wielkość zarówno tablicy jak i 
komórek, żeby pasowały do nowych ustawień. (Patrz Zmiana wielkości tablic lub komórek). 

Zmiana wielkości tablic i komórek 

Właściwości Dimensions (wymiary) i Cells size (wielkość komórek) umożliwia zmianę wielkości obiektów 
według potrzeb. 

 

Wskazówka: 
W celu uzyskania informacji o innych ogólnych właściwościach tablicy należy wybrać 
tytuł Geometry (geometria) i nacisnąć F1, żeby wyświetlić stosowny temat Pomocy. 

Aby zmienić wielkość obiektów: 
1. Kliknąć w tablicę, żeby włączyć okno Properties (właściwości). 

2. Aby zmienić wielkość tablicy: Pod Geometry > Dimensions (geometria > wymiary) ustawić 
pożądane właściwości Width (szerokość) i Height (wysokość). (Można także użyć myszy: mając 
wybrany obiekt, przeciągnąć uchwyty, które go otaczają,  na żądaną pozycję.) 

3. Aby zmienić wielkość komórek taablicy: Pod Array > Cell size (tablica > wielkość komórki) ustawić 
pożądane właściwości Width (szerokość) i Height (wysokość). 
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Zmiana odległości między komórkami 
Właściwości Pitch (podziałka) i Extra Pitchs (podziałki specjalne) umożliwiają zwiększanie lub zmniejszanie 
odległości między rzędami, kolumnami, poszczególnymi komórkami i/lub grupami komórek. 

 
 Aby uaktywnić okno Properties (właściwości), kliknąć w obiekt tablicowy.. 

Aby zmienić odległość między rzędami i/lub kolumnami: 

1. Pod Array > Pitch (tablica > podziałka) ustawić następujące właściwości: 

o X - Ustawia odległość między kolumnami. 

o Y - Ustawia odległość między rzędami. 

Aby zmienić odległość między komórkami lub grupami komórek: 
Można pogrupować komórki i zdefiniować dodatkowe odległości między nimi, w poziomie i w pionie. 

1. Pod Array (tablica) wybrać właściwość Extra Pitchs (podziałki specjalne) i wprowadzić liczbę 
przypadków, tzn. liczbę dodatkowych odległości, które mają być utworzone. Właściwości, które 
umożliwiają ustawienie podziałek specjalnych są pokazane poniżej. 

2. Ustawić wartości właściwości jak następuje (patrz także przykład poniżej): 
o Grupa - Wprowadzić liczbę komórek, które mają być włączone do grupy, która będzie 

przesunięta. 
o Pierwsza - Wprowadzić numer pierwszej kolumny, do której ma być zastosowana podziałka 

specjalna. 
o Podziałka - Określić wielkość dodatkowej odległości. 
o Kierunek - Wybrać żądany kierunek: Kierunek Y doda odległość między rzędami, kierunek 

X doda odległość między kolumnami. 

Poniższy rysunek pokazuje jak wygląda tablica po ustawieniu właściwości jak następuje: 

 

3. Powtórzyć krok 2 dla innej podziałki specjalnej, którą chcemy dodać. 
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Nieprostoliniowość komórek 
Właściwości Interleave (przeplot) umożliwiają zmianę wyosiowania rzędów i/lub kolumn. 

Aby zmienić wyosiowanie komórek: 
1. Kliknąć w tablicę, żeby włączyć okno Properties (właściwości). 

2. Pod Array (tablica) wybrać właściwość Interleave > Offset (przeplot > przesunięcie) i wprowadzić 
pomiar nieprostoliniowości. 

3. Z rozwijanej w dół listy Direction (kierunek) wybrać żądany kierunek: 

o X - Ustawia nieprostoliniowość między rzędami. 

o Y - Ustawia nieprostoliniowość między kolumnami. 

Poniższy rysunek pokazuje jak wygląda tablica po ustawieniu właściwości jak następuje: 
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Wybór / odwołanie wyboru jednej lub kilku komórek 
Można operować na poszczególnych komórkach przez odblokowanie tablicy i wybranie żądanej komórki 
(komórek). 

Aby wybrać / odwołać wybór poszczególnych komórek: 

1. Wybrać tablicę, a potem kliknąć w uchwyt w kształcie pluskiewki  z lewej strony u góry. Uchwyt 
zmienia się na  i komórki w tablicy stają się odblokowane co umożliwia ich wybór: 

 

2. W celu wybrania jednej lub kilku komórek należy wykonać jedną z następujących czynności: 
o Kliknąć w jedną lub więcej komórek. (Można wybrać tyle komórek ile się chce). 
o Kliknąć prawym przyciskiem myszy, żeby wyświetlić menu, które umożliwia wybór / 

odwołanie wyboru wszystkich komórek albo odwrócenie wy6boru między komórkami 
wybranymi a odwołanymi. 

o Kliknąć w niebieski wskaźnik rzędów lub kolumn, żeby wybrać / odwołać wybór całego rzędu 
lub kolumny. 

3. Kiedy komórka jest wybrana i uaktywniona, jej kolor zmienia się na jasnożółty. (Aby odwołać wybór 
komórki, należy w nią kliknąć). 

4. Poza tym, w oknie Właściwości pod Array (tablica) jest wyświetlana nowa grupa Cells (komórki), 
która umożliwia: 

o uaktywnienie / dezaktywację jednej lub kilku komórek 
o zdefiniowanie własnych ustawień przesunięcia i obrotu 
o dołączenie dokumentu do komórki (patrz Tworzenie zawartości poszczególnych komórek). 

 
 Kiedy komórka jest nieaktywna, jej kolor zmienia się na jasnożółty. 

5. Kliknąć w uchwyt myszy  , żeby zablokować komórki i operować na całej tablicy. 

 

Wskazówka: 
Więcej informacji o operowaniu myszą, patrz Użycie myszy do wyboru obiektów i manipulowania 
nimi: 
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Tworzenie zawartości poszczególnych komórek 
Można wprowadzić dowolną zawartość do poszczególnych komórek, żeby stworzyć swój układ, a także 
zdefiniować własne ustawienia przesunięcia i obrót. Można stworzyć dokument z grafiką lub ciągami, a 
potem dołączyć dokument do komórki. 

Aby utworzyć zawartość komórki: 

1. Kliknąć w tablicę, a potem kliknąć w uchwyt w kształcie pluskiewki  z lewej strony u góry: 
2. Kliknąć, żeby wybrać żądaną komórkę (komórki). Kolor wybranej komórki (komórek) zmienia się na 

jasnożółty. Należy zwrócić uwagę, że wszystkie komórki nazywają się Plain 0. 
3. Można ustawić inny numer Plain: W oknie Properties (właściwości), pod Array > Cells (tablica > 

komórki) wybrać właściwość Linked Plain (dołączony Plain) i wprowadzić identyfikator Plain. Numer 
Plain wybranej komórki odpowiednio zmienia się: 

 

4. Dwukrotnie kliknąć w komórkę. Otwiera się nowy dokument reprezentujący Plain, z tym samym 
numerem identyfikacyjnym. (Domyślnie byłoby to 0, jak wybrana komórka). 
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5. Wprowadzić potrzebny obiekt, tak jak to się robi w dokumencie płaskim. (Patrz Tworzenie 
dokumentu do grawerowania płaskiego i O obiektach graficznych). 

6. Kiedy układ jest wykonany, z paska menu edytora laserowego wybrać File > Save (plik > zapisz), 
żeby zapisać Plain jako plik .xlp . 

7. Wrócić do tablicy. 

8. Wybrać komórkę (komórki), do której ma być dołączony już utworzony Plain. (Można wybrać cały 
rząd lub całą kolumnę klikając w niebieski wskaźnik. 

9. We właściwości Linked Plain (dołączony Plain) wprowadzić numer Plain, który został utworzony. 
(Patrz krok 3, powyżej). 

Komórki będą dynamicznie wypełniane zawartością dołączonego Plain przy wysyłaniu tablicy do 
grawerowania laserowego. (Patrz Wykonywanie operacji grawerowania). 

10. Można ustawić własne właściwości dla komórki przy użyciu właściwości Cells (komórki). Ustawienia 
pojawiają się na komórce, jak pokazano poniżej: 

 

Należy zwrócić uwagę, że kąt obrotu dla komórki został ustawiony na 160; mały czarny wskaźnik 
został odpowiednio przesunięty, żeby wskazać obrót. Więcej informacji, patrz Właściwości tablic i 
komórek ). 
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Właściwości tablic i komórek 

Okno Properties (właściwości) współpracuje z pomocą kontekstową: Podczas edycji układu - wybór 
tytułu właściwości (np. Geometry), a następnie naciśnięcie F1 otwiera pomoc kontekstową dla tych 
właściwości. 

Poniższe właściwości pojawiają się po wyborze obiektu Tablica w obszarze roboczym. 

 

Wskazówka: 
Bliższe informacje o sposobie stosowania właściwości w celu wykonania konkretnych operacji na 
obiekcie, patrz sekcja Stosowanie tablic . 

 

Grupa tablic Właściwość Opis 
Kolumny   Ustawia liczbę kolumn danych dla tablicy. 
Rzędy   Ustawia liczbę rzędów dla tablicy. 

Szerokość Ustawia szerokość wszystkich komórek w tablicy. Wielkość 
komórek Wysokość Ustawia wysokość wszystkich komórek w tablicy. 

Szerokość Określa odległość między kolumnami. Odległość można zwiększyć lub 
zmniejszyć. Podziałka 

Wysokość Określa odległość między rzędami. Odległość można zwiększyć lub 
zmniejszyć. 

Przesunięcie Ustawia nieprostoliniowość między rzędami lub kolumnami. 

Przeplot 
Kierunek 

Określa kierunek nieprostoliniowości. 

 X - Ustawia nieprostoliniowość między rzędami. 

 Y - Ustawia nieprostoliniowość między kolumnami. 

Grupa Reprezentuje grupę komórek uwzględnianych przy podziałce specjalnej. 

Pierwsza Wskazuje pierwszą kolumnę, do której podziałka specjalna będzie 
zastosowana. 

Podziałka Ustawia dodatkową odległość. Podziałki 
specjalne 

Kierunek 

Ustawia kierunek podziałki specjalnej: 

 Kierunek Y doda odległość między rzędami. 

 Kierunek X doda odległość między kolumnami. 

Rzędy / 
kolumny Określa czy przyrost licznika następuje przy kierunku rzędów lub kolumn 

od lewej do 
prawej, czy od 
prawej do 
lewej 

Określa czy przyrost licznika następuje przy kierunku od lewej do prawej, 
czy od prawej do lewej 

od góry do 
dołu czy od 
dołu do góry 

Określa czy przyrost licznika następuje przy kierunku od góry do dołu czy 
od dołu do góry 

Licznik 
samoprzyrostowy 

Na 
nieaktywnych 
komórkach 

Określa czy przyrost licznika następuje nawet przy nieaktywnych 
komórkach, czy nie 
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Ta grupa właściwości jest wyświetlana dopiero po wyborze jednej lub kilku poszczególnych 
komórek. (Patrz także Tworzenie zawartości poszczególnych komórek). 

Przesunięcie 

Ustawia przesunięcie znakowania dla wybranej komórki (komórek): 

 X - Ustawia przesunięcie poziome 

 Y - Ustawia przesunięcie pionowe 

Uaktywniona Uaktywnia / dezaktywuje wybraną komórkę (komórki) 
Obrót Stosuje kąt obrotu  do wybranej komórki (komórek). 

Komórki 

Dołączony Plain 

Umożliwia dołączanie dokumentu o specyficznej zawartości do wybranej 
komórki (komórek). Dwukrotne klikniecie w komórkę spowoduje otwarcie 
dokumentu z tym samym identyfikatorem Plain co wybrana komórka. 
Można traktować go jak dokument, a potem dołączyć do tylu komórek 
tablicy, do ilu się chce. (Szczegółowe instrukcje, patrz Tworzenie 
zawartości poszczególnych komórek). 

Import obiektów graficznych 

 

 

Przy użyciu przycisku paska narzędziowego Imported (importowane) lub menu Actions (działania) edytor 
laserowy umożliwia importowanie dwuwymiarowej grafiki. 

Wspierane formaty plików 
Edytor laserowy umożliwia import i edycję następujących formatów graficznych: 

 Wektorowe: 
o HPGL 1/2 (.PLT and .HPGL) - Początkowo formaty wektorowe były traktowane jak plotery, 

więc obejmują funkcje specyficzne dla ploterów (takie jak szerokość linii), których laser nie 
uwzględnia. Proszę zwrócić uwagę, że nie ma automatycznej regulacji plamki laserowej, gdy 
zmienia się pióro plotera. 

o AutoCad DXF - Dwuwymiarowy, wektorowy, wymienny format graficzny był pierwotnie 
opracowany przez Autodesk, a następnie ujawniony do użytku publicznego. Jednakże jest 
wciąż utrzymywany przez Autodesk, który aktualizuje go od czasu do czasu. 

o AutoDesk DWG - Wektorowy format graficzny na licencji firmy Autodesk. Jest to format 
pliku stosowany do przechowywania dwu- i trójwymiarowych danych projektowych i 
metadanych. Jest to rodzimy format dla kilku pakietów CAD. 

 

Uwaga: 
Dla formatów graficznych AutoCAD .DXF i .DWG dodano nowe opcje konfiguracji filtrów, które 
umożliwiają wybór sposobu przetwarzania pliku. Bliższe informacje, patrz Ustawianie opcji 
filtrów (pliki .DWG i .DXF). 
Dla wszystkich obiektów wektorowych dodano nowe, zaawansowane opcje przetwarzania, które 
umożliwiają zautomatyzowaną edycję wektorów. Bliższe informacje, patrz Stosowanie 
zaawansowanych opcji przetwarzania. 
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 Pliki obrazów (mapa bitów): 
o BMP - jest to standardowy format dla grafiki rastrowej. Można go wygenerować za pomocą 

dowolnej aplikacji graficznej, z cyfrowych aparatów fotograficznych lub skanerów. 
o GIF - jest to format podobny do BMP. Można go wygenerować za pomocą dowolnej aplikacji 

graficznej, z cyfrowych aparatów fotograficznych lub skanerów. 
o JPG - jest to jeden z najpopularniejszych skompresowanych formatów map bitów. Obraz 

BMP przekształcony w JPG ma dużo mniejszy rozmiar (w bajtach). 
o PNG - jest to rozszerzalny format plików w celu bezstratnego, przenośnego, dobrze 

skompresowanego przechowywania obrazów rastrowych, tzn. pliki PNG są 
skompresowanymi mapami bitów. 

o TIF - jest to zwykły format do wymiany obrazów grafiki rastrowej (map bitów) między 
programami użytkowymi, włącznie ze stosowanymi do obrazów skanera. 

 Dokumenty laserowe (.XLP) - Układy graficzne grawerowania generowane przez edytor laserowy. 

Można użyć okna Properties (właściwości), narzędzi z paska narzędziowego lub myszy, żeby zmienić 
wielkość, przesunąć, obrócić i przekształcić importowaną grafikę, żeby dopasować ja do obiektu, który ma 
być grawerowany.. 

 

Wskazówki: 
Więcej informacji o operowaniu myszą, patrz Użycie myszy do wyboru obiektów i 
manipulowania nimi. 
Informacje o tym jak operować grafikami, patrz Zwykłe operacje na obiektach. 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości. 

Następujące sekcje opisują sposób pracy z importowaną grafiką: 

 Grafika rastrowa vs. grafika wektorowa 
 Import pliku do edytora laserowego 
 Ustawianie opcji filtrów (pliki .DWG i .DXF) 
 Stosowanie zaawansowanych opcji przetwarzania 
 Właściwości grafik importowanych 

Grafika rastrowa vs. grafika wektorowa 

Edytor laserowy umożliwia edycję i import dwuwymiarowych grafik wektorowych, a także import i edycję 
grafik rastrowych utworzonych za pomocą innych aplikacji. 

O grafice rastrowej 

(.bmp, .gif, .jpg, .png, .tif) 

Grafika rastrowa opisuje obrazy przy użyciu kolorowych punktów zwanych pikselami, umieszczonych 
wewnątrz siatki. Obraz jest opisany przez specyficzne położenie i kolor każdego piksela w siatce, a proces 
tworzenia jest bardzo podobny do tworzenia mozaiki. 

Podczas edycji grafiki rastrowej edytuje się piksele zamiast linii i krzywych. Grafika rastrowa zmienia się 
wraz z rozdzielczością, ponieważ dane, które opisują obraz, są stałe w siatce o danych wymiarach. Edycja 
grafiki rastrowej może zmienić jej jakość. W szczególności zmiana wielkości może spowodować 
nieregularność krawędzi obrazu, ponieważ piksele w siatce są ponownie rozmieszczane. Dodatkowo, 
wyświetlanie grafiki rastrowej na urządzeniu wyjściowym o mniejszej rozdzielczości w stosunku do obrazu 
zmniejsza jakość prezentacji. 
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O grafice wektorowej 

(.plt, .hpgl, .dxf, .dwg) 

Grafika wektorowa opisuje obraz przy użyciu linii i krzywych zwanych wektorami, które obejmują właściwości 
związane z kolorem i położeniem. Obraz jest opisywany przez punkty, przez które przechodzą linie, tworząc 
formę konturu. (Należy zwrócić uwagę, że grawerowanie laserowe jest monochromatyczne.) 

Znakowanie rastrowe vs. znakowanie wektorowe 

Rastrowe 

Technika grawerowania rastrowego umożliwia znakowanie obiektu wektorowego jak gdyby był obiektem rastrowym. 
Obraz jest podzielony na rzędy, a rzędy są znakowane sekwencyjnie, ponieważ laser omiata obraz w poprzek 
powierzchni tam i z powrotem tworząc wolno posuwający się naprzód wzór liniowy, co przypomina wzór drukarki 
atramentowej lub podobnej. 

Laser przesuwa się ze stałą prędkością, a poziom sygnału dostosowuje się ciągle do „ciemności” rysowanego piksela. 
Tę technikę można stosować tylko na materiałach, których reakcja zmienia się głęboko wraz z mocą stosowanej wiązki; 
poliwęglan i PCW mogą zachowywać się w ten sposób przy zastosowaniu prawidłowych dodatków, natomiast metal nie 
może. W zasadzie, najlepsze wyniki daje grawerowanie rastrowe na kartach plastikowych. 

Przy grawerowaniu laserowym grafika rastrowa jest wolniejsza do grawerowania i gorzej zdefiniowana w kategoriach linii 
konturowych i wypełnienia. Można ją stosować, przy odpowiednich przekształceniach, do grawerowania fotografii 
cyfrowych. 

Wektorowe 

Przy znakowaniu wektorowym laser podąża za liniami i krzywą wzoru, który ma być wygrawerowany, dość podobnie do 
tego jak rysuje pióro plotera konstruując segmenty linii z opisu konturów wzoru. Śledzi wszystkie wektory, bez względu 
na to jak obiekt jest skalowany. 

Przy grawerowaniu laserowym grafika wektorowa jest szybsza do grawerowania i lepiej zdefiniowana w kategoriach linii 
konturowych i wypełnienia. Grafiki wektorowej nie można stosować do grawerowania fotografii cyfrowych. 

Import pliku do edytora laserowego 

W celu zaimportowania pliku: 
1. Utworzyć lub otworzyć dokument, żeby umożliwić wstawianie obiektów (patrz Tworzenie układów 

graficznych i Otwieranie istniejących układów). 
2. Wykonać jedną z następujących czynności: 

o Na poziomym pasku narzędziowym kliknąć w  (importowany). (Jeżeli nie widać tego 

przycisku, kliknąć w  (wstaw obiekty) na pionowym pasku narzędziowym ). 
o Z paska menu edytora laserowego wybrać Actions > Insert > Imported (działania > wstaw 

> importowany). 
3. Wyświetla się okno Choose a file to import (wybierz plik do importowania. Z rozwijanej w dół 

listy Files of type (pliki typu) wybrać potrzebny plik. (Więcej informacji, patrz Wspierane formaty 
plików ). 

4. Wybrać plik, który ma być importowany. Obraz jest wyświetlany w obszarze roboczym. 

 

Uwaga: 
Po wyborze plików o formacie .DWG lub .DXF (pliki AutoCAD) wyświetli się okno Filter 
Configuration (konfiguracja filtrów), żeby można było wybrać sposób przetwarzania pliku, który 
będzie importowany. Patrz Ustawianie opcji filtrów (pliki.DWG i .DXF). 
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5. Przy użyciu okna Properties (właściwości), myszy i pasków narzędziowych można wykonać, co 
następuje: 

o Przesunąć obiekt lub zmienić jego wielkość (patrz Zwykłe operacje na obiektach) 
o Edytować właściwości map bitowych, patrz Właściwości grafik importowanych) 
o Dołączyć importowany plik do układu (patrz Dołączanie importowanego pliku) 
o Wypełnić go liniami wypełniacza (tylko wtedy, gdy linie importowanego obiektu są zamknięte) i 

wykonać inne operacje na grafice (patrz Zwykłe operacje na obiektach) 
o Zastosować zaawansowane funkcje przetwarzania, żeby edytować węzły grafiki wektorowej 

(patrz Stosowanie zaawansowanych opcji przetwarzania) 

 

Wskazówka: 
Podręczne informacje o stosowaniu pasków narzędziowych w edytorze laserowym, 
patrz Stosowanie narzędzi z pasków narzędziowych. 
Kliknięcie w tytuł właściwości w oknie Properties (właściwości) a następnie naciśnięcie F1 
otwiera tabelę z opisem tych właściwości. 

Dołączanie importowanego pliku 
Właściwość Linked (dołączone) umożliwia określenie pełnej ścieżki importowanego pliku. W ten sposób, przy ładowaniu 
dokumentu program szuka pierwotnego pliku na określonej ścieżce, a jeżeli go nie znajduje, to stosuje wewnętrzną 
kopię, która była utworzona. Jeżeli pierwotny plik został zmieniony lub zaktualizowany, dokument jest także 
aktualizowany. 

1. Wybrać importowany obiekt w obszarze roboczym. 

2. W oknie Properties (właściwości), pod Imported (importowane )ustawić właściwość  Linked (dołączone) 
na True. 

3. Wyświetlana jest właściwość Linked file (dołączony plik), która pokazuje pełną ścieżkę importowanego pliku. 
Aby zmienić ścieżkę, użyć przycisku przeglądarki. 

Ustawianie opcji filtrów (pliki .DWG i .DXF) 
Kiedy do edytora laserowego importuje się plik .DWG lub .DXF , tzn. plik AutoCAD, to wyświetla się okno Filter 
Options (opcje filtrów), żeby można było wybrać sposób przetwarzania pliku. 

Importowane pliki AutoCAD mogą być ciągami, które stosują specyficzne i prawnie zastrzeżone fonty, które mogą być 
niedostępne w systemie użytkownika. Stosując te opcje można rozwiązać tę kwestię, a także przetwarzać warstwy 
pierwotnego pliku jak grupy edytowalnych obiektów. 

Aby ustawić opcje filtrów: 

1. Kliknąć w ikonę  (importowane) na pasku narzędziowym, a potem wybrać plik AutoCAD 
DXF/DWG jako File Type (typ pliku). 

2. Wybrać plik do zaimportowania i kliknąć w Open (otwórz). Wyświetla się następujące okno: 
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3. Wybrać prawidłowe opcje mając na uwadze: 

a. Import ciągów jako wektorów 

 Jeżeli jest ustawiony na False (domyślnie), to ciągi będą importowane jako ciągi. W 
tym przypadku, jeżeli oryginalny font nie jest dostępny, może być zgłoszony błąd lub 
ostrzeżenie. Aby rozwiązać ten problem, należy zastosować opcję Default 
font (font domyślny) i określić font domyślny. 

 Jeżeli jest ustawiony na True, ciągi będą importowane jako czyste obiekty 
wektorowe, tzn. nie będą już ciągami. 

b. Font domyślny - Umożliwia wybór fontu z listy rozwijanej w dół, który musi być 
zastosowany, jeżeli oryginalny nie jest dostępny. 

 

Wskazówka: 

Jeżeli zaimportowałeś ciągi jako ciągi (Import strings as vectors = False [importuj ciągi jako 
wektory = fałsz]) i ustawiłeś inny font domyślny niż oryginalny, to układ wynikowy może 
wykazywać różnice, jeśli chodzi o przestrzeń lub wyosiowanie obiektów. W celu rozwiązania tego 
typu problemu, należy wykonać poniższe czynności. 

 Przejrzeć wynik importu pod kątem problemów. 

 Zaimportować obiekt jeszcze raz ustawiając Import as vectors (importuj jako 
wektory) na True (prawda). 

Porównać wyniki i prawidłowo zmieniać font, aż do uzyskania pożądanego rezultatu. 
W razie potrzeby zaimportować wymagany font do swojego systemu (patrz 
„Importowanie fontów” na stronie 79). 

c. Przetwarzanie warstw jako grup - Zwykle pliki AutoCAD składają się z wielu warstw, z 
których każda zawiera inne informacje. Na przykład, na rysunku mechanicznym uwagi mogą 
być na jakiejś warstwie, a dane techniczne mogą rezydować na innych warstwach. Jeżeli ta 
opcja będzie ustawiona na True (domyślnie), to warstwy będą przekształcone w grupy 
obiektów, które będą pogrupowane warstwa po warstwie. Umożliwia to zarządzanie i 
operowanie warstwami, a także dodawanie specyficznych właściwości. 

4. Po zakończeniu, kliknąć w OK. Obiekt pojawi się w dokumencie użytkownika. 

5. W celu edycji wektorów w zautomatyzowany sposób, patrz Stosowanie zaawansowanych opcji 
przetwarzania. 

Stosowanie zaawansowanych opcji przetwarzania 
Opcje zaawansowanego przetwarzania zapewniają funkcje przetwarzania wektorowego, które umożliwiają 
edycję wektorów w zautomatyzowany sposób. Stosuje się to, jeżeli pierwotny dokument nie spełnia 
wymagań użytkownika co do znakowania.  

Można przerobić importowany obiekt na wektorowy, żeby sprawdzać jego wielokąty, a potem używać tych 
funkcji do rozwiązywania problemów, takich jak wielokąty nie zamknięte lub podwójne, zanim wyśle się 
dokument do znakowania. 

Te funkcje są dostępne dla obiektów wektorowych (.PLT, .HPGL, .DXF, .DWG). 
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Krok 1 - Przerobić obiekt na wektorowy i sprawdzić węzły: 
1. Wybrać importowany obiekt, a potem wykonać jedną czynność z poniższych: 

o Z paska menu wybrać Actions > Make vectorial (działania > przekształć na wektorowy). 

o Na pionowym pasku narzędziowym kliknąć w   (operacje na obiekcie) i albo kliknąć 

w  (przekształć na wektorowy), albo w    (wybór rozgrupowania) na poziomym 
pasku narzędziowym. 

2. Dwukrotnie kliknąć w obiekt, żeby wyświetlić węzły wektorów, a potem sprawdzić czy wielokąty są 
prawidłowo zamknięte lub czy są podwójne linie, które zachodzą na siebie. (Bliższe informacje o tym 
jak otwierać przeglądać i edytować węzły, patrz Edycja węzłów:). 

Poniżej pokazano przykład importowanego pliku .DXF, gdzie przedstawiono te rodzaje 
niedoskonałości. Po lewej widać obiekt w takiej postaci, w jakiej był importowany, a po prawej ten 
sam obiekt przekształcony na wektorowy jak opisano powyżej. 

 

Na pierwszy rzut oka nie widać żadnych problemów. Ale po otwarciu węzłów, przez przeciągnięcie 
małych szarych kwadratów, pojawią się problemy: 

 

Te problemy spowodują niedoskonałości znakowania. 

 
Wskazówka: 
Aby wyjść z trybu operacyjnego edycji węzłów należy nacisnąć ESC. 

3. W takim przypadku można użyć funkcji Advanced Processing (przetwarzanie zaawansowane), 
żeby edytować wielokąty automatycznie. 
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Krok 2 - Edytować wektory automatycznie, żeby skorygować niedoskonałości: 
1. Wybrać obiekt, a potem wykonać jedną czynność z poniższych: 

o Z menu Actions (działania) wybrać Advanced Processing (przetwarzanie zaawansowane). 

o Na pionowym pasku narzędziowym kliknąć w   (operacje na obiekcie), a potem  
(przetwarzanie zaawansowane). 

Wyświetli się następująca ramka: 

 

Są trzy opcje, które można zastosować łącznie: 
o Sort Edges & Close Polygons (sortuj krawędzie i zamknij wielokąty) - Opcja operuje na obszarach, 

które są zamknięte w wielokątach, a potem zamykają je eliminując wszelkie podwójne linie. 
o Join Open Polylines (łącz otwarte linie łamane) - Opcja operuje na odległości między węzłami i 

próbuje zamknąć je w maksymalnej odległości. To znaczy, próbuje łączyć wielokąty, które są dość 
blisko, a potem zamknąć je. 

o Split in Polygons (podziel na wielokąty) - Opcja umożliwia podział obiektu wektorowego na 
poszczególne wielokąty. Jest to odpowiednie zwłaszcza w przypadku importowanego obiektu, który 
jest wykonany z wielu wielokątów umieszczonych na różnych warstwach: przy użyciu tej opcji można 
zobaczyć jak obiekty są pogrupowane na każdej warstwie, rozgrupować je, a następnie operować na 
wielokątach osobno. 

Przykład zastosowania 
Weźmy powyższy przykład importowanego obiektu, żeby opisać jak opcje przetwarzania zaawansowanego 
mogą być zastosowane łącznie w celu rozwiązania wszystkich problemów. 

1. Wybrać obiekt, a następnie z menu  Actions (działania) wybrać Advanced 

Processing (przetwarzanie zaawansowane) (lub kliknąć w   (operacje na obiekcie) na 

pionowym pasku narzędziowym, a potem w    [przetwarzanie zaawansowane]). 
2. Zastosować pierwszą opcję Sort Edges & Close Polygons (sortuj krawędzie i zamknij wielokąty), 

która operując na obszarach powinna usunąć wszelkie podwójne lub niezamknięte wielokąty. 

Jednakże wynik jest wciąż nie taki jakiego oczekiwano, co pokazano na następującym rysunku: 
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3. Kliknąć w  (anuluj) lub nacisnąć CTRL+Z, żeby anulować operację. 
4. Z menu Actions (działania) jeszcze raz wybrać Advanced Processing (przetwarzanie zaawansowane), a 

potem zastosować drugą opcję Join Open Polylines (łącz otwarte linie łamane). 
5. Zastosować wypełnienie: Z rozwijanej w dół listy właściwości Filling (wypełnienie) wybrać Single line 

(pojedyncza linia): 

 

6. Wydaje się, że to działa, ale sprawdźmy węzły: Kliknąć w  (anuluj), żeby anulować wypełnienie, 
przekształcić obiekt na wektorowy przez dwukrotne kliknięcie i sprawdzić węzły: 

 

Jak widać na powyższym przykładzie, wciąż są podwójne wielokąty, które spowodowałyby problemy 
przy znakowaniu w przypadku zastosowania, na przykład, wypełnienia z przywłaszczeniem, które 
wymaga doskonale zamkniętych i dobrze przygotowanych wielokątów. 

7. Można spróbować tego: Z właściwości Filling (wypełnianie) wybrać Pocketing a potem 
wybrać Mark Preview (zaznacz podgląd) z menu Actions (działania) Oto, co spowoduje 
zaznaczenie: 
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8. Nacisnąć ESC , żeby wyjść z trybu Mark preview (zaznacz podgląd), a potem kliknąć w 
(anuluj), żeby anulować wypełnie. 

9. Z menu Actions (działania) wybrać Advanced Processing (przetwarzanie zaawansowane). 
10. Jeszcze raz zastosować pierwszą opcję, Sort Edges & Close Polygons (sortuj krawędzie i zamknij 

wielokąty), żeby usunąć wszystkie podwójne linie. 
11. Przekształcić obiekt na wektorowy przez dwukrotne kliknięcie w niego i znowu wybrać węzły. Teraz 

wszystkie węzły będą zamknięte i nie będzie już podwójnych linii. 
12. Aby sprawdzić wyniki zaznaczenia, jeszcze raz zastosować wypełnienie, a potem wybrać Mark 

preview (zaznacz podgląd) z menu Actions (działania). Na poniższych rysunkach pokazano wyniki 
obu wypełnień: 

 

Wynik zaznaczenia za pomocą wypełnienia pojedynczych linii 

 

Wynik zaznaczenia za pomocą wypełnienia z przywłaszczeniem 

Teraz obiekt będzie zaznaczony zgodnie z oczekiwaniem, pokazując zamknięte i dobrze zorientowane 
wielokąty. 
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Właściwości grafik importowanych 
Okno Properties (właściwości) współpracuje z pomocą kontekstową: Podczas edycji układu - wybór 
tytułu właściwości (np. Geometry), a następnie naciśnięcie F1 otwiera pomoc kontekstową dla tych 
właściwości. 

 

Wskazówki: 
Bliższe informacje o sposobie stosowania właściwości w celu wykonania konkretnych operacji na 
obiekcie, patrz sekcja Zwykłe operacje na obiektach . 
Więcej informacji o importowanych obiektach, patrz sekcja Import obiektów graficznych . 

 
Grupa Właściwość Opis 

Jaskrawość Umożliwia regulację jaskrawości mapy bitów. 
Kontrast Umożliwia regulację kontrastu mapy bitów. 
Rozdzielczość Umożliwia zmianę rozdzielczości obrazu, wyrażonej w punktach na cal. 

Odwrotność 

Jeżeli jest ustawiona na True, określa  odwrotne grawerowanie dla importowanej 
mapy bitów: 

 

Szare tony - Przekształca obraz przez rozsiewanie do szarych tonów. 
(Domyślnie) 
Półtony - Przekształca obraz czarno-biały na symulowane punkty rastrowe. 
Półtony zmieniają wielkość punktów rastrowych, żeby symulować cieniowanie. 

Obraz 

Tryb 
wyświetlania 

Rozpraszanie błędów - Przekształca obraz o ciągłym kolorycie na kliszę 
siatkową o modulacji częstotliwościowej. 

Dołączone 
Jeżeli jest ustawiony na True, to umożliwia określenie pełnej ścieżki 
importowanego pliku; jest to ścieżka, którą wyszuka program przy każdym 
ładowaniu dokumentu. (Patrz Dołączanie importowanego pliku). Importowane 

Dołączony 
plik Pokazuje pełną ścieżkę dołączonego pliku. Ścieżkę można zmienić. 
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Stosowanie funkcji podziału 

 

Uwaga: 
Właściwość Tilable jest dostępna tylko wtedy, gdy edytuje się obiekty wektorowe w 
dokumentach pierścieniowych. (Bliższe informacje, patrz Tworzenie dokumentu do 
grawerowania pierścieniowego) 

Właściwość  geometryczna Tilable jest stosowana, gdy znakuje się obiekty niepodzielne na separatorze 
pierścieniowym, tzn. na powierzchni cylindrycznej. 

Zwykle, kiedy znakuje się na dokumencie pierścieniowym, laser skupia się na części (sektorze) pierścienia 
do znakowania. 

W niektórych zastosowaniach obiekt do znakowania może być dłuższy niż sam sektor. Na przykład w 
biżuterii, może być potrzebne oznaczenie logo producenta lub imię klienta na obrączce ślubnej. To mogłoby 
spowodować deformacje. 

Przez zastosowanie funkcji podziału: 
 Obiekt zostanie podzielony na tworzące go wielokąty. 
 Jeżeli wielokąt będzie większy niż sektor i będzie zamknięty (w przeciwnym razie funkcja nie będzie 

działać), to zostanie „pokrojony” na części o wielkości równej sektorom pierścienia do znakowania. 

W ten sposób obiekt będzi oznakowany jak gdyby był pojedynczym sektorem, co spowoduje bardzo 
precyzyjne znakowanie. 

Właściwość Podział jest stosowana  łącznie z zaawansowanymi właściwościami dokumentu 
pierścieniowego Wielkość sektora i Przerwa sektorowa jak to opisano w przykładzie poniżej. 

Przykład zastosowania podziału 
Następny przykład opisuje jak działa oprogramowanie, kiedy stosuje się funkcję podziału i jak mają być 
ustawione właściwości Wielkość sektora oraz Przerwa sektorowa pierścienia, zgodnie z konkretnymi 
potrzebami użytkownika. 

1. Otworzyć dokument pierścieniowy wybierając File > New >  Ring document (plik > nowy > 
dokument pierścieniowy). 

2. Przypuśćmy, że musimy importować logo jubilera. Więc należy kliknąć w  i importować plik. 
3. Jak we właściwości ciągu tekstowy,,wpisać datę, a potem ustawić żądane właściwości Font, Styl, 

and Wypełnienie . Następnie ustawić właściwość Tilable (podział) jako prawdę, pod Geometry: 
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4. Odwołać wybór ciągu i ustawić właściwości Sector Size (wielkość sektora) i Sector Gap (przerwa 
sektorowa) dla dokumentu, żeby zdefiniować właściwości sektorów: 

 

5. Ustawić właściwości według potrzeb pamiętając, że: 

a. Właściwość Wielkość sektora definiuje szerokość sektora, tzn. część, która ma być 
grawerowana w jednym ruchu osi obrotu. Obiekt będzie podzielony na sektory, których 
wielkość jest równa maksymalnej wielkości sektora, która jest oparta na głębi ostrości 
lasera. 

Wartość 0 (domyślna) zapewnia wysoki poziom jakości. Dla każdego wielokąta będzie 
wykonany jeden ruch, a wielokąt będzie wyśrodkowany w przynależnym mu sektorze. 

Za pomocą podzielnych obiektów można ustawić wartość mniejszą od 0, jeżeli potrzebna 
jest duża precyzja. Należy zwrócić uwagę, że mniejsza wartość powoduje dłuższy czas 
znakowania. 

b. Właściwość Przerwa sektorowa umożliwia dokładniejsze dostrojenie operacji podziału. 

Jeżeli jest ustawiona na 0 (domyślnie), to tylko jedno cięcie będzie zastosowane do lewego i 
prawego obiektu. 

Jeżeli wartość jest mniejsza od 0, to będą zastosowane dwa cięcia, żeby albo nałożyć 
wielokąty (lewą i prawą granicę), albo pozostawić przestrzeń między nimi. 

Należy zwrócić uwagę, że to ustawienie jest oparte na głębi ostrości lasera, a także na 
mechanicznej precyzji wirnika. 

6. Zapisać swój układ. 
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Zrozumienie koloru obiektów w obszarze roboczym 

Obiekty w obszarze roboczym mogą przyjmować różne kolory w zależności od ich stanu lub charakterystyki, 
jak pokazano na rysunku: 

 
 
Kolor Znaczenie 

Czerwony Obiekt graficzny NIE jest prawidłowo umieszczony w obszarze graficznym. Obiekty w kolorze 
czerwonym NIE będą grawerowane. 

Niebieski 

Obiekt graficzny jest prawidłowo umieszczony w obszarze graficznym i jest udostępniony do 
grawerowania. Jego parametry grawerowania NIE są standardowymi parametrami dokumentu; 
zostały ustawione specjalne parametry grawerowania laserowego, które odnoszą się tylko do 
tego obiektu (patrz Własne parametry laserowe dla obiektów). W obszarze graficznym mogą być 
różne obiekty w kolorze niebieskim; ich parametry laserowe mogą różnić się między sobą.  

Szary 
Obiekt graficzny jest prawidłowo umieszczony w obszarze graficznym, ale NIE jest udostępniony 
do grawerowania i NIE będzie grawerowany. Właściwość Udostępnij w przeglądarce właściwości 
jest ustawiona na fałsz. 

Czarny Obiekt jest prawidłowo umieszczony w obszarze graficznym i jest udostępniony do 
grawerowania. Jego parametry grawerowania są standardowymi parametrami dokumentu. 
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Stosowanie zmiennych globalnych. 

 

Uwaga: 
Aby przeglądać zmienne globalne i zarządzać nimi, trzeba być podłączonym do urządzenia 
laserowego. Bliższe informacje, patrz Podłączenie do urządzenia laserowego. 
Ta funkcja jest również dostępna na poziomie interfejsu mechanizmu laserowego. Bliższe 
informacje, patrz Interfejs użytkownika mechanizmu laserowego. 

Cel funkcjonalności 
Zmienne globalne są ciągami lub licznikami, które są przechowywane w małej bazie danych na poziomie 
urządzenia. Następnie można zastosować spe3cjalne sekwencje znaków, żeby uzyskać dostęp do ciągu 
globalnego lub zmiennej licznika i dzielić jego zawartość wśród wielu obiektów lub dokumentów. (Patrz 
także Stosowanie specjalnych sekwencji znaków). 

Na przykład można zastosować ten sam licznik w tylu dokumentach ile jest potrzebnych lub przedstawić 
zmienną globalną ciągu w dowolnej liczbie dokumentów. 

Podsumowując, ta funkcja ma następujące główne zalety: 
 Licznik nie jest już tylko ściśle związany z ciągiem.  Można stworzyć licznik wspólny dla wielu 

ciągów, zarządzany na poziomie maszyny. 
 Nie trzeba już tworzyć konkretnego programu dla każdego dokumentu do grawerowania w celu 

zwiększania licznika. 
 Jest przewidziana scentralizowana baza danych zarządzana przez mechanizm laserowy. Można ją 

wykorzystać do przechowywania, przeglądania lub edytowania zmiennych globalnych, albo zdalnie 
przez interfejs użytkownika edytora laserowego, albo poprzez projekt w celu ich aktualizacji lub 
edycji podczas wykonania. 

 Zawartość zmiennej (np. bieżąca liczba dla licznika) nie jest ściśle połączona z konkretnym plikiem 
dokumentu. Przykładowo, liczniki są automatycznie aktualizowane po każdym użyciu. Użytkownicy 
nie muszą się już troszczyć o ich zapisywanie. Można wyłączyć maszynę lub edytować dokument, a 
przy następnym włączeniu maszyny nastąpi przyrost licznika zgodnie z poprzednio osiągniętą 
wartością. 

Bliższe informacje o zarządzaniu zmiennymi globalnymi, patrz:  
 Dodawanie, przeglądanie lub edycja zmiennych globalnych 
 Użycie specjalnej sekwencji znaków, aby dołączyć zmienne globalne do konkretnego ciągu 

Dodawanie, przeglądanie lub edycja zmiennych globalnych 
Aby dodać, przejrzeć lub edytować zmienne globalne, należy postępować zgodnie z tą procedurą. Wtedy 
będzie można dołączyć je do obiektów przy użyciu specjalnych sekwencji znaków. 

1. Upewnij się, że jesteś podłączony do urządzenia laserowego (patrz Podłączanie do urządzenia 
laserowego). 

2. Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać Laser > Edit device global variables (laser > 
edytuj zmienne globalne urządzenia). 

o Na pasku narzędziowym edytora laserowego kliknąć w  (edytuj zmienne globalne 
urządzenia). 

3. Wyświetlają się Device variables (zmienne urządzenia) i użytkownik może zdalnie dodawać 
zmienne lub zarządzać nimi. 
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Aby dodać zmienną globalną: 

1. W oknie Device variables (zmienne urządzenia) należy wykonać co następuje: 

o Kliknąć w Add new counter (dodaj nowy licznik), żeby dodać typ zmiennej: licznik. 

o Kliknąć w Add new string (dodaj nowy ciąg), żeby dodać typ zmiennej: ciąg. 

W tabeli zostanie dodana nowa zmienna przy użyciu parametrów domyślnych. 

2. W celu edycji parametrów należy wybrać zmienną, a potem dwukrotnie kliknąć w pole, które ma być 
zmienione. Skorzystać z następującej tabeli: 

Tabela 3 Parametry zmiennych globalnych 
Pole Opis 
Liczniki 
 

Zmienna Unikalny identyfikator licznika. Jest do nazwa, która ma być zastosowana dla licznika w 
specjalnej sekwencji znaków. 

Wartość Bieżąca wartość licznika. Ta wartość będzie wyświetlana wtedy, gdy zmienna globalna jest 
przywołana w ciągu poprzez stosowną specjalną sekwencję znaków. 

Start Minimalna wartość dla licznika. 
Stop Maksymalna wartość dla licznika. 
Krok Wartość przyrostu (dodatnia lub ujemna). 
Cykle Liczba razy jaką licznik będzie oznaczony zanim nastąpi przyrost o jeden krok. 

Liczenie 
cykli 

Umożliwia śledzenie liczby znakowań, które zostały wykonane w ciągu wymaganej liczby cykli. 
Ten parametr jest resetowany do 0, kiedy liczba grawerowań została osiągnięta, a licznik 
zwiększył się. 
(Ma to zastosowanie tylko wtedy, gdy parametr Cykle został ustawiony na inną wartość niż 1). 

Cyfry Minimalna liczba cyfr, jaka będzie wyświetlana. 

Podstawa 

System liczbowy, który będzie stosować licznik do przedstawienia liczb. Dozwolone są 
następujące wartości: 

o 2 - Znakowana liczba będzie przekształcona na postać binarną. Format binarny 
wykorzystuje tylko 2 cyfry (0 i 1) i dlatego nazywa się także formatem o podstawie 2. 
Wartość 10 w systemie binarnym będzie znakowana jako 1010. 

o 8 - Znakowana liczba będzie przekształcona na postać ósemkową. Zapis 
ósemkowy wykorzystuje 8 cyfr (0,1,2,3,4,5,6,7) i jest także nazywany formatem o 
podstawie 8. Wartość 10 w systemie ósemkowym będzie znakowana jako 012. 

o 10 - Liczba będzie znakowana w postaci dziesiętnej. Zapis dziesiętny 
wykorzystuje 10 cyfr (0,1,2,3,4,5,6,7,8,9 ) i jest także nazywany formatem o podstawie 
10. Wartość 10 w systemie dziesiętnym będzie znakowana jako 10. 

o 16 - Liczba będzie znakowana w postaci szesnastkowej. Zapis szesnastkowy 
składa się z 2 części: 6 liter i 10 cyfr (0,1,2,3,4,5,6,7,8,9,A,B,C,D,E,F). Nazywa się 
także zapisem o podstawie 16. Wartość 10 w systemie ósemkowym będzie znakowana 
jako 0A. 

Ciągi 

Zmienna Unikalny identyfikator ciągu. Jest do nazwa, która ma być zastosowana dla ciągu w specjalnej 
sekwencji znaków. 

Wartość Zawartość zmiennej, tzn. ciąg tekstowy. 

Poniższy rysunek pokazuje przykład, gdzie jako zmienne dodano jeden licznik i dwa ciągi: 

Rysunek Okno dialogowe zmiennych urządzenia 
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3. Po zakończeniu kliknąć w Apply (zastosuj), a potem w OK, żeby zamknąć okno dialogowe i wrócić 
do edytora laserowego. 

Zmienna globalna będzie zapisana w urządzeniu i przechowywana w bazie danych zarządzanej przez 
mechanizm laserowy. Wtedy będzie można odszukać ją z edytora laserowego w celu jej sprawdzenia lub 
edycji. 

Aby przejrzeć, edytować lub usunąć istniejącą zmienną globalną: 
Można użyć edytora laserowego w celu wyświetlenia zmiennej globalnej, która została zapisana w 
urządzeniu, żeby móc sprawdzić lub edytować wartości. 

1. Upewnij się, że jesteś podłączony do urządzenia laserowego (patrz Podłączanie do urządzenia 
laserowego). 

2. Nacisnąć przycisk  (edytuj zmienne globalne urządzenia) na pasku narzędziowym, żeby 
pojawiła się ramka dialogowa Device variables (zmienne urządzenia), gdzie są wymienione 
zmienne, które są obecnie przechowywane w urządzeniu. 

3. Wykonać jedną z następujących czynności: 
o W celu edycji parametrów należy wybrać zmienną, a potem dwukrotnie kliknąć w pole, które 

ma być zmienione. Wykorzystać tabelę Parametry zmiennych globalnych . 
o Aby usunąć zmienną globalną z bazy danych mechanizmu laserowego, należy wybrać 

zmienną, a potem kliknąć w  Delete counter(s) [usuń licznik(i)] lub Delete string(s) [usuń 
ciąg(i)], w zależności od typu usuwanej zmiennej Kliknąć w Yes (tak), aby potwierdzić 
wybór. 

4. Po zakończeniu kliknąć w Apply (zastosuj), a potem w OK, żeby zamknąć okno dialogowe i wrócić 
do edytora laserowego. 
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Użycie specjalnej sekwencji znaków, aby dołączyć zmienne globalne do 
konkretnego ciągu 
Postępować zgodnie z tą procedurą, żeby dołączyć zmienną globalną (ciąg lub licznik) do jednego lub kilku 
ciągów. Można dołączyć tę samą zmienną do ciągów, które należą do różnych dokumentów. (Patrz 
także Dodawanie, przeglądanie lub edycja zmiennej globalnej). 

W celu dołączenia zmiennej globalnej do ciągu: 
1. Dodać ciąg do dokumentu, a potem wybrać go (patrz Dodawanie ciągu tekstowego). 
2. W oknie Properties (właściwości), pod String (ciąg), w ramce Text (tekst) wprowadzić żądaną 

specjalną sekwencję znaków, w zależności od stosowanej zmiennej globalnej. Może to być ciąg, 
licznik lub oba (patrz przykład poniżej): 

o %v[stringname] lub %V[stringname] - gdzie stringname jest nazwą, którą przydzieliłeś do 
ciągu, kiedy go tworzyłeś (tj. pole Variable (zmienna) w ramce dialogowej Device 
variables (zmienne urządzenia). V wymusza duże litery. 

o %v[countername] - gdzie countername jest identyfikatorem, którą przydzieliłeś do licznika, 
kiedy go tworzyłeś (tj. pole Variable (zmienna) w ramce dialogowej Device 
variables (zmienne urządzenia). 

 

 Należy zwrócić uwagę, że dla wartości variablename (nazwa zmiennej) rozróżniana jest 
wielkość liter; trzeba wpisać dokładnie to co było wpisane w ramce dialogowej Device 
variables (zmienne urządzenia). 

3. Nacisnąć Enter. Ciąg zmienia się na ciąg określonego formatu. Kiedy ciąg jest wysłany do 
znakowania, licznik zwiększa się odpowiednio do parametrów, które zostały określone podczas 
tworzenia zmiennej. 

Przykład 
W poniższym przykładzie połączyliśmy ten sam licznik z dwoma różnymi ciągami, które znajdują się w 
różnych dokumentach. Po wysłaniu dwóch dokumentów do znakowania, licznik globalny na poziomie 
urządzenia laserowego zwiększył się. 

 Na poniższym rysunku ciąg został dołączony do zmiennych globalnych: string1 (wartość: 
Marking) i counter1 (patrz rysunek Okno dialogowe zniennych urządzenia). 

 

 Na poniższym rysunku drugi ciąg, który znajduje się w innym dokumencie, został dołączony do 
zmiennej globalnej: string1 (wartość: Laser Editor) i do tej samej zmiennej globalnej counter1. 
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 Po wysłaniu dwóch dokumentów do znakowania, licznik globalny zwiększył się, co można zobaczyć 
w oknie dialogowym Device Variables (zmienne urządzenia), poniżej: 
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Zwykłe operacje na obiektach 
W tej sekcji opisano wszystkie operacje, które można wykonać na obiektach graficznych, albo przy użyciu 
myszy, albo okna Właściwości, albo przycisków pasków narzędziowych. 

Temat Więcej... 
Stosowanie siatki dokumentu Kliknij tutaj 
Aktywacja / dezaktywacja obiektów Kliknij tutaj 
Użycie myszy do manipulowania obiektami Kliknij tutaj 
Kopiowanie, wklejanie lub usuwanie obiektów Kliknij tutaj 
Osiowanie, przełączanie lub spacjowanie obiektów Kliknij tutaj 
Grupowanie, scalanie lub dołączanie obiektów Kliknij tutaj 
Edycja obiektów wektorowych Kliknij tutaj 
Zbliżanie obiektów Kliknij tutaj 
Określanie właściwości wypełniania Kliknij tutaj 
Ustawianie punktu początkowego obiektu Kliknij tutaj 
Optymalizacja kolejności grawerowania obiektów Kliknij tutaj 
Obliczanie czasu znakowania Kliknij tutaj 
Wykorzystanie możliwości Zaznacz podgląd Kliknij tutaj 



TWORZENIE UKŁADÓW GRAFICZNYCH 

 113
 

4

Stosowanie siatki dokumentu 
Siatka dokumentu jest szeregiem nakreślonych linii, które się przecinają. Można je wykorzystać do 
precyzyjnego wyosiowania i pozycjonowania obiektów w oknie rysowania. 

Odległość między liniami siatki można ustawić przez określenie spacjowania w przeglądarce właściwości 
dokumentu. (Bliższe informacje o sposobie tworzenia dokumentów, patrz O dokumentach). 

Dostosowywanie siatki: 
1. Odwołać wybór obiektu w obszarze roboczym, żeby wyświetlić okno Properties (właściwości) dla 

dokumentu. Domyślnie, pod Geometry (geometria), właściwość Grid (siatka) jest ustawiona 
na True, co oznacza, że siatka jest uaktywniona. 

2. Aby ustawić dokładną odległość między liniami, należy wprowadzić żądaną wartość jako Step 
(krok). Domyślnie ta wartość jest ustawiona na 10,00. Wprowadzić mniejszą wartość, żeby 
wyosiować i wypozycjonować obiekty z większą precyzją. 

3. Aby przerzucić obiekty do siaki, ustawić wartość właściwości Snap to grid (przerzut do siatki) 
na True. Tym sposobem obiekty będą przesunięte i wyosiowane do najbliższej linii siatki. 

Aktywacja / dezaktywacja obiektów 
Obiekt, który ma być znakowany, musi być uaktywniony w układzie. Domyślnie, każdy obiekt dodawany do 
dokumentu jest uaktywniony. 

Aby dezaktywować dokument: 
1. Wybrać obiekt  obszarze graficznym, żeby wyświetlić jego właściwości. 
2. W oknie Właściwości, pod Geometrią, ustawić wartość Uaktywnij na fałsz. 
3. Obiekt jest nadal wyświetlany w obszarze graficznym, ale jego kolor zmienia się na szary, żeby 

wskazać, że jest nieaktywny i nie będzie znakowany. 

Użycie myszy do wyboru i manipulowania obiektami 

 

Przy użyciu myszy można wybierać obiekty i operować na nich. 

Oprócz wybierania obiektów, mysz umożliwia szybkie, zgrubne wymiarowanie i pozycjonowanie. 

 

Wskazówka: 
Do wyjątkowo precyzyjnej zmiany wielkości, pozycjonowania lub zukosowania obiektów 
należy zastosować właściwości Geometry (geometria) w 
przeglądarce Property (właściwości). (Patrz Właściwości  geometryczne obiektów). 

Co można zrobić za pomocą myszy: 
 Wybór obiektu (obiektów) 
 Przesuwanie, zmiana wielkości lub blokowanie obiektów 
 Ukosowanie i  obiektów 
 Edycja węzłów 
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Wybór obiektu (obiektów) 

Aby wybrać jeden obiekt: 

1. Kliknąć, żeby wybrać obiekt. Wybrany obiekt wygląda następująco: 

 

Symbol  przedstawia środek wyboru i odpowiada początkowi, który został ustawiony dla obiektu 
(patrz Ustawianie początku obiektu). Należy zwrócić uwagę, że przeglądarka Property (właściwość) 
zawiera właściwości dla wybranego obiektu. 

2. Można użyć uchwytów, które pojawiają się wokół obiektu, żeby przesunąć lub zmienić wielkość 
obiektu. (Patrz niżej). 

3. Aby odwołać wybór obiektu, należy kliknąć w pusty obszar dokumentu. 

Aby wybrać wiele obiektów: 
Wykonać jedną z następujących czynności: 

 Przeciągnąć myszą, żeby wybrać wiele obiektów. 
 Przytrzymać naciśnięty CTRL podczas klikania w żądane obiekty. 
 Można użyć uchwytów, które pojawiają się wokół obiektu, jak gdyby to był jeden obiekt. (Patrz niżej). 

Przesuwanie, zmiana wielkości lub blokowanie obiektów 
Po wybraniu obiektu można użyć myszy, żeby zmienić jego położenie w dokumencie, a także zmienić jego 
wielkość. Można także zablokować go, żeby uniemożliwić jakąkolwiek zmianę. 

Aby przesunąć obiekt: 
1. Wybrać obiekt. 

2. Kiedy wskaźnik myszy zmieni się na (krzyżyk), kliknąć lewym przyciskiem myszy i przesunąć 
obiekt na żądaną pozycję w dokumencie. (Należy zwrócić uwagę, że wpłynie to na właściwości 
geometryczne obiektu). 

Aby zmienić wielkość obiektu: 
1. Wybrać obiekt. 
2. Ustawić wskaźnik na uchwycie i poczekać aż wskaźnik przyjmie ten sam kształt co uchwyt; wtedy 

kliknąć lewym przyciskiem myszy, żeby zmienić wielkość obiektu. 
3. Skorzystać z następującej tabeli: 

Uchwyt 
obiektu 

Wskaźnik 
myszy Można 

  Przeciągnąć, żeby zmienić wielkość obiektu. 

  Przeciągnąć w dół, żeby zmienić wysokość obiektu. 

  Przeciągnąć w lewo lub w prawo, żeby zmienić szerokość obiektu. 
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Aby zablokować / odblokować obiekt: 
1. Wybrać obiekt. 
2. Kliknąć w uchwyt  . Znikają uchwyty do przesuwania i zmiany wielkości, a pluskiewka zmienia 

kształt na  . To zapobiega zmianom obiektu. 
3. Aby odblokować obiekt, kliknąć w uchwyt  . 

Ukosowanie i obrót obiektów 

Można dwukrotnie kliknąć w obiekt, żeby uaktywnić uchwyty do ukosowania i obracania. 

Aby obrócić obiekt: 

1. Dwukrotnie kliknąć w obiekt(y). Należy zwrócić uwagę, że uchwyty wyglądają następująco: 

 

2. Ustawić wskaźnik na uchwycie   i poczekać aż wskaźnik zmieni się na krzyżyk, wtedy kliknąć 
lewym przyciskiem myszy i przeciągnąć uchwyt w górę lub w dół, żeby obrócić obiekt. 

Aby zukosować obiekt: 
1. Ustawić wskaźnik na uchwycie i poczekać aż wskaźnik przyjmie ten sam kształt co uchwyt; wtedy 

przeciągnąć, żeby zukosować obiekt. 
2. Skorzystać z następującej tabeli: 

Uchwyt obiektu Wskaźnik myszy Można 

 
 Przeciągnąć w lewo-prawo, żeby zukosować obiekt poziomo. 

 
 Przeciągnąć w górę-dół, żeby zukosować obiekt pionowo. 

Edycja węzłów 
Można użyć myszy do edycji węzłów obiektu wektorowego. 

Aby edytować węzły: 

1. Dwukrotnie kliknąć w obiekt wektorowy. Kontur obiektu staje się zielony i pojawia się pasek 

narzędziowy  Edit nodes (edytuj węzły). 

2. Ustawić wskaźnik na linii łamanej i poczekać aż wskaźnik zmieni się w krzyżyk; następnie kliknąć, 
żeby wyświetlić węzły. 

Bliższe informacje, patrz sekcja Edycja obiektów wektorowych . 
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Kopiowanie, wklejanie, wycinanie lub usuwanie obiektów 

 

Do kopiowania, wklejania lub usuwanie obiektów z obszaru graficznego można użyć albo standardowych 
przycisków paska narzędziowego, albo menu Edit (edytuj), albo klawiszy skrótów. 

 

Wskazówka: 
Przeciągnąć myszą, żeby wybrać wiele obiektów, jeżeli chce się je skopiować, wkleić lub usunąć 
w jednej operacji. 

Aby skopiować i wkleić obiekt: 
1. Wybrać żądany obiekt(y) w obszarze graficznym. Wykonać jedną z następujących czynności: 

o Na standardowym pasku narzędziowym kliknąć w przycisk kopiuj   , a potem w przycisk 

wklej   . 
o Z paska menu edytora laserowego wybrać Edit > Copy (edytuj > kopiuj), a potem Edit > 

Paste (edytuj > wklej). 
o Nacisnąć Ctrl+C, a potem Ctrl+V. 

2. Kopia jest wklejona na górze pierwotnego obiektu. Przeciągnąć ją, żeby ją przenieść. 

Aby wyciąć obiekt: 
1. Wybrać żądany obiekt(y) w obszarze graficznym. Wykonać jedną z następujących czynności: 

o Na standardowym pasku narzędziowym kliknąć w przycisk   (wytnij). 
o Z paska menu edytora laserowego wybrać Edit > Cut (edytuj > wytnij). 
o Nacisnąć Ctrl+X. 

2. Następnie można wkleić obiekt. 

Aby usunąć obiekt: 
1. Wybrać żądany obiekt(y) w obszarze graficznym. Wykonać jedną z następujących czynności: 

1. Na standardowym pasku narzędziowym kliknąć w przycisk   (usuń). 
2. Z paska menu edytora laserowego wybrać Actions > Remove object(s) [działania > usuń 

obiekt(y)]. 
2. Obiekt jest usunięty z dokumentu. 
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Osiowanie, przełączanie lub spacjowanie obiektów 

  

Można użyć paska narzędziowego Adjust objects (reguluj obiekty) lub menu Actions (działania), żeby 
szybko wyosiować, przełączyć, rozstawić i zwymiarować obiekty graficzne. Większość z tych funkcji jest 
aktywna tylko wtedy, gdy więcej obiektów jest wybranych w obszarze graficznym. W szczególności, 
narzędzia do spacjowania są aktywne tylko wtedy, gdy są wybrane co najmniej trzy obiekty. 

Aby wyregulować obiekty graficzne: 

 Na pionowym pasku narzędziowym kliknąć w  , żeby wyświetlić poziomy pasek 
narzędziowy Adjust objects (reguluj obiekty). (Wszystkie polecenia są także dostępne z 
menu Actions [działania]). 

 Skorzystać z następującej tabeli: 

Przycisk Działanie 

 Wyrównaj do lewej 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty do tego najbardziej na lewo. 

 Wyrównaj do góry 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty do tego najwyższego. 

 Wyrównaj do prawej 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty do tego najbardziej na prawo. 

 Wyrównaj do dołu 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty do tego najniższego. 

 Wyrównaj do środka X 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty wzdłuż osi X. 

 Wyrównaj do środka Y 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, żeby wyrównać 
wszystkie obiekty wzdłuż osi Y. 

 Przełącz poziomo 
Wybrać jeden lub więcej obiektów; potem kliknąć w ten przycisk, żeby przełączyć 
obiekt(y) poziomo. Jeżeli wybierze się więcej obiektów, to będą one przełączone 
zarówno indywidualnie jak i w stosunku do siebie. 

 Przełącz pionowo 
Wybrać jeden lub więcej obiektów; potem kliknąć w ten przycisk, żeby przełączyć 
obiekt(y) pionowo. Jeżeli wybierze się więcej obiektów, to będą one przełączone 
zarówno indywidualnie jak i w stosunku do siebie. 

 Spacjuj poziomo 
Wybrać co najmniej trzy obiekty; potem kliknąć w ten przycisk, żeby rozstawić 
obiekty poziomo w takiej samej odległości od siebie. 

 Spacjuj pionowo 
Wybrać co najmniej trzy obiekty; potem kliknąć w ten przycisk, żeby rozstawić 
obiekty pionowo w takiej samej odległości od siebie. 

 Taka sama wielkość 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, powodując że będą 
mieć taką samą wielkość. 

 Taka sama szerokość 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, powodując że będą 
mieć taką samą szerokość. 

 Taka sama wysokość 
Wybrać co najmniej dwa obiekty; potem kliknąć w ten przycisk, powodując że będą 
mieć taką samą wysokość. 

 Przywróć transformacje 
Odwraca każdą dokonaną zmianę, tzn. przywraca wybranemu obiektowi (obiektom) 
jego pierwotną wielkość lub orientację. 
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Grupowanie, scalanie lub dołączanie obiektów 

  

Można użyć paska narzędziowego Objects operations (operowania obiektami) lub 
menu Actions (działania), żeby zbierać obiekty w obszarze graficznym i utworzyć jeden obiekt, a także, 
żeby edytować węzły obiektów, albo ręcznie, albo przy użyciu zaawansowanych funkcji przetwarzania 
(patrz Edycja obiektów wektorowych). 
Funkcje zbierania są aktywne tylko wtedy, gdy więcej obiektów niż jeden jest wybranych w obszarze 
graficznym. 
Te narzędzia można stosować do wszystkich obiektów. Jednakże nie można scalać ani przecinać obrazów 
rastrowych. 

W szczególności: 

1. Narzędzia Group (grupuj) i Merge (scalaj) umożliwiają zbieranie obiektów, które zachodzą na siebie 
lub nie, w jeden obiekt, żeby można było przesuwać je lub transformować jako prupę. Pojedyncze 
obiekty zachowują swoje właściwości. Narzędzie Ungroup (rozgrupuj) może służyć do podzielenia 
zgrupowanego obiektu z powrotem na poszczególne obiekty. 

2. Narzędzia Union (jednoczenie), Intersection (część wspólna), Difference (różnica) 
i Exclusion (wykluczenie) umożliwiają zbieranie obiektów wektorowych, tak żeby tworzące wielokąty 
zostały scalone w nowy obiekt wektorowy. Wektory mozna edytować. Przycisk Undo (anuluj) może 
służyć do odwrócenia operacji. Właściwości wypełniania wynikowego obiektu są pobierane z 
pierwszego wybranego obiektu. Jeżeli tego wypełnienia nie można zastosować do wszystkich 
wybranych obiektów, bierze się je z następnego obiektu. Jeżeli żadne z tych wypełnień nie będzie 
możliwe, będzie to pierwsze z listy wspólnych wypełnień. Inne opcje są wyłączone przez interfejs 
użytkownika. 

Stosowanie narzędzi grupowania: 
 Wybrać więcej obiektów w obszarze graficznym. 

 Na pionowym pasku narzędziowym kliknąć w  , żeby wyświetlić poziomy pasek 
narzędziowy Objects operations (operacje na obiektach). 

 Wybrać żądany przycisk paska narzędziowego. (Wszystkie polecenia są także dostępne z 
menu Actions [działania]). W poniższej tabeli pokazano przykłady jak stosować narzędzia: 

Narzędzie grupowania Wynik 

W tym przykładzie mamy dwa zachodzące na siebie obiekty. Czarna gwiazda 
jest pierwszym wybranym obiektem. 
Przeciągamy myszą, żeby wybrać oba obiekty. 

 

 Wybór grupy 
W rezultacie dwie gwiazdy są zebrane w jeden obiekt, więc można je 
przesuwać lub transformować jako grupę. Pojedyncze obiekty zachowują swoje 
indywidualne właściwości, a także własne właściwości laserowe i wypełniania. 
Kontur nakładającego się obszaru będzie znakowany dwa razy. 
W celu rozebrania zgrupowanego obiektu na poszczególne obiekty należy użyć 

przycisku  (wybór rozgrupowania) , żeby każdy z nich można było 
przesuwać lub zmieniać indywidualnie.  



TWORZENIE UKŁADÓW GRAFICZNYCH 

 119
 

4
 

 Wybór scalania 
W rezultacie dwie gwiazdy są zebrane w jeden obiekt, więc można 
je przesuwać lub transformować jako grupę. Pojedyncze obiekty 
zachowują swoje indywidualne właściwości, z wyjątkiem 
właściwości laserowych i wypełniania. 
Ten przycisk można wyłączyć, jeżeli wybór zawiera obiekt rastrowy, 
tablicę lub jeżeli wypełnienia obiektów nie mają wspólnych 
akceptowalnych wartości. Scalony obiekt przyjmuje atrybuty 
wypełnienie i kontur zgodnie z tymi zasadami, w tej kolejności: 

o Wypełnienie i kontur pierwszego wybranego 
obiektu (czarna gwiazda), jeżeli wszystkie wybrane 
obiekty uwzględniają takie parametry. 

o Wypełnienie i kontur pierwszego obiektu z 
listy, którego parametry są na liście parametrów 
wspólnej części wszystkich obiektów. 

o Jeżeli żadne wypełnienie lub kontur już 
ustawione dla obiektów nie znajdują się na liście 
parametrów części wspólnej, a ta lista nie jest pusta, 
to stosuje się pierwsze wypełnienie z listy. 

Dane wektorowe, które tworzą obiekty, są scalone w jeden 
obiekt. W tym przypadku wspólny obszar nie będzie 
uwzględniony podczas grawerowania. 
W celu rozebrania zgrupowanego obiektu na poszczególne 

obiekty należy użyć przycisku  (wybór 
rozgrupowania) , żeby każdy z nich można było przesuwać 
lub zmieniać indywidualnie. 

 

 Jednoczenie 
W rezultacie dwa obiekty wektorowe są zebrane w jeden 
obiekt, tzn. tworzące je wielokąty są scalone w nowy obiekt 
wektorowy. Poszczególne obiekty tracą swoje własne 
właściwości. 
Nowy obiekt jest wektorowy: dwukrotnie kliknąć w niego, 
żeby wyświetlić węzły i pasek narzędziowy Edit 
nodes (edytuj węzły), który umożliwia edycję wektorów 
(bliższe informacje, patrz Edycja węzłów początkowych ). 
W celu rozebrania grupy trzeba albo użyć przycisku 

anuluj   z paska narzędziowego Union (jednoczenie) lub 
listy poleceń Undo/Redo (anuluj / ponów) . 

 

 Część wspólna 
W rezultacie obiekty są zebrane w jeden nowy obiekt 
wektorowy, którego wektory różnią się od wektorów, które 
tworzą pierwotne obiekty.  
Uwaga: Tylko obszar, który jest wspólny dla nakładających 
się obiektów, będzie brany pod uwagę przy grawerowaniu. 
Nowy obiekt jest wektorowy: dwukrotnie kliknąć w niego, 
żeby wyświetlić węzły i pasek narzędziowy Edit 
nodes (edytuj węzły), który umożliwia edycję wektorów 
(bliższe informacje, patrz Edycja węzłów początkowych ). 
W celu rozebrania grupy trzeba albo użyć przycisku 

anuluj   z paska narzędziowego Union (jednoczenie) 
albo listy poleceń Undo/Redo (anuluj / ponów) . 
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 Różnica 
W rezultacie obiekty są zebrane w jeden nowy obiekt 
wektorowy, którego wektory różnią się od wektorów, które 
tworzą pierwotne obiekty. 
Uwaga: Tylko kontur pierwszego wybranego obiektu minus 
obszar, który był dzielony z drugim obiektem, będzie 
znakowany. 
Nowy obiekt jest wektorowy: dwukrotnie kliknąć w niego, 
żeby wyświetlić węzły i pasek narzędziowy Edit 
nodes (edytuj węzły), który umożliwia edycję wektorów 
(bliższe informacje, patrz Edycja węzłów początkowych ). 
W celu rozebrania grupy trzeba albo użyć przycisku 

anuluj   z paska narzędziowego Union albo listy 
poleceń Undo/Redo (anuluj / ponów)  

 

 Wykluczenie 
W rezultacie dwa obiekty są zebrane w jeden nowy obiekt 
wektorowy, tzn. tworzące je wielokąty są scalone w nowy 
obiekt wektorowy. 
Uwaga: Wspólny obszar został usunięty. Będą znakowane 
kontury obu obiektów minus wspólny obszar. Z punktu 
widzenia grawerowania wynik jest taki sam jak dla scalania, 
ale ten obiekt jest wektorowy: dwukrotnie kliknąć w niego, 
żeby wyświetlić węzły i pasek narzędziowy Edit 
nodes (edytuj węzły), który umożliwia edycję wektorów 
(bliższe informacje, patrz Edycja węzłów początkowych ). 
W celu rozebrania grupy trzeba albo użyć przycisku 

anuluj   z paska narzędziowego Union albo listy 
poleceń Undo/Redo (anuluj / ponów) . 

 

Edycja obiektów wektorowych 

  
 

W grafice wektorowej obraz jest opisywany przez punkty, przez które przechodzą linie, tworząc formę konturu. 

Oprócz zmiany wielkości kształtu wektorowego przy użyciu uchwytów (patrz Użycie myszy do wyboru i manipulowania 
obiektami), można wprowadzić tryb edycji węzłów i przesuwać punkty kontrolne lub węzły, tak żeby zmienić kształty. 
(Patrz O węzłach i punktach kontrolnych). 

Edytor laserowy umożliwia dodawanie prostych obiektów wektorowych do układu (patrz Praca z prostymi obiektami 
wektorowymi) i dostarcza funkcję Make vectorial (przekształć na wektorowy), aby użytkownik mógł przekształcić 
dowolny ciag lub kod w obiekt czysto wektorowy. W ten sposób można edytować ich kształt przez manipulowanie 
punktami kontrolnymi i węzłami, albo używając myszy, albo paska nar4zędziowego Edit Nodes (edytuj węzły). 

Przy grawerowaniu laserowym grafika wektorowa jest szybsza do grawerowania i lepiej zdefiniowana w kategoriach linii 
konturowych i wypełnienia. Grafiki wektorowej nie można stosować do grawerowania fotografii cyfrowych. 

Patrz następne sekcje: 

1. O węzłach i punktach kontrolnych 

2. Przekształcanie obiektu na wektorowy 

3. Edycja węzłów początkowych 
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Uwaga: 
Jeżeli pracujesz z rozbudowanymi obiektami (np. importowane rysunki), rozważ użycie 

funkcji Przetwarzanie zaawansowane (przycisk  ), dostępnej także z 
menu Actions (działania), która zapewnia zautomatyzowany sposób edycji wektorów. 
Patrz Stosowanie zaawansowanych opcji przetwarzania. 

O węzłach i punktach kontrolnych 
Po dwukrotnym kliknięciu w obiekt wektorowy pojawiają się węzły jako małe kratki połączone zielonymi liniami. Wtedy 
można przeciągnąć węzeł lub edytować typ węzła przy użyciu paska narzędziowego Edit Nodes (edytuj węzły): np. 
można spowodować, że węzeł będzie symetryczny lub asymetryczny (patrz Edycja węzłów początkowych). Po 
wykonaniu tego, na węźle pojawi się linia z dwoma kółeczkami na końcach. Nazywają się one punktami kontrolnymi. 

Na poniższym rysunku pokazano przykład: 

  

Typ węzła determinuje zachowanie się linii łamanych przed i za węzłem. 
Należy zwrócić uwagę, że punkt kontrolny definiuje dwa punkty, przez które przechodzi linia łamana. Położenie punktów 
kontrolnych w stosunku do węzła definiuje typ węzła, z którym pracujesz (symetryczny, asymetryczny lub kątowy). 
Można przeciągnąć kółeczka, żeby zmienić kształt.  

Przekształcanie obiektu na wektorowy 
Ta funkcja umożliwia przekształcenie ciągu lub kodu w obiekt wektorowy, żeby można było wprowadzić tryb edycji 
węzłów i zmienić lub zdeformować ich kształt według potrzeb. Należy zwrócić uwagę, że kiedy ciąg zostanie 
przekształcony na wektorowy, to straci swoje specyficzne właściwości ciągu i stanie się obiektem czysto wektorowym. 

Przekształcanie obiektu na wektorowy: 
 Wybrać obiekt, który ma być przekształcony na wektorowy. (Można również operować na obiektach 

zgrupowanych.) 
 Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać Actions > Make vectorial (działania > przekształć na 
wektorowy). 

o Na pionowym pasku narzędziowym kliknąć w  , potem kliknąć w  (przekształć na 
wektorowy) na poziomym pasku narzędziowym. 

 W celu włączenia funkcji edycji węzłów należy kliknąć w przycisk edytuj węzły .  (lub dwukrotnie 
kliknąć w obiekt wektorowy). To spowoduje, że zostanie wyświetlony poziomy pasek narzędziowy  Edit 
nodes (edytuj węzły), a kolor linii zmieni się na zielony. 

 Kliknąć w obiekt, żeby wyświetlić mały kwadratowy uchwyt wierzchołkowy przy każdym wierzchołku granicy 
kształtu. Są to węzły, które można zastosować do edycji kształtu: 
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Edycja węzłów początkowych 
W celu edycji kształtów wektorowych trzeba przejść do trybu edycji węzłów. Robi się to na dwa sposoby: 

1. przez dwukrotne kliknięcie w obiekt wektorowy 

2. przez wybranie obiektu wektorowego, a następnie kliknięcie w przycisk edytuj węzły . .  

Można użyć myszy do przeciągnięcia węzłów lub można użyć paska narzędziowego Edit nodes (edytuj 
węzły), jak opisano poniżej. Bliższe informacje o sposobie przekształcania ciągu lub kodu na obiekt 
wektorowy, patrz sekcja Przekształcanie obiektu na wektorowy. 

Aby edytować węzły: 

1. Kliknąć w węzeł (węzły), żeby go wybrać.  

Wiele węzłów wybiera się przez przytrzymanie naciśniętego klawisza Ctrl i jednoczesne klikanie w 
węzły, które mają być wybrane. 

 
Wybranie wielu węzłów umożliwia jednoczesne ich przesuwanie. 

2. Poniższa tabela zawiera kilka przykładów użycia paska narzędziowego Edit nodes (edytuj węzły): 

Działanie Wynik 

Kliknąć w   (węzły kątowe), żeby utworzyć węzeł kątowy, tak żeby 
można było zarządzać osobno dwoma punktami kontrolnymi. 

 

Kliknąć w   (węzły asymetryczne), żeby utworzyć węzeł, który 
umożliwia zarządzanie indywidualnym punktem kontrolnym. Aby 
zmienić kształt, przeciągnąć punkt kontrolny. 

 

Kliknąć w   (węzły symetryczne), żeby utworzyć węzeł, który 
umożliwia jednoczesne i symetryczne przesuwanie dwóch punktów 
kontrolnych. Aby zmienić kształt, przesunąć punkt kontrolny. 
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Wybrać wiele węzłów i kliknąć w  (łącz węzły), żeby zarządzać nimi 
jak jednym węzłem. Kliknąć z dala od kształtu, żeby wrócić do 
pierwotnej sytuacji. 

 

Kliknąć w  (przerwij ścieżkę), żeby wziąć wybrany węzeł i rozbić na 
dwa w tym punkcie. Tam gdzie był jeden węzeł, teraz są dwa 
niepołączone węzły. Teraz węzły można przesuwać niezależnie od siebie. 

 

Wybrać dwa węzły i kliknąć w  (usuń ścieżkę), żeby usunać linię 
łamaną między nimi. 
Użyć przycisku Join segment (dołącz segment), żeby narysować linię 
łamaną łączącą dwa osobne węzły. 

 

3. Aby dodać węzeł do segmentu, należy dotąd wskazywać granicę segmentu aż wskaźnik zmieni się 
w krzyżyk, a wtedy dwukrotnie w niego kliknąć. 

 

4. Aby usunąć węzeł, należy kliknąć w niego i nacisnąć klawisz Delete (usuń). 

5. Kliknąć w przycisk  (wstaw obiekty), żeby zamknąć tryb operacyjny edycji węzłów. 
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Zbliżanie 

  

 

Zmiana wielkości obrazu umożliwia wyświetlanie całego obszaru graficznego na ekranie lub znacznie 
powiększonego szczegółu danej części. Maksymalna zmiana wielkości obrazu zależy od rozdzielczości 
ekranu i wymiarów obszaru graficznego. 

Do zmiany wielkości obiektów można użyć paska narzędziowego Zoom dynamic (zbliżanie dynamiczne) 
lub menu View (widok) edytora laserowego. 

Powiększanie lub zmniejszanie obiektów w obszarze graficznym: 

1. Na pionowym pasku narzędziowym kliknąć w przycisk   (zmień wielkość obrazu). Wyświetlany 
jest poziomy pasek narzędziowy zmiany wielkości obrazu. 

2. Za pomocą przycisków paska narzędziowego zmień wielkość obrazu zgodnie z wymaganiami: 

1. Aby stopniowo zwiększać obszar roboczy, należy użyć przycisku  (powiększ) tyle razy 

ile się chce. Użyć przycisku  (zmniejsz), żeby stopniowo zmniejszać wielkość obrazu. 

2. Aby zmienić wielkość pewnego elementu, wybrać go, a potem kliknąć w przycisk 
 (wybór) . Ten przycisk jest niedostępny, jeżeli nie wybierze się żadnego obiektu w 
obszarze graficznym. 

3. Aby powrócić do widoku standardowego, kliknąć w  (strona). 

4. Aby zmienić wielkość określonego obszaru na rysunku, kliknąć w przycisk  (okno), a 
potem śledzić prostokątne okno wokół obwodu. Edytor laserowy ustawia poziom zmiany 
wielkości więc okno wypełnia specyficzny prostokąt. 
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Określanie wzorów wypełniania 
Dla obiektów można określić różne wzory wypełnienia, tzn. wypełnianie obiektu liniami wypełniacza. Do tego 
celu wykorzystuje się właściwości Filling (wypełnianie) w oknie Properties (właściwości) obiektów. 
(Patrz Właściwości  wypełniania dla obiektów). 

Na poniższym rysunku pokazano przykłady: 

 

 

 

Uwagi: 
 Właściwości wypełniania nie mają zastosowania do tablic ani do importowanych 
obrazów rastrowych. 

Ustawianie właściwości wypełniania: 
1. Wybrać obiekt w obszarze graficznym. Właściwości dla obiektu są wyświetlane w 

oknie Properties (właściwości). 

2. Z rozwijanej w dół listy właściwości Filling (wypełnianie) wybrać żądany wzór. (Domyślnie ta wartość 
jest ustawiona na None, (żadne), co oznacza, że dla obiektu nie ustawiono żadnego wypełnienia). 

3. Więcej właściwości jest wyświetlonych poniżej, żeby umożliwić dostosowanie wzoru wypełnienia. 
Pełny opis każdej właściwości, patrz sekcja Właściwości wypełniania dla obiektów . 
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Ustawianie początku obiektu 
Początek jest punktem, który definiuje położenie obiektu w obszarze grawerowania. Ten początek odnosi się 
do punktu początkowego obszaru grawerowania dokumentu (patrz Właściwości geometryczne - 
dokument płaski, właściwość Origin (początek). 

Początek jest przedstawiany symbolem krzyżyka : Domyślnie, ten symbol jest umieszczony w środku 
obiektu. 

Edytor laserowy umożliwia zmianę tej właściwości dla dowolnego obiektu, żeby uzyskać lepsze 
dopasowanie do specjalnych wymagań grawerowania. 

Aby ustawić początek obiektu: 

1. Wybrać obiekt w obszarze roboczym, dla którego trzeba ustawić punkt początkowy, inny niż 
 Środek. 

2. W oknie Properties (właściwości), pod Geometry (geometria) wybrać żądaną wartość z rozwijanej 
w dół listy Origin (początek). 

3. Należy zwrócić uwagę, że symbol krzyżyka przesuwa się odpowiednio. Poniższy przykład pokazuje 
obiekt, którego początek został ustawiony  na środku u góry w dokumencie, którego punkt 
początkowy jest ustawiony w środku: 

 

4. Można określić położenie obiektu przez ustawienie współrzędnych X i Y . (Opis każdej właściwości, 
patrz Właściwości geometryczne obiektów ). 
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Optymalizacja kolejności znakowania obiektów 
Edytor laserowy ma funkcję, która automatycznie ustawia kolejność znakowania obiektów, które tworzą 
układ, w celu optymalnego wykonania. 

Innymi słowy, system porządkuje obiekty do grawerowania, żeby zminimalizować ścieżkę laserową między 
obiektami, co powoduje skrócenie czasu znakowania. 

Aby zoptymalizować kolejność grawerowania obiektów: 
1. Kiedy utworzony układ jest gotowy do grawerowania (patrz Tworzenie układów graficznych), należy 

wykonać jedną z poniższych czynności. 

o Z paska menu edytora laserowego wybrać Actions > Marking order (działania > kolejność 
znakowania). 

o Na pionowym pasku narzędziowym kliknąć  (reguluj), a potem kliknąć w 
 (kolejność znakowania) na poziomym pasku narzędziowym. 

2. Wyświetla się okno Optimizing marker order (optymalizacja kolejności markerów) pokazujące 
postęp operacji. 

3. Należy zwrócić uwagę, że po zakończeniu zmieniła się kolejność obiektów w okienku Objects 
engraving order (kolejność grawerowania obiektów). Patrz rysunek poniżej: 
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Obliczanie czasu znakowania 
Edytor laserowy umożliwia obliczenie czasu znakowania układu graficznego, tzn. jak długo potrwa operacja 
znakowania. 

Czas znakowania jest zdeterminowany poziomem szczegółu, który został dodany do obiektów, które tworzą 
układ. Jeżeli nie można przekroczyć konkretnego czasu znakowania, należy rozważyć usunięcie niektórych 
szczegółów. 

 

Uwaga: 
Należy pamiętać, że jest to wartość przybliżona, która ma jedynie pomóc w obliczeniu czasu. 
Rzeczywisty czas znakowania zależy także od konkretnego urządzenia, które jest stosowane, 
a także od jego ustawień. 
Aby obejrzeć ostateczne wyniki znakowania oprócz obliczenia czasu znakowania, 
patrz Podgląd znakowania. 

Aby obliczyć czas znakowania: 
1. Stworzyć układ grawerowania (patrz Tworzenie układów graficznych). 

2. Możliwe są dwa scenariusze: 

o Jeżeli czas znakowania dla układu jest krótszy niż 30 sekund, to przycisk czas znakowania 
na pasku narzędziowym automatycznie pokazuje spodziewany czas. Na przykład: 

 

o Jeżeli czas znakowania dla układu przekracza 30 sekund, to w celu obliczenia 

przewidywanego czasu trzeba kliknąć w przycisk  . 

Podgląd znakowania 
Funkcja Mark preview (podgląd znakowania) umożliwia sprawdzenie ostatecznego wyniku procesu 
znakowania układów użytkownika bezpośrednio w edytorze laserowym. 

Po wybraniu tej opcji, okno Mark preview (podgląd znakowania) pokazuje zarówno linie, które laser będzie 
w rzeczywistości wykonywać według wypełnienia określonego przez użytkownika, jak i czas znakowania. W 
ten sposób można precyzyjnie sprawdzić czas, który proces zajmie oraz wynik, który zostanie uzyskany, np. 
jeżeli są umieszczane w równym oddaleniu od siebie. 

Funkcja przeciągnij i upuść umożliwia przesuwanie obiektów układu po obszarze roboczym. 

 

Uwaga: 
Obiekt z funkcjonalnością podglądu znakowania jest dostępny także na poziomie wykonania 
skryptu. Programiści mogą stworzyć swój własny interfejs użytkownika obejmujący podgląd 
dokumentu, który ma być grawerowany. Bliższe informacje znajdują się w dokumentacji online 
edytora projektu, rozdział „Language reference”. 
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Podgląd znakowania: 

 Stworzyć układ. (Patrz Tworzenie układów graficznych). 

Poniżej pokazano przykład obiektu typu ciąg: 

 

Należy zwrócić uwagę, że zastosowano właściwość Cross lines Filling (wypełnianie krzyżujących 
się linii 

 Wykonać jedną z następujących czynności: 
o Z menu File (plik) wybrać Mark preview (podgląd znakowania). 

o Na standardowym pasku narzędziowym edytora laserowego kliknąć w przycisk 
 (podgląd znakowania), który jest udostępniony po otwarciu lub utworzeniu dokumentu. 

Wyświetla się następujące okno: 

 

Okno Mark preview (podgląd znakowania) pokazuje dokładnie jak będą znakowane linie. 

 Można użyć paska zbliżania po prawej stronie, żeby bardziej szczegółowo sprawdzić wyniki, a 
funkcji przeciągnij i upuść, żeby przesuwać elementy. 

 W razie potrzeby można edytować układ, żeby osiągnąć pożądany rezultat. 
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5- WYKONANIE OPERACJI GRAWEROWANIA 

Ten rozdział jest podzielony na następujące sekcje: 

Temat Więcej 
Ustawianie własnych parametrów lasera 

 Stosowanie kilku przejść grawerujących 
 Stosowanie funkcji bicia wzdłużnego do grawerowania grubszych linii 

Kliknij tutaj 

Wyświetlanie granic śledzenia Kliknij tutaj 
Symulacja operacji znakowania Kliknij tutaj 
Podłączenie do urządzenia laserowego Kliknij tutaj 
Wysyłanie układu do znakowania 

1. Tryb automatyczny vs. tryb ręczny Kliknij tutaj 
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Ustawianie własnych parametrów lasera 
Parametry grawerowania muszą być ustawione przed grawerowaniem układu graficznego. Prawidłowe 
parametry grawerowania mają zasadnicze znaczenie dla zapewnienia jakości grawerowania. Przy 
ustawianiu parametrów lasera należy uwzględnić stosowane źródło laserowe, materiał, który będzie 
znakowany i wymagany proces. 

Parametry grawerowania mogą być takie same dla wszystkich obiektów graficznych: domyślnie, każdy 
obiekt graficzny wykorzystuje parametry laserowe dokumentu. Jednak można ustawić inne parametry 
laserowe dla każdego obiektu; to spowoduje, że kolor obiektu zmieni się na niebieski. 

Aby ustawić właściwości lasera dla wszystkich obiektów: 
1. Stworzyć lub otworzyć dokument (patrz O dokumentach). Upewnić się, że w obszarze roboczym nie 

jest wybrany żaden obiekt. 

2. W oknie Properties (właściwości), pod Geometry (geometria), ustawić wymagane Laser 
properties (właściwości lasera). Informacje o sposobie ustawiania parametrów, patrz 
sekcja Właściwości laserowe dla dokumentów . 

Aby ustawić właściwości lasera dla poszczególnych obiektów: 
1. Wybrać obiekt(y) w dokumencie. Patrz O obiektach graficznych). 

2. W oknie Properties (właściwości) ustawić właściwość Custom Laser (własny laser) na True . 

3. Właściwości, które się pojawią, ustawić według wymagań. Informacje o sposobie ustawiania 
parametrów, patrz sekcja Własne parametry laserowe dla obiektów . 

Należy zwrócić uwagę, że po edycji kolor obiektu zmieni się na niebieski. 

Bliższe informacje, patrz: 

 Stosowanie kilku przejść grawerujących 

 Stosowanie funkcji bicia wzdłużnego do grawerowania grubszych linii 

Stosowanie kilku przejść grawerujących 
Właściwości Laser umożliwiają ustawienie liczby przejść światła laserowego po obiekcie w celu 
wygrawerowania. Można ustawić do 3 przejść, a każde z innymi parametrami laserowymi. 

Ta opcja może być szczególnie przydatna w celu wykonania kilku przejść grawerujących światła, żeby 
oczyścić przedmiot obrabiany po ostrzejszym procesie grawerowania. 

 

Ostrzeżenie: 
Upewnić się, że wybrane parametry są najlepsze dla stosowanego materiału i wymaganego 
rodzaju procesu. Aby wykonać dobre przejście czyszczące, prędkość musi być taka sama jak 
przy przejściu grawerującym. 

Aby ustawić więcej przejść: 
1. Kliknąć w pusty obszar na dokumencie (aby ustawić parametry dla wszystkich obiektów (patrz Aby 

ustawić właściwości lasera dla poszczególnych obiektów:). 

2. W oknie Properties (właściwości), pod Laser (lub Custom Laser (własny laser), wybrać liczbę 
przejść (Passages), tzn. liczbę przebiegów światła laserowego (od 1 do 3). Będą wyświetlane 
parametry dla każdego przejścia co umożliwi ustawienie innych parametrów. 

3. W razie potrzeby ustawić inne parametry. Informacje o sposobie ustawiania parametrów, patrz 
sekcja Własne parametry laserowe dla obiektów . 
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Stosowanie funkcji bicia wzdłużnego do grawerowania grubszych linii 
Funkcja bicia wzdłużnego jest wbudowana w edytor laserowy i umożliwia grawerowanie pojedynczych linii 
grafiki wektorowej, albo znaków True Type albo importowanych rysunków, za pomocą grubszych linii. 

Zwykle grubość linii odpowiada wymiarowi plamki laserowej. Jeżeli trzeba zwiększyć tę grubość, można użyć 
funkcji bicia wzdłużnego. 

Dwa poniższe rysunki przedstawiają zasadę działania bicia wzdłużnego: 

Rysunek po lewej pokazuje wynik grawerowania wektora przy wyłączonym biciu wzdłużnym, natomiast 
rysunek po prawej pokazuje taki sam wektor, ale przy włączonym biciu wzdłużnym: 

 

Przekształcenie wektora w gęstą spiralę zapewnia większą grubość grawerowanej linii. 

Aby włączyć funkcję bicia wzdłużnego: 

 

Uwaga: 
Aby uzyskać pożądany efekt, trzeba przetestować i sprawdzić parametry 
konfiguracyjne funkcji bicia wzdłużnego. Czasy grawerowania za pomocą funkcji 
bicia wzdłużnego są dłuższe; funkcję bicia wzdłużnego należy stosować tylko wtedy, 
gdy jest to absolutnie konieczne. 

Funkcję bicia wzdłużnego można włączać albo na poziomie dokumentu, albo na poziomie obiektu. W tym 
celu można użyć właściwości Laser (lub Custom Laser [własny laser]) > Wobble (bicie wzdłużne). 

1. Aby włączyć funkcję bicia wzdłużnego, należy wykonać jedną z następujących czynności: 

o Stworzyć lub otworzyć dokument (patrz O dokumentach), a potem w 
oknie Properties (właściwości), pod Laser, ustawić właściwość Wobble (bicie wzdłużne) 
na True . Będzie ustawienie domyślne dla wszystkich obiektów dodawanych do dokumentu. 

o Wybrać obiekt (patrz O obiektach graficznych); potem, w oknie Properties (właściwości) 
ustawić na True właściwość Custom Laser (własny laser), a potem 
właściwość Wobble (bicie wzdłużne). 

2. Określić wartość dla właściwości Radius (promień), tzn. promień krzywej spiralnej, która będzie 
stosowana. 

3. Określić wartość dla właściwości Speed (prędkość), tzn. częstotliwość powtarzania spirali. 

4. Użyć narzędzia Symulator, żeby zweryfikować rezultat funkcji bicia wzdłużnego: z paska menu 
edytora laserowego wybrać Laser > Simulator: 
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Należy zwrócić uwagę, że znak pojedynczej linii ma dużo grubszy kontur. Taki sam rezultat zostałby 
uzyskany przy rzeczywistym grawerowaniu. 
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Wyświetlanie granic  
Ta funkcja odnosi się do wyświetlania marginesów rysunku na płaszczyźnie roboczej. Marginesy są 
wyświetlane przy użyciu czerwonego wskaźnika laserowego. 

Funkcja Granice wyświetla ramkę brzegową obiektu (obiektów), który będzie grawerowany: ten rezultat 
uzyskuje się przez takie prowadzenie skanerów, żeby przesuwały się wzdłuż ścieżki ramki z dużą 
szybkością. 

W celu zastosowania tej funkcji trzeba być podłączonym do urządzenia i musi być uaktywniony tryb ręczny. 
W trybie automatycznym ta funkcja jest niedostępna (patrz Tryb automatyczny vs. tryb ręczny). 

 

Uwaga: 
Bliższe informacje o parametrach wskazywania laserowego, które służą do wyświetlania granic 
grawerowania, patrz Ustawianie parametrów celowania. 
Te funkcje są także dostępne na poziomie interfejsu mechanizmu laserowego poprzez przyciski 
menu  (granice początkowe) i  (granice poprzedniego / następnego sektora) . 
Bliższe informacje, patrz Interfejs użytkownika mechanizmu laserowego. 

Aby wyświetlić granice: 

1. Upewnij się, że jesteś podłączony do urządzenia (patrz Podłączenie do urządzenia laserowego) oraz 
że uaktywniłeś tryb ręczny (w przeciwnym razie przyciski Granice są niedostępne). W celu 
aktywacji należy wykonać jedną z następujących czynności: 

o Wybrać  (przełącz na tryb ręczny) na pasku narzędziowym. 

o Z paska menu edytora laserowego wybrać Laser > Switch to Manual Mode (laser > 
przełącz na tryb ręczny). 

 

Uwaga: 
Jest to przycisk dwustabilny: jeżeli jest uaktywniony tryb ręczny, etykieta narzędzia  mówi „przełącz 
na tryb automatyczny” i odwrotnie. 

2. Wykonać jedną z następujących czynności: 

o Aby zobaczyć granice grawerowania dla jednego lub kilku konkretnych obiektów, wybrać 
obiekt(y) i kliknąć w   (granice do wyboru) na pasku narzędziowym. (Alternatywnie, 
wybrać Laser > Limits on selection (laser > granice do wyboru) z paska menu). 

o Aby zobaczyć granice grawerowania dla całego obszaru graficznego, kliknąć w 
  (wszystkie granice) na pasku narzędziowym. (Alternatywnie, wybrać Laser > Limits 
all (laser > wszystkie granice) z paska menu). 

o Aby zobaczyć granice grawerowania dla  sektorów, które tworzą obiekt przy grawerowaniu 
na dokumencie pierścieniowym, należy kliknąć w przyciski  (granice poprzedniego 
sektora) i (granice następnego sektora) na pasku narzędziowym. Te przyciski stają się 
dostępne (zabarwione na zielono) po naciśnięciu przycisku Granice do wyboru lub 
Wszystkie granice. (Alternatywnie, wybrać Laser > Limits next sector (laser > granice 
następnego sektora i Limits previous sector (laser > granice poprzedniego sektora) z 
paska menu). 
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Poniższy przykład pokazuje jak powinny wyglądać granice dla ściętego słowa (Editor). 

 

Tematy pokrewne: 

 Ustawianie własnych parametrów lasera 

 Symulacja operacji znakowania 

 Podłączenie do urządzenia laserowego 

 Wyślij znakowanie 
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Symulacja operacji znakowania 
Edytor laserowy może służyć do symulacji wyników grawerowania, tzn. po skończeniu tworzenia układu można 
przetestować grawerowanie poprzez symulator graficzny, przed wysłaniem go do urządzenia w celu znakowania. 

 

 Wskazówka: 
Aby zweryfikować ostateczny rezultat swojego układu, a także czas znakowania, można zastosować 
funkcję podglądu znakowania (menu File > Mark preview [plik > podgląd znakowania]). Bliższe 
informacje, patrz Podgląd znakowania. 

Jeżeli nie jesteś podłączony do urządzenia, to naciśnięcie F5 czyli Wyślij Znakowanie (które w przeciwnym razie 
rozpoczęłoby grawerowanie laserowe) powoduje wyświetlenie okna graficznego, które symuluje operację grawerowania. 
Symulacja zachowuje wszystkie parametry ustawione w dokumencie, czyli prędkość, wypełnienie, bicie wzdłużne lub 
inne parametry. 

 

Uwaga: 
Symulację można przeprowadzić tylko w trybie ręcznym. IW trybie automatycznym ta funkcja nie jest 
dostępna, a grawerowaniem laserowym zarządza się automatycznie poprzez mechanizm laserowy 
(patrz Tryb automatyczny vs. tryb ręczny). Należy zwrócić uwagę, że kiedy w trybie automatycznym 
naciśnie się przycisk Symulacja, to oznacza, że urządzenie pracuje w symulacji. 

Aby symulować grawerowanie: 
1. Upewnić się, że jest aktywny tryb ręczny. W celu aktywacji należy wykonać jedną z następujących czynności: 

o Wybrać  (przełącz na tryb ręczny) na pasku narzędziowym edytora laserowego. 
o Z paska menu edytora laserowego wybrać Laser > Switch to Manual Mode (laser > 

przełącz na tryb ręczny). 

Uwaga: Jest to przycisk dwustabilny: jeżeli jest uaktywniony tryb ręczny, etykieta narzędzia  mówi 
„przełącz na tryb automatyczny” i odwrotnie. 

2. Możliwe są dwa scenariusze: 

o Jeżeli nie jesteś podłączony do urządzenia, to naciśnięcie F5 (lub kliknięcie w  (wyślij 
znakowanie)) automatycznie uaktywni symulator. 

o Jeżeli jesteś podłączony do urządzenia, to przycisk  (symulator) jest włączony i trzeba go 
nacisnąć (lub wybrać Laser > Simulator z paska menu), żeby uaktywnić symulator graficzny. 

Na poniższym rysunku pokazano przykład: 
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3. Aby przerwać symulację znakowania, należy użyć przycisku  (zatrzymaj znakowanie) (lub 
wybrać Laser > Stop Marking (laser > zatrzymaj znakowanie) z paska menu). 

Tematy pokrewne: 

 Ustawianie własnych parametrów lasera 

 Wyświetlanie granic 

 Podłączenie do urządzenia laserowego 

 Podgląd znakowania 

 Wyślij znakowanie 
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Podłączenie do urządzenia laserowego 

 

Uwaga: 
Poniższa procedura podłączania odnosi się tylko do użytkowników, którzy mają instalację 
programu nadzorczego edytora laserowego. (Bliższe informacje, patrz sekcja Rodzaje 
instalacji i tryby podłączania). 

W edytorze laserowym, urządzenie laserowe, które jest stosowane do znakowania  układów graficznych, jest 
zarządzane przez interfejs mechanizmu laserowego i może być albo lokalne, w przypadku autonomicznego 
rozwiązania znakowania, albo zdalne, w przypadku bezobsługowego rozwiązania znakowania, zwykle na 
linii produkcyjnej. 

W szczególności, tryb podłączenia (lokalny lub zdalny) zależy od rodzaju posiadanej instalacji: 

 Jeżeli masz bezobsługową instalację programu nadzorczego edytora laserowego, możesz użyć 
procedury, która jest opisana poniżej, żeby zdalnie podłączyć się do mechanizmu laserowego, pod 
warunkiem, że włączone jest sterowanie zdalne. (Patrz Sterowanie lokalne / zdalne). 

 Jeżeli masz autonomiczną instalację (bez sterowania zdalnego), możesz uzyskać dostęp tylko do 
interfejsu mechanizmu laserowego, który steruje lokalnym urządzeniem. Przyciski Podłącz do 
urządzenia edytora laserowego, które są opisane w poniższej procedurze, nie są dostępne dla tego 
typu instalacji. 

Więcej informacji o stosowaniu interfejsu mechanizmu laserowego, patrz Interfejs użytkownika 
mechanizmu laserowego. 

Aby ustawić swoją zaporę (Windows Firewall), tak żeby umożliwić zdalne 
podłączenie: 
Ta operacja jest wymagana w celu umożliwienia zdalnej komunikacji między edytorem laserowym a 
mechanizmem laserowym. Obejmuje ona prawidłowe ustawienie Windows Firewall: 

1. Kliknąć w Start, kliknąć w Control Panel (pulpit operatora), a potem dwukrotnie kliknąć w Windows 
Firewall. 

2. Wybrać zakładkę Exceptions (wyjątki), a potem kliknąć w Add Port (dodaj port). 
3. W ramce Port number (numer portu) wpisać 4659, a potem kliknąć w OK. 
4. Powtórzyć krok 3, ale wpisać 4657 w celu otwarcia portu dla transferu plików i danych binarnych. 

Aby podłączyć do urządzenia: 
1. Wykonać jedną z następujących czynności: 

o Z paska menu edytora laserowego wybrać Laser > Connect to device (laser > podłącz do 
urządzenia). 

o Na pasku narzędziowym kliknąć w  Connect to device (podłącz do urządzenia). 
2. W wyświetlonym oknie Connect to device (podłącz do urządzenia) wybrać urządzenie, które ma 

być podłączone. 

Należy zwrócić uwagę, że są wymienione wszystkie dostępne urządzenia, zarówno lokalne jak i 
zdalne. W przypadku urządzenia zdalnego wyświetla się także adres IP . 

3. Kliknąć w OK. Należy zwrócić uwagę, że pasek stanu edytora laserowego pokazuje zarówno stan 
połączenia jak i informacje o podłączonym urządzeniu. 

Tematy pokrewne: 
 Symulacja operacji znakowania 
 Wyślij znakowanie 
 INTERFEJS UŻYTKOWNIKA  MECHANIZMU LASEROWEGO 
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Wyślij znakowanie 
Edytor laserowy umożliwia wysyłanie układu graficznego do znakowania na dwa sposoby: 

 W trybie ręcznym - przez naciśnięcie F5 (lub wybranie Laser > Send Marking [laser > wyślij 
znakowanie]),żeby wysłać układ. Przez naciśnięcie F9 lub kliknięcie w  (lub wybranie Laser > 
Send Marking on selection [laser > wyślij wybrane znakowanie]), żeby wysłać wybrany obiekt. 
Jeżeli pracujesz na autonomicznym urządzeniu znakującym i współdziałasz bezpośrednio z 
urządzeniem laserowym, możesz albo użyć symulatora, żeby przetestować układ, albo wysłać go do 
znakowania. (Patrz Symulacja operacji znakowania). 

 W trybie automatycznym - przez zapisanie układów graficznych w urządzeniu. Następnie układy 
będą wysłane do znakowania na podstawie programów stworzonych za pośrednictwem edytora 
projektów. 

 

Uwaga: 
Funkcje opisane w tej sekcji są również dostępne poprzez interfejs mechanizmu laserowego. Bliższe 
informacje, patrz rozdział Interfejs użytkownika mechanizmu laserowego. 

Tryb automatyczny vs. tryb ręczny 
Lighter ma różne tryby robocze: 

 Tryb automatyczny 
 Tryb pracy 
 Tryb ręczny 

Tryb automatyczny 
 W trybie automatycznym dokument lub projekt zapisany w urządzeniu jest przetwarzany i wysyłany do pulpitu operatora 
lasera w oczekiwaniu na zewnętrzne sygnały we/wy, żeby rozpocząć proces znakowania.  

Kiedy mechanizm laserowy uruchamia się w trybie automatycznym, dokument lub projekt, który jest zapisany w 
urządzeniu i który jest ustawiony jako dokument domyślny, jest automatycznie przetwarzany i wysyłany  do pulpitu 
operatora lasera w oczekiwaniu na zewnętrzne sygnały we/wy, żeby rozpocząć proces znakowania.  

Tryb automatyczny jest szczególnie przydatny w środowiskach pracy, gdzie:  

 do stanowiska grawerowania nie jest przydzielony żaden operator; 
 proces znakowania jest zautomatyzowany przy użyciu zewnętrznego sterownika programowalnego. 

Należy zwrócić uwagę, że w celu zastosowania edytora laserowego do interakcji z urządzeniem laserowym, tj. 
ustawienia parametrów konfiguracyjnych lasera lub wysłania dokumentów bezpośrednio do znakowania, trzeba 
przełączyć się na tryb ręczny.  

Zachowanie  
Zwykle w tym trybie można wykonać następujące operacje:  

 Wybrać projekt lub dokument do znakowania przy użyciu mechanizmu laserowego. 

 Nacisnąć przycisk trybu automatycznego  w mechanizmie laserowym. 
 Użyć zewnętrznych sygnałów we/wy do rozpoczęcia procesu znakowania; 

Tryb pracy 
W trybie pracy dokument aktualnie otwarty w edytorze laserowym jest tymczasowo zapisany w urządzeniu, 
przetwarzany i wysyłany do pulpitu operatora lasera w oczekiwaniu na zewnętrzne sygnały we/wy, żeby 
rozpocząć proces znakowania.  

Tryb pracy jest szczególnie przydatny w środowiskach pracy, gdzie:  
 do stanowiska grawerowania jest przydzielony operator; 
 edytor laserowy służy do do wyboru i modyfikacji dokumentów; 
 zewnętrzne sygnały we/wy służą do rozpoczęcia procesu znakowania; 

Należy zwrócić uwagę, że w celu zastosowania edytora laserowego do interakcji z urządzeniem laserowym, 
tj. ustawienia parametrów konfiguracyjnych lasera lub wysłania dokumentów bezpośrednio do znakowania, 
trzeba przełączyć się na tryb ręczny.  
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Zachowanie 
Zwykle w tym trybie można wykonać następujące operacje: 

 Otworzyć projekt lub dokument do znakowania przy użyciu edytora laserowego. 
 W razie potrzeby, przed znakowaniem wykonać operację edycji lub testowania. 

 Nacisnąć przycisk trybu pracy  w edytorze laserowym. 
 Użyć zewnętrznych sygnałów we/wy do rozpoczęcia procesu znakowania; 
 W takich środowiskach pracy jak linia produkcyjna, po wyborze dokumentu można uaktywnić tryb 

automatyczny, żeby umożliwić zewnętrzne uruchomienia ze sterownika programowalnego. 

Tryb ręczny 
W trybie ręcznym operator ma pełną kontrolę nad procesem znakowania i nie są przyjmowane żadne 
zewnętrzne sygnały we/wy.  

Tryb ręczny jest szczególnie przydatny w środowiskach pracy, gdzie:  
 do stanowiska grawerowania jest przydzielony operator; 
 edytor laserowy służy do do wyboru i modyfikacji dokumentów; 
 żadne zewnętrzne sygnały we/wy nie są stosowane do rozpoczęcia procesu znakowania; 

Zwróć uwagę, że musisz aktywować tryb ręczny w celu stworzenia i przetestowania układu zanim zapiszesz 
go w urządzeniu lub jeżeli chcesz zmienić parametry konfiguracyjne lasera.  

Symulacja grawerowania i operacje testowania są dostępne tylko w trybie ręcznym.  

Zachowanie  

Zwykle w tym trybie można wykonać następujące operacje:  

 Otworzyć projekt lub dokument do znakowania przy użyciu edytora laserowego. 
 W razie potrzeby, przed znakowaniem wykonać operację edycji lub testowania. 

 Nacisnąć przycisk wyślij znakowanie  w edytorze laserowym. 
 W takich środowiskach pracy jak linia produkcyjna, po wyborze dokumentu można uaktywnić tryb 

automatyczny, żeby umożliwić zewnętrzne uruchomienia ze sterownika programowalnego. 

W celu przełączenia się na tryb automatyczny, jeżeli jest uaktywniony tryb ręczny: 

 Wybrać Laser > Switch to Auto Mode (laser > przełącz na tryb automatyczny) na pasku menu. 

lub 

 Kliknąć w  (przełącz na tryb automatyczny) na pasku narzędziowym. 

Wysyłanie układu do znakowania 
Aby wysłać układ bezpośrednio do znakowania: 

1. Upewnić się, że jest aktywny tryb ręczny. W celu przełączenia się na ten tryb należy wykonać jedną 
z następujących czynności: 

o Wybrać Laser > Switch to Manual Mode (laser > przełącz na tryb ręczny) na pasku menu 
edytora laserowego. 

o Kliknąć w  (przełącz na tryb ręczny) na pasku narzędziowym. 

2. Nacisnąć F5 lub kliknąć w  (wyślij znakowanie) na pasku narzędziowym. (Alternatywnie, 
wybrać Laser > Send Marking (laser > wyślij znakowanie) z paska menu). 
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Ważna uwaga: 
Jeżeli nie jesteś podłączony do urządzenia laserowego, to zamiast tego automatycznie 
uaktywni się symulator graficzny. (Patrz Symulacja operacji znakowania). 

3. Aby przerwać znakowanie laserowe lub symulację, należy użyć przycisku  (zatrzymaj 
znakowanie) na pasku narzędziowym (lub wybrać Laser > Stop Marking (laser > zatrzymaj 
znakowanie) z paska menu). 

Aby zapisać układ w urządzeniu, do kolejnego znakowani: 
1. Z paska menu edytora laserowego wybrać File > Save to Device (plik > zapisz w urządzeniu) lub 

nacisnąć  na pasku narzędziowym. 
2. W wyświetlonym oknie Save document as (zapisz dokument jako), z rozwijanej w dół 

listy Devices (urządzenia) wybrać urządzenie, do którego układ jest przesyłany. 
3. Wprowadź nazwę dla dokumentu i kliknąć w OK. Jest to nazwa, która będzie stosowana w edytorze 

projektu, żeby zapisać program w celu przesłania dokumentu i wysłania go do grawera w 
zautomatyzowany sposób. 

 

Uwaga: 
 Edytor projektu jest to narzędzie zintegrowane z edytorem laserowym, które umożliwia 
tworzenie dostosowanych programów. Aby uzyskać dostęp do niego, należy wybrać File > 
Project Editor (plik > edytor projektów). To narzędzie ma własną pomoc kontekstową i 
służy do automatyzacji procedur znakowania lub aktualizacji zawartości układu podczas 
wykonania. To narzędzie zapewnia domyślne programy i łatwe do zastosowania przykłady. 
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6- INTERFEJS UŻYTKOWNIKA  MECHANIZMU 
LASEROWEGO 

W tym rozdziale opisano sposób stosowania mechanizmu laserowego, który jest aplikacją dostarczaną 
razem z edytorem laserowym i umożliwia operowanie urządzeniem laserowym. 

Interfejs umożliwia podglądanie jak będzie znakowany dokument lub projekt, który był zapisany w 
urządzeniu, a także wykonywanie wielu innych operacji precyzyjnego dostrajania przed znakowaniem. 

Mechanizm laserowy może być zainstalowany z edytorem laserowym lub niezależnie, a dostępne przyciski 
lub funkcje mogą się różnić w zależności od typu instalacji, którą użytkownik wybrał podczas instalacji 
edytora laserowego. Bliższe informacje, patrz Rodzaje instalacji i tryby podłączania. 

Bliższe informacje: 

Temat Patrz 
Uruchamianie mechanizmu laserowego Kliknij tutaj 
Przegląd interfejsu użytkownika mechanizmu laserowego: 

 Elementy głównego okna 
 Przyciski menu 
 Polecenia menu skrótów 

Kliknij tutaj 

Zarządzanie użytkownikami i prawami dostępu. Kliknij tutaj 
Stosowanie funkcji zmiennych globalnych Kliknij tutaj 
Przełączanie między trybami roboczymi (lokalny / zdalny lub automatyczny / ręczny) Kliknij tutaj 
Konfigurowanie parametrów urządzenia laserowego Kliknij tutaj 

Stosowanie funkcji „znakowanie w trakcie działania programu”, żeby znakować obiekty 
w ruchu 

Kliknij tutaj 

Wyświetlanie granic śledzenia Kliknij tutaj 
Zarządzanie osią i wykonywanie testu ogniskowania Kliknij tutaj 
Korekcja odkształcenia soczewki Kliknij tutaj 
Wysyłanie dokumentów do znakowania Kliknij tutaj 
Oglądanie stanu urządzenia Kliknij tutaj 
Stosowanie pliku-rejestratora do rozwiązania problemów, które mogą powstać Kliknij tutaj 
Testowanie połączeń sytemu Kliknij tutaj 

 

Uwaga: 
Mechanizm laserowy można teraz zintegrować z aplikacjami klienta jako serwer AciveX. 
Wykonawcy mogą teraz zapisać swoich klientów ActiveX i zbudować wysoce dostosowany 
interfejs użytkownika dla swoich klientów, stosując mechanizm laserowy do sterowania 
laserem. 
W tym celu został stworzony nowy obiekt jako punkt wejściowy w serwerze ActiveX. (Bliższe 
informacje znajdują się w dokumentacji online edytora projektu, rozdział „Language 
reference”. 
Ta funkcja musi być licencjonowana. 
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Uruchamianie mechanizmu laserowego 
Aby uruchomić mechanizm laserowy: 

1. Po zainstalowaniu edytora laserowego, na pasku narzędziowym aplikacji pojawia się ikona 
mechanizmu laserowego, pokazana poniżej: 

 

2. W celu wyświetlenia interfejsu użytkownika mechanizmu laserowego należy wykonać jedną z 
następujących czynności: 

o Dwukrotnie kliknąć w ikonę mechanizmu laserowego, aby wyświetlić okno aplikacji. 

o Prawym przyciskiem myszy kliknąć w ikonę mechanizmu laserowego, a potem kliknąć w 
 Show (pokaż). 

3. Aby zamknąć okno mechanizmu laserowego, należy wykonać jedną z następujących czynności: 

o Kliknąć w przycisk Close (zamknij)  z prawej strony i góry okna. 

o Prawym przyciskiem myszy kliknąć w ikonę mechanizmu laserowego, a potem kliknąć w 
 Minimize (minimalizuj). 

 

Uwaga: 
Począwszy od wydania 5.3, zarówno mechanizm laserowy jak i konfigurację lasera można także 
uruchamiać z edytora laserowego przy użyciu specjalnych przycisków paska 
narzędziowego  lub poleceń menu Laser. 

Bliższe informacje o elementach, które pojawiają się w oknie, patrz sekcja Przegląd interfejsu użytkownika. 
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Przegląd interfejsu użytkownika 
Ta sekcja zawiera podręczny informator na temat graficznego interfejsu użytkownika mechanizmu 
laserowego, zarówno funkcji dostępnych w oknie głównym jak i menu skrótów, do którego uzyskuje się 
dostęp przez kliknięcie prawym przyciskiem myszy w ikonę mechanizmu laserowego na pasku 
narzędziowym aplikacji. 

Bliższe informacje: 
 Elementy głównego okna 
 Przyciski menu 
 Polecenia menu skrótów 

Elementy głównego okna 
Poniższy rysunek przedstawia główne okno mechanizmu laserowego po otworzeniu go. 
W tym przykładzie wybrano dokument, którego zawartość jest wyświetlana w obszarze Preview (podgląd): 

 

Ponumerowane elementy są opisane poniżej: 

Obszar Opis 

 

Przyciski menu - Po lewej stronie okna mechanizmu laserowego znajdują się przyciski, które 
umożliwiają dostęp do głównych funkcji. Wszystkie przyciski są dwustabilne: najechać 
wskaźnikiem na przycisk, żeby zobaczyć bieżący wybór. Więcej informacji o każdym przycisku, 
patrz Przyciski menu. 
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Dokumenty i projekty zapisane w laserze - W zakładce Documents (dokumenty), która jest 
pokazana przy uruchomieniu, wymienione są wszystkie projekty lub dokumenty, które zostały 
zapisane w urządzeniu i które można wysłać do znakowania (patrz Wysyłanie dokumentów do 
znakowania): 

 ikona  wskazuje dokument (.xlp) utworzony za pomocą edytora laserowego 

 ikona  wskazuje projekt utworzony w edytorze projektów 

 ikona  wskazuje sekwencję (.xse) utworzoną za pomocą edytora laserowego 
Po wyborze jakiejś pozycji, na obszarze Podgląd wyświetla się zawartość. Jeżeli wybrano 
sekwencję, wyświetlany jest jej pierwszy dokument. 
Należy zwrócić uwagę, że kliknięcie prawym przyciskiem myszy w dokument lub projekt 
powoduje otwarcie menu skrótów, które umożliwia usunięcie elementu lub ustawienie go jako 
domyślnego, tzn. jako dokument lub projekt, który będzie wybierany przy uruchamianiu 
mechanizmu laserowego: 

 

 

Zakładki - W tym obszarze mogą być wyświetlone następujące zakładki: 
 Documents (dokumenty) - wymienione są projekty i dokumenty objaśnione powyżej. Bliższe 

informacje, patrz Wysyłanie dokumentów do znakowania. 
 Device Status (stan urządzenia) - pokazuje informacje dotyczące stanu urządzenia laserowego. 

Jest to zakładka tylko do odczytu. Bliższe informacje, patrz Oglądanie stanu urządzenia. 

Dostępność następnych zakładek zależy od stosowanego źródła laserowego i sposobu jego konfiguracji, tj. 
czy oś jest uaktywniona. Bliższe informacje, patrz Zarządzanie osią i wykonywanie testu lasera. 

 X-Y Axis (oś X-Y) - umożliwia zarządzanie osią poziomą i pionową w celu znakowania dokumentu 
płaskiego. 

 Z Axis (oś Z) - umożliwia zarządzanie osią  przed znakowaniem, a także wykonanie testu 
ogniskowania lasera. 

 Rotor Axis (oś wirnika) - umożliwia zarządzanie osią R przed znakowaniem dokumentu 
pierścieniowego. 

 Statistic (statystyka) - pokazuje statystykę dotyczącą znakowania i weryfikacji (funkcja dostępna z 
licencją Marvis). Więcej szczegółów, patrz Uwaga o Aplikacji. 

 

Podgląd dokumentu lub projektu - Jeżeli wybrano dokument (jak w przykładzie), ten obszar 
pokazuje jak obiekty graficzne będą rzeczywiście znakowane. Jeżeli wybrano projekt, podane są 
informacje o projekcie. 

 
Czas znakowania - Pokazany jest wymagany czas znakowania w oparciu o obiekty, które mają 
być znakowane; pokazany jest też postęp. 

 
Funkcja zmiany wielkości obrazu - W przypadku dokumentu umożliwia zbliżanie obiektów do 
znakowania. 

 

Ikona stanu urządzenia - Pokazuje bieżący stan urządzenia: np. zielona ikona oznacza, 
że urządzenie czeka na start, a czerwona ikona oznacza, że urządzenie jest gotowe. Bliższe 
informacje o stanach urządzenia, patrz Oglądanie stanu urządzenia 

 

Ikona Reader available (dostępności czytnika) - Pokazuje bieżący stan czytnika: np. zielona 
ikona oznacza, że czytnik jest dostępny do weryfikacji, a czerwona ikona oznacza, że czytnik 
pracuje. Bliższe informacje o stanach urządzenia, patrz konfiguracja MARVIS. 

 

Ikona mechanizmu laserowego na pasku narzędziowym aplikacji - kliknięcie prawym 
przyciskiem myszy w tę ikonę otwiera menu skrótów, które zawiera wiele poleceń. Bliższe 
informacje, patrz Polecenia menu skrótów . 
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Przyciski menu 

 

Informacja: 
Jeżeli jest włączona kontrola dostępu użytkowników, a ty nie masz odpowiednich praw to 
używania przycisków, będziesz poproszony o hasło z prawami. (Bliższe informacje, 
patrz Zarządzanie użytkownikami i prawami dostępu). 

Poniższa tabela zawiera krótki opis wszystkich dostępnych przycisków menu. Podany jest link do stosownej 
sekcji tego rozdziału. 

Przyciski Opis 

 

Lokalny / Zdalny - Umożliwia określenie poziomu nadzoru mechanizmu laserowego: 
poziom może być lokalny (edytor laserowy i mechanizm laserowy na tej samej maszynie) 
lub zdalny (edytor laserowy i mechanizm laserowy są na różnych maszynach.) Po 
ustawieniu sterowania zdalnego, operator, który ma zainstalowany program nadzorczy, 
może zdalnie sterować laserem. 
Ten przycisk jest dostępny tylko wtedy, gdy jest interaktywna instalacja z włączonym 
sterowaniem zdalnym. 
Po ustawieniu sterowania zdalnego wszystkie inne przyciski stają się niedostępne. 
Bliższe informacje, patrz Sterowanie lokalne / zdalne. 

 

Tryb automatyczny / ręczny - Umożliwia przełączanie między trybami roboczymi. Ten 
przycisk jest dostępny tylko wtedy, gdy jest uaktywnione sterowanie lokalne. 
Kiedy jest uaktywniony tryb automatyczny, to operacje grawerowania są wykonywane 
automatycznie.  Tryb ręczny służy do edycji i testowania układów graficznych. 
Domyślny tryb roboczy można ustawić poprzez menu skrótóww. Bliższe informacje, 
patrz Automatyczny / ręczny tryb roboczy. 

 

Start - Umożliwia, odpowiednio, wysłanie dokumentu do znakowania lub zatrzymanie 
operacji znakowania. Po naciśnięciu ten przycisk zmienia się na  
Ten przycisk jest dostępny tylko wtedy, gdy jest uaktywnione sterowanie lokalne. Bliższe 
informacje, patrz Wysyłanie dokumentów do znakowania. 

 

Uruchom granice - Umożliwia wyświetlanie marginesów obiektów graficznych do 
znakowania. 
Bliższe informacje, patrz Wyświetlanie granic. 

 

Granice poprzedniego sektora / granice następnego sektora - Te przyciski umożliwiają 
wyświetlanie marginesów sektorów, które tworzą obiekt do znakowania, kiedy graweruje 
się na dokumentach pierścieniowych. Przyciski stają się aktywne po kliknięciu w Uruchom 
granice. 
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Polecenia menu skrótów 

Kliknięcie prawym przyciskiem myszy w ikonę mechanizmu laserowego na pasku narzędziowym aplikacji 
Windows powoduje otwarcie menu skrótów: 

 

Poniżej opisano w skrócie polecenia dostępne w menu skrótów. Podany jest link do stosownej sekcji tego 
rozdziału. 

Polecenie menu Opis 
Minimize/Show 
(minimalizuj / pokaż) 

Umożliwia minimalizację lub wyświetlenie interfejsu użytkownika mechanizmu 
laserowego. 

Always on top (zawsze 
na wierzchu) Umożliwia utrzymywanie zawsze widocznego okna mechanizmu laserowego. 

User management 
(zarządzanie 
użytkownikami) 

Umożliwia dostęp do funkcji zarządzania użytkownikami. Trzeba mieć stosowne 
przywileje, żeby zarządzać użytkownikami. Bliższe informacje, patrz Zarządzanie 
użytkownikami i prawami dostępu . 

Global variables 
(zmienne globalne) 

Polecenie umożliwia dostęp i zarządzanie zmiennymi globalne; są to ciągi lub liczniki, które 
są przechowywane w małej bazie danych na poziomie urządzenia. Jeżeli włączono 
zarządzanie użytkownikami, a dostęp do tej funkcji został ograniczony,  będziesz poproszony 
o hasło z odpowiednimi prawami. Więcej informacji, patrz Stosowanie zmiennych 
globalnych. 

Troubleshooting 
(wykrywanie i 
usuwanie usterek) 

Umożliwia sprawdzanie błędów i śledzenie zdarzeń w systemie. 

System test (test 
systemu) 

Wyświetla okno dialogowe, które umożliwia sprawdzenie sprzętu i połączeń 
kablowych. Więcej informacji, patrz Testowanie systemu . 

Laser configuration 
(konfiguracja lasera) 

Umożliwia dostęp do parametrów w celu skonfigurowania lasera. Więcej 
informacji, patrz Konfigurowanie parametrów lasera . 

Start in auto mode (start 
w trybie automatycznym) 
Start in remote mode 
(start w trybie zdalnym) 

Umożliwia określenie trybu roboczego, który musi być aktywny przy uruchomieniu. 
Bliższe informacje, patrz Automatyczny / ręczny tryb roboczy . 

Quit (wyjście) Wychodzi z interfejsu mechanizmu laserowego. Użyj tego polecenia, jeżeli chcesz 
zrestartować mechanizm laserowy.  
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Zarządzanie użytkownikami i prawami dostępu. 

 

Funkcja User management (zarządzanie użytkownikami) umożliwia ustawianie i zarządzanie prawami 
użytkowników. 

Domyślnie, edytor laserowy nie prosi o zalogowanie się i dowolny użytkownik może mieć dostęp i zarządzać 
wszystkimi funkcjami systemu.  

Aby zmienić to ustawienie, trzeba najpierw włączyć funkcję Users management (zarządzanie 
użytkownikami) przez wprowadzenie unikalnego hasła, które daje przywileje administracyjne; wtedy można 
określić prawa do funkcji systemu dla określonych klas użytkowników. 

 

Uwaga: 
Do tej funkcji można również mieć dostęp i można jej używać na poziomie edytora laserowego 
przez kliknięcie w przycisk   (zarządzaj użytkownikami urządzenia) na pasku 
narzędziowym lub przez wybranie Manage device users (zarządzaj użytkownikami 
urządzenia)  z menu Laser . 

W celu umożliwienia zarządzania użytkownikami i ustawiania praw dostępu: 
1. Prawym przyciskiem myszy kliknąć w  ikonę mechanizmu laserowego na pasku aplikacji Windows. 
2. W menu skrótów, które się pojawi, kliknąć w User management (zarządzanie użytkownikami) 
3. Wyświetla się ramka dialogowa, gdzie trzeba wpisać hasło: 
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4. Wpisać unikalne hasło wg swojego wyboru. 

 

Uwaga: 
Jeżeli wpisane hasło nie jest jednoznaczne w systemie, wyświetli się komunikat o 
błędzie. 

5. Określić czy i jak długo system musi pamiętać hasło: Można określić albo konkretny przedział czasu 
w minutach, albo całą sesję programu. Po upływie określonego czasu, pojawi się prośba o hasło, 
żeby funkcja została udostępniona. 

 

Uwaga: 
Jak zmienić hasło administratora lub uniemożliwić kontrolę dostępu użytkowników, 
patrz Wyłączanie kontroli dostępu użytkowników. 

6. Kliknąć w OK. Wyświetli się okno User management (zarządzanie użytkownikami). 

 

Po lewej stronie siatki jest lista dostępnych typów użytkowników, a u góry są funkcje, do których dostęp można 
ograniczyć. Gwiazdka (*) wskazuje, że kontrola dostępu jest  obecnie wyłączona dla tych użytkowników, 
ponieważ nie ustawiono żadnego hasła, a wybrane pole wyboru wskazuje, że użytkownik ma prawo do danej 
funkcji. 

Dostępni użytkownicy to: 

o  Administrator - ma pełne prawa do funkcji systemu i może zarządzać prawami użytkowników; nie 
możesz edytować tego użytkownika. 

o  Everyone  (każdy) użytkownik jest użytkownikiem domyślnym, który ma wszystkie prawa, z wyjątkiem 
funkcji zarządzania użytkownikami; ten użytkownik jest edytowalny i można wykorzystać go jako 
podstawę do ustawiania praw innych użytkowników. 

o Są jeszcze trzy dodatkowe typy użytkowników: Operator, Designer (projektant) i Developer 
(wykonawca). Przedstawiają one typowych operatorów systemu laserowego, którym można ograniczyć 
prawa dostępu do funkcji. 

Dostęp można ograniczyć do następujących funkcji: 

Nazwa funkcji Dozwolone operacje 
Zarządzanie 
użytkownikami Ta funkcja umożliwia zarządzanie prawami dostępu użytkowników do systemu. 

Automatyczny / 
ręczny 

Ta funkcja umożliwia przełączanie między ręcznym a automatycznym trybem roboczym. Patrz Tryb 
automatyczny vs. tryb ręczny. 

Zarządzanie 
układami 

Ta funkcja umożliwia tworzenie układu i wysyłanie go do znakowania. Patrz Tworzenie układów 
graficznych. 

Programowanie 
Ta funkcja umożliwia realizację projektu za pomocą edytora projektów, a potem wysłanie go do 
znakowania. (Patrz pomoc online edytora projektów, która jest zintegrowana z systemem pomocy 
edytora laserowego.) 

Konfiguracja lasera Ta funkcja umożliwia dostęp i konfigurację parametrów konfiguracji lasera. Patrz Konfiguracja 
parametrów lasera. 

Global variables 
(zmienne globalne) 

Ta funkcja umożliwia tworzenie zmiennych globalnych, do których można mieć dostęp z interfejsu 
zarówno edytora laserowego jak i mechanizmu laserowego. Patrz Stosowanie zmiennych 
globalnych. 



EDYTOR LASEROWY 

150  
 

5

7. Aby włączyć kontrolę dostępu dla operatora, projektant lub wykonawcy, należy w oknie User 
management (zarządzanie użytkownikami) kliknąć w Set passwords (ustaw hasła) Wyświetli się 
okno Change passwords (zmień hasła). 

 

8. Kliknąć w strzałkę przy User (użytkownik), żeby wyświetlić listę użytkowników, a potem wybrać 
żądanego użytkownika, np. Designer (projektant) 

 

Uwaga:  
Należy wybrać Administratora, żeby zmienić bieżące hasło lub wyłączyć kontrolę dostępu 
użytkowników przez wprowadzenie pustego hasłaa. 

9. Wpisać unikalne hasło wg swojego wyboru, a potem potwierdzić go. 
10. Wykonać jedną z następujących czynności: 

o Kliknąć w OK, żeby wrócić do okna User management (zarządzanie użytkownikami). 
o Kliknąć w Apply (zastosuj), żeby wyczyścić pola, jeżeli chcesz wyłączyć kontrolę dostępu 

dla użytkownika lub jeżeli chcesz zmienić hasło. 
11. Należy zwrócić uwagę, że użytkownik projektant odziedziczył wszystkie prawa każdego, tzn. ma 

dostęp do wszystkich funkcji, ale pola wyboru są wciąż niedostępne i nie możesz ich oczyścić. 
12. Aby ograniczyć prawa dostępu do konkretnej funkcji dla użytkownika projektant : 

o Wyczyścić odpowiednie pole wyboru dla użytkownika każdy . 
o Pole wyboru staje się dostępne także dla użytkownika projektant; oczyścić go, żeby 

ograniczyć dostęp do funkcji dla tego typu użytkownika, jak pokazano w poniższym 
przykładzie: 

 

13. Kliknąć w OK , żeby zapisać swoje ustawienia. Gdy następnym razem użytkownicy spróbują 
uzyskać dostęp do funkcji Laser configuration (konfiguracja lasera), system poprosi ich o 
wprowadzenie hasła z odpowiednimi przywilejami. 

 

Uwaga: 
Niektóre funkcje są uzależnione od siebie. Np. użytkownik, który ma prawa dostępu do 
programowania, musi zawsze mieć także prawa dostępu do zarządzania układami i trybem 
automatycznym / ręcznym, więc system uniemożliwi ci wyłączenie ich. 
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Wyłączenie kontroli dostępu użytkowników 

Aby wyłączyć kontrolę dostępu dla jakiegoś typu użytkownika lub dla wszystkich użytkowników: 
1. Uzyskać dostęp do funkcji zarządzanie użytkownikami przy użyciu hasła Administratora. 

2. W oknie User management (zarządzanie użytkownikami) kliknąć w Set passwords (ustaw hasła). 

3. Kliknąć w strzałkę przy  User (użytkownik), żeby wyświetlić listę użytkowników, a potem wykonać 
jedną z następujących czynności: 

o Wybrać Administratora, żeby wyłączyć kontrolę dostępu dla wszystkich użytkowników. W 
ten sposób wszyscy użytkownicy będą mieć prawa dostępu do wszystkich funkcji. 

o Wybrać typ użytkownika, który ma być wyłączony z listy User (użytkownik). 

4. Pola Passwords (hasła) zostawić puste, a potem kliknąć w OK, jeżeli chcesz zamknąć 
okno Change password (zmień hasło) lub kliknąć w Apply (zastosuj), żeby zostawić otwarte. 

5. W oknie komunikatu, które się wyświetli, kliknąć w Yes (tak). 

W celu ponownego udzielenia dostępu do funkcji dla danego typu użytkownika: 
1. Uzyskać dostęp do funkcji zarządzanie użytkownikami przy użyciu hasła Administratora. 

2. W oknie User management (zarządzanie użytkownikami) wybrać pole wyboru odpowiadające 
funkcji, którą chcesz ponownie przydzielić. 

3. Kliknąć w OK. 
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Przełączanie między trybami roboczymi 
W tej sekcji: 

 Sterowanie lokalne / zdalne 
 Automatyczny / ręczny tryb roboczy 

Sterowanie lokalne / zdalne 

 

Uwagi: 
Przycisk zdalny / lokalny jest dostępny tylko wtedy, gdy instalacja jest interaktywna z dozwolonym 
sterowaniem zdalnym (bliższe informacje, patrz Rodzaje instalacji i tryby podłączania). 
Domyślnie, przy uruchomieniu, włączone jest sterowanie lokalne. W ten sposób tylko uprawnieni 
operatorzy mogą uaktywnić sterowanie zdalne umożliwiając zdalne połączenia od innych 
operatorów w sieci. 

Przycisk zdalny / lokalny z lewego menu mechanizmu laserowego umożliwia określenie kto nadzoruje 
mechanizm laserowy, tzn. kto steruje i może rzeczywiście wysyłać polecenia do mechanizmu laserowego. 

Przycisk jest dwustabilny: Należy przesunąć wskaźnik na niego, żeby zobaczyć bieżący wybór. Na rysunku 
poniżej uaktywnione jest sterowanie lokalne: 

 

Sterowanie lokalne  

Sterowanie lokalne jest stosowane, kiedy na komputerze jest zainstalowany i edytor laserowy, i mechanizm 
laserowy, tzn. jeżeli jesteś podłączony lokalnie i bezpośrednio sterujesz źródłem laserowym. 

W tym przypadku mechanizm laserowy zaakceptuje polecenia od ciebie, ale nie od innych operatorów w 
sieci. 

Zachowanie przy przejmowaniu z powrotem sterowania lokalnego od sterowania zdalnego 

Jeżeli zostało uaktywnione sterowanie zdalne i trzeba dokonać zmian w wykonaniu, takich jak wyświetlenie 
granic lub testowanie układu, należy wykonać co następuje: 

 Kliknąć w przycisk Lokalny w lewym Menu mechanizmu laserowego, żeby wznowić sterowanie 
lokalne. 

 Zostaniesz zawiadomiony, jeżeli inni operatorzy są podłączeni zdalnie, a zdalne połączenia zostaną 
zakończone. 
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Sterowanie zdalne 

Sterowanie zdalne może być stosowane w dwóch celach:  

 Ustanowienie połączenia sieciowego między edytorem laserowym a mechanizmem laserowym, które są 
zainstalowane na różnych maszynach.  Edytor laserowy musi mieć zainstalowany program nadzorczy, a 
mechanizm laserowy musi być ustawiony na tryb zdalny. Mechanizm laserowy zaakceptuje polecenia od 
pierwszego edytora laserowego, który się połączy. Tylko operatorzy w sieci, którzy mają zainstalowany program 
nadzorczy edytora laserowego mogą łączyć się zdalnie z mechanizmem laserowym. (Bliższe informacje, 
patrz Rodzaje instalacji i tryby podłączania). 

 Sterowanie markerem lasera przy użyciu protokołu TCP / IP wbudowanego w Lighter (Lighter 6.3.0 i 
późniejsze). Mechanizm laserowy zaakceptuje polecenia TCP / IP od pierwszego, który się połączy. 

Zachowanie: 

Ustanowić połączenie sieciowe między edytorem laserowym, który ma zainstalowany program nadzorczy, a markerem 
laserowym z mechanizmem laserowym ustawionym na tryb zdalny:  

 Kliknąć w przycisk Zdalny w lewym Menu mechanizmu laserowego, żeby ustawić sterowanie zdalne. 
 Źródło laserowe podłączone do mechanizmu laserowego pojawi się na liście źródeł laserowych dostępnych do 

podłączenia zdalnego. 
 Z edytora laserowego kliknąć w przycisk Connect to device (podłącz do urządzenia), a potem wybrać źródło 

laserowe z wyświetlanej listy. (Patrz Podłączenie do urządzenia laserowego). 

Sterowanie markerem lasera przy użyciu protokołu TCP / IP wbudowanego w Lighter (Lighter 6.3.0 i późniejsze): 

 Określić numer portu protokołu TCP / IP stosowanego przez mechanizm laserowy w środowisku trybu 
zdalnego. (Bliższe informacje, patrz Ustawianie parametróww sieciowych). 

 Kliknąć w przycisk Zdalny w lewym Menu mechanizmu laserowego, żeby ustawić sterowanie zdalne. 

Ustawianie trybu zdalnego jako domyślnego trybu roboczego: 

1. Prawym przyciskiem myszy kliknąć w  ikonę mechanizmu laserowego na pasku aplikacji Windows. 

2. W menu skrótów, które się pojawia, kliknąć w Start in Remote mode (start w trybie zdalnym), żeby 
ustawić go jako tryb domyślny. Należy zwrócić uwagę, że teraz jest sprawdzane polecenie menu: 
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3. Lighter poprosi o potwierdzenie wyboru. Nacisnąć Yes (tak), żeby kontynuować: 

 

4. Aby odwołać wybór Start in Remote mode (start w trybie zdalnym), kliknąć w niego jeszcze raz. 

Automatyczny / ręczny tryb roboczy 

 

Uwagi: 
Ten przycisk jest dostępny tylko wtedy, gdy jest uaktywnione sterowanie lokalne 
(patrz Sterowanie lokalne / zdalne). 

Przycisk Automatyczny / ręczny z lewego menu mechanizmu laserowego umożliwia przełączanie się 
między trybami roboczymi. Przycisk jst dwustabilny: Należy przesunąć wskaźnik na niego, żeby zobaczyć 
bieżący wybór. Na rysunku poniżej uaktywniony jest tryb ręczny: 

 

Bliższe informacje, patrz rozdział „Wykonywanie operacji grawerowania”, sekcja Tryb automatyczny vs. tryb 
ręczny. 

Można ustawić tryb automatyczny jako domyślny tryb roboczy, tzn. jako tryb, który będzie stosowany przy 
uruchamianiu mechanizmu laserowego. 

Ustawianie trybu automatycznego jako domyślnego trybu roboczego: 
1. Prawym przyciskiem myszy kliknąć w ikonę mechanizmu laserowego na pasku aplikacji 

Windows. 
2. W menu skrótów, które się pojawia, kliknąć w Start in auto mode (start w trybie 

automatycznym), żeby ustawić go jako tryb domyślny. Należy zwrócić uwagę, że teraz jest 
sprawdzane polecenie menu: 

 

3. Aby odwołać wybór trybu domyślnego, kliknąć w niego. 
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Konfigurowanie parametrów lasera 

 

Ten rozdział opisuje parametry konfiguracyjne lasera, które można ustawić, żeby skonfigurować urządzenia 
laserowe na optymalną wydajność grawerowania. 

Aby uzyskać dostęp do okna konfiguracji lasera  
1. Prawym przyciskiem myszy kliknąć w ikonę mechanizmu laserowego na pasku aplikacji 

Windows. 
2. W menu skrótów, które się pojawi, kliknąć w Laser configuration (konfiguracja lasera) 

 

Uwaga: 
Jeżeli włączono zarządzanie użytkownikami, a dostęp do tej funkcji został ograniczony 
(patrz Zarządzanie użytkownikami i prawami dostępu), będziesz poproszony o hasło z 
odpowiednimi prawami. 

3. Wyświetlane jest okno Laser configuration (konfiguracja lasera) umożliwiające ustawienie 
wszystkich właściwości urządzeń laserowych, do których jesteś podłączony. 

4. Aby ustawić parametry, należy skorzystać z następujących tabel: 
o Ustawianie parametrów ogólnych 
o Błąd! Nie podano nazwy zakładki 
o Ustawianie parametrów lasera 
o Ustawianie parametrów korekcji 
o Ustawianie parametrów celowania 
o Ustawianie parametrów wejściowych / wyjściowych 
o Ustawianie parametrów osi X, Y, Z i wirnika 
o Konfigurowanie znakowania w trakcie działania programu 
o Ustawianie parametrów sieciowych 
o Konfiguracja MARVIS 
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Ustawianie parametrów ogólnych 
To okno umożliwia określenie języka interfejsu użytkownika, jednostki miary długości i maksymalnej ilości 
miejsca na dysku na pliki-rejestratory. 

Ramka grupy Parametr Opis 

Język   

Wymienione są języki dostępne dla interfejsu użytkownika. Wybrać język, 
który ma być zastosowany. 
Należy zwrócić uwagę, że domyślnie język jest ustawiony 
na Autodetect (automatyczne wykrywanie), co oznacza, że zależy on od 
języka systemu operacyjnego użytkownika. 

Długości Ustawia jednostkę miaary długości. Dostępne opcje to mm lub cale. 
Jednostki 

Ułamki dziesiętne Ustawia liczbę stosowanych miejsc po przecinku. Dozwolone są 
wartości od 0 do 5. 

Rejestracja Maks. obszar 
rejestracji (KB) 

Określa maksymalny obszar na dysku na pliki-rejestratory. 
Plik-rejestrator jest kompilowany na poziomie mechanizmu laserowego i 
rejestruje wszystkie działania, które nastąpiły umożliwiając użytkownikowi 
rozwiązanie jakiegoś problemu, który mógł wystąpić. 
Bliższe informacje o sposobie stosowania i zarządzania plikiem-rejestratorem 
znajdują się w sekcji Zrozumienie pliku-rejestratora. 

Wielkość Określa maksymalną przestrzeń dyskową na bazę danych wykrywania i 
usuwania usterek. Dozwolone są wartości od 1 do 500 MB. 
Ustawić poziom zdarzeń do śledzenia i zapisywania w urządzeniu. 
BŁĘDY Śledzi tylko błędy systemowe. 
OSTRZEŻENIA Śledzi ostrzeżenia i błędy systemowe. 

Poziom  

INFO Śledzi informacje, ostrzeżenia i błędy systemowe. 
Udostępnia zdarzenia, które chcesz śledzić. 

LIGHTER Śledzi zdarzenia dotyczące komunikacji między 
edytorem laserowym a mechanizmem laserowym 

ETHERNET_IP 
Śledzi zdarzenia dotyczące komunikacji 
Ethernet_IP między markerem laserowym a 
urządzeniem klienta 

AXIS Śledzi zdarzenia dotyczące ruchu osi 
INPUTS_OUTPUTS Śledzi zdarzenia dotyczące we/wy 

READER Śledzi zdarzenia dotyczące komunikacji z 
czytnikiem 

Wykrywanie i 
usuwanie usterek) 

Śledzenie 

TCP-SERVER Śledzi zdarzenia dotyczące komunikacji protokołu 
TCP-SERVER 

Ustawianie parametrów skanera 
Strona Scanner (skaner) okna Laser configuration (konfiguracja lasera) służy do ustawiania prędkości 
skanera i czasu oczekiwania w celu regulacji jakości grawerowania ze względu na czasy działania. 

Grupa 
właściwości Właściwość Opis 

Jump Speed 
[Kpts/s] 

Prędkość jaką stosują skanery podczas przesuwania się między wielokątami (tzn. 
kiedy nie znakują). 

Scan Ramp [ms] 

Pasywne źródła laserowe typu Q-switch „oscylują” przy uruchomieniu, co powoduje, 
że pierwsza linia (linie) robi się stopniowo grubsza. Parametr Scan Ramp ustawia 
czas (wyrażony w milisekundach) przyśpieszania skanera od zera do prędkości 
maksymalnej: umożliwia to zmniejszenie wadliwości. Ten parametr trzeba ustawiać 
tylko dla pasywnych źródeł laserowych typu Q-switch. 

Scan 

Scan Threshold 
[ms] 

Przyśpieszenie musi występować tylko przy uruchamianiu, żeby umożliwić 
stabilizację emisji. Próg skanowania jest to ilość czasu, który musi upłynąć (po 
wyłączeniu lasera), żeby można było powtórzyć narastanie przyśpieszania. 
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Standby Position 

Położenie, do którego przesuwa się skaner, kiedy jest w stanie oczekiwania, tzn. na 
końcu operacji znakowania. Jeżeli emisji nie da się całkowicie zatrzymać, ten 
parametr umożliwia takie przesunięcie skanera, żeby zapobiec uszkodzeniom. 
Możliwe wartości: 

 Center, przesuwa skaner do początku. Jest to ustawienie obligatoryjne, 
jeżeli stosuje się funkcję  Marking on the Fly (znakowanie w trakcie 
działania programu) (bliższe informacje, patrz Konfiguracja funkcji 
znakowania w trakcie działania programu). 

 Corner, przesuwa skaner do lewego dolnego rogu. Jeżeli wybierze się tę 
opcję, to poniżej wyświetlane są pola Corner Position (położenie rogu) 
wskazując dokładne położenie w punktach. Domyślnie to położenie jest 
oddalone od początku. 

 Dynamic, przesuwa skaner dynamicznie z powrotem do środka po upływie 
pewnego czasu. 

Corner Position 
[pts] X Wskazuje położenie rogu na współrzędnej X. 

Corner Position 
[pts] Y Wskazuje położenie rogu na współrzędnej Y. 

  
  
Odnosi się do czasów oczekiwania, wymaganych przy grawerowaniu o wysokiej jakości. K i C są to dwie 
zmienne, gdzie K jest współczynnikiem proporcjonalnym do prędkości, a C jest stałą. System oblicza 
czasy oczekiwania na ruch lasera, zgodnie z tymi parametrami. Wszystkie czasy oczekiwania są 
wyrażone w mikrosekundach [µs]. (Bliższe informacje, patrz Obliczanie czasów oczekiwania). 
K first [µs] 
C first [µs] 
K next [µs] 
C next [µs] 
K last [µs] 
C last [µs] 

 First = pierwszy punkt wektora. (Tj. czas oczekiwania przed przystąpieniem 
do pierwszego ruchu.) 

 Next = punkt koniunkcji między dwoma wektorami 

 Last = ostatni punkt wektora 

Polygon 
Delays 

Przycisk edycji 
zaawansowanych 
parametrów 

Ten przycisk włącza więcej parametrów, które umożliwiają konfigurację źródła 
laserowego, żeby odpowiadało wymaganiom użytkownika. Ta funkcja jest 
przeznaczona dla wykwalifikowanych techników, którzy będą wyposażeni w 
specjaalne hasło. 

Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane), następujące 
parametry są edytowalne. 
C on [µs] Czas, który laser spędza na znakowaniu pojedynczego piksela. 

C off [µs] Czas oczekiwania zanim laser dokona znakowania następnego piksela. Im dłuższy 
jest ten czas, tym mocniejszy jest następny impuls. 

Raster Delays 

C line [µs] Czas oczekiwania między liniami, tzn. zanim laser dokona znakowania następnej linii. 
Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane), następujące 
parametry są edytowalne. 

C draw [µs] 
Czas, który upływa zanim system rzeczywiście rozpoczyna emisję. 
System laserowy może mieć pewną bezwładność, tzn. zwłokę reakcji między 
sygnałem „emisji” a rzeczywistą emisją. 

Laser Delays 

C jump [µs] Czas, który upływa zanim system wygasi emisję lasera. 
To zjawisko jest uzupełniające do zjawiska zapoczątkowującego zwłokę Cdraw. 
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Obliczanie czasów oczekiwania 
Proces grawerowania jest realizowany za pomocą urządzenia odchylającego wiązkę laserową, sterowanego 
przez dwa retroaktywne napędy elektryczne (PID), których pozycja kątowa jest proporcjonalna do 
dostarczanego napięcia sterującego. Z powodu właśnie tego charakteru systemu czas reakcji (faza) 
napędów nie jest bez znaczenia. Gdyby nie uwzględniać tej zwłoki reakcji, uzyskane wyniki byłyby słabe: 
rozwiązanie polega na tym, że system sterowania czeka aż zwierciadło ustawi się prawidłowo przed 
przystąpieniem do działania. 

Poniżej przedstawiono czasy oczekiwania wymagane dla wysokiej jakości grawerowania. Czasy 
oczekiwania są funkcjami liniowymi (faza liniowa) prędkości grawerowania; i dlatego są sparametryzowane 
przez dwie zmienne: K, współczynnik proporcjonalny do prędkości i C, stałą. System oblicza czas 
oczekiwania według tych dwóch parametrów  z następującego wzoru: 

 

Prędkości we wzorze są wyrażone w tysiącach współrzędnych na sekundę, a maksymalna prędkość 
odniesienia we wzorze jest równa 1000 [Kcoord/s], co odpowiada następującym prędkościom wyrażonym w 
[mm/s], stosownie do soczewki: 

 f100 = 1133,3 mm/s 
 f160 = 1822,2 mm/s 
 f254 = 2900,2 mm/s 
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Uwagi: 

Wszystkie czasy oczekiwania są wyrażone w mikrosekundach [µs]. 

Poniższy przykład pokazuje sposób grawerowania słowa „LASER”. Grube linie wskazują rzeczywiste 
znakowanie, a cienkie skok zwierciadeł (tzn. ruch zwierciadeł między znakowanymi wektorami): 

 

Następne przykłady lepiej zilustrują jak nieprawidłowe ustawienie technicznego czasu oczekiwania może 
wpłynąć na rezultat. 

TFirst [µs] 
Czas oczekiwania aż skaner rzeczywiście osiągnie wymaganą pozycję zanim włączy się laser. 

 

 Jeżeli zwłoka jest krótsza niż wartość optymalna - 
widać, że pierwszy wektor każdego wielokąta jest 
zniekształcony i dłuższy od prawidłowej długości. 

 Jeżeli zwłoka będzie dłuższa niż wartość optymalna - 
proces grawerowania będzie wolniejszy, ale żadne skutki 
nie będą widoczne. 
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TNext [µs] 
Czas oczekiwania aż skaner osiągnie prawidłową pozycję przed śledzeniem wektora, po pierwszym, z 
wyjątkiem ostatniego. Ten czas oczekiwania jest odpowiedni do prędkości grawerowania i zależy od kąta 
między dwoma kolejnymi wektorami. Jeżeli czas będzie równy 180°, to czas oczekiwania będzie równy zero; 
przy czym czas oczekiwania będzie rosnąć w miarę zmniejszania się kąta, osiągając maksimum, kiedy kąt 
będzie równy zero stopni. 

 

 Jeżeli zwłoka jest krótsza niż wartość optymalna - 
widać, że wektory wielokąta są zaokrąglone, a nie 
ostre 

 

 Jeżeli zwłoka jest dłuższa niż wartość optymalna - 
widać, że wektory wielokąta są bardziej znakowane i 
głębsze niż być powinny. 

TLast [µs] 
Czas oczekiwania aż skaner osiągnie prawidłową pozycję przed wyłączeniem lasera (skanowanie ostatniego 
wektora wielokąta). 

 

 Jeżeli zwłoka jest krótsza niż wartość optymalna 
- widać, że ostatnie wektory wielokąta są krótsze i 
niekompletne. 

 

 Jeżeli zwłoka jest dłuższa niż wartość optymalna - 
widać, że punkty końcowe wektora są bardziej 
znakowane. 

TDraw (laser diodowy) [µs] 
Czas potrzebny systemowi na rzeczywiste rozpoczęcie emisji. System laserowy może mieć pewną 
bezwładność, choćby niewielką, tzn. zwłokę reakcji między sygnałem „emisji” a rzeczywistą emisją. 

Ten czas nie zależy od prędkości (we wzorze wymagany jest tylko stały komponent). 

 

 Jeżeli zwłoka jest krótsza niż wartość optymalna - 
widać, że pierwszy wektor każdego wielokąta jest 
krótszy. 

 

 Jeżeli zwłoka jest dłuższa niż wartość optymalna - 
widać, że punkty początkowe wektora są głębsze. 

 

C:\Users\rbrev
DL\Desktop\H
mages\note.gif

 

Uwagi: 

Czas Tdraw jest zwykle krótszy niż Tfirst. Ponieważ oba czasy dotyczą punktu 
początkowego pierwszego wektora, pierwszy (first) jest zwykle pomijany. 
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TJump (laser diodowy) [µs] 
Czas potrzebny systemowi na wygaszenie emisji laserowej. Jest to zjawisko uzupełniające do zjawiska 
zapoczątkowującego zwłokę Tdraw. 

Ten czas nie zależy od prędkości (we wzorze wymagany jest tylko stały komponent). 

 

 Jeżeli zwłoka jest krótsza niż wartość optymalna - 
widać rozmycie między wielokątami. 

 Jeżeli zwłoka będzie dłuższa niż wartość optymalna 
- proces grawerowania będzie wolniejszy, ale żadne 
skutki nie będą widoczne. 

Ustawianie parametrów lasera 
Strona Laser okna Laser configuration (konfiguracja lasera) zawiera następujące parametry: 

 

Uwaga: 
Źródło laserowe jest ustawione na parametr domyślny, który został ustawiony dla edytora 
laserowego. Bliższe informacje, patrz Ustawianie parametrów lasera (strona lasera). Nadal można 
ustawić inny rodzaj źródła niż źródło domyślne. 

Grupa 
właściwości Właściwość Opis 

Rodzaj źródła Jest to obecnie wybrane źródło laserowe. 

Przycisk edycji 
zaawansowanych 
parametrów 

Ten przycisk włącza więcej parametrów, które umożliwiają konfigurację źródła 
laserowego, żeby odpowiadało wymaganiom użytkownika. Ta funkcja jest 
przeznaczona dla wykwalifikowanych techników, którzy będą wyposażeni w 
specjalne hasło. 

Opis 
Ten parametr jest wyświetlany po uaktywnieniu funkcji Edit advanced 
parameter (edytuj parametry zaawansowane). 
Umożliwia wprowadzenie opisu źródła laserowego 

Rodzaj zmiany 
mocy 

Ten parametr jest wyświetlany po uaktywnieniu funkcji Edit advanced 
parameter (edytuj parametry zaawansowane). 
Niektóre systemy (zwłaszcza lampowe) mają dużą „bezwładność optyczną”: 
potrzebują czasu na stabilizację emisji laserowej po zmianie zasilania. Źródła 
diodowe zachowują się w ten sposób tylko wtedy, gdy nachylenie poziomu zaczyna 
się poniżej progu emisji. Ten parametr może mieć dwie wartości (nie zmieniać 
ustawień w pliku laser.ini): 

 Once (raz): Czas zmiany mocy (patrz parametry Delays (zwłoki) ma 
zastosowanie tylko po pierwszym opuszczeniu pióra grawerującego) 

 Always (zawsze): Czas zmiany mocy ma zastosowanie do każdej zmiany 
poziomu (źródła lampowe) 

Diagnostyka 
LaserLink  

Umożliwia włączanie / wyłączanie komunikacji z urządzeniem zewnętrznym, żeby 
sprawdzić jego stan przed znakowaniem. Jeżeli jest ustawiony 
na False, sprawdzanie nie jest wykonywane. 

Laser 

Włącz ciągłą 
emisję 

Jeżeli ta właściwość jest ustawiona na True, to wtedy parametr 
Częstotliwość można ustawić na 0. Parametr Częstotliwość służy do 
regulacji częstotliwości wyjściowej lasera przez bezpośrednie operowanie 
przełącznikiem Q; można go ustawiać na poziomie dokumentów lub 
obiektów (patrz Właściwości laserowe dla dokumentów). 
Przełącznik Q jest to układ elektrooptyczny, który steruje 
nieprzezroczystością soczewki umożliwiając zmianę częstotliwości wiązki 
laserowej. Ustawienie parametru Częstotliwość na 0 zapobiega nieciągłości 
emisji. 
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Sygnał poziomu mocy steruje prądem elektrycznym płynącym do diody laserowej: im większy prąd 
tym wyższa moc emitowana. Jest wyrażony w procentach wartości maksymalnej. 

Min. Level [%] Minimalny dozwolony sygnał poziomu mocy. Jest to wartość jaką 
stosuje oprogramowanie, kiedy użytkownik ustawi moc lasera na 0%. 

Thermal Level [%] Sygnał poziomu na jaki przechodzi laser podczas oczekiwania. 

Max. Level [%] Maksymalny dozwolony sygnał poziomu. Jest to wartość jaką stosuje 
oprogramowanie, kiedy użytkownik ustawi moc lasera na 100%. 

Poziomy 

Ramp Time [ms] Czas, wyrażony w milisekundach, potrzebny na przejście z poziomu 
minimalnego na poziom maksymalny. 

Power Change 
[ms] 

Oczekiwanie termiczne, wyrażone w ms, jest to czas oczekiwania między 
końcem narastania poziomu a początkiem grawerowania. To oczekiwanie służy 
laserowi do stabilizacji przed rozpoczęciem pracy. 

Zwłoki 

Stand by [s] 

Jest to wyrażony w sekundach czas oczekiwania między końcem grawerowania 
a nachyleniem poziomu, które ponownie ustawia wartość minimalną 
(oczekiwania). To oczekiwanie pozwala laserowi zachować stabilność między 
dwoma bezpośrednimi grawerowaniami, co w konsekwencji oszczędza czas 
pracy. 

Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane), 
następujące parametry są edytowalne. 

Shot Time [µs] 

Czas trwania impulsu błysku lasera, tzn. cza, w którym przełącznik Q 
jest otwarty (czyli, lepiej, przezroczysty). Czas odwracania kryształu jest 
zawsze o rząd wielkości krótszy od czasu błysku; dlatego ten parametr 
wpływa na energię błysku tylko pośrednio; może być zastosowany do 
dostrajania czasu ponownego zapełnienia kryształu (zaczyna się 
dopiero po zamknięciu przełącznika Q). 

Parametry 

Shot/Base 
Frequency [Hz] 

Ten parametr ustawia domyślną częstotliwość przełącznika Q. 
Częstotliwość jest odwrotnie proporcjonalna do mocy wiązki laserowej, 
tzn. jeżeli częstotliwość jest za wysoka, to moc może być 
niewystarczająca dla procesu grawerowania. Częstotliwość można 
zmienić poprzez interfejs użytkownika i dostosować do każdego 
obiektu, ale grawerowanie rastrowe za pomocą techniki LEVEL 
wykorzystuje ten parametr jako szybkość pikseli, tzn. szybkość z jaką 
generowane są piksele (czyli skaner jest przesuwany). W tym 
przypadku parametr „częstotliwość błysków” służy do sterowania 
modulacją przełącznika Q. Ustawienie go na zero (0) powoduje, że 
modulacja przełącznika Q jest synchroniczna z ruchem skanerów (czyli 
jeden impuls na piksel). 

Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane), 
następujące parametry są edytowalne. 
FPK: Kiedy stosuje się niezmienną częstotliwość przełącznika Q, moc emitowanych impulsów zależy 
od samej częstotliwości (ponieważ jest to czas potrzebny na ponowne zapełnienie kryształu) i 
poziomu pompy optycznej (diody). Jednakże właśnie pierwszy impuls jest inny, ponieważ zapełnienie 
kryształu znacznie wzrosło w czasie oczekiwania: energia pierwszego impulsu może być wiele razy 
większa niż następnych impulsów. FPK jest techniką unikania pierwszego impulsu. 

FPK Delay [µs] Czas, w jakim sygnał poziomu lub opuszczenia pióra jest niski, żeby 
stłumić wygaszacz pierwszego impulsu (FPK). 

Wygaszacz pierwszego 
impulsu (FPK) 

FPK Level [%] Poziom wygaszacza pierwszego impulsu. 
Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane) 
wyświetlane są następujące parametry. 
Min Frequency 
[Hz] 

Reguła częstotliwości 

Max Frequency 
[Hz] 

Definiuje dozwolone częstotliwości, minimalną i maksymalną, w [Hz] 
(oddzielone przecinkiem). 

The following parameters are displayed after activating the Edit advanced 
parameter function. 
Min Speed 
[Kpts/s] 

Reguła prędkości 

Max Speed 
[Kpts/s] 

Definiuje dozwolone prędkości, minimalną i maksymalną, w [mm/s] 
(oddzielone przecinkiem). 
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Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane) 
wyświetlane są następujące parametry. 
Min Power [%] 
Max Power [%] 
Constant Power 
Correction [%] 
Gain Power 
Correction 
[%/Hz] 

Reguła mocy 

Offset Power 
Correction [%] 

Ta reguła służy do sterowania energią szczytową wiązki, żeby  
nie przekroczyła granic powodujących uszkodzenie. Niskie 
częstotliwości odpowiadają wysokiej energii pojedynczych 
błysków. Pojedyncze błyski o wysokiej energii mogą uszkodzić 
zwierciadła skanujące. 
Reguła mocy zawiera listę pięciu parametrów. 
Pierwsze dwa parametry wskazują bezwzględnie 
dopuszczalne poziomy mocy, minimalny i maksymalny.  
Trzeci i czwarty parametr służy do obliczania mocy 
maksymalnej związanej z wybraną częstotliwością, zgodnie ze 
wzorem Pmax = C + K * F, gdzie Pmax jest dopuszczalną 
mocą maksymalną, C (stała korekcji mocy) i K (korekcja 
wzmocnienia mocy) są liczbami w tej regule, a F jest bieżącą 
częstotliwością.  
Piąty parametr służy do ustawiania przesunięcia mocy.  W 
niektórych typach lasera (laser światłowodowy) związek 
między poziomem mocy a mocą wyjściową jest taki, że już 
przy zerowym poziomie mocy laser emituje znaczną moc 
wyjściową. Parametr korekcji przesunięcia mocy przedstawia 
procentowy poziom mocy, który jest emitowany, kiedy laser 
jest ustawiony na minimalny poziom mocy. 

Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane) 
wyświetlane są następujące parametry. 
Min Delay [ms] Reguła zwłoki 

Max Delay [ms] 

Definiuje dozwolone zwłoki punktowe, minimalną i maksymalną, w  
[ms], (oddzielone przecinkiem). Zwłoka punktowa jest stosowana 
w znakowaniu wektorowym i jest to czas stosowany do 
znakowania całego „punktu”. 

Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane) 
wyświetlane są następujące parametry. 
Ten parametr jest dostępny tylko dla źródła laserowego MOPA. Źródło laserowe 
MOPA umożliwia wybór czasu trwania impulsu laserowego z wybranego 
zakresu wartości. Te wartości nazywają się profilami impulsu. 

Profil impulsu 

Wybór profilu  Lista dostępnych profili impulsu 
Po uaktywnieniu funkcji Edit advanced parameter (edytuj parametry zaawansowane) 
wyświetlane są następujące parametry. 
Ten parametr jest dostępny tylko dla źródła laserowego MOPA. Źródło laserowe 
MOPA umożliwia wybór czasu trwania impulsu laserowego z wybranego 
zakresu wartości. Te wartości nazywają się profilami impulsu. 

Opis 
Własna nazwa przydzielona do wybranego profilu impulsu. Ta 
nazwa będzie widoczna na liście profili impulsu w przeglądarce 
właściwości edytora laserowego. 

Czas trwania Czas trwania impulsu laserowego dla wybranego profilu 
impulsu 

Właściwości profilu impulsu 

Min Frequency 
[Hz] 

Minimalna dopuszczalna częstotliwość dla wybranego profilu 
impulsu  

 Max Frequency 
[Hz] 

Maksymalna dopuszczalna częstotliwość dla wybranego 
profilu impulsu 

 Enable 

Włączanie / wyłączanie wybranego profilu impulsu. Jeżeli 
wybrany profil impulsu będzie wyłączony, to nie będzie 
widoczny  na liście profili impulsu w przeglądarce właściwości 
edytora laserowego. Jeżeli w dokumencie będzie zastosowany 
profil impulsu, który jest obecnie wyłączony, to ten profil 
impulsu zostanie zastąpiony najbliższym profilem. 
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Ustawianie parametrów korekcyjnych 
Strona Correction (korekcja) okna Laser configuration (konfiguracja lasera) służy do ustawiania 
wymaganej korekcji optycznej w celu zrekompensowania zniekształcenia zwierciadeł i soczewki. 

Grupa 
właściwości Właściwość Opis 

Ogniskowa [mm] Zawiera listę dostępnych soczewek, które można zainstalować na głowicy 
skanera urządzenia laserowego. 

Powiel soczewkę 
Ten przycisk umożliwia powielenie soczewki, aby użyć jej jako wzornika w celu 
stworzenia nowej. Wtedy można tak ustawić parametry soczewki, żeby 
pasowały do potrzeb użytkownika. 

Usuń soczewkę Ten przycisk umożliwia usunięcie soczewki stworzonej przez użytkownika. 
Soczewka 

Importuj 
soczewkę 

Ten przycisk umożliwia import soczewki przy użyciu innego pliku 
konfiguracyjnego (laser.inz). W ten sposób można zastosować konfigurację 
własnej soczewki, która została wykonana na innym urządzeniu. 

Parametry w tym obszarze umożliwiają użytkownikowi zorientowanie pola optycznego w 
dowolnym odpowiadającym mu kierunku. 

Odwróć oś X Jeżeli jest ustawiony na True, to parametry osi są odwracane. Domyślne 
jest ustawienie False. 

Odwróć oś Y Jeżeli jest ustawiony na True, to parametry osi Y są odwracane. 
Domyślne jest ustawienie False. 

Orientacja pola 

Przerzut osi X-Y 

Przerzut osi X i osi Y. 
Parametry odwracania trzech osi służą do skierowania pola 
grawerowania w czterech pozycjach kątowych, jak opisano poniżej: 

 Obrót o 0°: Brak 
 Obrót o 90°: Odwróć X + przerzuć X-Y. 
 Obrót o 180°: Odwróć X + odwróć Y. 
 Obrót o 270°: Odwróć Y + przerzuć X-Y. 

Parametry w tym obszarze umożliwiają użytkownikowi ustawienie swoich własnych korekcji 
optycznych (np., jeżeli głowica skanująca nie jest prawidłowo wyosiowana z polem 
znakowania. 
Zastosuj plik 
korekcyjny 

Jeżeli jest ustawione na True, to umożliwia określenie ścieżki własnego 
pliku, który ma być zastosowany do korekcji pola. 

Offset X [pts] Umożliwia poziome wyosiowanie pola. 
Offset Y [pts] Umożliwia pionowe wyosiowanie pola. 
Scale X [%] 
Scale Y [%] 

Współczynniki skali stosowane do skorygowania powiększenia. 

Theta X [deg] 
Theta Y [deg] 

Kąty theta stosowane do obliczania korekcji optycznej. 

Proporcja boków 
poziomych [góra / 
dół] 

Proporcja boków 
pionowych [prawy / 
lewy] 

Te parametry korygują błąd wprowadzony przez nieprawidłowe 
wyosiowanie głowicy skanującej z polem znakowania. 
Powoduje to odkształcenie pola: kwadrat staje się trapezem. Aby 
rozwiązać problem, należy zastosować parametr „proporcja 
przekątnych”. 

Kąt obrotu pola 
[stopnie] 

Obraca pole optyczne, aby wyosiować go z polem fizycznym. Ponieważ 
ta operacja wprowadza błędy blisko granic pola, akceptowane są tylko 
wartości mniejsze niż 1°. 

Korekcja 
optyczna 

Proporcja 
przekątnych 

Proporcja między górnym i dolnym bokiem (Proporcja boków 
poziomych), prawym i lewym bokiem (Proporcja boków pionowych), które 
użytkownik może zastosować w celu usunięcia odkształcenia przez 
regulację korekcji optycznej. 
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Te parametry umożliwiają skonfigurowanie swojej własnej soczewki. Stosuje się je razem z 
przyciskami Duplicate - Delete (powiel - usuń) i Import lens(importuj soczewkę). (Patrz 
wyżej) 
Opis Ciąg opisujący soczewkę. 
Głębia ostrości Zakres wzdłuż osi Z, gdzie wiązka jest zogniskowana. 
Nominalna 
ogniskowa [mm] 
Rzeczywista 
ogniskowa [mm] 

Te parametry determinują wielkość obszaru znakowania i inne 
właściwości systemu. 

Szerokość pola 
[mm] 
Wysokość pola 
[mm] 

Znakowanie wymiarów pola. Pole optyczne jest zawsze kwadratem, ale 
fizyczne może mieć inne wymiary w rzeczywistej aplikacji. 

Mechaniczny bok 
pola [mm] 

Parametry 
soczewki 

Logiczny bok 
pola [pt] 

Bok kwadratu pola znakowania. 
Ta wartość służy do konwersji między punktami a milimetrami. 

Ustawianie parametrów celowania 
Strona Aiming (celowanie) okna Laser configuration (konfiguracja lasera) służy do korekcji granic 
wskaźnika w stosunku do grawerowania, żeby uzyskać doskonałe nakładkowanie, ponieważ długości fal 
lasera mocy i lasera wskaźnikowego są różne. 

Rezonator może zawierać czerwoną diodę świecącą. Służy ona do podświetlenia operatorowi obszaru 
znakowania, zwykle w zastosowaniach przemysłowych. Nie każdy laser ma czerwoną diodę. 

Inna długość fali widzialnego światła czerwonej diody i światła laserowego powoduje różną refrakcję w 
obiektywie. W konsekwencji, współrzędna generowana podczas wyświetlania granic układu musi być 
skorygowana, żeby pasowała do grawerowania układu. 

Ta strona umożliwia pewne dostrojenie rozmieszczenia granic; jeżeli wynik wciąż będzie niewłaściwy, proszę 
skontaktować się z zespołem wsparcia technicznego. 

Grupa 
właściwości Właściwość Opis 

Skaner Scan Speed 
[Kpts/s] 

Prędkość skanerów stosowana podczas śledzenia granic, wyrażona w 
Kplamkach/s. 

Offset X [pts] 
Przesunięcie wyosiowania wyrażone w punktach, stosowane do 
współrzędnej X podczas śledzenia granic. Ta wartość jest ograniczona do 
±1% zakresu współrzędnych. 

Offset Y [pts] 
Przesunięcie wyosiowania wyrażone w punktach, stosowane do 
współrzędnej Y podczas śledzenia granic. Ta wartość jest ograniczona do 
±1% zakresu współrzędnych. 

Scale X [%] Skala zastosowana do współrzędnej X podczas śledzenia granic. Ta 
wartość jest ograniczona do ±5% (95÷105%). 

Korekcja 

Scale Y [%] Skala zastosowana do współrzędnej Y podczas śledzenia granic. Ta 
wartość jest ograniczona do ±5% (95÷105%). 
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Ustawianie parametrów wejścia / wyjścia 
Strona Input / Output (wejście / wyjście) okna Laser configuration (konfiguracja lasera) służy do 
ustawiania czasów trwania i zwłok sygnałów wejściowych lasera w stosunku do grawerowania. 

Grupa 
właściwości Właściwość Opis 

Start time [ms] Ustawia minimalny czas trwania, w ms, sygnału rozpoczęcia 
grawerowania. 

Start delay 
[ms or mm] 

Ustawia zwłokę, w ms, między akceptacją sygnału rozpoczęcia 
grawerowania a rzeczywistym rozpoczęciem grawerowania. 

Wejścia 

Stop time [ms] Ustawia minimalny czas trwania sygnału zatrzymania grawerowania, w 
ms. 

Busy advance 
[ms] 

Zwłoka między sygnałem pracy w toku (laser zajęty) a rzeczywistą enisją 
lasera. Ten parametr może być przydatny, jeżeli sygnał służy do 
otwierania elektromechanicznej przegrody ruchomej. 

Busy delay 
[ms] 

Zwłoka między końcem rzeczywistej emisji laserowej a końcem sygnału 
Laser Zajety. 

End time [ms] Czas trwania sygnału końca grawerowania (koniec lasera) po 
zakończeniu się sygnału „laser zajęty”. 

Wyjścia 

Sw Ready 
Compatibility 

Jeżeli jest ustawiony na true (prawda) to sygnał SW_Ready przechodzi w stan 
wysoki, kiedy dokument lub sekwencja jest w TRYBIE AUTOMATYCZNYM. To 
ustawienie zachowuje takie samo zarządzanie jak Smartist. 
Jeżeli jest ustawiony na false (fałsz), to sygnał SW_Ready przechodzi w stan 
wysoki, kiedy dokument lub sekwencja jest w TRYBIE AUTOMATYCZNYM, a 
stan lasera to GOTOWY (Key=aktywny; Enable=aktywny) 

Ustawianie parametrów X, Y, Z i osi wirnika 
Strony osi X, osi Y, osi Z i osi wirnika służą do ustawiania parametrów dotyczących trzech osi mechanicznych, których 
ruch jest sterowany silnikami krokowymi. 

W szczególności: 
 Oś Z jest osią mechaniczną. Umożliwia ogniskowanie na różnych poziomach. 
 X, Y i oś wirnika są osiami mechanicznymi stosowanymi pozycjonowania obiektów pod laserem poprzez 

sterowanie silnikiem krokowym. 

Zarządzanie i ustawienia osi zależą od sterowania pokładowego ich ruchem. Te parametry są zwykle wykorzystywane 
przez osobę, która instaluje i ustawia silnik krokowy do zarządzania osią. Bliższe informacje, patrz Zarządzanie osiami 
mechanicznymi. 

Grupa 
właściwości Właściwość Opis 

Te dwa parametry ustawiają konwersję między krokami silnika a ruchem osi. 

Kroki [kroki] Liczba kroków do przebycia przez silnik odległości podanej w wartości 
Jednostki. 

Konwersja 

Jednostki [mm, 
cal, stopień...] 

Odległość przesunięcia osi, kiedy silnik wykonuje określoną liczbę 
kroków. Wartość jednostek zależy od osi, którą zarządzasz: jeżeli jest to 
oś obrotowa, wartość jest w stopniach (np. liczba kroków dla obrotu o 
360°); jeżeli jest to oś liniowa, wartość jest wyrażona w jednostce miary 
długości, tej, którą ustawiłeś dla aplikacji. 

Parametry Włącz oś 
Jeżeli jest ustawiony na True (domyślnie), to zezwala na zarządzanie 
osią. W oknie mechanizmu laserowego pojawi się odpowiednia 
zakładka. 
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Dedykowane 
we/wy 

Ma zastosowanie tylko do osi wirnika (oś R). Umożliwia zarządzanie aż 
4 osiami, całkowicie niezależnie od siebie. W tym celu można 
zarządzać nowym zestawem wyjść. 
Jeżeli jest ustawiony na True, sprawdzić dokumentację we/wy 
dotyczącą pulpitu operatora, a potem podłączyć oś R do 
dedykowanego zestawu wyjść. 
Jeżeli jest ustawiony na False, sprawdzić dokumentację we/wy 
dotyczącą pulpitu operatora, a potem podłączyć oś R do zestawu wyjść 
używanego przez oś X. 

Poniższe parametry umożliwiają użytkownikowi ustawianie prędkości, która najlepiej 
odpowiada właściwościom mechanicznym stosowanego silnika, żeby zapobiec poślizgowi 
silnika. Można stosować albo kroki, albo jednostki jako jednostkę miary. 
Prędkość początkowa 
[kroki/s] 

Prędkość początkowa 
[jednostki/s] 

Prędkość silnika na początku rampy przyśpieszania. 

Prędkość [kroki/s] 

Prędkość [jednostki/s] 
Prędkość silnika na końcu rampy przyśpieszania. 

Czas rampy [ms] 
Czas jakiego potrzebuje rampa przyśpieszania, żeby przejść od 
prędkości minimalnej (prędkość początkowa) do prędkości roboczej 
(prędkość). 

Zresetuj przy tej 
samej prędkości 

Jeżeli jest ustawiony na True, to taka sama prędkość jaką ustawiłeś powyżej 
będzie zastosowana do resetowania osi (szukania pozycji spoczynkowej). 
Jeżeli jest ustawiony na False, to poniżej pojawią się pewne właściwości 
umożliwiające wprowadzenie innej prędkości dla szukania pozycji 
spoczynkowej. 

Prędkość 
początkowa 
resetowania 
[kroki/s] 
Prędkość 
początkowa 
resetowania 
[jednostki/s] 

Prędkość silnika na początku rampy przyśpieszania podczas operacji 
resetowania. (Te parametry są wyświetlane, jeżeli Zresetuj przy tej 
samej prędkości jest ustawione na False). 

Prędkość 
resetowania 
[kroki/s] 
Prędkość 
resetowania 
[jednostki/s] 

Prędkość silnika na końcu rampy przyśpieszania podczas operacji 
resetowania. (Te parametry są wyświetlane, jeżeli Zresetuj przy tej 
samej prędkości jest ustawione na False). 

Czas rampy 
resetowania [ms] 

Czas potrzebny do przyśpieszania od prędkości minimalnej (prędkość 
początkowa resetowania) do prędkości roboczej (prędkość resetowania). Reset 
osi jest wykonywany z inną prędkością, żeby dążyć do maksymalnej preccyzji. 
(Te parametry są wyświetlane, jeżeli Zresetuj przy tej samej prędkości jest 
ustawione na False). 

Zwolnienie 
hamulca [ms] 

Czas zwalniania hamulca elektromagnetycznego. Jest to czas, który upływa 
między aktywacją sygnału zwolnienia hamulca a początkiem ruchu 
mechanicznego. 

Zwłoka po 
przesunięciu [ms] 

Czas między końcem ruchu osi a początkiem znakowania. Gdy silnik 
(zwłaszcza obracający się) osiągnie pozycję, musi upłynąć czas, żeby 
zatrzymać drgania; ten czas zależy od bezwładności systemu. 

Kierunek 
szukania pozycji 
spoczynkowej 

Kierunek szukania pozycji spoczynkowej. Może być ustawiony 
na Automatyczny, Malejące kroki silnika lub Rosnące kroki silnika. 
W szczególności opcja Automatyczny umożliwia bezpośrednie szukanie 
pozycji spoczynkowej, w oparciu o bieżącą pozycję osi. 

  

Reset po 
uruchomieniu 

Jeżeli jest ustawiony na True, to przy uruchamianiu mechanizmu 
laserowego oś będzie przesuwana do pozycji spoczynkowej. 
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Poniższe parametry odnoszą się do granic (w krokach), minimalnej i maksymalnej, do 
których może dotrzeć oś. 
Minimum [kroki] 
Minimum 
[jednostki] 

Minimalna granica położenia silnika 

Maksimum [kroki] 
Maksimum 
[jednostki] 

Maksymalna granica położenia silnika 

Zero [kroki] 

Zero [jednostki] 

Położenie zera logicznego w stosunku do zera mechanicznego. 
Każdy ruch osi jest rozpatrywany w stosunku do sera logicznego. I na 
odwrót, szukanie pozycji początkowej lokalizuje zero mechaniczne 
(czujnik pozycji spoczynkowej). 

Przesunięcie 
pierścieniowe 
[kroki] 
Przesunięcie 
pierścieniowe 
[jednostki] 

Przesunięcie zera logicznego osi Z w środku obrotu. Ten parametr 
daje możliwość zastosowania dwóch zer logicznych odniesienia, zero 
logiczne dla dokumentów warstwy i „przesunięcie pierścieniowe” 
dodane do zera logicznego  dla dokumentów pierścieniowych. 

Granice 

Odwróć oś 
Wartość True ustawia odwrócenie logiki osi. Można ją stosować, 
kiedy orientacja osi jest odwrócona, tak że zero mechaniczne jest 
umieszczone jest umieszczone tam gdzie operator oczekuje. 

Poniższe parametry można stosować do testowania ustawień w fazie instalacji. 
Szukanie pozycji 
spoczynkowej 

Umożliwia szukanie czujnika pozycji spoczynkowej (zero mechaniczne) z 
prędkością określoną dla parametrów Reset.  

Przesuń do 
[kroki] 
Przesuń do 
[jednostki] 

Te parametry umożliwiają przesuwani osi na żądaną pozycję. 

Poniższe parametry są tylko do odczytu i zależą od trzech powyższych parametrów. 
Flaga pozycji 
spoczynkowej 

Po sprawdzeniu wskazuje, że została osiągnięta pozycja 
spoczynkowa (zero mechaniczne).  

Bieżąca pozycja 
[kroki] 

Polecenia 

Bieżąca pozycja 
[jednostki] 

Pokazuje ostatnią pozycję jaką osiągnęła oś (w krokach lub 
jednostkach), zgodnie z parametrami „Przesuń do”. 



EDYTOR LASEROWY 

168  
 

5

Konfigurowanie funkcji „znakowanie w trakcie działania programu” 

 

Uwaga: 
Funkcja Marking on the Fly (znakowanie w trakcie działania programu) jest dostępna tylko na 
pulpitach operatora iMark. 

Po włączeniu tej opcji wszystkie obiekty są automatycznie porządkowane, tak że będą znakowane w 
odwrotnym kierunku wałka. W ten sposób wykorzystujemy ruch do powiększenia pola znakowania. 

Ta funkcja jest zwykle stosowana na linii produkcyjnej, gdzie wałek przenośnika jest podłączony do systemu 
laserowego i oba elementy są sterowane przez pulpit operatora PCI. 

Można podłączyć koder do systemu dla najlepszych osiągów lub ustawić tryb Continuous marking (ciągłe 
znakowanie), żeby znakować wielokrotnie tę samą treść. 

Jest przewidziany Wizard (kreator), do którego można uzyskać dostęp z okna konfiguracji znakowania w 
trakcie działania programu, a który pomaga prawidłowo skonfigurować i stosować tę funkcję. 

Kiedy stosuje się koder 
Kiedy wymagana jest wysoka jakość lub duża precyzja, na przykład w razie bardzo małych znakowań 
laserowych, koder umożliwia najlepsze osiągi. 

Koder zlicza ruchy wałka i natychmiast wyznacza jego prędkość. Umożliwia to uzyskanie prawidłowej pozycji 
ruchomego celu i zapewnienie wysokiej precyzji znakowania. 

Kiedy cel zostanie wykryty przez czujnik i podany jest sygnał startu, koder oblicza pozycję celu przez 
podanie konkretnej liczby impulsów dla danej odległości. 

Czas do obliczenia pochodzi z właściwości Start Delay (zwłoka startu). 

 

 Wskazówka: Jeżeli nie używasz kodera (np. prędkość poruszania się celu jest znana lub nie jest 
wymagana wysoka precyzja znakowania), możesz go symulować przez włączenie 
parametru Simulation (symulacja), a potem określenie średniej prędkości. 

Kiedy stosuje się tryb znakowania ciągłego 
Tryb znakowania ciągłego umożliwia takie ustawienie lasera, że takie samo znakowanie będzie powtarzane 
w określonych z góry odległościach lub odstępach. 

Zwykle jest stosowany, gdy trzeba wielokrotnie oznakować rurę na określonym odcinku. 

Kiedy ustawi się ten tryb, czujnik wykrywa cel i sygnał startu jest podany tylko raz; potem znakowanie jest 
powtarzane po każdym osiągnięciu określonej odległości. 

Jeżeli stosuje się koder, wartość odległości dla powtórzeń musi być ustawiona w mm; natomiast, jeżeli nie 
stosuje się kodera, wartość ustawia się w ms. 

Ustawianie parametrów konfiguracyjnych 

 

Warunek wstępny: 
Aby funkcja „znakowanie w trakcie działania programu” działała prawidłowo, trzeba obowiązkowo 
ustawić następujący parametr: 
Laser Configuration > Scan parameters > Standby Position = Center (konfiguracja lasera > 
parametry skanowania > pozycja oczekiwania = środek 
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Po kliknięciu w Marking on the Fly (znakowanie w trakcie działania programu) w oknie Laser 
Configuration (konfiguracja lasera) otwiera się poniższe okno konfiguracji. 

 

Należy zwrócić uwagę, że przewidziany jest kreator, który prowadzi przez prawidłowe ustawienie połączeń 
sprzętu i parametrów, które sterują tą funkcją. (Patrz Opis parametrów, gdzie są opisane wszystkie 
parametry). 

Poniżej opisano ja należy stosować kreatora. 

Stosowanie kreatora 
1. W oknie konfiguracji „znakowania w trakcie działania programu” kliknąć w Wizard (kreator). 

Wyświetla się pierwsze okno, które umożliwia sprawdzenie sprzętu i połączeń kablowych. 
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2. Postępować zgodnie z instrukcjami opisanymi w kreatorze, aby sprawdzić czy wszystko jest 
podłączone i pracuje prawidłowo oraz czy fotokomórka jest prawidłowo zamontowana: 

a. Jeżeli masz koder, to po włączeniu zasilania taśmy transportowej upewnij się, że niebieskie 
koło zębate porusza się w oknie. 

b. Jeżeli nie masz kodera podłączonego do swojego systemu, wybierz Simulate Encoder 
Signal (symuluj sygnał kodera). 

c. Po aktywacji zewnętrznego sygnału startu upewnij się, że dioda świecąca sygnału start  w 
oknie zaświeci się na zielono. 

Wejścia od 0 do 15 stają się zielone, żeby wskazać obecnie aktywne sygnały wejściowe, o 
ile są; w przeciwnym razie są szare (jeżeli nie są używane lub są nieaktywne). 

 
 Wskazówka: Jeżeli potrzebujesz tylko sprawdzenia sprzętu i połączeń kablowych, możesz 
zamknąć kreatora. 

3. Kliknij w Next (następny). Wyświetli się okno Scan Head Position (skanuj pozycję głowicy), które 
umożliwia zdefiniowanie początku obiektu do znakowania w stosunku do pola znakowania w celu 
wyznaczenia prawidłowego kierunku znakowania: 

 

4. Postępować zgodnie z instrukcjami i zakończyć test tak jak to opisano w oknie - strzałka ma 
wskazywać prawidłowo. 
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5. Kliknij w Next (następny). Wyświetli się okno Speed conversion (konwersja prędkości), które 
umożliwia obliczenie Scale Factor (współczynnik skali), który definiuje prędkość taśmy 
transportowej. W ten sposób nie musisz stosować specjalnych przyrządów, żeby obliczyć tę 
wartość: 

 

6. Postępuj zgodnie z instrukcjami podanymi w oknie. 

Wartość, która jest wyświetlana w ramce Speed (prędkość) po zakończeniu testu, jest wartością, 
której należy użyć, żeby obliczyć Scale Factor (współczynnik skali), który musi być wprowadzony w 
oknie Konfiguracji, w Marking on the Fly (znakowanie w trakcie działania programu) (liczba 
impulsów/mm, jeżeli masz koder; mm/s, jeżeli stosujesz symulację). Prędkość odpowiada liczbie 
impulsów, które upływają między obiektami do znakowania. 
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7. Kliknij w Next (następny). Wyświetli się okno Start Delay (zwłoka startu), które umożliwia 
obliczenie odległości między czujnikiem startu, który wykrywa obiekt do znakowania, a środkiem 
pola znakowania. Ten test w rzeczywistości nie znakuje; raczej umożliwia sprawdzenie czy 
odległość jest ustawiona prawidłowo: 

 

8. Postępuj zgodnie z instrukcjami podanymi w oknie. 

Po naciśnięciu Run upewnij się, że kółeczko, które śledzi laser, wskazuje cel, kiedy wchodzi on w 
pole znakowania. Jeżeli nie, sprawdź odległość Start delay (zwłoka staru), a potem powtórz test. 
Jeżeli zwłoka startu jest ustawiona prawidłowo, musisz przeliczyć obliczoną prędkość (okno Wizard 
(kreator), Speed Conversion (konwersja prędkości)). 

9. Kliknij w Next (następny). Wyświetli się okno Fine Tuning (dokładne strojenie), które umożliwia 
dokładne dostrojenie parametrów i sprawdzenie czy prędkość taśmy transportowej (współczynnik 
skali) została prawidłowo obliczona. Test w rzeczywistości wykona znakowanie podczas ruchu 
taśmy. 
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10. Postępuj zgodnie z instrukcjami podanymi w oknie. Należy zwrócić uwagę, że przez powtarzanie 
testu i wybieranie żądanego kółka prędkość zmienia się, aż kółko będzie prawidłowo oznakowane. 

11. Możesz także zmienić wartości Power (moc), Frequency (częstotliwość) i Scan speed (prędkość 
skanowania), aby dopasować je do swoich specyficznych potrzeb, w zależności od znakowanego 
materiału. 

12. Po zakończeniu kliknąć w Finish (zakończ). 

13. Uzupełnij parametry w oknie Marking on the Fly Configuration (znakowanie w trakcie działania 
programu), według potrzeb. Poniżej jest tabela z opisem. 
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Opis parametrów 
W poniższej tabeli opisano parametry, które pojawiają się w oknie znakowania w trakcie działania programu: 

Grupa 
właściwości Parametr Opis 

  
Włącz znakowanie 
w trakcie działania 
programu 

Wybrać pole wyboru, aby włączyć funkcję. 
(Najlepsze praktyki ustawiania tej funkcji, żeby odpowiadała potrzebom, 
patrz Kiedy stosuje się koder i Kiedy stosuje się tryb znakowania ciągłego.) 

Symulacja Jeżeli wybrano tę opcję, koder jest symulowany przez pulpit operatora iMark, 
tzn. laser będzie ścigać cel z podaną prędkością. 

Współczynnik 
skali 

Prędkość wałka przenośnika (lub ruchomego celu). Możliwe są dwa 
scenariusze: 

 Jeżeli jest stosowany koder, ta wartość odpowiada liczbie impulsów 
na milimetr, zmierzonej przez koder. 

 Jeżeli stosuje się symulację, trzeba określić wartość, która odpowiada 
średniej prędkości wałka, na podstawie czasu (w mm/s). 

Do obliczenia tej wartości użyć okna kreatora Speed conversion (konwersja 
prędkości). 

Koder 

Odwróć koder Umożliwia odwrócenie sygnału do kodera, a więc odwrócenie kierunku 
znakowania. 

Pozycja 

Oś, wzdłuż której cele są znakowane na wałki przenośnika, w stosunku do 
głównego skanera. 
Użyć okna kreatora Scan Head Position (skanuj pozycję głowicy), żeby 
prawidłowo wyznaczyć kierunek. 

Przesunięcie 
[mm] 

Dodatkowe przesunięcie, które może służyć do dokładnego dostrojenia operacji 
znakowania. Ujemne przesunięcia przemieszczą układ w kierunku, z którego 
nadchodzi cel. Tego parametru można użyć do regulacji położenia układu i w celu 
skorzystania z ruchu celu, żeby rozszerzyć pole znakowania. Następujący rysunek 
pokazuje jak ten parametr wpływa na operację znakowania: 

 

Kierunek 

Odwrotne 
porządkowanie 
wielokątów 

Ustawia porządek wielokątów na podstawie konfiguracji głowicy skanującej 
(oś X / Y) i kierunku obiektu do znaakowania. 
Użyć okna kreatora Scan Head Position (skanuj pozycję głowicy), żeby ustawić 
ten parametr. 

Jednostka 
[mm] lub [ms] Jednostka miary, albo [mm], albo [ms] dla parametru zwłoka startu. 

Zwłoka startu 
[mm] lub [ms] 

Odległość w [mm] lub zwłoka w [ms] między środkiem pola znakowania a 
czujnikiem zbliżeniowym. 
Do obliczenia tej wartości użyć okna kreatora Start Delay (zwłoka startu). 

Znakowanie 
ciągłe 

Wybrać tę opcję, jeżeli trzeba wielokrotnie znakować taki sam układ, w 
określonej odległości. 
Jeżeli stosowany jest koder, ta wartość jest w [mm]. Jeżeli stosuje się 
symulację, ta wartość jest w [ms]. 

Ustawienia 

Odległość 
[mm] 

Odległość w [mm] między znakowaniami, kiedy włączony jest tryb znakowania 
ciągłego. 
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Ustawianie parametrów sieciowych 
Okno konfiguracji sieci zawiera następujące parametry: 

Grupa 
właściwości Właściwość Opis 

Sieć Nazwa sieciowa 
urządzenia  

Określić nazwę urządzenia stosowanego przez Lighter w środowisku trybu 
zdalnego. Jest to przydatne, kiedy do tej samej sieci jest podłączonych wiele 
laserów i trzeba je rozpoznawać. 

Serwer TCP Numer portu  Określić numer portu protokołu serwera TCP stosowanego przez mechanizm 
laserowy w środowisku trybu zdalnego. 

Ethernet/IP  Karta sieciowa Określić kartę sieciową, na której będzie włączone połączenie Ethernet_IP. 

Ustawienia DHCP 

Jeżeli ustawiono „użyj DHGP”, to adres IP jest przydzielany automatycznie 
(sprawdzić, czy sieć ma tę możliwość). 
Jeżeli ustawiono „Określ ręcznie adres IP”, to trzeba spytać administratora 
sieci o prawidłowe ustawienia IP.  

Adres IP Adres IP urządzenia 
Maska podsieci Maska podsieci 
Brama domyślna Brama domyślna 
Preferowany serwer 
DNS Preferowany serwer DNS 

Podłączenie 
obszaru lokalnego 

Zastępczy serwer 
DNS Zastępczy serwer DNS 

Konfiguracja MARVIS 
Okno konfiguracji MARVIS służy do ustawiania poniższych parametrów. 

Grupa 
właściwości Właściwość Opis 

Uaktualnianie oprogramowania 
urządzenia Ten przycisk umożliwia uaktualnianie oprogramowania czytnika. 

Ujawnianie urządzeń Ten przycisk umożliwia ujawnienie jednego lub kilku czytników podłączonych do sieci. 

Adres IP urządzenia Adres IP czytnika podłączonego do markera laserowego. 

Model urządzenia Model czytnika podłączonego do markera laserowego. 

Nazwa urządzenia Nazwa czytnika podłączonego do markera laserowego. 

Numer urządzenia Numer fabryczny czytnika podłączonego do markera laserowego. 

Zarządzaj urządzeniem Ten przycisk umożliwia ustawianie parametrów czytnika podłączonego do markera 
laserowego. 

Przeterminowanie (ms) Przeterminowanie wyznacza odcinek czasu na oczekiwanie odpowiedzi od czytnika przed 
uznaniem błędu. Dozwolone są wartości od 5000 do 30 000 ms. 

Podłączenie 

Test urządzenia Ten przycisk wykonuje test połączenia między markerem lasera a czytnikiem. 

Parametry w tym obszarze umożliwiają programowanie rodzajowych wejść / wyjść do stosowania w aplikacjach automatycznych. 
Uwaga: Wejścia / wyjścia czytnika Matrix nie są używane w aplikacjach MARVIS. 

Sygnał MARVIS DOBRY/ZŁY Uniwersalny sygnał wyjściowy walidacji DOBRY/ZŁY. 

Sygnał końca MARVIS Uniwersalny sygnał wyjściowy walidacji końca. 

Sygnał błędu MARVIS Uniwersalny sygnał wyjściowy błędu rodzajowego, który wystąpił w czasie walidacji. 

Walidacja 

Przycisk gromadzenia To pole umożliwia wybór trybu przycisku gromadzenia w celu zastosowania do walidacji/ 

Parametry w tym obszarze umożliwiają ustawienie pożądanych preferencji dla zapisywania obrazów zgromadzonych w czasie 
walidacji. 

Zapisywanie obrazów To pole umożliwia wybór obrazu do zapisania. 

Maks. obszar obrazów [MB] Ten parametr ustawia maksymalną przestrzeń zarezerwowaną dla zapisywania obrazów. 
Dozwolone są wartości od 1 do 1000 MB. 

Bieżąca ścieżka zapisywania: To pole pokazuje ścieżkę zapisywania. 

Obrazy 

Ścieżka zapisywania obrazów Ten przycisk umożliwia wybór ścieżki zapisywania. 

Parametr w tym obszarze umożliwia ustawienie przestrzeni zarezerwowanej dla statystycznych informacji walidacyjnych. 
Baza danych 

Maks. wielkość [MB] Dozwolone są wartości od 1 do 500 Mb. 
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Zarządzanie osią i wykonywanie testu lasera 

 

Uwaga: 
Zakładki interfejsu mechanizmu laserowego oś X-Y, oś Z i oś wirnika są dostępne tylko wtedy, 
gdy laser jest podatny i prawidłowo skonfigurowany, tzn. jeżeli oś jest uaktywniona na poziomie 
konfiguracji lasera (patrz Ustawianie parametrów osi X, Y, Z i wirnika). 
W szczególności zakładka oś wirnika jest dostępna tylko wtedy, gdy na urządzeniu jest 
zainstalowany separator pierścieni. 

Mechanizm laserowy zapewnia graficzny interfejs użytkownika do bezpośredniego zarządzania ruchami osi, 
które są sterowane silnikami krokowymi. 

Osie można przesuwać albo przez ustawianie parametrów osi, albo przy użyciu klawiszy zs strzałkami na 
swojej klawiaturze. 

Bliższe informacje: 

Temat Zawartość 
Zarządzanie osiami mechanicznymi Krótki opis techniczny jak oprogramowanie zarządza osią. 
Stosowanie zakładek osi X-Y lub 
wirnika do zarządzania osiami 

Jak zarządzać osią mechaniczną, liniową lub obrotową, swojego 
urządzenia. 

Stosowanie zakładki oś Z do 
zarządzania osią i testowania lasera. 

Jak zarządzać osią mechaniczną, która umożliwia ogniskowanie na 
różnych poziomach i jak wykonywać test lasera. 

Zarządzanie osiami mechanicznymi 
Opis ustawień dotyczących osi wymaga krótkiego opisu sposobu w jaki oprogramowania zarządza osią. 

Informacje o osiach 
Poniższy rysunek pokazuje powiązania osi, logiczne (niebieskie) i mechaniczne (czarne). One mogą być różne, 
ponieważ przedstawienie logiczne jest zbudowane na tym czego operator oczekuje, natomiast przedstawienie 
mechaniczne zależy od wyborów lub potrzeb konstrukcyjnych. Na rysunku oś Z pokazuje tę różnicę: orientacja jest 
odwrócona i logiczne zero jest umieszczone w całkiem innym miejscu niż zero mechaniczne (tam gdzie jest 
umieszczony czujnik zera). 

Ruch osi napędzają silniki krokowe. Oś może być liniowa albo obrotowa. Urządzenia, które napędzają ruch osi mają 
oczywiście minimum i maksimum, których nie można przekroczyć; jest to prawdziwe także dla osi obrotowej: wprawdzie 
obrót mógłby być ciągły, ustawione są granice, których nie można przekroczyć. 
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Oś liniowa vs. oś obrotowa 
Oprogramowanie napędza oś w taki sam sposób, czy to liniową, czy obrotową. 

Głównym ustawieniem jest konwersję między krokiem silnika a ruchem osi. W przypadku osi liniowej jest to 
liczba kroków, które przesyłają silnik o 1 mm (lub o jakąś inną jednostkę: 1 metr, 1 cal, itd.); w przypadku osi 
obrotu jest to liczba kroków dających obrót o 360° (lub jakąś inną miarę kątową). 

Inwersja wskazuje kierunek obrotu w osi obrotu. 

 

Stosowanie zakładek osi X-Y lub wirnika do zarządzania osiami 

 

Uwaga: 
Te zakładki są dostępne tylko wtedy, gdy osie są uaktywnione na poziomie konfiguracji lasera 
(patrz Ustawianie parametrów osi X, Y, Z i wirnika). 
Pola na zakładkach są dostępne tylko wtedy, gdy są uaktywnione tryby: lokalny tryb sterowania i 
tryb ręczny. (Patrz Przełączanie między trybami roboczymi). 

X, Y i oś wirnika są osiami mechanicznymi (liniowymi i obrotu) stosowanymi pozycjonowania obiektów pod 
laserem poprzez sterowanie silnikiem krokowym. (Więcej informacji, patrz Zarządzanie osiami 
mechanicznymi ). 

Przy użyciu tych zakładek można sterować ruchami osi i pozycją obiektów na płaszczyźnie roboczej. 

Zarządzanie osiami: 
Poniższy przykład opisuje jak stosować zakładkę X-Y Axis (oś X-Y) do sprawdzania i zarządzania 
mechanicznymi osiami liniowymi. Użycie przycisku polecenia Home Search (szukanie pozycji 
spoczynkowej) powoduje takie przesunięcie silnika osi, żeby osiągnąć czujnik zbliżeniowy. Znaczenie pól na 
zakładce Rotor Axis (oś obrotu) jest identyczne. 
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1. Wybrać zakładkę mechanizmu laserowego X-Y lub Rotor Axis (oś obrotu), w zależności od tego, 
którą oś przesuwasz. 

 

Powyższy przykład przedstawia płaszczyznę roboczą z dwiema osiami liniowymi, które przesuwają 
obiekt w kierunku X i Y; pokazane jest położenie plamki laserowej na płaszczyźnie. 

2. Kliknąć w Home Search (szukanie pozycji spoczynkowej). Jeżeli Home Flag (flaga pozycji 
spoczynkowej) nie jest sprawdzona, tzn. jeżeli zero nie zostało osiągnięte, silnik rozpoczyna ruch w 
kierunku czujnika zbliżeniowego, trwający o momentu jego osiągnięcia. Jeżeli flaga pozycji 
spoczynkowej jest już sprawdzona, silniki nie przesuną się. 

3. Parametry pod spodem oznaczają co następuje: 
o Home Flag (flaga pozycji spoczynkowej) - To pole wyboru jest wybrane, jeżeli zero zostało 

osiągnięte, tzn. jeżeli czujnik 0 jest uaktywniony. 
o Minimum position (pozycja minimalna) - Minimalna pozycja silnika, którą może osiągnąć 

oś. 
o Maximum position (pozycja maksymalna) - Maksymalna pozycja silnika, którą może 

osiągnąć oś. 
o Current position (pozycja bieżąca) - Pokazuje ostatnią pozycję osiągniętą przez oś. 

Stosowanie zakładki oś Z do zarządzania osią i testowania lasera. 

 

Uwagi: 
The Z Axis tab is only available if the axis is enabled at the laser configuration level (see Setting 
the X, Y, Z, and Rotor Axes parameters). 
Pola na zakładce są dostępne tylko wtedy, gdy są uaktywnione tryby: lokalny tryb sterowania i 
tryb ręczny. (Patrz Przełączanie między trybami roboczymi). 

Oś Z służy do ogniskowania lasera na różnych poziomach. (Bliższe informacje, patrz Informacje o osiach ). 

Przy użyciu zakładki Z Axis (oś Z) można także wykonać test lasera odnośnie ogniska. (Patrz Wykonywanie 
testu lasera odnośnie ogniska). 
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Zarządzanie osią Z 
Poniższy przykład opisuje jak stosować zakładkę Z Axis (oś Z) do sprawdzania i zarządzania osią. Użycie 
przycisku polecenia Home Search (szukanie pozycji spoczynkowej) powoduje takie przesunięcie silnika osi, 
żeby osiągnąć czujnik zbliżeniowy. 

1. Wybrać zakładkę mechanizmu laserowego Z Axis (oś Z). 

 

2. Patrz poprzednia sekcja Zarządzanie osiami: w celu uzyskania bliższych informacji o przycisku Home 
Search (szukanie pozycji spoczynkowej) i parametrach znajdujących się pod spodem. 

Wykonywanie testu lasera odnośnie ogniska 
Ta funkcja umożliwia szukanie płaszczyzny ogniskowej. 

Dla najlepszych osiągów, podczas grawerowania głowica laserowa musi być w prawidłowej odległości ogniskowej od 
przedmiotu grawerowanego. 

Test lasera umożliwia grawerowanie kształtu geometrycznego o wstępnie określonych parametrach i jednocześnie ze 
wstępnie określoną pozycją osi. 

Wykonanie testu: 

1. Wybrać zakładkę mechanizmu laserowego Z Axis (oś Z). 

2. Pod Laser Test (test lasera) ustawić następujące parametry: 
o Z rozwijanej w dół listy Type (typ) wybrać potrzebny kształt geometryczny dla testu (kwadrat, linia, koło 

lub punkt). 
o Określić Size (wielkość) kształtu i moc (Power)  wyjściową lasera (wyrażoną w procentach mocy 

maksymalnej urządzenia). 
o Określić częstotliwość (Frequency) wyjściową lasera. Ten parametr służy do regulacji częstotliwości 

wyjściowej lasera przez bezpośrednie operowanie przełącznikiem Q. 
o Określić czy powinna być stosowana emisja ciągła (Continuous Emission). Ten parametr jest 

stosowany tylko przez źródło laserowe DPSS. 
o Określić Pulse Profile (profil impulsu). Ten parametr jest stosowany tylko przez źródło laserowe 

MOPA. 

3. Kliknąć w  , żeby uruchomić test. Większa interakcja lasera z badanym materiałem 
wskazuje, że uzyskano optymalne ognisko. 

 

Wskazówka: 
Prawidłowe położenie można zidentyfikować jako punkt grawerowania, w którym hałas i 
jaskrawość subiektywna generowane przez laser są maksymalne. 
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Korekcja odkształcenia soczewki 
Przy znakowaniu laserowym soczewka i zwierciadła, które służą do odchylania światła laserowego, 
wytwarzają odkształcenia, których korekcja jest decydująca dla dokładnej operacji znakowania. 

Funkcja korekcji soczewki zapewnia sposób łatwego korygowania tego zjawiska. 

Tematy pokrewne: 

 Ustawianie parametrów korekcyjnych 

Wysyłanie dokumentów do znakowania 

 

Uwagi: 
Ten przycisk jest dostępny tylko wtedy, gdy jest uaktywnione sterowanie lokalne. 
(Patrz Przełączanie między trybami roboczymi). 
Aby wybrać dokument lub wykonać operacje testowania, a także, aby wprowadzić jakąś 
zmianę, trzeba aktywować tryb ręczny (patrz Automatyczny / ręczny tryb roboczy). 

 

  

Przy użyciu interfejsu mechanizmu laserowego można wysłać do znakowania dowolny dokument, który 
został zapisany w urządzeniu. (Patrz Zapisywanie układu w urządzeniu). 

Aby wysyłać dokument do znakowania 

1. Upewnij się, że jesteś w ręcznym trybie roboczym. (Aby sprawdzić bieżący tryb roboczy, przesunąć 
wskaźnik na przycisk  .) 

2. W obszarze Name (nazwa) zakładki Documents (dokumenty) wybrać dokument .xlp, który ma 
być znakowany. 

3. Kliknąć w  , żeby wysłać dokument do znakowania. Aby zatrzymać znakowanie, kliknąć w . 

Należy zwrócić uwagę, że gdy laser znakuje, w dolnej części okienka Preview (podgląd) przesuwa 
się pasek postępu i zmniejsza się czas znakowania. 

 

Wskazówka: 
Funkcja edytora laserowego Mark preview (podgląd znakowania), patrz Podgląd znakowania), 
która umożliwia podglądanie jak linie będą znakowane przez laser i sprawdzanie czasu 
znakowania, została wdrożona jako obiekt skryptowy. Programiści mogą dodać obiekt do 
swojego interfejsu użytkownika, aby umożliwić operatorom sprawdzanie grawerowanego 
układu. 
(Bliższe informacje znajdują się w dokumentacji online edytora projektu, sekcja „Language 
reference”. 
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Oglądanie stanu urządzenia 
Zakładka interfejsu mechanizmu laserowego Device Status (stan urządzenia) jest oknem tylko do odczytu, 
które pokazuje informacje o stanie urządzenia. Jest dostępna tylko wtedy, gdy stosuje się urządzenia 
ULYXE lub VLase, lub Arex 20MW. 

Kolorowa ikona po prawej stronie u dołu okna pokazuje stan urządzenia (patrz tabela Ikony przedstawiające 
stan urządzenia). 

Oprócz dostarczania informacji o stanie, ta funkcja pomaga diagnozować lub korygować błędy, które mogą 
wystąpić. 
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Ikona stanu po prawej stronie u dołu zmienia się stosownie do stanu urządzenia. Znaczenie każdej ikony jest 
opisane w następującej tabeli: 

Ikony przedstawiające stan urządzenia 
Ikona Stan urządzenia Znaczenie 

 
WYŁĄCZONY Laser jest wyłączony lub odłączony. 

OSTRZEŻENIE 

Ten stan oznacza, że VLASE jest podłączony, nie wykryto błędu, ale nie 
można go stosować. Możliwe przyczyny: 

 sekwencja klawiszy jest nieprawidłowa 
 uaktywnił się stan awaryjny 
 laser podgrzewa się  

 Wskazówka: Szczegółowy opis, a także ostrzeżenia związane z wykrywaniem i 
usuwaniem usterek, patrz podręcznik dostarczony przez producenta źródła laserowego. 

 
CZEKAJ Laser czeka na sygnał wejściowy. 

 
OCZEKIWANIE 
lub GOTOWOŚĆ 

Laser jest w stanie oczekiwania lub jest gotowy, a przegroda ruchoma 
jest zamknięta. 

 
GOTOWY Laser jest gotowy do użytku. 

 
ZAJĘTY Laser obecnie znakuje. 

BŁĄD 
Urządzenie laserowe jest w stanie błędu. 
Kiedy zostanie wykryty stan błędu, żadnych dokumentów ani projektów 
nie można wysłać do znakowania. 

 
 Wskazówka: Szczegółowy opis, a także wykrywanie i usuwanie stanów błędu, patrz 

podręcznik dostarczony przez producenta źródła laserowego. 
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Zrozumienie pliku-rejestratora 

 

Polecenie menu skrótów interfejsu mechanizmu laserowego View log (oglądaj rejestrator) wymienia 
wszystkie działania, które nastąpiły umożliwiając użytkownikowi rozwiązanie jakiegoś problemu, który mógł 
wystąpić.  

Domyślna wielkość pliku-rejestratora jest ustawiona zarówno w edytorze laserowym jak i w mechanizmie 
laserowym.  

W edytorze laserowym jest ustawiona poprzez stronę General (informacje ogólne) okna edytora laserowego 
Configuration (konfiguracja), Max Log Space (maks. obszar rejestratora). Informacje o dostępie do tego 
okna, patrz Ustawianie języka, jednostki miary i efektów graficznych (strona ogólna). 

 

W mechanizmie laserowym jest ustawiona poprzez stronę General (informacje ogólne) okna mechanizmu 
laserowego Configuration (konfiguracja), Max Log Space (maks. obszar rejestratora). Informacje o 
dostępie do tego okna, patrz Ustawianie parametrów ogólnych. 
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W szczególności, parametr Max log space (maks. obszar rejestratora) definiuje obszar dysku na pliki-
rejestratory. Kiedy data systemu zmienia się, aplikacja sprawdza czy ten obszar został powiększony, a jeżeli 
jest to prawda, stare pliki są usuwane.  

Aby uzyskać dostęp do rejestratora: 
 Na pasku aplikacji Windows kliknąć prawym przyciskiem myszy w ikonę mechanizmu laserowego, 

żeby wyświetlić menu skrótów. 
 Kliknąć w View log (oglądaj rejestrator), żeby wyświetlić plik-rejestrator. 

Zwiększanie maksymalnego poziomu rejestratora, patrz Aby zwiększyć poziom rejestratora, poniżej.  

Aby zrozumieć plik-rejestrator 
Informacje o pliku-rejestratorze są zakodowane kolorami, aby pomóc w zrozumieniu czy wymagane jest działanie:  

 Czarny kolor - Komunikat informacyjny. Nie jest potrzebne żadne działanie. 
 Niebieski kolor - Komunikaty ostrzegawcze. Może być wymagane działanie. 
 Czerwony kolor - Komunikaty o błędach. Wymagane jest działanie. 

Aby zwiększyć poziom rejestratora 
Aby zwiększyć poziom rejestratora, tzn. poziom szczegółu dla pliku-rejestratora, trzeba postępować zgodnie z 
następującą procedurą:  

1. Zamknąć mechanizm laserowy 

2. Otworzyć edytor laserowy i kliknąć w Help > Open Data Folder (pomoc > otwórz folder danych)  
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3. Przejść do foldera Data\Config (dane / konfig.) 
4. Dwukrotnie kliknąć w LaserEngine.ini. 
5. Zmienić wartość poziomu rejestratora dla komponentu, którego poziom rejestratora ma być 

zwiększona lub zmniejszona. 

o LogLevel: ogólne informacje rejestratora o mechanizmie laserowym 

o LogLevelComPort: specjalne informacje rejestratora o porcie COM zarządzanym przez 
mechanizm laserowy 

o LogLevelxLaser: specjalne informacje rejestratora o funkcjach niskiego poziomu 
zarządzanych przez mechanizm laserowy 

o LogLevelTcpIp: specjalne informacje rejestratora o protokole TCP / IP zarządzanym przez 
mechanizm laserowy 

o LogLevelCan: specjalne informacje rejestratora o komunikatach CAN zarządzanych przez 
mechanizm laserowy 

o Uwaga: wartość domyślna wynosi 4, co odpowiada najniższemu poziomowi szczegółu. Im 
niższa wartość, tym wyższy poziom rejestratora, tzn. należy ustawić tę wartość na 0, 
żeby uzyskać maksymalny poziom szczegółu. 

o Uwaga: aby uzyskać szczegółowy plik-rejestrator, należy ustawić LogLevel=0 i 
LogLevelxLaser=0 

6. Zapisać LaserEngine.ini 

Testowanie systemu 

 

Polecenie menu skrótów interfejsu mechanizmu laserowego System test (test systemu) umożliwia dostęp 
do ramki dialogowej, gdzie można sprawdzić połączenia systemu. 

W szczególności, oprócz testowania lasera, można testować wszystkie wejścia i wyjścia, a także 
zewnętrzne sygnały Start i Stop . 
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Testowanie połączeń sytemu: 
1. Na pasku aplikacji Windows kliknąć prawym przyciskiem myszy w ,  ikonę mechanizmu 

laserowego, żeby wyświetlić menu skrótów. 
2. Kliknąć w System test (test systemu), żeby wyświetlić okno dialogowe: 

 

Testowanie lasera: 
1. Pod Laser Test (test lasera) ustawić następujące parametry: 

o Z rozwijanej w dół listy Type (typ) wybrać potrzebny kształt geometryczny dla testu (kwadrat, 
linia, koło lub punkt). 

o Określić Size (wielkość) kształtu i moc (Power)  wyjściową lasera (wyrażoną w procentach 
mocy maksymalnej urządzenia). 

o Określić częstotliwość (Frequency) wyjściową lasera. Ten parametr służy do regulacji 
częstotliwości wyjściowej lasera przez bezpośrednie operowanie przełącznikiem Q. 

o Określić czy powinna być stosowana emisja ciągła (Continuous Emission). Ten parametr 
jest stosowany tylko przez źródło laserowe DPSS. 

o Określić Pulse Profile (profil impulsu). Ten parametr jest stosowany tylko przez źródło 
laserowe MOPA. 

2. Kliknąć w przycisk uruchomienia testu. 

Testowanie wejść: 
Wejścia są uaktywniane / dezaktywowane poprzez polecenia zewnętrzne Start i Stop . Jeżeli wejścia nie 
staną się zielone (uaktywnione), to jest coś niewłaściwego w połączeniach: 

 Po naciśnięciu zewnętrznego Start dioda Start staje się zielona. Sprawdzić czy 
diody Input (wejściowe) stają się zielone. 

 Po naciśnięciu zewnętrznego Stop dioda Stop staje się zielona. 
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Testowanie wyjść: 
Aby przetestować połączenia wyjść, trzeba je aktywować ręcznie, albo jedno po drugim, albo wszystkie 
naraz. 

 

 Aby sprawdzać wyjścia jedno po drugim, klikać w stosowny przycisk. 

 Aby sprawdzić wszystkie wyjścia naraz, kliknąć w Change all outputs (zmień wszystkie wyjścia). 

Jeżeli przycisk Output (wyjście) zmienia się na zielony, wskazuje to, że jest uaktywniony i wszystkie 
połączenia są ustawione prawidłowo. Jeżeli przycisk wyjściowy jest nadal szary, to jest coś 
niewłaściwego w połączeniach. 

 Kiedy przycisk Ready (gotowy) jest zielony i uaktywniony, to wskazuje, że urządzenie jest gotowe do 
operacji znakowania. 
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